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1 ВВЕДЕНИЕ 

 
Со времени издания в России первой книги, посвященной описанию 

коммерческой программы Touchstone, прошло 15 лет. В эти годы продолжалось 
интенсивное развитие систем автоматизированного проектирования (САПР) 
радиоэлектронной аппаратуры (РЭА). 

Первые коммерческие программы проектирования, ориентированные на 
СВЧ диапазон (Touchstone, Libra), отличались сравнительной простотой 
математического обеспечения и текстовым описанием исследуемой схемы. 
Последующее развитие САПР СВЧ было связано с совершенствованием 
интерфейса, а также с переходом к применению электродинамических методов 
расчета. Здесь можно назвать САПР Microwave Office фирмы Applied Wave 
Research, в которой сочетаются электродинамический анализ устройства (EM 
Sight) с его представлением в виде набора схемных элементов (Schematic). 
Следует отметить, что система Microwave Office содержит также практически 
полный набор инструментов, характерных для низкочастотной САПР, таких как 
нелинейный анализ схемы, её оптимизация, анализ чувствительности, 
статистический анализ. Здесь видна тенденция к созданию интегрированных 
САПР, поддерживающих весь цикл проектирования РЭА вплоть до изготовления 
схемы. В ряду таких систем необходимо отметить Advanced Design System 
(ADS), содержащую блок электродинамического анализа ADS Momentum. 

Системы Microwave Office и ADS не являются в полной мере системами 
трехмерного электродинамического моделирования, так как они ориентированы 
на анализ многослойных печатных схем. Такие системы называют также 2.5-
мерными системами. Максимальной универсальностью с точки зрения решения 
трехмерных задач электродинамики обладают такие системы как High Frequency 
System Simulator (HFSS) [3] и Microwave Studio (MWS) [4]. 

В современных САПР реализуются разные математические методы. Среди 
них можно отметить прямые методы решения граничных задач, такие как метод 
конечных элементов (МКИ) и метод Finite Difference Time Domain (FDTD). 
Отличительной и наиболее привлекательной их чертой является универсальность, 
то есть возможность анализировать практически любую структуру. Платой за 
универсальность являются большие затраты компьютерных ресурсов. С точки 
зрения пользователя наиболее существенным недостатком является значительное 
время анализа СВЧ структур. Причина этого обусловлена дискретизацией 
пространства, лежащей в основе МКИ и FDTD. Количество элементов разбиения 
определяет размерность решаемой задачи, и в методах МКИ и FDTD оно 
является максимально возможным из всех известных методов. Отметим, что 
МКИ используется в HFSS, а FDTD – в CST MWS. 

Альтернативным направлением в решении задач электродинамики являются 
непрямые методы. Среди них следует отметить метод моментов (МОМ). Отличие 
его от упомянутых выше подходов состоит в том, что численное определение 
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поля основывается на аналитическом решении некоторой ключевой задачи 
возбуждения структуры элементарным источником тока. Такое решение в 
математике получило название метода функции Грина. МОМ оказывается 
эффективным, если функция Грина может быть записана аналитически в простой 
форме. В этом случае дискретизации подвергается уже не пространство, а лишь 
поверхность, что значительно снижает размерность задачи. К сожалению, 
функция Грина может быть достаточно просто найдена лишь для ограниченного 
числа структур. К ним можно отнести плоскослоистые структуры и свободное 
пространство. По этой причине именно для таких структур были разработаны 
САПР на основе МОМ. Данный метод используется в системах Microwave 
Office, ADS, FEKO. К числу таких систем следует отнести программу ЭДЭМ 
(Электродинамика экранов из металла), автор А.Г. Давыдов [5]. 

Особое место среди задач, решаемых САПР РЭА, занимают задачи 
излучения и рассеяния электромагнитных волн. Их отличие от задач анализа 
печатных или волноводных схем состоит в необходимости определения поля в 
области больших электрических размеров (под электрическим размером 
понимается отношение геометрического размера к длине волны в свободном 
пространстве). Дискретизация больших областей порождает задачи огромной 
размерности. Поэтому использование таких методов, как МКИ и FDTD здесь 
заведомо неэффективно. Более того, часто оказывается неэффективным даже 
существенно более экономичный МОМ. В этом случае строгие методы 
электродинамики необходимо дополнить так называемыми асимптотическими 
методами: физической оптики (ФО), геометрической теории дифракции (ГТД) и 
т.д. Гибридные подходы, использующие ФО и ГТД, реализованы в системе 
FEKO. 

Главной особенностью программы FEKO, отличающей ее от других 
коммерческих программ электромагнитного проектирования, является удачное 
сочетание базового метода моментов (МОМ) [8] с приближенными 
аналитическими методами: методом физической оптики (МФО) [9,10] и 
однородной теории дифракции (ОТД) [9]. Такое сочетание позволяет преодолеть 
главный недостаток программ компьютерного моделирования высокочастотных 
структур - значительные затраты ресурсов при моделировании объектов с 
электрическими размерами много большими длины волны. В результате 
появляется возможность решения с хорошей точностью таких задач, как 
рассеяние радиоволн на поверхностях самолета или корабля и распространение 
радиоволн в городских условиях. 

Остается важным вопрос, насколько точны результаты расчетов на 
электродинамическом уровне. Имеется ряд путей проверки точности расчета: 

• сравнение с точными результатами, если они доступны; 
• сравнение с решениями, полученными с помощью другой программы, 

которая использует другие методы вычисления; 
• сравнение с результатами измерений; 
• правдоподобность результатов, (например, отрицательные реальные 

входные сопротивления не существуют); 
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• выполнение базовых физических законов и соотношений: закона 
сохранения энергии, свойств симметрии, теорем взаимности и т.д. 

В последнее время опыт СВЧ проектирования все больше обогащается и 
приводит к тому, что при разработке СВЧ-устройств может быть исключен этап 
полномасштабной экспериментальной проверки. Это означает, что точное 
моделирование приведет, в конце концов, к полностью компьютеризированному 
проектированию радиотехнических систем большой сложности. 

Опыт внедрения САПР СВЧ показал, что лучшей программой для 
разработчика становится та, которую он лучше всего знает, хорошо понимает ее 
особенности, доверяет полученным результатам. Продолжительность 
практического использования описания программ моделирования соизмерима с 
жизнью очередной версии программы и сокращается до 1-2 года. Поэтому, 
представляя эту книгу, мы не вносим в неё теоретический материал, а 
ограничиваемся описанием особенностей программы и приводим несколько 
ключевых, ярких примеров, которые раскрывают возможности FEKO последней 
версии. 

Авторы благодарят сотрудников кафедры Антенно-фидерных устройств и 
распространения радиоволн Московского энергетического института, д.ф.-м.н., 
проф. В.А. Пермякова и к.т.н. доцента Б.А. Мишустина за полезные дискуссии и 
обсуждение результатов работ, которые вошли в книгу как составные задачи, а 
также н.с. ОАО «НИИ Приборостроения им. В.В. Тихомирова» В.А. Никиточкину 
за помощь в техническом редактировании книги. 
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2 ХАРАКТЕРИСТИКА СИСТЕМЫ FEKO 

Название программы FEKO происходит от немецкой фразы 
«FEldberechnung bei Körpern mit beliebiger Oberflache» (Расчет поля структуры 
произвольных форм). 

Базовым методом FEKO является метод моментов (MoM). Метод моментов 
– это способ решения интегральных уравнений (иногда его называют методом 
Галеркина или Бубнова-Галеркина). В отличие от метода конечных элементов [3], 
где пространство расчета замкнуто и ограничено, метод, в основе которого лежит 
решение интегральных уравнений, не ограничивает величину задачи. Метод МоМ 
– базовый, но не единственный метод, реализованный в FEKO (рис. 2.1). 

 
Рис. 2.1. Применение различных методов, реализованных в FEKO,  

для решения различных задач 
 

Электромагнитные поля вычисляются после расчета токов на проводящих 
поверхностях и эквивалентных электрических и магнитных токов на поверхности 
диэлектрического твердого тела. 

Токи находят, используя линейную комбинацию базовых функций, а 
коэффициенты при них определяются в результате решения системы линейных 
уравнений. Как только распределение тока найдено, может быть рассчитаны 
ближнее поле, дальнее поле, диаграмма направленности излучения, 
направленность и входное сопротивление антенн. 
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Задачи, включающие большие объекты, обычно решаются с помощью 
метода физической оптики (PO) и его вариантов, или используя однородную 
теорию дифракции (UTD). В комплексе FEKO (рис. 2.2) эти решения 
объединяются с MoM на уровне матрицы взаимодействий. 

 
Рис. 2.2. Состав комплекса FEKO 

 
Этим делается существенный шаг к решению задач, если рассматриваемый 

объект имеет достаточно большие электрические размеры, чтобы его 
моделировать методом MoM, но слишком маленькие, чтобы применять только 
асимптотическую аппроксимацию UTD. Применяя комбинации методов 
MoM/PO или MoM/UTD, критические области структуры можно анализировать, 
используя MoM, а остающиеся области (обычно большие, плоские или 
искривленные металлические поверхности) с использованием аппроксимации PO 
или UTD. 

В FEKO предусмотрен вывод сигналов во временной области, для чего в 
ней имеются гармонические источники. Преобразования из частотной области во 
временную, выполняются с помощью преобразования Фурье. Различные 
источники позволяют описывать возбуждение как падающую плоскую волну, 
напряжение в разрыве структуры (между сегментами проводов), и магнитным 
кольцевым током (TEM-Frill), которым может быть смоделирован коаксиальный 
фидер. 

Программа CADFEKO содержит основной интерфейс комплекса, в котором 
выполняется черчение сложной геометрии, выполняется импорт и экспорт 
отдельных ее частей. С другой стороны, ту же задачу можно решить в редакторе 
EditFEKO. Программа PREFEKO обрабатывает и готовит входной файл (*.fek) 
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для программы FEKO, которая является фактическим кодом вычисления поля. 
PREFEKO дает возможность пользователю создать сложные конфигурации 
простой командой, например, спираль, состоящую из сегментов провода, или 
плоские, цилиндрические, сферические поверхности, состоящие из 
треугольников. 

Эта геометрия может также быть создана в программе CADFEKO. 
Ядром программы FEKO является алгоритм решения трехмерных задач 

электродинамики в частотной области. Для решения электродинамических задач 
используются три метода, отмеченные выше. 

2.1 Используемые методы 

2.1.1 Метод моментов 
Метод моментов (MоM) предусматривает несколько этапов решения 

электродинамической задачи. Сначала металлические элементы анализируемой 
структуры заменяются эквивалентными электрическими поверхностными токами. 
Затем решается задача возбуждения окружающей среды данными токами. При 
этом среда может быть сложной, то есть может содержать 
магнитодиэлектрические слои. 

Решение задачи возбуждения среды осуществляется с помощью аппарата 
тензорных функций Грина. После того, как задача возбуждения решена и найдено 
электрическое поле, используются граничные условия на металлических 
элементах. Эти условия используются для определения эквивалентных токов. 
Важным моментом решения является разбиение поверхности металла на 
элементарные площадки и аппроксимация электрического тока в пределах 
площадки. Пример разбиения показан на рис. 2.3. 

 
Рис. 2.3. Антенна Вивальди, разбитая на элементы программой Mesher 

 
В программе FEKO для аппроксимации тока используются постоянные, 

линейные и треугольные функции, которые принято называть базисными 
функциями. Граничные условия на поверхности металла в МоМ выполняются 
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приближенно, а именно, в нескольких точках в пределах каждой элементарной 
площадки (строго эти условия должны выполняться во всех точках). В результате 
задания граничных условий в дискретных точках формируется система линейных 
алгебраических уравнений (СЛАУ) относительно коэффициентов при базисных 
функциях, которые имеют смысл амплитуд токов, текущих в пределах 
элементарной площадки. Данная СЛАУ решается численным методом на 
компьютере. 

В программе FEKO элементарная площадка имеет треугольную форму, что 
позволяет хорошо описывать, в том числе и искривленные поверхности. 

Точность МoМ тем выше, чем меньше размер площадки разбиения. Из 
опыта расчетов найдено, что для получения приемлемой точности размер 
площадки не должен превышать /10, где  – длина волны в свободном 
пространстве. Количество уравнений в СЛАУ равно числу элементарных 
площадок N, которое неизбежно увеличивается при увеличении размеров 
анализируемого объекта или при увеличении частоты. Поэтому легко увидеть, что 
непосредственное решение задачи типа рассеяния радиоволн на автомобиле с 
помощью МoМ потребует решения СЛАУ огромной размерности. На практике 
это можно выполнить, только используя широко используемый в последнее время 
расчет на суперкомпьютерах. 

2.1.2 Метод физической оптики 
Метод физической оптики (МФО) – это классический метод 

приближенного решения электродинамических задач (рис. 2.4), который еще 
называется методом Кирхгофа. 

 
Рис. 2.4. Антенная система радиолокационной станции на вертолете, 

анализируемая методами MoM и MФО 
 

В рамках этого метода задача поиска токов на металлических поверхностях 
исключается, а ток приближенно вычисляется через магнитное поле падающей на 
объект волны. Количественно его полагают равным удвоенной величине 
тангенциальной составляющей магнитного поля падающей волны. Далее 
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рассеянное поле вычисляется с помощью аппарата функций Грина через заданное 
распределение токов. МФО хорошо работает при решении задач рассеяния 
плоских волн на объектах больших размеров. При уменьшении размеров объекта 
аппроксимация тока магнитным полем падающей волны становится неточной. 

2.1.3 Однородная теория дифракции 
Однородная теория дифракции (ОТД) – более современный метод 

приближенного решения задач рассеяния волн на больших объектах. В рамках 
этого метода поверхность объекта представляется набором плоских 
многоугольников, имеющих общие ребра. Поле, рассеянное каждым 
многоугольником, разделяется на две составляющие: геометро-оптическая часть, 
порожденная плоской поверхностью, и поле, порожденное ребрами. Метод ОТД 
считается более точным, чем МФО, и имеет примерно те же пределы 
применимости. 

2.2 Виды анализируемых структур 
Программа FEKO позволяет анализировать сложные устройства на основе 

СВЧ линий передач: полосковых, микрополосковых линий и волноводов. 
Пользователь описывает геометрию структуры (топологию проводников и 

структуру слоев) и материальные параметры (магнитные и диэлектрические 
проницаемости сред, проводимости проводников), задает положение и вид 
портов. Программа с помощью МoМ находит токи на проводниках, на основе 
которых определяются внешние параметры устройства: матрицы рассеяния, Y, Z 
параметры и т.д. Программа может анализировать многослойные печатные 
схемы. Анализ проводится с учетом конечных потерь в элементах конструкции, 
то есть предполагается, что проводники имеют конечную проводимость, а 
диэлектрические слои ненулевой тангенс угла потерь. 

Программа FEKO позволяет разбивать анализируемую структуру как на 
ячейки однородные, с одинаковым размером, так и на ячейки, сильно 
отличающиеся по размеру. Это позволяет создавать структуры, которые по форме 
значительно отличаются от традиционных линий, поворотов, т.е. иметь 
нетрадиционную форму. 

2.2.1 Электромагнитная совместимость 
FEKO позволяет рассчитывать поля, наводимые протяженными линейными 

токами (коаксиальные кабели, витые пары, двухпроводные линии и т.д.), а также 
рассчитывать их взаимное влияние. Кроме того, подпрограмма CableMod 
содержит средства, поддерживающие решение задач прохождения 
информационных сигналов через информационные линии передачи.  

2.2.2 Одиночные планарные и объемные излучатели 
C помощью программы FEKO могут моделироваться планарные 

излучатели, например, печатные дипольные и микрополосковые антенны на 
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основе многослойных магнито-диэлектрических подложек. Задачи данного класса 
решаются с помощью МoМ.  

Для повышения эффективности решения используется специальный 
алгоритм вычисления функции Грина в многослойной среде. В программе также 
предусмотрена возможность учета конечных размеров подложки, что является 
существенным фактором в ряде случаев. Вместе с излучающей структурой 
одновременно может анализироваться схема питания антенны. 

FEKO позволяет рассчитать параметры антенны как СВЧ многополюсника 
(матрицы S, Y, Z) и как излучателя (диаграмма направленности в дальней зоне, 
коэффициент направленного действия, поляризационные характеристики).  

FEKO предусматривает разные способы возбуждения антенн: 
- источник напряжения, включенный в проволочный элемент или между 

элементами сетки; 
- источник тока; 
- плоская волна заданной поляризации; 
- волноводный, микрополосковый порт и порт на ребре; 
- апертура. 

Объемные излучатели типа открытого конца металлического волновода или 
рупора также могут анализироваться с помощью программы FEKO. 

2.2.3 Решетки излучателей 
Одиночные излучатели часто используются в антенной технике в качестве 

элементов решеток. Поэтому важной задачей является их эффективное 
моделирование, учитывающее эффект взаимной связи излучателей через 
свободное пространство.  

На рис. 2.5 показана антенная 
решетка для базовой станции, 
состоящая из 16-и вибраторных 
излучателей и 32-х проволочных 
экранов, которая моделировалась с 
помощью программы FEKO. 

 
 

2.2.4 Зеркальные антенны с 
облучателями 

Удачным сочетанием МоМ и МФО является анализ зеркальной 
параболической антенны с облучателем в виде рупора (рис. 2.6). Особенностью 
анализа такой структуры является то, что малоразмерные элементы (облучатель) 
моделируются с помощью МоМ, а параболическое зеркало больших 
электрических размеров описывается с помощью МФО. 

 

Рис. 2.5. Фазированная антенная решетка 
для базовой станции системы связи, 
реализующая функции смарт-антенны с 
перестраиваемой диаграммой 
направленности 
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Рис. 2.6. Зеркальная антенна с облучателем в виде рупора 

 
Большой интерес представляют задачи оптимизации антенн мобильных 

телефонов, а также расчет поля, наводимого такой антенной в теле человека. 
Основную сложность в данном случае представляет расчет поля в голове 
человека, поскольку последняя с точки зрения электродинамики является 
сложной структурой, состоящей из различных сред с потерями. 

Для анализа подобных структур в программе FEKO используются метод 
эквивалентных поверхностных токов и метод объемных токов поляризации. 
Сочетание этих методов позволяет осуществлять расчет электромагнитного поля 
в салоне транспортного средства и голове человека с достаточно хорошей 
точностью. 

В радиолокации важной задачей является дифракция электромагнитной 
волны на объекте (самолет, корабль, автомобиль и т.д.) и определение его 
эффективной площади рассеяния. В подобных задачах наиболее полно 
раскрываются преимущества программы FEKO, использующей приближенные 
методы решения электродинамических задач для объектов больших 
электрических размеров (все перечисленные объекты относятся именно к классу 
таких объектов). 

С методической точки зрения к такому же классу задач относится, 
например, задача об излучении антенны мобильного телефона, установленной на 
крыше автомобиля. Данная структура содержит относительно малоразмерные 
элементы – антенна и прилегающая к ней часть крыши автомобиля, и элементы с 
большими размерами (собственно автомобиль). На рис. 2.7 показана схема, 
поясняющая решение такой задачи. Собственно антенна и часть крыши 
автомобиля описываются методом МoМ. 
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Рис. 2.7. Структура антенны, установленной на корпусе транспортного средства. 
Указаны лучи распространения радиоволн, моделируемые методом 
геометрической оптики 
 

Оставшаяся часть крыши описывается в приближении заданных токов 
МФО и, наконец, рассеяние остальными элементами конструкции автомобиля 
моделируется в приближении ОТД, то есть вычисляются траектории лучей, 
падающих на плоские поверхности и кромки, а далее – поля рассеянные этими 
поверхностями и кромками. 

Описание такой сложной структуры можно выполнить в FEKO с помощью, 
так называемых карт геометрии, то есть специальных подпрограмм, которые 
пишутся пользователем на внутреннем языке FEKO, имеющем достаточно 
простую и естественную структуру. Сложные конфигурации целесообразно 
описывать также с помощью других программ, предназначенных для 
формирования трехмерных сеток, в CADFEKO. Программа FEKO допускает 
импорт стандартных файлов, описывающих трехмерные структуры и их 
разбиения на сетки (ACIS, Parasolid, IGES, SAT, DXF). 

Описание структуры в виде карт на первый взгляд кажется архаичным 
подходом, идущим от традиций командной строки DOS. Однако такое построение 
геометрии, а затем исполнительных карт имеет и свои преимущества. Оно дает 
возможность дополнительного контроля правильности конструкции и 
нахождения в ней ошибок. Текст задания можно проверять отдельно от 
графического редактора, это особенно важно при создании сложных структур со 
многими источниками возбуждения. Проектировщик, по сути, имеет перед собой 
текст задания, который он может сразу же откорректировать. Задание в виде 
текста дает универсальность, поскольку все задание записано в текстовом файле.  

Визуализация результатов выполняется в FEKO на этапе постпроцессорной 
обработки данных. Это включает просмотр: 

- распределения электрических токов на металлических поверхностях; 
- распределения поля в объеме; 
- параметров многополюсников (матрицы S, Y, Z и т.д.); 
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- параметров на диаграмме Смита (рис. 2.8); 
- параметров антенн (диаграмма направленности, коэффициент 

направленного действия, поляризационные диаграммы); 
- относительной поглощенной мощности (для биологических объектов); 
- визуализацию лучей (при решении методом ОТД); 
- реакцию цепей во временной области (при анализе переходных процессов). 

 
Рис. 2.8. Рассчитанные S параметры, выводимые на диаграмму Смита 

 
Программа FEKO является программой, в которой сосредоточены все 

лучшие качества, достигнутые и развитые в настоящее время в программах 
проектирования СВЧ устройств. Точный метод моментов с добавленными 
методами оптической оптики открывает широкие возможности расчета 
большеразмерных антенных систем в присутствии больших металлических 
объектов сложной формы. 

Наличие удобного и мощного инструмента построения геометрии, 
возможность описания различных источников возбуждения (дискретных, 
волноводных и в виде планарных волн) - создают предпосылки для расчета 
управляемых диаграмм направленности фазированных антенных решеток. 
Программа FEKO легка для освоения, имеет возможности контроля точности 
описания задачи. Фирма-производитель EMSS [1,2] дает возможность оценить 
мощность программы, давая 30-дневную лицензию для работы на полноценной 
версии программы, и её можно рекомендовать для обучения студентов и 
разработчиков СВЧ устройств. 
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3 МЕТОД МОМЕНТОВ – БАЗОВЫЙ МЕТОД МОДЕЛИРОВАНИЯ В 
FEKO 

Задачу, решаемую с помощью МоМ [2], можно представить в операторной 

форме: 

gfL )(       (3.1), 
где L – оператор, который формирует законы распространения электромагнитных 

волн в пространстве, т.е. уравнения Максвелла,  
f – токи, текущие по проводящим поверхностям, 
g – известная функция, описывающая источники возбуждения. 
В электродинамике чаще используются интегро-дифференциальные 

операторы. О том, как они получаются, будем говорить ниже. Сейчас же 
рассмотрим основную идею МоМ. При этом чисто математические вопросы об 
области определения оператора L(f) и сходимости МоМ оставляем в стороне, 
рассматривая только конструктивную часть метода. Под оператором в математике 
понимают действие, ставящее в соответствие функции функцию. 

Наиболее простым примером оператора может служить 
дифференцирование, которое исходной функции ставит в соответствие другую 
функцию – ее производную. Другой класс операторов – интегральные. Среди них 
наиболее известным является преобразование Фурье: 






 dxexffL xi)()(      (3.2) 

Нетрудно видеть, что оператор из (3.2) ставит в соответствие исходной 
функции f(x) новую функцию, которая называется Фурье-образом и определяется 
правой частью (3.2). 

Для компактного изложения схемы МоМ необходимо привлечь некоторые 
понятия из функционального анализа. К числу таких понятий относится 
скалярное произведение. Пусть мы имеем две функции f и g. Их скалярное 
произведение gf ,  должно удовлетворять следующим условиям: 

fggf ,,  ,       (3.3) 
 

hghfhgf ,,,   ,    (3.4) 
 

f f* ,  0 , если f ≠0,      (3.5) 
 

f f* ,  0 , если  f =0,      (3.6) 
 где,   и   – постоянные, а символ * - обозначает операцию комплексного 
сопряжения. Определение скалярного произведения неоднозначно. Его можно 
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строить по-разному. Часто под скалярным произведением двух функций, 
определенных в области S, понимают следующий интеграл: 


S

fgdSgf , .      (3.7) 

Легко видеть, что определение (3.7) удовлетворяет всем условиям (3.3)-
(3.6). Однако нам ничего не мешает добавить в (3.7) некоторую известную 
функцию, которую называют весовой функцией w. Тогда скалярное произведение 
изменится следующим образом: 


S

wfgdSgf , .      (3.8) 

Оно по-прежнему удовлетворяет всем условиям (3.3)-(3.8). Свободу в 
выборе скалярного произведения можно эффективно использовать, чтобы строить 
более эффективные алгоритмы решения уравнения (3.1). Перейдем далее 
непосредственно к МоМ. 

Представим неизвестную функцию f (токи) в виде разложения следующего 
вида: 


n

nnAf        (3.9) 

где n  – известные функции, получившие название базисных функций, а nA  – 
неизвестные коэффициенты. Пусть функция f определена в некоторой области S. 
Подставим формулу (3.9) в (3.1): 

 
n

nn gLA )(       (3.10) 

Введем еще одну систему функций n , которые назовем тестовыми или 
пробными функциями. Умножим (3.10) последовательно на пробные функции с 
разными номерами 1…m и вычислим соответствующие скалярные произведения 
(таких сумм будет m): 

 
n

mnmn gLA  )( .    (3.11) 

Итак, в формуле (3.11) мы получили систему линейных алгебраических 
уравнений (СЛАУ) относительно неизвестных коэффициентов mA . Если решить 
эту СЛАУ и найти mA , то мы автоматически находим искомую функцию f. 
Собственно говоря, в этом и состоит метод моментов, который позволяет свести 
исходную операторную задачу к СЛАУ, которые эффективно решается в FEKO. 

Запишем СЛАУ (3.11) в матричной форме: 
 



23 
 

.

......

.....,

......

.....

,

.......
...)(...)()(

............
...)(...)()(

...)(...)()(
,

2

1

2

1

21

22212

12111















































































NN

NNNN

N

N

A

A
A

A
g

g

g

G

LLL

LLL

LLL

Z

GAZ













   (3.12) 

  
Порядок этих матриц равен m. Используя (3.12), можно записать выражение 

для искомой функции f: 
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.      (3.13) 

В формулах (3.9)-(3.12) мы умышленно не указывали пределов 
суммирования. Дело в том, что, строго говоря, для точного описания неизвестной 
функции f требуется бесконечный набор базисных функций. На практике 
приходится ограничиваться конечной суммой: 





N

n
nnN Af

1
 .      (3.14) 

При этом предполагается, выполнение следующего соотношения: 





N
Ff N )lim( ,      (3.15) 

где F – точное решение уравнения (3.1). Формула (3.15) подразумевает, что 
предел существует и равен решению (3.1). В этом случае говорят о том, что метод 
сходится. Поскольку функция F неизвестна, то в качестве критерия сходимости 
соотношение (3.15) использовать нельзя. На практике используют следующее 
соотношение: 
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N
ff NN ,0)lim( 1      (3.16) 

которое утверждает лишь то, что итерационный процесс сходится, и функция f 
при увеличении N меняется всё меньше, что не всегда означает, что сходится она 
к точному решению уравнения (3.1). Обоснование равенства (3.15) относится к 
доказательной части МОМ, и мы его рассматривать не будем. 

Для остановки итерационного процесса, то есть выбора N, можно 
использовать соотношение следующего типа: 

 
S

NN dSff 2
1 ,     (3.17) 

где  – некоторое наперед заданное число, называемое критерием остановки. 
Формула (3.17) не является единственно возможным правилом для выбора 

N. Более того, часто на практике применяют другие критерии, но смысл их тот же 
самый: некоторая величина на шаге N должна стать меньше некоторого 
фиксированного значения. 

3.1 Базисные и тестовые функции.  
Существует большое разнообразие используемых базисных функций. 

Метод моментов не накладывает на систему базисных функций таких жестких 
требований, как ортогональность. Достаточно удовлетворить требованию 
полноты системы функций, которое означает, что бесконечный ряд вида (3.9) 
сходится в функциональном пространстве, в котором определена функция f. 

Существуют два подхода к выбору базисных функций. Первый подход 
ориентирован на решение конкретной задачи. В этом случае базисные функции 
выбираются так, чтобы быть максимально похожими на точное решение 
уравнения (3.1). Для этого приходится учитывать априорную информацию о 
свойствах решения. Возьмем в качестве примера оператор следующего вида: 

.)(

,)(1)(
1

1

gfL

dt
xt

tffL




 



     (3.18) 
Уравнения вида (3.18) часто встречаются в теории полосковых линий 

передачи, а также при анализе волноводных диафрагм. Известно точное решение 
уравнения (3.18): 
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Из (3.19) следует, что функция f(x) при 1x  имеет особенности типа x
1

, 
определяемые первым множителем. Второй сомножитель из (3.19) описывает 
некоторую гладкую функцию. Присутствие особенностей на краях интервала [-
1,1] относится к априорной информации о поведении функции f и может быть 
использовано для правильного выбора базисных функций. Например, удачным 
примером правильного выбора базисных функций является следующая система: 

21

)cos()(
x

nxxn





 .       (3.20) 

Мы видим, что базисные функции определены на всем интервале задания 
оператора L(f), и они стремятся к бесконечности на краях интервала также как 
строгое решение. Подставим выражение (3.20) в (3.9) и приравняем его строгому 
решению (3.19). В результате имеем следующее соотношение: 
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Сокращая общие множители, получаем: 
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Из формулы (3.21) видно, что задача определения неизвестных 
коэффициентов nA  эквивалентна разложению функции, стоящей в правой части 
(3.21), в ряд Фурье. Так как эта функция гладкая, то коэффициенты её Фурье-

разложения убывают не медленнее, чем 2
1

n . 
Совсем другая картина наблюдается при ином выборе системы базисных 

функций. Определим ее следующим образом: 
 

)cos()( nxxn   .     (3.22) 
 

Проделав операции, аналогичные предыдущим, получаем равенство, 
эквивалентное (3.21): 
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Мы вновь имеем дело с разложением в ряд Фурье. Однако сейчас нам 
нужно представить рядом функцию с особенностями. Без доказательства отметим, 

что в этом случае коэффициенты nA  убывают как n
1

, то есть намного 
медленнее, чем раньше. С практической точки зрения это означает, что для 
удовлетворения критерию (3.18) во втором случае придется взять N много 
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большее, чем в первом. Платой за это будет большой порядок решаемой СЛАУ и, 
следовательно, несравненно большие затраты компьютерного времени и памяти. 

К сожалению, обычно платой за быструю сходимость МоМ является потеря 
универсальности. Действительно, в каждой конкретной структуре будут свои 
подходящие базисные функции. Поиск их является неформализуемым процессом, 
который трудно превратить в компьютерную программу. Поэтому разработчики 
программного обеспечения отдают предпочтение базисным функциям, 
способным решать более широкий набор задач даже в ущерб сходимости 
решения. Это не означает, что учет априорной информации совсем не нашел 
применения в реальных системах проектирования. Это не так. Например, анализ 
регулярных полосковых линий передачи почти целиком построен на 
использовании функций (3.20). Однако при переходе к более сложным 
структурам приходится использовать другие базисные функции. 

Примером такой универсальной системы функций являются импульсные 
функции. Они вводятся следующим образом. Для простоты будем считать, что 
функция f является функцией одной переменной x, заданной на некотором 
интервале [a,b]. Тогда этот интервал разделяется на N подинтервалов nS , 

],[ 1 nn xxx , которые могут иметь, вообще говоря, разную длину nx . Тогда 
базисные функции определяются следующим образом: 
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Применение базисных функций (3.24) приводит к кусочно-постоянной 
аппроксимации функции f(x). На рис. 3.1 показан результат такой аппроксимации 
функции 

2
2

2

1

x







 
для разных N=10, 25. 
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Рис. 3.1. Аппроксимация ступенчатыми функциями 
 

Коэффициенты аппроксимирующей функции равны значениям f(x) в 
центрах интервалов nS . Таким образом, для аппроксимирующей функции F(x) 
получается следующее представление: 
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n
nn xxfxF
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0 )()()(  .     (3.25) 

Недостатком импульсных функций является то, что получаемая в 
результате их использования аппроксимирующая функция разрывная. Последнее 
обстоятельство в электродинамике в ряде случаев неприемлемо, так, разрывные 
функции могут порождать сингулярные поля, не отвечающие физической 
реальности. Тем не менее, рассматриваемая система базисных функций нашла 
достаточно широкое применение. 

Из рис. 3.1 также следует правило, относящееся ко всем другим системам 
функций. Точность решения зависит от скорости изменения неизвестной функции 
f. Это вывод верен для процедуры аппроксимации вообще и для МоМ в 
частности, так как, вообще говоря, решение по МоМ является аппроксимацией 
функции f рядом (3.9). Только коэффициенты аппроксимации ищутся несколько 
нетрадиционным путем, а именно – как решение СЛАУ (3.12). 

Широко применяются в МоМ треугольные функции. В англоязычной 
литературе для них используется термин, дословный перевод которого звучит как 
«крышечные» функции. Мы будем далее использовать русскоязычное название 
для этих функций. Ниже приводится определение треугольной функции: 
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   (3.26) 

При записи (3.26) предполагалось, что интервал [a,b] разбит на 
подинтервалы, которые могут иметь разную длину. На рис. 3.2 показан результат 
аппроксимации той же функции, что и раньше (кривая 1), рядом (3.25), в котором 
в качестве функций n  используются функции (3.26) (кривая 2). Величина N 
равна 20. Кривые 3 представляют элементарные функции n . 

Из рис. 3.2 видно, что мы получаем линейно-ломаную аппроксимацию 
исходной функции, которая точнее аппроксимации импульсными функциями и не 
имеет разрывов. 
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Базисные функции одной 
переменной применяются для 
решения практических задач 
достаточно редко. Из таких 
применений можно отметить 
моделирование регулярных линий 
передачи. Задачи расчета 
многополюсников, антенн и задачи 
рассеяния требуют использования 
более сложных базисных функций 
двух переменных. Это связано с тем, 
что, как правило, роль неизвестной 
функции в МоМ играет 
распределение поверхностных токов, 

текущих по металлическому телу. Поскольку поверхность характеризуется двумя 
координатами, то и, соответственно, для описания функции, заданной на 
поверхности, нужны базисные функции двух переменных. 

Для простоты изложения будем считать нашу поверхность плоской. Пусть 
функция f определена в прямоугольной области S: dycbxa   ,  (рис. 3.3). 
Введем в этой области прямоугольную сетку, то есть разделим ее на 
элементарные прямоугольные площадки Snm: 11  ,   mmnn yyyxxx . 

 
Рис. 3.3. Область определения функции f  

 
Элементарные площадки не обязательно имеют квадратную форму. Они 

могут быть и прямоугольниками. Не составляет труда определить импульсную 
функцию в двумерном случае. Для нее сохраняется определение (3.24). Только 

 
Рис. 3.2. Аппроксимация треугольными 

функциями 
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вместо интервала nS  следует использовать область nmS . Аппроксимирующая 
функция представляется теперь в виде двойного ряда: 


 


N

n

M

m
nmmn yxyxfyxF

1 1
00 ),(),(),(  .   (3.27) 

В формуле (3.27) под mn yx 00 ,  понимаются координаты центра 
элементарной площадки. 

Сложнее обстоит дело с треугольными функциями. В двумерном случае 
использовать термин треугольная функция, вообще говоря, не имеет смысла, но 
правильнее говорить о функциях, позволяющих получить линейно-ломаную 
аппроксимацию. К числу таких функций относится пирамидальная функция. 
Будем её называть двумерной треугольной функцией. Эта функция описывает 
пирамиду, вершина которой имеет координаты mn yx , . Приведем далее 
определение двумерной треугольной функции для случая одинакового шага по x и 
по y: 
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   (3.28) 

 
где  – размер элементарной площадки. 

 
Пирамида, соответствующая функции ),(00 yx , показана на рис. 3.4. 

 
Рис. 3.4. Двумерная треугольная функция 
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Результат аппроксимации двумерными треугольными функциями 
параболоида вращения, поверхность которого описывается функцией 
 

 2221),( yxyxf  , 
 
представлен на рис. 3.5. На этом рисунке показаны разные сечения двух функций 
(точной и аппроксимирующей), соответствующие разным координатам y. 
Аппроксимация проводилась в области 10,10  yx . Общее число 
элементарных N2 площадок равно 400. 

Из рис. 3.5 видно, что и в двумерном случае треугольные функции дают 
хорошую непрерывную аппроксимацию. 

Обсудим теперь вопросы, связанные с тестовыми функциями. В качестве 
тестовых могут использоваться все рассмотренные выше функции.  
 

Здесь необходимо отметить, 
что когда в качестве тестовых 
функций используются функции, 
совпадающие с базисными 
функциями, то такая реализация 
МоМ имеет специальное название – 
метод Бубнова-Галеркина. Метод 
Бубнова-Галеркина обладает рядом 
замечательных свойств, 
отличающим его от общего случая 
МоМ, которые мы рассмотрим 
ниже. Отметим, что термин МоМ в 
русскоязычной литературе часто 
заменяется термином «метод 
Галеркина» по имени одного из 
авторов. 

В качестве тестовых функций 
часто используются дельта-
функции. Последние, вообще 

говоря, могут использоваться и как базисные. Однако считается, что они дают 
весьма грубое приближение и поэтому применяются в этом качестве редко. 
Поэтому дельта-функции рассматриваются преимущественно как тестовые. 

Если мы имеем интервал [a,b], разделенный на элементарные интервалы 
точками nx , то система тестовых функций n  в виде дельта-функций имеет 
следующий вид: 
 

)( nn xx   .     (3.29) 
 

 
Рис. 3.5. Аппроксимация двумерной 

треугольной функцией 
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Благодаря известному свойству дельта-функции скалярные произведения в 
МоМ преобразуются следующим образом: 
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     (3.30) 
Из (3.30) видно, что СЛАУ, получаемая по МоМ 
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      (3.31) 

выражает условие точного выполнения операторного уравнения (3.1) в 
дискретных точках mx . Таким образом, использование дельта-функций 
эквивалентно поточечному выполнению равенства (3.1). Такая процедура 
получила название метод коллокации. В электродинамике этот метод чаще всего 
связан с выполнением граничных условий в ряде дискретных точек на некоторой 
поверхности. 

3.2 Метод Бубнова-Галеркина и вариационные принципы.  
Рассмотрим в данном разделе одно важное свойство метода Бубнова-Галеркина, а 
именно, его связь с вариационными методами решения операторного уравнения 
(3.1). В дальнейшем изложении потребуется понятие сопряженного оператора. 

Пусть мы имеем исходное операторное уравнение 
 

gfL )( .      (3.32) 

Оператор aL  будет сопряженным оператору L , если выполняется 
следующее равенство: 
 

)(,),(  aLffL  .    (3.33) 
Пусть далее функция   удовлетворяет следующему уравнению: 

 
aa gL )( .     (3.34) 

Поставим задаче (3.32) в соответствие функционал: 
 

agffgfLfZ ,,),(),(   .  (3.35) 
Под функционалом в математике понимается операция, ставящая в 

соответствие функции (функциям) скаляр (число). Таким образом, Z – это просто 
число. Замечательным свойством функционала (3.35) является его вариационная 
устойчивость на решении операторного уравнения (3.32). Поясним, что под этим 
понимается. 
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Допустим, что 0f  – это точное решение задачи (3.32), а fff  0  – 
некоторое приближенное решение, отличающееся от точного. Тогда ),( 0 fZ  
соответствует точному решению, а ZfZ  ),( 0  соответствует приближенному 
решению. Величина Z  называется вариацией функционала. Можно показать, что 
малые вариации решения f  порождают изменения Z , пропорциональные лишь 

2f , то есть величинам второго порядка малости. Это свойство получило 
название вариационной устойчивости функционала. 

На практике это свойство широко используется. Дело в том, что многие 
интересные параметры реальных устройств могут быть представлены в виде 
вариационно устойчивых функционалов. К числу таких параметров относятся 
характеристическое сопротивление линии передачи, входное сопротивление ряда 
неоднородностей в линиях передачи и т.д. После представления в виде 
функционала, в него можно подставить приближенное решение уравнения (3.32) 
и получить весьма точное значение искомого параметра. Таким образом, можно 
сделать вывод, что погрешность определения параметра, представляемого в 
форме (3.35), намного меньше погрешности определения самой функции f. 

Рассмотрим далее связь функционала (3.35) со СЛАУ, получаемой по 
методу Бубнова-Галеркина. Для этого допустим, что функции f  и   
описываются следующими суммами: 
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Подставим (3.36) в (3.35): 
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Будем искать коэффициенты nA  таким образом, чтобы функционал (3.37) 
был стационарным на приближенном решении задачи (3.32), определяемом рядом 
(3.36). Для этого потребуем выполнения следующих равенств: 
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     (3.38) 

Дифференцирование (3.37) приводит к следующей СЛАУ: 

NngLA n

N

m
nmm ,...1,0,,),(

1



 ,   (3.39) 

которая полностью совпадает со СЛАУ (3.12), если взять одинаковые базисные и 
тестовые функции, то есть применить метод Бубнова-Галеркина. Таким образом, 
этот метод автоматически дает решение, на котором функционал (3.35) 
стационарен. 
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3.3  Интегральные операторы и уравнения электродинамики 
В этом разделе рассмотрим некоторые операторы и соответствующие 

уравнения, к которым сводятся граничные задачи электродинамики. Начнем с 
простейших случаев двумерных задач, в которых поля зависят от двух координат. 
Известно, что решение уравнений Максвелла в двумерном случае распадается на 
две группы: Е и Н-волны. Если поля не зависят от координаты z, то Е-волны 
имеют компоненты Ez, Hx, Hy, а Н-волны – компоненты Hz, Ex, Ey. Более простым 
является случай Е-волн. Перейдем к его обсуждению. 

 
 

3.3.1 Двумерный интегральный оператор для Е-волн.  
На рис. 3.6 показана геометрия рассматриваемой структуры. 

 
Рис. 3.6. К выводу интегрального оператора для Е-волн 

 
Мы имеем идеально проводящее тело с поверхностью S, которое 

возбуждается плоской волной, имеющей компоненту ziE . Нам необходимо найти 
рассеянное телом поле, удовлетворяющее уравнениям Максвелла в свободном 
пространстве и следующим условиям: 

- граничным условиям на поверхности металла S: 0E , 
- условиям излучения на бесконечности. 
Для вывода интегрального уравнения используем следующий прием. 

Допустим, что тело отсутствует, вместо него имеется поверхность S, по которой 
текут поверхностные электрические токи. Известно, что ток связан с магнитным 
полем следующим соотношением: 

 
 HnJ e , ,      (3.40) 

где n  – вектор, нормальный к поверхности S (рис. 3.6). Поскольку магнитное 
поле ориентировано в плоскости XOY, то из (3.40) легко увидеть, что ток имеет 
одну z-ю компоненту. 
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После удаления металлического тела решим задачу о возбуждении 
свободного пространства электрическим током, текущим по поверхности S. Эта 
задача хорошо известна в электродинамике, и её решение дается с помощью 
функции Грина свободного пространства. Выпишем это решение: 


S

e
z

e
z dsVsGsJVA '),'()'()(  ,   (3.41) 

где 's  – координаты точки интегрирования, расположенной на поверхности S, а V  
– координаты точки наблюдения, расположенной вне металлического тела, )(VAe

z  
– z-я компонента векторного потенциала, ),'( VVG  – функция Грина свободного 
пространства. Для функции Грина свободного пространства известно выражение: 
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    (3.42) 

где k – волновое число свободного пространства, а )()2(
0 xH  – функция Ханкеля 

второго рода нулевого порядка. 
Все компоненты поля могут быть выражены через векторный потенциал. В 

частности компонента zE : 
 

e
zaz AiE  ,     (3.43) 

где   – круговая частота, a  – абсолютная магнитная проницаемость свободного 
пространства. 

Отметим следующие свойства полученного поля. Оно удовлетворяет 
уравнениям Максвелла в свободном пространстве, что следует из определения 
функции Грина. Оно удовлетворяет условиям излучения на бесконечности. 
Единственное условие исходной задачи, которое нам пока не удалось 
удовлетворить – это граничное условие на поверхности металла. Так как у Е-волн 
существует одна компонента электрического поля, то граничное условие можно 
переписать в новом виде: 
 

0 ziz EE    на поверхности S.    (3.44) 
 
Подставим (3.41)-(3.43) в (3.44) и получим искомое интегральное уравнение: 
 

zi
S

e
z

a EdskRHsJ  ')()'(
4

)2(
0


 на S.    (3.45) 

Уравнение (3.45) выполняется на поверхности S. Функция )'(sJ e
z  

неизвестна, и её надо определить, решая уравнение (3.45), а функция )()2(
0 kRH  

называется ядром интегрального уравнения. 
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Область интегрирования в (3.45) совпадает с областью определения 
уравнения. Характерной особенностью ядра уравнения является наличие 
особенности, когда 'VV  . Это связано с тем, что функция Ханкеля при 0x  
имеет логарифмическую особенность. 

Перейдем теперь к случаю Н-волн. 

3.3.2 Двумерный интегральный оператор для Н-волн.  
Сохраним геометрию структуры неизменной. Отличие случая Н-волн состоит 
только в том, что у падающей волны имеется компонента ziH . Используя (3.40), 
можно установить, что токи уже текут не вдоль оси 0z, а вдоль граничного 
контура цилиндрической поверхности S. Поэтому они имеют как x-ю, так и у-ю 
компоненты.  

Введем на поверхности металлического тела локальную систему координат 
nz . Тогда в этой системе координат ток имеет одну компоненту eJ . 

Действуем далее по прежней схеме. Заменяем тело токами и решаем задачу 
при возбуждении ими свободного пространства. В системе координат nz  это 
решение имеет следующий вид: 


S

ee dsVsGsJVA '),'()'()(  .     (3.46) 

Функция Грина осталась той же самой, что и раньше. Существенно 
изменилась связь векторного потенциала с тангенциальным к поверхности тела 
электрическим полем: 
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где a  – абсолютная диэлектрическая проницаемость свободного пространства. 
Используя соотношения (3.46), (3.47) и граничные условия на металле, 

получаем искомое интегральное уравнение: 
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   (3.48) 

Интегральное уравнение существенно отличается от уравнения (3.45) 
присутствием в нем дифференциального оператора. Правильнее было бы 
называть его интегро-дифференциальным уравнением. Дифференциальный 
оператор существенно усиливает особенность ядра уравнения, что может 
привести к определенным затруднениям при решении (3.48). 

3.3.3 Трехмерный интегральный оператор. 
 Трехмерный случай отличается еще большей сложностью. Пусть в свободном 
пространстве расположено металлическое тело с поверхностью S, возбуждаемое 
первичным полем, имеющим касательный к S вектор электрического поля iE . 

Схема вывода интегрального уравнения остается неизменной. Отличие 
состоит в том, что вектор тока имеет все три компоненты, также как и векторный 
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потенциал, порождаемый этим током. Для векторного потенциала справедлива 
следующая формула: 
 

,'),'(~)'()( 
S

ee dsVsGsJVA .     (3.49) 
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Связь векторного потенциала с вектором электрического поля, касательным 

к поверхности S, дается соотношением (3.50): 
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e
a Adivgrad
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AiE  

     (3.50) 

где grad и div – дифференциальные операторы градиент и дивергенция. 
Приравнивая суммарное тангенциальное электрическое поле нулю на 

поверхности S, получаем интегро-дифференциальное уравнение: 
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 . (3.51) 

 
 
 

3.3.4 Магнитные токи и интегральные уравнения 
 
 
 До сих пор формулировали интегральные уравнения относительно 
электрических токов. Это естественный с физической точки зрения путь, 
поскольку по поверхности металла текут именно электрические токи, являющиеся 
источниками рассеянного поля. Тем не менее, имеются ситуации, в которых этот 
естественный путь оказывается нерациональным. Дело в том, что МоМ тем 
эффективнее, чем меньше область, в которой действует решаемое операторное 
уравнение. Это вполне понятно, поскольку для описания решения в большой 
области потребуется аппроксимация большого порядка, получение которой 
связано с решением большой СЛАУ. Теперь представим себе структуру, 
показанную на рис. 3.7. Это бесконечный металлический экран с бесконечно 
малой толщиной. В этом экране имеется отверстие, занимающее область S. 

В принципе задача рассеяния на таком экране может быть сведена к 
интегральному уравнению относительно электрических токов, текущих по 
поверхности Sa. 
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Рис. 3.7. Отверстие в металлическом бесконечно тонком экране 

 
Однако нетрудно понять, что возмущение в структуре создает отверстие, 

имеющее небольшую сравнительно с Sa площадь. Поэтому интересно было бы 
найти способ формулировки интегрального уравнения, определенного в области 
S. 

На рис. 3.8 показана часть экрана с отверстием (пунктирная линия). 

 
Рис. 3.8. Магнитные токи на металле 

 
Мысленно металлизируем отверстие, а в области S разместим 

поверхностные магнитные токи. Токи по разные стороны экрана могут быть 
разными. После этого решим задачи возбуждения этими токами двух 
полупространств выше и ниже экрана. Задача о возбуждении полупространства 
над (под) металлическим экраном хорошо известна в электродинамике. Ее 
решение записывается с помощью функции Грина трехмерного пространства 
(3.49): 

')'(),'(~2 2,12,1 dssJVsGA m

S

m
  ,    (3.52) 

где mA 2,1  – тангенциальный к поверхности экрана векторный магнитный 
потенциал. Индекс 1 соответствует области над экраном, а 2 – под экраном. 

Магнитное поле, тангенциальное к поверхности экрана 2,1H , выражается 
через векторный потенциал следующим образом: 

)(1 m

a

m
a Adivgrad

i
AiH  

  .  (3.53) 

В (3.53) индексы 1,2 опущены. 
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Отметим некоторые свойства поля, определяемого потенциалами (3.52). Это 
поле удовлетворяет уравнениям Максвелла. Также оно удовлетворяет нулевым 
граничным условиям для тангенциального электрического поля на всей 
поверхности экрана, за исключением области S (то есть там, где надо). Наконец, 
это поле удовлетворяет условиям излучения на бесконечность. Для решения 
граничной задачи не хватает выполнения двух условий в области отверстия S: 

.
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21
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EE





     (3.54) 
Чтобы приблизить нашу задачу к реальной, введем возбуждающее поле 

следующим образом. Пусть источник расположен под экраном в области 2. И 
пусть этот источник создает поле, удовлетворяющее нулевым граничным 
условиям для электрического поля как в области Sa, так и в области S, то есть на 
всем экране, включая отверстие. Таким образом, мы можем заключить, что такой 
источник на поверхности экрана имеет только тангенциальное магнитное поле 

iH , и, следовательно, граничные условия (3.54) надо дополнить, прибавив к 

2H  слагаемое iH . 

Выберем токи mJ 2,1  так, чтобы первое из условий (3.54) выполнялось бы 
автоматически. Для этого запишем связь магнитного тока, текущего по 
поверхности металла, и тангенциального электрического поля: 
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      (3.55) 
Так как 21 nn  , то граничное условие будет выполнено, когда mm JJ 21   . 

У нас осталось одно условие для магнитного поля. Подставим в него (3.52), (3.53) 
и получим интегральное уравнение относительно магнитного тока: 
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   (3.56) 

Из формулы (3.56) видно, что нам действительно удалось получить 
уравнение, заданное в области S. 

3.3.5 Интегральные операторы для плоскослоистых структур.  
Очень большое прикладное значение в технике СВЧ и антеннах имеют так 
называемые плоскослоистые структуры. Пример такой структуры показан на 
рис. 3.9. Она представляет собой набор слоев разных магнитодиэлектриков разной 
толщины. Допустимо присутствие между слоями металлических экранов, 
разделяющих структуру на изолированные части. На рис. 3.9 над слоем с номером 
N находится свободное пространство. В принципе это необязательно. Вместо 
этого структура может заканчиваться металлическим экраном.  

Такая плоскослоистая структура моделирует подложку печатной схемы. 
Чтобы она превратилась в полноценную схему, в ней должны появиться 
полосковые проводники. В отличие от слоев, показанных на рис. 3.9, проводники 
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не могут быть бесконечными в плоскости ХОУ. Они должны иметь некоторую 
форму и формировать топологию печатной схемы. Как любое физическое тело 
полосковые проводники имеют конечную толщину. Однако моделирование 
полосковых структур с проводниками конечной толщины сложнее, чем 
моделирование тех же структур в приближении бесконечно тонких проводников, 
которые в этом случае называются металлизациями. Поэтому в практике 
проектирования печатных схем широкое распространение получила модель 
печатной схемы с бесконечно тонкими металлизациями. Такая модель называется 
еще 2.5D моделью. Здесь имеется в виду, что полностью трехмерная структура (с 
конечной толщиной проводников) является 3D моделью. Далее рассмотрим 2.5D 
модель печатной схемы (и антенны в том числе) и получим для нее алгоритм, 
позволяющий формировать интегральные уравнения для анализа схемы с 
произвольным сочетанием слоев и экранов. 

 
Из примеров, приведенных выше, видно, что центральным моментом при 

записи интегрального оператора является решение задачи о возбуждении 
рассматриваемой структуры произвольной комбинацией электрических и 
магнитных токов. Решим эту задачу для плоскослоистой структуры. 

Отметим, что бесконечно 
тонкие проводники или экраны с 
отверстиями заменяются при выводе 
интегральных уравнений листками 
электрических и магнитных токов. 
Поскольку все экраны располагаются 
между слоями, то, следовательно, и 
листки токов расположены там же. 
Далее, так как мы имеем дело с 
бесконечно тонкими экранами, то 
поверхностные токи могут иметь 
только две компоненты, лежащие в 
плоскости XOY. 

Для построения функции Грина 
плоскослоистой структуры и решения 
задачи о ее возбуждении, очень 

эффективным оказался подход, основанный на использовании эквивалентной 
схемы структуры. Фрагмент такой схемы показан на рис. 3.10. 

 
Рис. 3.9. Плоскослоистая структура 
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Каждому слою ставится в 
соответствие четырехполюсник TLn, 
который представляет собой отрезок 
линии передачи с длиной, равной 
толщине слоя. В линиях передачи 
имеются токи и напряжения, 
подчиняющиеся телеграфным 
уравнениям, описывающим процессы в 
длинных линиях. Анализ распределения 
токов и напряжений в линиях передачи, 
который осуществляется методами 
теории цепей СВЧ, позволяет 
определить их значения для любой 
координаты z. 

В плоскослоистой структуре 
существуют два решения уравнений 

Максвелла - Е и Н-волны ( 0,0  zz EH ). Их распространение вдоль оси z 
происходит независимо друг от друга. Таким образом, можно отдельно найти 
поле типа Е и поле типа Н, а суммарное поле будет суммой полей обоих типов. 
Существование волн двух типов означает, что, вообще говоря, нам надо 
рассматривать две эквивалентные схемы отдельно для Е и Н-волн. Для 
упрощения записи введем индекс  , равный e, если речь идет о Е-волнах и m, 
если об Н-волнах. 

Тогда в каждой линии передачи существуют токи и напряжения 
nn UJ , , 

являющиеся функциями координаты z. Каждая линия характеризуется своей 
постоянной распространения n  и волновым сопротивлением nZ , для которых 
могут быть получены следующие выражения: 
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    (3.57) 

где kn – волновое число n-го слоя, 21 ,  – некоторые параметры, меняющиеся от 
минус до плюс бесконечности. Их смысл будет пояснен позже. 

Каскадно соединенные четырехполюсники удобнее описывать ABCD 
матрицами. Ниже приводится ABCD матрица отрезка линии передачи: 
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    (3.58) 

 
Рис. 3.10. Модель плоскослоистой 

структуры 
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Чтобы найти матрицу передачи всей плоскослоистой структуры достаточно 
перемножить матрицы передачи отдельных четырехполюсников: 
 


n

nAA  .      (3.59) 

 
Присутствие токов, возбуждающих структуру, отображается на 

эквивалентной схеме источниками тока и напряжения. Электрические токи 
соответствуют параллельно включенному источнику тока, а магнитные токи – 
последовательно включенному источнику напряжения (рис. 3.11). 

 
 

 
Рис. 3.11. Эквивалентные схемы электрических и магнитных токов 

 
 
Таким образом, задача сводится к анализу возбуждения некоторой схемы 

заданными источниками тока и напряжения. Рассмотрим показанную на рис. 3.12 
типичную структуру. Снизу она экранирована металлическим экраном, который 
отображается закороткой, а сверху нагружена на свободное пространство, которое 
моделируется двухполюсником с номером 0. Между ним и четырехполюсником с 
номером N расположен источник тока. Этот источник моделирует электрические 
токи, текущие по полосковому проводнику. 
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Рис. 3.12. Матричная 
модель плоскослоистой 

структуры над 
металлическим экраном 

Рис. 3.13. Модифицированная 
эквивалентная схема 

 
Найдем напряжение в линии передачи в точке подключения источника тока. 

Для этого нам надо найти матрицу передачи цепочки четырехполюсников с 
номерами 1…N. Это легко сделать, используя формулу (3.59). В результате 
приходим к новой эквивалентной схеме, показанной на рис. 3.13. 

Двухполюсники, расположенные выше и ниже источника тока, можно 
заменить их входными сопротивлениями. Входное сопротивление свободного 
пространства равно 

0Z , а входное сопротивление четырехполюсника с матрицей 

A  и одним закороченным входом – 

inZ  выражается следующим образом: 
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Z in .     (3.60) 

Теперь, анализируя схему, показанную на рис. 3.14, не составляет труда  
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Рис. 3.14. Эквивалентная схема со входными сопротивлениями 

 
 
 

найти напряжение в точке подключения источника тока: 
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Для записи интегральных уравнений нам необходима связь токов и 
напряжений в линиях передачи с полями в плоскослоистой структуре. Эта связь 
определяется следующими соотношениями: 
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  (3.62) 

где yxr 21   , интегрирование в (3.62) ведется в бесконечных пределах. 
 
Связь электрических и магнитных токов с источниками тока и напряжения 

имеет следующий вид: 
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   (3.63) 
где индекс  принимает значения x и y. 

Объединяя соотношения (3.61)-(3.63) и подставляя их в граничные условия 
на поверхности полоскового проводника: 

 
,, ,0 ,0 SyxEE yx        (3.64) 

 
где S – область, занятая проводником, получаем искомую систему интегральных 
уравнений: 
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где вектор 
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 соответствует полю источника возбуждения, а матрица 
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 находится из формул (3.61)-(3.63). 

Введем следующие обозначения: 
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С их помощью удается привести систему интегральных уравнений к 

компактной форме: 
.0')'(),'(ˆ  i

S

e EdssJVsG     (3.67) 

Функция ),'(ˆ VsG  является тензорной функцией Грина плоскослоистой 
структуры. 
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Аналогичным образом записываются интегральные уравнения, когда речь 
идет о магнитных токах. Рассмотрим похожую структуру, но не полоскового, а 
щелевого типа. Она отличается от полосковой тем, что на слое с номером N 
располагается металлический экран со щелью. Пусть щель занимает область S. 
Такой структуре соответствует эквивалентная схема, показанная на рис. 3.15. 

 

 

 

Рис. 3.15. Эквивалентная 
схема структуры с 

магнитными токами 

Рис. 3.16. Преобразования эквивалентной 
схемы структуры с магнитными токами 

 
Многополюсники с номерами от 1 до N соответствуют слоям с теми же 

номерами. Верхний двухполюсник с номером 0 соответствует свободному 
пространству, перемычки, расположенные выше N-ого слоя и ниже нулевого, 
моделируют экраны. Щель, как и ранее, заменяется листками магнитных токов, 
расположенными на обеих поверхностях верхнего экрана. Эти токи отображаются 
на эквивалентной схеме источниками напряжения, которые имеют одинаковые 
амплитуды, но противонаправлены, то есть их фазы отличаются на . Это 
отражает тот факт, что магнитные токи на разных поверхностях экрана должны 
быть также одинаковы по модулю, но противоположны по знаку. Такой выбор 
магнитных токов, как было показано выше, обеспечивает выполнение граничных 
условий для электрического поля в области щели. 

Поскольку интегральные уравнения в случае магнитных токов 
записываются из условия непрерывности магнитного поля в области S, то нас 
будут интересовать токи, текущие через источники напряжения. Верхний 
металлический экран разделяет нашу структуру на две части. В первой находятся 
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нулевой слой и верхний источник напряжения, а во вторую входят остальные 
слои и нижний источник напряжения (рис. 3.16). 

Заменяем двухполюсники их входными сопротивлениями, которые 
определяются по формуле (3.60) и находим токи, текущие через источники: 
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Дальнейшая последовательность действий не отличается от уже 

рассмотренных. С помощью формулы (3.68) находим тангенциальные 
компоненты магнитного поля и приравниваем их в области щели. Связь 
источников напряжения с магнитными токами дается формулой (3.63). 

Рассмотренная выше схема легко обобщается на два важных случая: 
экранированной плоскослоистой структуры (рис. 3.17) и периодического 
возбуждения плоскослоистой структуры (рис. 3.18).  

 
 

 
Рис. 3.17. Экранированная плоскослоистая структура 

 
 
Экранированная структура отличается от уже рассмотренной выше тем, что 

слои в ней ограничены в плоскости XOY. Пределы им ставят идеально 
проводящие вертикальные стенки. Эти стенки могут быть бесконечно 
протяженными по оси 0z, а могут быть и конечной длины, если в плоскости XOY 
имеются металлические или магнитные экраны. 

 
Таким образом, в отсутствие хотя бы одного горизонтального экрана из 

данной структуры возможно излучение в бесконечный волновод, ось которого 
направлена вдоль оси 0z. Следовательно, модель, показанная на рис. 3.17, может 
быть полезна для решения, в том числе и волноводных задач. Основное ее 
применение, тем не менее, связано с моделированием печатных экранированных 
схем. 
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Рис. 3.18. Периодическая плоскослоистая структура 

 
 
Модификация рассмотренной схемы состоит в следующем. Формулы (3.57)-

(3.61) остаются неизменными, за исключением замены 1  на a
n

 и 2  на b
m

, где 

a и b – размеры металлической полости по осям 0x и 0y соответственно. Формула 
(3.62) претерпевает более существенные изменения: 
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 (3.69) 

 
Поверхностные токи представляются через источники эквивалентных схем 

следующим образом: 
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 (3.70) 

 
Структура с периодически расположенными источниками используется при 

моделировании антенных решеток большого электрического размера. Реальная 
решетка, конечно, ограничена в плоскости XOY. Однако если ее размеры велики, 
то краевые эффекты сказываются не существенно, по крайней мере, на 
параметрах элементов решетки, удаленных от её границ. Поэтому эффективным 
средством моделирования такой структуры является ее модель в виде 
бесконечной по обеим осям 0х и 0у решетки. В этой модели и возникает задача о 
возбуждении плоскослоистой структуры периодически расположенными 
электрическими и магнитными токами. 

Решение этой задачи дается формулами (3.57)-(3.61) с заменой в них 1  на 

xP
n2

 и 2  на 
yP
m2

.  Формулы (3.62), (3.63) незначительно изменяются: 
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3.4  Источники в методе моментов 
С одним видом реальных источников мы уже сталкивались в разделе 3.1. 

Это волны, распространяющиеся в свободном пространстве. Такой вид источника 
характерен преимущественно для задач рассеяния. Для полосковых схем и 
печатных антенн характерны другие источники. 

В технике СВЧ наибольшее распространение получило представление СВЧ 
устройства в виде многополюсника. Причем многополюсник имеет выходы (их 
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еще называют портами) в виде линий передачи, чаще всего одноволновых линий 
передачи. В такой линии передачи устанавливается некоторой сечение, 
называемое отсчетной плоскостью, в котором определяются амплитуды 
падающих и отраженных волн, токи и напряжения и т.д. Эти параметры 
позволяют далее найти матрицы Y, Z или S многополюсника. 

Предполагается, что за пределами многополюсника в линии передачи поля 
могут существовать только в виде падающей и отраженной волн. Строго говоря, 
это условие никогда не выполняется, так как кроме основной волны в линии 
передачи всегда существуют высшие типы волн, затухающие вдоль линии 
передачи. Эти волны возбуждаются в многополюснике и всегда создают конечное 
поле в любом сечении выходной линии передачи. Однако, если отсчетная 
плоскость находится на достаточном расстоянии от места возбуждения 
реактивных волн, то их амплитуда в этом месте будет пренебрежимо малой. 

Известно, что для определения, например, матрицы рассеяния 
многополюсника, надо проделать N опытов, состоящих в том, что к одному из 
портов устройства подключается идеальный генератор, а к другим подключаются 
идеальные согласованные нагрузки. Затем надо измерить амплитуды отраженных 
от многополюсника волн. В такой процедуре кроется определенное противоречие 
со строгой электродинамикой. Дело в том, что в качестве идеально согласованной 
нагрузки может выступать бесконечная линия передачи, в которой нет 
источников отражений или какая-то гипотетическая согласованная нагрузка, 
модель которой пока неизвестна. Таким образом, возникает проблема, как создать 
модель бесконечной линии передачи. Сделать это чисто электродинамическими 
методами достаточно трудно. Напрямую просто невозможно, так как все 
структуры, подлежащие численному анализу, должны быть конечными. Кроме 
всего прочего, эта модель должна логично входить в общую схему решения 
электродинамической задачи, в нашем случае – в схему МоМ. 

Покажем, как решается данная задача в случае моделирования портов 
полосковой схемы (рис. 3.19). 

Предполагается, что 
подложка и все проводники 
находятся внутри металлической 
коробки. В этом месте интересы 
моделирования и практики 
совпадают, так как, с одной 
стороны, анализировать 
закрытую структуру проще, а, с 
другой стороны, металлическая 
коробка играет роль корпуса, в 
который помещается реальное 
устройство. 

Заканчивается наша схема портами. На практике это чаще всего 
коаксиальные разъемы, к которым присоединяются одноволновые коаксиальные 
кабели. Реально такие разъемы неидеально согласованы, но перед нами стоит 

 
Рис. 3.19. Полосковая схема 
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задача создать модель некоторого идеального разъема, не вызывающего 
отражений. 

На рис. 3.20 показан 
полосковый проводник, подходящий 
к вертикальной стенке корпуса. На 
проводник нанесена прямоугольная 
сетка, используемая в МоМ. 

 
Крайний слой, примыкающий к 

металлической стенке, используется 
для описания порта (на рис. 3.20 он 
заштрихован). Номера ячеек в этом 
слое меняются от 1 до N. 

Напомним, что мы записываем 
операторное уравнение, к которому 
затем применяется МоМ с учетом 
граничных условий. В данном случае 
это граничные условия на 

поверхности полоскового проводника, требующие равенства нулю 
тангенциального электрического поля. Данное граничное условие справедливо 
для всех ячеек сетки, кроме тех, что используются для описания порта. Установим 
здесь другие условия: 

,
0














u

E       (3.73) 

где верхняя строчка соответствует х-ой компоненте, а нижняя – у-ой, u – 
напряжение между проводником и стенкой корпуса,   – размер ячеек с номерами 
1…N по оси 0х. 

Смысл формулы (3.73) понятен. Мы требуем, чтобы на крайних площадках 
электрическое поле равнялось бы не нулю, а некоторой величине, определяемой 
напряжением в зазоре между проводником и стенкой. Предполагая, что размер 
ячейки достаточно мал, мы можем записать для напряжения закон Ома: 

,0EZJu       (3.74) 
где 0E  – ЭДС, включенная в зазор, Z – включенное там же сосредоточенное 
сопротивление, J – полный продольный ток, текущий по проводнику. 

Соотношение (3.74) - есть закон Ома для участка цепи. Эта цепь моделирует 
два процесса: поглощение волны, распространяющейся из схемы в нагрузку, и 
возбуждение схемы падающей извне волной. Сопротивление Z равно волновому 
сопротивлению полосковой линии передачи, подходящей к порту. 

Полный ток J определяется через интеграл по сечению проводника. В 
условиях дискретной сетки он заменяется суммой: 

 
Рис. 3.20. Модель порта  

в полосковой линии 
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Теперь мы можем модифицировать СЛАУ, получаемую в МоМ так, чтобы 
она учитывала наличие портов. Приведем её окончательную форму: 
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При записи (3.76) учтено, что токи имеют две компоненты, и, 

следовательно, базисные и тестовые функции являются комплексными. 
Описанная выше модель порта не является строгой. Она основана на 

предположении, что сосредоточенная нагрузка может обеспечить идеальное 
согласование полосковой линии передачи. Это, строго говоря, верно только для 
достаточно низких частот. Однако практика применения такой модели показала, 
что она дает хорошие результаты в большинстве практически важных случаев. 
Аналогичную модель в виде сосредоточенного источника используют не только 
для описания печатных схем, но также при анализе вибраторных и проволочных 
антенн, когда реальную питающую линию передачи заменяют сосредоточенным 
генератором с конечным внутренним сопротивлением. 

Итак, в этом разделе рассмотрен метод моментов – электродинамический 
метод расчета поля, показано, как выбираются базисные функции, и, используя 
известные функции Грина, составляется система уравнений СЛАУ, которая 
решается для нахождения коэффициентов при каждой базисной функции. В 
дальнейшем ближние и дальние поля излучающей структуры рассчитываются по 
полученному распределению тока на поверхности структуры. 
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4 БАЗОВЫЕ ОПРЕДЕЛЕНИЯ И ПОНЯТИЯ FEKO 

В этом разделе приведем материал, который поможет провести 
последовательное описание задачи, задаваемой для решения в программе FEKO. 

4.1  Разбиение структуры на ячейки и моделирование 
В FEKO проводящие поверхности анализируемой структуры разбиваются 

на треугольники, а провода – на сегменты. Для диэлектриков имеется несколько 
способов описания. При использовании метода поверхностных токов поверхность 
диэлектрического тела также разделяется на треугольники, а когда применяется 
метод объемных токов, твердое тело разделяется на кубоиды. При задании 
режима, в котором некоторый объем рассчитывается методом конечных 
элементов, разбиение в этой области выполняется на объемные тетраэдры. 

Тонкие слои диэлектрического материала разбиваются на треугольники, 
расположенные в середине слоя. 

При описании работы FEKO используются следующие определения: 
• Segment (сегмент): сегмент провода (короткий по сравнению с длиной волны); 
• Cuboid (кубоид): элемент объема, используемый для моделирования 

диэлектрических и магнитных материалов методом объемного тока в методе 
MоM. Он имеет углы в 90 градусов, как в кубе, но может быть 
параллелепипедом; 

• Tetrahedron (тетраэдр): трехмерный тетраэдральный объемный элемент, 
имеющий 4 стороны. Тетраэдры используются для решения методом FEM; 

• Polygon (многоугольник): плоский поверхностный элемент с границами в виде 
прямых ребер. Это может быть примитив (который будет разбит на 
треугольники) или многоугольная плоскость polygonal plate (которая решается 
методом дифракций UTD); 

• Vertex (вершина): Любая конечная точка, точка сегмента сетки или угла 
элемента сетки (треугольник, тетраэдр, и т.д.); 

• Node (узел): точка, где соединены два сегмента. К каждому узлу назначается 
одна базовая функция; 

• Edge (ребро): В геометрии ребро – любая кривая (они также называются 
проводами) или любая граница кривой поверхности. Если рассматривать сетку, 
то ребро – общая линия между двумя смежными треугольниками. (Если три 
треугольника совместно используют две вершины, имеются две грани, 
связанные с этими треугольниками.) Если поверхность – металл, то на каждом 
ребре назначается одна базисная функция. Если поверхность – диэлектрик, то к 
каждому ребру назначаются две базисные функции: одна для эквивалентной 
плотности электрического тока и одна для эквивалентной плотности 
магнитного тока. На свободном ребре находятся стороны треугольников, 
которые относятся только к одному треугольнику. Если оно не находится на 
земляной плате или на многоугольной проводящей плате, никакие 
электрические токи не текут поперек этого ребра; 
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• Connection point (точка соединения) – точка, где сегмент соединен к 
треугольнику. Конец сегмента связан с вершиной треугольника. Базовая 
функция назначена к каждой точке соединения. 

4.2  Выбор размеров ячеек разбиения 
Во время разбиения на ячейки необходимо придерживаться следующих 

правил: 
• Длина сегмента l должна быть меньше, чем десятая часть длины волны 

свободного пространства. 
• Заметим также, что электрические токи сегмента текут в направлении оси 

провода. Таким образом, сегменты также не должны быть слишком 
короткими относительно радиуса провода. Идеально длина сегмента должна 
быть, по крайней мере, в четыре раза больше радиуса. 

• Область A каждого треугольника должна быть меньшей, чем 70/2 . Для 
треугольников, которые по форме близки к равносторонним, это означает, что 
длина стороны должна быть короче, чем приблизительно )6...5/( . Если память 
RAM позволяет, длина ребра должна быть равной )10...8/( . 

• При моделировании поверхности с помощью сетки проводов, радиус должен 
быть выбран так, чтобы 

2
lr        (4.1), 

где r – радиус, а l – длина сегмента, которая должна быть около десятой части 
длины волны. 

• При соединении провода и поверхности, радиус сегмента провода должен быть 
мал по сравнению с размером плоского треугольника, на стороне которого 
строится базисная функция. Длина этих сторон должна быть большей по 
сравнению с радиусом сегмента провода. 

Если треугольники разбивают поверхность диэлектрика, то длина сторон 
должна быть маленькая по сравнению с длиной волны в диэлектрике, а также 
соизмерима с глубиной поверхностного слоя 




2
       (4.2) 

Рекомендуется выбирать длину сторон треугольников сетки разбиения 
равной десятой части минимальной длины волны или равной глубине 
поверхностного слоя или даже меньшей. 
• При разбиении области на тетраэдральные элементы, размер элемента (длина 

ребра тетраэдра) должен быть около пятой части длины волны внутри 
диэлектрической среды. Для правильного выбора размеров элементов при 
расчете методами FEM/MOM, рекомендуется более плотное разбиение, около 
десятой части длины волны в среде. Внутри среды может быть более крупная 
сетка разбиения, потому что здесь применяются базисные функции высокого 
порядка. Иногда требование к памяти (Random Access Memory RAM) можно 
уменьшить, добавляя малый воздушный зазор в области вокруг фактического 
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диэлектрического объекта, и также используя метод конечных элементов FEM, 
разбивая его на тетраэдры. Так как длина волны в воздухе больше, чем в 
диэлектрике, большие тетраэдральные элементы могут тогда использоваться в 
методе FEM/MOM. Это уменьшает размер матриц в методе FEM/MOM, и 
уменьшение обычно тем значительнее, чем больше тетраэдральных элементов. 

• В некоторых случаях модель требует существенно более плотное разбиение на 
сетку. Для низких частот правило сегментации как на десятую часть длины 
волны часто слишком грубое, чтобы получить разумное представление 
геометрии. Пример того, где может потребоваться более плотное разбиение – 
это случай, когда провод выполняется в виде ленты, параллельной проводящей 
плоскости. Если провод расположен ближе, чем на десятую часть длины волны 
до плоскости, размер треугольников в направлении, ортогональном 
проводнику, должен быть соизмерим с расстоянием от ленты до платы, чтобы 
дать точное представление распределения поверхностного заряда. Другой 
случай, где может потребоваться более плотное разбиение – это волноводные 
порты, где размер ячейки должен быть достаточно малый, чтобы учесть 
распределение напряженности электрического поля самой высокой моды, 
включенной в описание порта. 

FEKO может вывести предупреждения о следующих ошибках: 
 Предупреждение Ошибка 
Отношение длины сегмента к длине 
волны  

 
l>0.3λ 

 
l>0.5λ 

Отношение радиуса сегмента к длине 
сегмента 

 
ρ>0.3λ 

 
ρ>1.0λ 

Отношение площади треугольника к 
квадрату длины волны  

2

30
1
A

 
2

10
1 A

 
Отношение радиуса провода к длине 
ребра треугольника в точке соединения r≥½ l r≥1/3 l 

Отношение длины ребра кубоида к длине 
волны l>0.25λ l>0.5λ 

Отношение длины ребра кубоида к 
глубине поверхностного слоя  l>1/5 δ l>1/3 δ 

Отношение площади тетраэдра к 
квадрату длине волны (внутренние 
элементы сетки) 

A>0.047 λ2 A>0.433 λ2 

Отношение площади грани тетраэдра к 
квадрату длины волны A>0.033 λ2 A>0.108 λ2 

Отношение площади треугольника на 
волноводном порте к самому малому 
периоду моды T 

A > 1/30 T2 A > 1/10 T2 
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4.3  Правила разбиения на связанные ячейки 
FEKO аппроксимирует ток в терминах базисных функций, связанных с 

гранями, узлами и точками соединения. Чтобы гарантировать электрическую 
связь, треугольники должны везде быть сопряжены. Сегменты должны быть 
связаны с другими сегментами в узлах или с вершинами треугольников (рис. 4.1). 

При разбиении 
диэлектрического объема на 
тетраэдры в метод FEM, элементы 
стороны сопряженных тетраэдров 
также должны быть согласованы. 
Кроме того, при моделировании 
проводящих поверхностей в 
области FEM, стороны 
металлических треугольников 
должны быть согласованы со 
сторонами тетраэдральных 
объемных элементов (рис. 4.2). 

 
 
В общем случае CADFEKO 

разбивает на ячейки каждую 
отдельную часть. Поэтому перед 
разбиением на сетку все связанные 
объекты должны быть объединены 
(рис. 4.3). Если, например, провод 
соединяется с поверхностью, но из-
за численной ошибки он расположен 
от фактической поверхности на 
расстоянии, большем, чем допуск 
модели, то CADFEKO не создаст 
узел на поверхностной сетке в точке 
крепления. Это может случиться при 
объединении двух объектов, которые 
не касаются друг друга. Тогда при 

расчете провод не будет электрически связан с поверхностью.  
 

 
Рис. 4.1. Пример связности сетки:  

несвязанные сверху,  
связанные верно – внизу 

Рис. 4.2. Пример соединения областей, 
рассчитываемых методом FEM:  
слева – неверно, справа – верно 
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Рис. 4.3. Диалог, в котором вводятся параметры сетки разбиения 

 
FEKO имеет несколько встроенных проверок, которые сообщат об ошибке, 

если, например, сетка содержит накладывающиеся треугольники.  

4.4  Диэлектрические объекты 
Имеется несколько способов моделировать диэлектрические среды в FEKO, 

три из которых относятся к диэлектрическим объектам произвольной формы: 
• Метод моментов (MоM), реализующий метод поверхностных токов. Здесь все 

стороны разных областей с однородным заполнением разбиваются на 
поверхностную сетку в виде треугольников. Базисные функции строятся на 
сторонах треугольниках для моделирования эквивалентных электрических и 
эквивалентных магнитных поверхностных токов. Граничные условия 
учитываются с помощью эквивалентных источников. 

Для моделей, созданных в CADFEKO, этот метод используется также и  
для всех диэлектрических областях, которые явно не разбиваются на 
тетраэдральные элементы. 

При работе с моделями в EDITFEKO области среды описываются картой 
ME. Это описание использует нормали треугольников, чтобы отличить 
соответствующие диэлектрические среды на двух сторонах, и желательно 
проверить эти свойства в POSTFEKO. 
• Метод моментов, реализующий метод объемных токов. Здесь объем 

разделяется на параллелепипеды. В принципе, каждому элементу могут быть 
назначены различные свойства материалов. Внутри элемента направление тока 
неизвестно. Обычно этот метод требует большее количество неизвестных, чем 
метод разбиения на поверхностную сетку, так что этот метод будет требовать 
большего количества ЗУ. Однако этот метод подходит для тонких листовых 
материалов и очень устойчив для низких частот. Другое преимущество состоит 
в том, что он основан на интегральном уравнении Фредгольма второго порядка, 
производя устойчивую формулировку, и таким образом, при использовании 
метода MLFMM число итераций обычно мало. Этот метод в настоящее время 
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не доступен из CADFEKO, и он реализуется в EDITFEKO с помощью карт 
DK, DZ или QU [2]. 

• Как альтернатива методу МоM, в FEKO реализован метод конечных 
элементов (FEM). Это метод также требует, чтобы трехмерные объемы были 
дискретизированы, но не на кубоиды, а на тетраэдры. Но в противоположность 
МоM, матрицы FEM разрежены, таким образом требование ЗУ для сетки 
объема FEM – намного меньше, чем сетка объема МоM той же самой модели.  

 
Кроме этих общих методов, в FEKO имеется ряд специальных методов 

моделирования диэлектрических объектов: 
• Тонкие листы диэлектрического материала: в этом случае применяется метод, в 

котором эквивалентные токи аппроксимируются поверхностным током. 
• Диэлектрические покрытия: в этом случае металлические провода или 

поверхности могут иметь диэлектрическое покрытие. 
• Диэлектрическое полупространство, например земляная поверхность: в этом 

случае используется метод учета коэффициента отражения. Этот метод 
реализуется, используя бесконечные плоскости в закладке Solution в 
CADFEKO или в карте BO в EDITFEKO. 

• Сферы, состоящие из одного или большего количества диэлектрических слоёв. 
Для этого включается специальная функция Грина, используя карту GF в 
EDITFEKO. 

• Плоская многослойная подложка: 
 
Многослойная плоская подложка (с или без идеальной земляной 

поверхности сверху и снизу) добавляется к модели, используя бесконечные 
плоскости в закладке Solution в CADFEKO или карте GF в EDITFEKO. 

В CADFEKO тонкие листы диэлектрического материала и покрытия 
применяются к поверхностям. В EDITFEKO тонкие листы диэлектрического 
материала описываются картой SK, а покрытия – картой CO. Геометрия модели 
(например, металлические провода и поверхности) не обязательно должны 
находиться в свободном пространстве. В EDITFEKO карты EG, DI и GF могут 
также задавать материальные параметры окружающей среды. 

 
Самое прогрессивное нововведение в FEKO – это новый метод MLFMM 

(рис. 4.4), в основе которого лежит метод моментов MоM, и он применяется к 
намного большим структурам чем МоМ, выполняя электродинамический расчет 
очень больших структур. Он может быть применен к большинству больших 
моделей, которые были предварительно обработаны MоM без изменения сетки 
разбиения. 
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4.5 Многоуровневый быстрый многопольный метод расчета 
(MLFMM) 

�  
Рис. 4.4. Последовательность решения в методе MLFMM – композиция, 
трансляция и декомпозиция отдельных блоков решения большой задачи 

 
Согласование между методами МоМ и MLFMM состоит в том, что в них 

используются те же самые базисные функции, которые моделируют 
взаимодействие между всеми треугольниками. MLFMM отличается от МоМ по 
тому, как группируются базовые функции и вычисляется взаимодействие между 
группами базисных функций, а не между отдельными базисными функциями. 

FEKO использует алгоритм упаковки, который включает полное 
вычислительное пространство в одно поле на самом высоком уровне, разделяя это 
поле на 3 - 8 дочерних боксов, и повторяет процесс итерационно, пока длина 
стороны каждого дочернего пространства не станет равна приблизительно 
четверти длины волны на самом низком уровне. Только заполняемые поля 
сохранены на каждом уровне, формируя эффективную последовательную 
структуру данных. 

В рамках МоМ метод MLFMM реализован как процесс соединения частей, 
трансляции и разбивки на составные части. 

В методе МоМ каждая из N базисных функций обрабатывается в 
отдельности, таким образом функционально в N2 задавая необходимые 
требования к RAM (чтобы сохранить матрицу импедансов) и к N3 ко времени 
расчета (чтобы решить линейную систему уравнений). Таким образом, 
необходимые условия решения методом МоМ быстро растут с увеличением 
размера задачи. 

Более эффективная обработка при решении методом MLFMM той же самой 
задачи уменьшает до Nlog (N) в требовании к ЗУ и Nlog (N) log(N) во времени 
расчета. 

Существенное усилия также было приложены для улучшения 
параллельного решения методом MLFMM, чтобы достичь высокой 
производительности при распределении расчета на нескольких процессорах. 
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4.6 Требования к памяти для различных задач 
 

Пример расчета  Число  
неизвестных 

Требуемая память 
MoM MLFMM 

Военный самолет на частоте 690 MГц, 
Корабль (115m x 14 m) на частоте 107 MHz, 
Зеркальная антенна с размером апертуры  
 19 длин волн 
 

100 000 150 ГГб 1 ГГб 

Военный самолет на частоте 1.37 ГГц, 
Корабль (115m x 14 m) на частоте 214 MHz, 
Зеркальная  с апертурой 38 длин волн 
 

400 000 2.4 ГГб 4.5 ГГб 

Военный самолет на частоте 2.65 ГГц, 
Корабль (115m x 14 m) на частоте 414 MHz, 
Зеркальная с апертурой 73 длин волн 

1 500 000 33.5 ГГб 18 ГГб 

4.7 Типичные примеры решения методом MLFMM 
 
Этот метод лучше подходит для решения задач, которые включают 

электрически сложные структуры, например, связь с антенной на кораблях (рис. 
4.5), размещение антенны на самолете и для анализа излучения позади 
рефлекторной антенны.  
 

 �  
Анализ излучения антенн 

корабля методом MLFMM 
Моделирование антенн на военном самолете 

методом  MLFMM. 
 

Рис. 4.5. Разбиение на блоки и подблоки больших объектов 
 

Каждую отдельную плоскость можно рассчитывать разными методами. 
Базовый метод – метод моментов. Для того чтобы связать в одной задаче 
несколько методов, нужно задать команду SolutionSolution setting и установить 
параметры в диалоге, показанном на рис. 4.6. 
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После создания геометрии необходимо задать порты, источники 
возбуждения, частоты, выбрать метод решения и подготовить все данные для 
запуска на расчет. Метод решения выбирается в диалоге Solution Setting, который 
вызывается командой Solution в дереве проекта. Появляется диалог рис. 4.6а. В 
закладке General устанавливается точность хранения данных: либо одиночная, 
либо двойная точность. 

Одиночная точность (Single precision) рекомендуется, если FEKO не дает 
предупреждения, чтобы переключиться на двойную точность (это может 
случиться на низких частотах, где требуется большая точность). 
 

    
Рис. 4.6.a Рис.4.6 б Рис. 4.6 в Рис. 4.6 г 

 
 

Если выбрана опция Store/re-use solution, FEKO хранит и повторно 
использует решение линейных уравнений. Этот режим используется, чтобы 
считать ближние поля, поля в дальней зоне, и другие характеристики, без 
повторного вычисления корней системы уравнений. Для малых моделей (когда 
время выполнения небольшое) это обычно не требуется. Для больших моделей 
это может существенно экономить время, но создает большой файл *.str. 

В закладке MLFMM (рис. 4.7) устанавливается многоуровневый быстрый 
мультипольный метод (MLFMM) и требуемые опции. 

Метод MLFMM может рассчитывать конструкции большого размера 
быстрее, чем метод моментов (MoM). В ранних версиях FEKO MLFMM не 
может использоваться одновременно с FEM. MLFMM основан на иерархическом 
алгоритме группировки, и FEKO сам устанавливает оптимальное число групп и 
боксов для каждой модели. Если решение не сходится, можно изменить размер 
бокса (рис. 4.7) в длинах волн (Box size in wavelengths). Рекомендуется начальное 
значение установить равным 0.23. 
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Рис. 4.7. Понятия и опции быстрого многоуровневого метода 

 
В разделе Advanced solver settings устанавливается число итераций или 

критерий остановки итеративного процесса. В режиме MLFMM можно также 
выбрать решение смешанного интегрального уравнения поля и параметры 
установки решения на фасках. 

В закладке FEM (рис. 4.8) задаются установки, относящиеся к методу 
конечных элементов.  
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Рис. 4.8. Закладка метода конечных 
элементов FEM Рис. 4.9. Закладка методов СВЧ 

 
Когда используется FEM, модель содержит тетраэдральные элементы 

разбиения. Если выбран режим Decouple FEM and MoM solutions, решение FEM 
(тетраэдральные элементы и любые проводящие поверхности на их границах) 
выполняется независимо от метода MoM. Эта развязка может существенно 
уменьшить время расчета, что справедливо, если две области достаточно далеки 
друг от друга. Переключение на режим первого порядка (First order) в разделе 
Element Order (рис. 4.8) уменьшает требуемое RAM и время выполнения, но 
ухудшает точность. Чтобы получить ту же самую точность, размер ячейки должен 
быть уменьшен, и в этом случае требуется больше RAM и время расчета. Таким 
образом, переключение на элементы первого порядка рекомендуется только в том 
случае, если разбиение на сетку – очень грубое, например, при моделировании 
однородных сред. 

Можно выбрать метод Direct sparse или итерационное решающее 
устройство Iterative solver. Для итерационного решающего устройства можно 
установить критерий сходимости. Коэффициент стабилизации применяется 
только к неполному (Multilevel ILU/diagonal decomposition) предварительному 
условию, и может улучшиться сходимость в критических случаях. Значение 
должно быть между 0 и 1. Заметим, что любое поле в этой закладке может быть 
оставлено пустым. 
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Закладка High frequency (на рис. 4.9) содержит разделы для установки 
параметров PO (физическая оптика) и параметров метода UTD (однородная 
теория дифракции). Решение PO устанавливается для любой поверхности, а UTD 
может применяться только к плоским многоугольным платам. 

Если отмечены Decouple PO and MoM solutions или Decouple UTD and 
MoM, то структуры PO/UTD не учитываются в расчете при вычислении токов в 
MoM. Тогда, например, входное сопротивление рупорной антенны, поле 
излучения которого падает на параболический отражатель, будет то же самое, как 
такого же рупора в свободном пространстве. Однако если требуется рассчитать 
только диаграмму направленности (ДН) с учетом развязки, то при таком решении 
существенно уменьшается объем памяти и время выполнения без влияния на 
результаты. 

При решении задачи методом физической оптики PO большинство времени 
тратится на определение, какие поверхности освещаются из каждого источника. 

 
 

4.8  Установка параметров решения на фасках 
 

Отдельные плоскости могут моделироваться разными методами. Например, 
некоторая плоскость модели может быть решена методом физической оптики PO. 
Это устанавливается в закладке Solution диалога Face properties (рис. 4.10). 

Если выбрана опция Solve with physical optics (PO), то для расчета токов на 
поверхности используется метод физической оптики. В этом методе, 
существенная часть времени решения затрачивается на трассировку лучей 
(устанавливающих, какие элементы поверхности PO являются видимыми от 
каждого сегмента тока). Это можно выбрать опцией Optimise ray tracing и 
выбором Always illuminated or Only illuminate from front (освещение со всех 
сторон или освещение только с передней стороны). Первая опция применима, 
когда вся PO поверхность освещается только для анализа отражения 
(поверхности, не заданные как PO, рассматриваются в этом случае 
прозрачными.). Вторая опция применяется ко всем замкнутым телам, но нормали 
должны быть направлены наружу от каждой фаски. 

При выборе метода моментов (None в диалоге рис. 4.10 слева) 
устанавливается Integral equation – как уравнение для электрического поля. Это 
– наиболее общая формулировка может быть применена и для разомкнутых, и 
замкнутых объектов. Установка Combined field может использоваться только на 
замкнутых объектах, и этот подход более устойчив. Его особенно полезно 
использовать в методе MLFMM, тогда требуется меньшее RAM и более быстрая 
сходимость. Можно выполнить установку Combined field на объектах модели, но 
поверхность должна быть замкнута, и все нормали должны быть направлены 
наружу. 
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Рис. 4.10. Установка методов решения на плоскости 

 
Если отмечена опция Export ray file for post-processing, FEKO записывает 

лучи в файл *.ray так, чтобы их можно будет просмотреть в POSTFEKO. Нужно 
отметить, что файл лучей может быть очень большой, особенно, если решения 
MoM и UTD не были разъединены, и имеется больше, чем несколько сотен 
элементов разбиения в области MoM. 

Параметр Max.no.ray interactions (рис.4.9) ограничивает число отраженных 
лучей. Например, луч, который включает двойную дифракцию и одно отражение, 
имеет три взаимодействия, а луч, который включает дифракцию и три отражения, 
имеет четыре взаимодействия. 

Опции в группе вкладов лучей Select ray contributions устанавливают, 
какие взаимодействия нужно принять во внимание. Выбор большего количества 
вкладов или увеличение числа взаимодействий луча увеличивает точность и 
время расчета. 

Выбор окончательных установок является компромиссом между точностью 
и временем расчета. Они должны быть основаны на физических соображениях. 
Заметим, что некоторые комбинации дублируются. Например, вклад дифракции 
от ребра и от угла (рис. 4.9) имеют обычно тот же самый порядок, и они должны 
быть включены или отключены одновременно. 
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5  РАБОТА В ИНТЕРФЕЙСЕ CADFEKO 

Первоначально FEKO был создан и приобрел мировую известность, как 
программа, которую запускали в виде пакета перфокарт. Но в 90-х годах 20-го 
столетия компания EMSS создала интерфейс CADFEKO, который приближает 
работу пользователя к пользователю Windows. Так что сейчас большинство 
моделей небольшой и средней сложности удобно создавать в программе 
CADFEKO. 

В этом интерфейсе чертится модель, информация о ней сохраняется в файле 
*.cfm, а топология – в файле *.cfs. После черчения структуры, из меню FEKO 
командой Run (или нажатием на ) запускается на счет программа PREFEKO. 
CADFEKO обрабатывает файлы *.cfm и *.pre и генерирует файл *.fek. 
Результаты расчета сохраняются в файле *.bof, из которого они могут 
просматриваться в POSTFEKO. Результаты также сохраняются в читаемом файле 
ASCII *.out. Для сложных моделей, можно использовать и редактировать файл 
*.pre. Этот файл содержит последовательность команд (макросы) и дает полный 
контроль над процессом решения. 

CADFEKO был разработан, чтобы облегчить создание моделей в 
графической среде автоматизированного проектирования. Этот процесс включает 
черчение геометрии и разбиение её на ячейки, а также задание электромагнитных 
параметров и конфигурации решения. 

CADFEKO дает возможность строить параметрические модели. Если 
модель создана с использованием переменных, то при изменении переменных вся 
модель перечерчивается. Это можно использовать, например, чтобы найти размер 
антенны с заданной резонансной частотой. Кроме того, CADFEKO сохраняет 
хронологию создания конструкции так, что все операции автоматически 
модифицируются, если изменяется какой-либо из внутренних объектов или 
параметров, например материалы диэлектриков, заполняющих области внутри 
модели.  

CADFEKO может также импортировать сложные модели в различных 
форматах. Однако в некоторых случаях может быть доступна только модель, 
разбитая на ячейки. После импорта модели пользователь может начертить 
«поверху» собственную параметризируемую модель, используя точки 
импортированной модели как привязки. 

5.1  Обзор CADFEKO 
Интерфейс CADFEKO, показанный на рис. 5.1, содержит главное меню и 

инструментальную панель сверху, закладки, дерево проекта слева, 
информационное окно и строку состояния внизу, и область черчения. 
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Рис. 5.1. Интерфейс CADFEKO 

 
Информационное окно внизу интерфейса сообщает о каждом шаге 

пользователя при создании геометрии, разбиения на ячейки и т.д. В нём также 
выводит информация об ошибках.  

Статус-бар внизу справа показывает единицы длины, режим захвата точки и 
координаты текущей позиции курсора – в глобальных координатах – с 
использованием выбранного режима захвата. 

В статус-баре можно видеть координаты точки ввода, нажимая <Ctrl> 
<Shift> при перемещении мыши в трехмерном представлении. В нем также 
указывается расстояние между точками. 

Вид интерфейса может быть изменен, перетаскивая панели. Можно 
изменять размер панелей, перемещая делители к ребрам и дальше от ребер. 

CADFEKO имеет гибкий интерфейс. Например, рабочая плоскость 
(workplane, рис. 5.2) и вид объекта могут быть изменены, или задана новая 
переменная, без закрытия диалога создания геометрии. Если открыт новый 
диалог, в то же время уже открыт другой диалог, все поля ввода данных в первом 
диалоге блокируются, пока не закрыт новый диалог. Если было открыто 
несколько диалогов, они будут доступными в обратном порядке, когда будет 
закрываться каждый диалог. Сами диалоги не блокируются, и таким образом, они 
могут всё еще находиться на экране. Но второй диалог не может быть открыт для 
редактирования того же самого элемента. 
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Рис. 5.2. Вид рабочей плоскости на структуре и ее диалог 

 
Например, если открыт диалог создания геометрии, и в то же время открыт 

диалог редактирования рабочей плоскости (РП), то рабочая плоскость для этого 
представления не может изменяться без закрытия диалога геометрии. Если диалог 
применяется к невыбранным объектам, они показываются зеленым цветом в 
дереве проекта. 

5.1.1 . Инструментальная линейка 
Эта инструментальная линейка (рис. 5.3) дает быстрый доступ к пунктам 

меню File для создания, открытия и сохранения модели. Кнопка Notes открывает 
текстовый файл, в котором можно дать описание задачи. Кнопка New 3D view 
создает новое трехмерное окно на экране дисплея. 

 
Рис. 5.3. Стандартная инструментальная линейка 

 
Команды Undo и Redo (они могут выполняться быстрыми клавишами 

<Ctrl><Z> и <Ctrl><Y>) позволяют вернуться на шаг назад. Эти операции 
включают создание, изменение геометрии, переменных, носителей, конфигурации 
решения и т.д. Списки отмены не сохраняются, если модель сохранена и 
запущена на расчет. Если объект повторно разбивается на ячейки или сетка 
удалена, полная существующая сетка сохраняется в списке Undo/Redo. Это 
позволяет быструю отмену операций. 
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5.1.2  Создание, открытие и сохранение моделей 
Команда File → New закрывает текущую модель и открывает новую задачу. 

Аналогично, File → Open или File → Save открывает и сохраняет модели 
CADFEKO. При сохранении модели CADFEKO автоматически сохраняет файл 
*.cfs – содержание рабочего пространства (представления, плоскости сечения, 
РП, параметры настройки видимости, и т.д.), и файлы *.cfm и *.pre, 
использующиеся при решении. 

При запуске CADFEKO из командной строки модель задается как параметр 
командной строки. Если файл не существует, CADFEKO создает новую модель, 
cadfeko model.cfx, убедившись, что каталог не содержит файл *.cfs, *.pre или 
*.cfm с этим именем. 

По команде File → Export → *.cfm file можно экспортировать текущую 
сетку в файл *.cfm , которая может тогда быть импортирована в файле *.pre. 
Сетка экспортируется «как есть», т.е. не выясняется, правильная ли она в этот 
момент. Если не имеется никаких компонентов сетки, переменных или 
поименованных точек в модели, файл *.cfm будет пустой, и импорт его в файле 
*.pre не будет иметь никакого влияния. Этот пункт меню только экспортирует 
сетку, но не сам файл. При запуске компонентов FEKO из меню Run, CADFEKO 
автоматически экспортирует файл *.cfm, используя имя модели. 

5.1.3  Перестройка геометрической модели 
При черчении в CADFEKO пользователь видит все изменения геометрии. 

Если геометрия создана в ранней версии CADFEKO, то имеется опция 
перечерчивания, вызываемая командой Geometry → Re-evaluate. Если часть 
объектов перечерчиваются неверно, то они отмечаются как подозрительные с 
вопросительным знаком. Если геометрия модели изменится в будущем, 
рекомендуется проверить геометрию и убрать подозрительные объекты перед 
черчением новой дополнительной части. 

Если геометрия модели не будет изменяться, то можно сохранить 
существующую модель и все её параметры настройки. Заметим, однако, что эта 
модель должна изменяться не всегда, когда требуется пересчет модели. Например, 
если рассматривается автомашина с вибраторной антенной, объединенной с ней, 
то изменение длины вибраторной антенны не требует пересчета, а изменение 
положения требует пересчета, чтобы заново выполнить объединение с новой 
вибраторной антенной. 

5.1.4  Архивирование моделей 
При работе со сложными моделями иногда требуется зафиксировать 

состояние модели. CADFEKO может сохранять и восстанавливать различные 
части файла проекта. Выберите File → Archive model из главного меню и введите 
комментарий для памяти файла модели (рис. 5.4). Текущая модель сохраняется в 
папке заархивированных файлов. Заметим, что внешний файл данных не 
включает точечные источники и идеальные приемные антенны, которые, как 
считается, изменяются независимо от модели CADFEKO. 
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Выберите File → Revert from 
archive, чтобы открыть диалог Revert 
model (рис. 5.5) который перечисляет 
заархивированные версии со временем 
их создания и комментариями. 
Выберите файл и нажмите кнопку 
Revert, чтобы возвратиться к 
начальному состоянию.  

Заметим, что операция возврата 
модели не может быть исключена, и 
текущий файл модели записывается 
поверх того, который существовал. 

Наконец, выбор File → Delete 
version from archive позволяет удалять 
заархивированные примеры, чтобы 
сэкономить дисковое пространство. 
Пользователь может выбрать и удалить 
несколько архивных файлов 
одновременно. 

5.2  Трехмерный вид моделируемой структуры 
Просмотр и управление моделью, выполняется, главным образом, при 

трехмерном представлении конструкции. В CADFEKO щелчок левой кнопкой 
используется для выбора и ввода точек. Щелчок правой кнопкой открывает 
контекстно-зависимое меню с командами. Модель вращается, если щелкнуть 
мышь в поле модели и перемещать курсор по рабочему столу. При нажатии левой 
кнопки мыши и перемещении курсора, модель будет вращаться. Можно изменять 
масштаб изображения, нажимая на <Shift> и перемещая мышь вперед и назад, 
увеличивая и уменьшая изображение. Вращение колеса мыши также изменяет 
масштаб изображения (при нажатой кнопке <Shift> масштаб будет меняться 
медленнее). 

Направление нормали по отношение к стороне часто важно. Например, 
ребро между двумя фасками, у которых нормали расположены противоположно, 
не может быть удалено. Поэтому в FEKO передняя и задние стороны окрашены 
по-разному, и можно полностью изменить направление нормали фаски. 

Отдельные объекты можно скрыть. Если объект скрыт, он удаляется из всех 
трехмерных представлений. 

В некоторых случаях дисплей может показывать части объектов, которые 
должны быть скрыты (командой Show/Hide). Эти проблемы в черчении очень 
зависят от компьютера, и CADFEKO имеет некоторые меры для решения этих 
проблем. Выберите Options → Rendering, чтобы открыть диалог, показанный на 
рис. 5.6. 

 

 
Рис.5.4. Ввод комментария при 

архивировании модели 
 

 
Рис. 5.5. Сохранение информации о 

заархивированных файлах 
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Рис. 5.6: Диалог опций Rendering options 

 
В разделе Rendering mode показывается алгоритм удаления скрытых 

линий. Если отмечена опция Auto-detect, этот алгоритм может быть 
сконфигурирован вручную. Это может улучшить просмотр конструкции, но 
может потребовать больший резерв памяти. 

Выполнение Hardware допускается только в пользовательской системе. 
Слайдеры изменяют показ геометрии сторон и сетки разбиения. 

Опции в разделе Face Displacement обеспечивают выбор оптимального 
вида линий ребер и структур. Относительные положения ползунков также 
устанавливают соотношения видимости геометрии и сетки. Различные параметры 
могут требоваться для различных направлений представления. Эти параметры 
записываются в файле конфигурации CADFEKO. 

 
 

5.2.1 Рабочая плоскость 
 

Каждое трехмерное представление имеет связанную с ним рабочую 
плоскость (РП), которая используется для задания координат с помощью мыши. 
РП чертится как синий прямоугольник (на границе) с осями U, V и N. Вывод РП 
может быть отключен командой Show / Hide workplane. 

Чтобы установить положение и направление РП, сделайте щелчок правой 
кнопкой мыши на трехмерном представлении и выберите Workplane → Edit или 
нажмите <F9>. (На инструментальной панели имеется также кнопка Edit work-
plane). Это открывает диалог рис. 5.7. 
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РП определяется параметрами 
начала координат Origin, векторами 
U и V, которые задают направление 
РП. Запись вектора (2,0,0) в 
направлении аналогично 
использованию (1,0,0). При расчете 
v оси компонента V-вектора, 
параллельная вектору U, удаляется, 
чтобы убедиться, что эти два 
параметра ортогональные. Таким 
образом, вектор V не может быть 
параллелен вектору U. Ось N 
нормальна к uv-плоскости. 

Поля Origin, U vector, V 
vector могут быть заданы численно, 
то есть параметрами РП можно 
управлять путем непосредственного 
ввода параметров. Кнопка Apply 
изменяет РП без закрытия диалога. 
После этого параметрами РП можно 
управлять с помощью мыши.  

Величина Size задает размер 
РП. Рабочая плоскость может быть несимметричной. Она может, например, 
простираться от -1 до 3 в u направлении. Можно не включать начало координат, 
то есть РП может также простираться от -3 до -1 или от 1 до 4. Для того чтобы 
использовать мышь для черчения, РП можно продлить до бесконечности, то есть 
точки могут быть выбраны снаружи синего прямоугольника. Когда отмечена 
опция Auto enlarge, РП увеличивается так, чтобы включить всю созданную 
геометрию. Это, однако, не изменяет размеры РП относительно существующей 
геометрии. Размеры РП изменяются нажатием правой кнопки на трехмерное 
представление и выбором Workplane → Fit to geometry. Команда Zoom to 
extents согласовывает РП с текущей геометрией. Опция Grid spacing управляет 
плотностью линий координатной сетки. 

Если размер РП увеличен до максимального размера, и число линий 
координатной сетки больше чем 10 000 в любом направлении, кнопка показа 
сетки автоматически отключается. Сетка может появиться вновь при повторной 
активации этой кнопки. Однако если число линий превышает 100 000, сетка не 
видна. 
 

5.2.2  Изменение рабочей плоскости 
 

 
Рис. 5.7. Диалог рабочей плоскости 
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Выберите Workplane-> 
Transform из всплывающего меню 
трехмерного представления (рис. 5.8) 
или щелкая кнопку Transform 
workplane на трехмерной 
инструментальной панели 
представления. 

В диалоге Edit workplane 
задается рабочая плоскость в глобальных координатах. При произвольной 
рабочей плоскости может быть трудно переместить РП, или вращать её вокруг 
одного из ее собственных ребер, например. Диалог Transform workplane (рис. 
5.9) позволяет вращение или сдвиг РП, используя три параметра (U, V, N). 

Углы вращения вводятся в градусах. Если вращение выполнено вокруг 
больше чем одной оси, CADFEKO использует углы Кардана. Это означает, что 
рабочая плоскость вращается сначала вокруг оси N, затем вокруг оси V и, 
наконец, вокруг оси U. 

 
 

 
Рис. 5.9. Диалог трансформации РП 

 
 
РП не может быть преобразована, когда открыт диалог редактирования, или 

когда открыт диалог преобразований. Операция Zoom to extents (по которой 
согласовывается рабочая плоскость и геометрия) также блокируется при 
редактировании рабочей плоскости. 
 

 

 
Рис. 5.8. Операции с рабочей плоскостью 
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5.2.3  Режим захвата 
Режим захвата (привязки) удобно использовать при создании структуры. 

Нажимая правую кнопку мыши на трехмерном представлении, можно выбрать 
опцию Snap, чтобы выполнить привязку точки, определяемой курсором мыши. 
Если выбрана Workplane, то точка привязывается на рабочей плоскости (рис. 
5.10). Если выбрана Grid, то механизм захвата тот же, но значения округляются к 
самым близким значения сетки (значения округляются в координатах рабочей 
плоскости и не могут округляться в глобальных координатах для произвольных 
направлений РП). 

Если выбраны Geometry 
point или Mesh vertex, точки 
выбираются геометрии или сетки. 
Выбор Geometry face centre или 
Geometry edge centre обеспечивает 
привязка курсора к центру фаски 
или ребра. Для изогнутых граней 
геометрический центр не 
обязательно лежит на ребре. При 
определении новой геометрии 
используется привязка к 
существующей геометрии. При 
этом нет строго правила, и новая 
точка не изменяется, когда 
изменена существующая 
геометрия. Эти объекты могут 

модифицироваться одновременно, при использовании поименованных точек, 
командой Snap to → Named point (рис. 5.10). 

К этому меню можно также обращаться нажатием клавиш <Ctrl><Q> и 
<Ctrl><Q><V> (табл. 5.1). 

Табл. 5.1. Выбор объекта привязки    

 

W Рабочая плоскость 
G Сетка 
N Поименованные точки 
P Геометрические точки 
F Геометрический центр фаски 
E Геометрический центр ребра 
V Ребро сетки 

 
Рис. 5.10. Операции захвата точки  
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5.2.4  Расстояние между точками 
Если в режиме трехмерного представления модели одновременно нажаты 

клавиши <Ctrl> и <Shift>, то при перемещении курсора, CADFEKO показывает в 
панели состояния координаты текущей точки и расстояние между этой точкой и 
«точкой привязки». Текущая точка определяется в режиме захвата, и 
высвечивается красным кружком. 

Расстояние до точки привязки устанавливается (в режиме захвата) в 
трехмерном представлении, когда окна диалогов закрыты. Координаты этой точки 
первоначально показываются в панели состояния. Если мышь перемещается при 
нажатых клавишах <Ctrl><Shift>, то точка привязки показывается в виде 
зеленого кружка. 

5.3  Плоскости сечения 
Если щелкнуть правой кнопкой мыши на трехмерном представлении и 

выбрать команду Cutplanes, то открывается диалог секущей плоскости для того, 
чтобы выполнить сечение геометрии (рис. 5.11). Первая плоскость сечения 
создается автоматически, когда диалог открыт. Нажатие на Add создает 
дополнительную плоскость сечения. Нажатие на Remove удаляет текущую 
плоскость сечения, при снятии опции Active разрез удаляется без потери всех 
параметров настройки. Кнопка Flip скрывает объекты с другой стороны 
плоскости сечения. 

Плоскость сечения  
задается аналогично рабочей 
плоскости РП, используя 
параметры начала координат и 
два вектора. Таким образом, 
сечение структуры можно 
изменять вручную, используя 
параметры в диалоге рис. 5.11. 
При разрезании твердого 
объекта, поверхность, по 
которому разрезается 
трехмерное тело, отображается 
с видимой внутренней 
областью, даже когда геометрия 
не окрашена как среда. 

 
 
Тогда можно выбрать поверхности, или геометрию, которая находится 

позади плоскости сечения. Когда выбран объект, CADFEKO вырезает твердый 
объект как оболочку (показывая только фактические фаски), обеспечивая доступ к 
внутренним поверхностям и граням. 

 
Рис. 5.11. Плоскость сечения,  

установленная по РП 
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В диалоге имеется опция «Active», которую можно снять, и тогда плоскость 
сечения исчезнет, или снова поставить, и тогда плоскость сечения появится. Эта 
опция включается подобно опциям захвата. 

5.3.1  Выбор просмотра 
В некоторых случаях, когда объекты закрыты другими объектами, бывает 

трудно установить секущую плоскость, чтобы рассмотреть эти объекты. Кроме 
того, рассчитанные поля могут мешать просмотру трехмерных объектов. Поэтому 
такие объекты могут быть частично скрыты. Скрытые объекты удаляются из всех 
трехмерных представлений, но они все еще часть модели и сохраняются в файлах 
*.cfm и *.pre. Скрытые объекты отображаются серыми значками в дереве 
проекта. 

Объекты скрываются командой View→Hide Selected Items из 
всплывающего меню. Эти объекты можно показывать снова, выбирая их в дереве 
и выбирая команду Show из всплывающего меню или View → Show selected 
items. Если выбор содержит видимые и скрытые объекты, выберите Show/Hide 
для каждого выбранного элемента. Наконец, при выборе View→Show all, все 
скрытые объекты показываются вместе с сеткой, независимо от текущего выбора. 
Порты могут быть скрыты на уровне портов или отдельных моделей. 

Заметим, что кнопки на инструментальной панели можно использовать для 
задания операций в выбранном представлении. Если часть объектов установлены 
как невидимые, но операция Show all выведет видимость. 

5.3.2  Инструментальная линейка FEKO 
Первые десять кнопок на инструментальной панели сверху трехмерного 

представления (рис. 5.12) управляют видимостью объектов. Геометрия (твердый 
объект, поверхности и линии), точки геометрии, элементы сетки, узлы сетки, 
нормали  элементов сетки, поименованные точки, индикаторы конфигурации 
решения, глобальные оси, РП и сетки могут быть показаны или скрыты 
соответствующими кнопками. 
 

Рис. 
5.12: Инструментальная линейка 3D вида 

 

Скрытие РП  также скрывает сетку на ней. Кнопка Highlight mesh 
edges на основной инструментальной панели также управляет видимостью 
элемента, это относится к выбранным объектам и одновременно применяется ко 
всем трехмерным представлениям. 
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Значки в виде стрелок , следующие за кнопками Geometry и Mesh, 
позволяют выбрать вид. По умолчанию все части поверхностей чертятся в одном 
цвете. Эти кнопки также выбирают, чтобы показать детали. Если снята опция 
Show ports в списке geometry/mesh, то маркеры для портов прикладываются к 
геометрии и к сетке, а порты не будут показаны. 

При просмотре сетки, можно показать радиусы сегмента и радиусы 

покрытий сегмента. Если выбрана видимость среды , 
каждая среда в области отображается своим цветом, назначенным в списке Media 
в дереве. Элементы на поверхности окрашены на каждой стороне согласно среде 
на этой стороне фаски. Например, при просмотре сетки диэлектрического объекта 
снаружи, весь объект будет иметь вид как из свободного пространства. Различные 
цвета внутри станут видимыми только, если введены плоскости сечения. Так как 
пользователь может установить произвольную среду на каждой стороне 
треугольника, эта схема окраски дает возможность проверить правильность 
задания среды. То же самое относится к фаскам, лежащим между различными 
диэлектриками. Внешние фаски геометрии, однако, отображаются согласно 
параметрам видимости внутренней среды. 

Следовательно, диэлектрический объект будет отображен как диэлектрик, 
когда просматривается снаружи. Если отображаются радиусы сегментов и 
покрытия, они окрашены согласно материалу среды или среды покрытия. 

Если выбрана опция , то показываются только грани 
модели. Это позволяет рассматривать объекты, скрытые внутри, но может дать 
очень запутанный вид. Так как отображены только грани, цилиндры будут 
выглядеть как два диска, а сфера будет полностью невидима. 

Кнопки Edit workplane, Transform workplane и Specify cutplanes 
обеспечивают быстрый доступ к этим функциям. Кнопка Vertical Z axis 
управляет вращением модели так, что ось z остается вертикальной осью на экране 
(т.е. блокирует её изменения). Следующие две кнопки изменяют масштаб 
изображения, заполняя модель в выбранном окне. Кнопка Restore default view  
возвращает угол обзора к стандартной позиции. 

Действие кнопок Undo view action и Redo view action (также дублируются 
клавишами <Alt><←> и <Alt><→>) управляют последовательностью видов 
представления. 

5.4  Дерево модели 
Дерево модели в интерфейсе FEKO показывает представление текущей 

модели. Сверху идут список переменных, поименованных точек и сред. Далее 
идет общее содержание геометрии, сетка разбиения, порты и конфигурация 
решения. 

Всю последовательность создания геометрии можно видеть в дереве. Когда 
объекты получены из операций, то первоначальные (исходные) объекты 
удаляются из верхнего уровня модели и становятся новым объектом в дереве. 
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Термин «части» используется для объектов с самым высоким уровнем. Они 
находятся папке Geometry. Нажатие правой кнопкой мыши в дереве откроет 
соответствующее выплывающее меню. Двойное нажатие на пункте в дереве 
выведет диалог Properties в этом пункте. 

Дерево может быть развернуто с помощью кнопок <+> или выбирая 
Collapse/Expand all из всплывающего меню. Чтобы скрыть исходные объекты, 
используют клавишу <->. Аналогично клавиша <+> разворачивает только 
текущий уровень. 

Дерево подробностей (внизу) показывает детальную информацию (фаски, 
грани, области, ребра, преобразования и т.д.) отдельных частей, отображенных в 
основном дереве полужирным курсивом. Списки фасок, граней и областей 
относятся только к частям верхнего уровня. 

5.4.1  Содержание дерева проекта 
Иконки, идущие вслед за именем в дереве проекта, показывают тип, среду, 

преобразования, свойства разбиения на сетку и т.д. (по умолчанию названия 
также показывают тип, но после переименования, например, Assembly1.to.Antenna, 
эти иконки становятся очень полезными). Эти иконки перечислены в табл. 5.2. 

Таблица 5.2a.  
Примитивы  

 Кубоид 

 Пирамида (усеченная пирамида) 

 Сфера 

 Цилиндр 

 Конус 

 Полигон 

 Эллипс 

 Параболоид 

 Линия 

 Многоугольник 

 Линия эллипса 

 Кривая Безе 

 Сплайн через точки 

 Спираль 

 Импортированные (Parasolid) CAD объекты 

 
Поверхности (созданные копированием фаски или 
операцией explode) 
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Искривленный объект (ребро или провод), созданный 
копированием ребра или операцией исключения 

 Части, которые были сведены к примитиву 

 Части сетки разбиения 
 
 

Табл. 5.2 б. Операции конструирования   

 
Объединение выделенных объектов 

 
Вычитание одного объекта из другого 

 Нахождение области пересечения двух объектов 

 
Расщепление объекта на два 

 
Создание трехмерного объекта вращением двухмерного 
объекта 

 
Создание трехмерного объекта сдвигом и перемещением 
двумерного объекта 

 
Операция Loft создания плоскости с мягким переходом 
между двумя ребрами 

 Создание проекции объекта на плоскость 

 
Впечатывание (проецирование) точек на поверхности 

 
Упрощение геометрии (удаление избыточных элементов) 

 
Ассемблирование (разбиение на части) 

 
Табл. 5.2 в. Индикация элементов проекта  

 
Эта часть была преобразована 

 
Эта часть содержит диэлектрическую область 

 
Эта фаска лежит на диэлектрической области 

 
Эта часть стала неопределенной (невозможно нанести на 
чертеж структуры) 

 
Свойства локальной сетки (в области, на фаске, на ребре) 

 
Локальный радиус провода 
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Табл. 5.2 г. Преобразование геометрии   

 
Сдвиг, перенос 

 
Вращение вокруг оси 

 
Масштабирование 

 
Зеркальное отражение 

 
 

Табл. 5.2 д. Порты, нагрузки и возбуждения   

 
Порты на сегменте провода 

 
Порты на ребре 

 
Порты на полосковой линии 

 
Импедансная нагрузка 

 
Параллельная точка нагрузки схемы 

 Последовательная схемная нагрузка 

 Источник напряжения 

 Электрический точечный источник 

 Магнитный точечный источник 

 
Точечный источник с заданной диаграммой 
направленностью 

 Возбуждение плоской волной 

 
Вынужденный ток в области FEM 

 
Задание частоты 

 
Установка мощности 

 
Табл. 5.2 е. Требуемые рассчитываемые характеристики  

 
Расчет тока на поверхности 

 
Расчет характеристик дальнего поля 
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 Расчет характеристик ближнего поля 

 Расчет SAR 

 
Расчет S параметров 

 Расчет характеристик анализа кабеля 

 
Расчет мощности, принимаемой идеальной приемной 
антенной 

 
 
Табл. 5.2 g. Расшифровка дерева подробностей 

 Для проводов и поверхностей, среда сердечника 

 Среда слоя, используемого как покрытие 

 
Для поверхностей – среда на нормальной стороне;  
для проводов – окружающая среда 

 
Используется только для поверхностей; среда с обратной 
стороны 

 
 
 
 

5.4.2  Значки среды в дереве подробностей 
 
В дереве подробностей имеются значки информации о среде. Видимость 

для каждой среды может быть установлена кликом правой кнопкой мыши на 
среде в списке Media. 

Для областей (Regions) имеется один столбец, указывающий среду области 
(PEC, свободное пространство или один из определенных диэлектриков). 

Для фасок (Faces) имеются два столбца. 
Первый столбец указывает среду фаски (PEC, одна из металлических сред, 

многослойный диэлектрик, если это – тонкий лист диэлектрического материала 
или импедансная поверхность).  

Второй столбец указывает многослойный диэлектрик Layered dielectric, 
если выполнено покрытие фаски. Для проводов имеются также два столбца. 
Первый указывает материал провода (PEC или одни из металлических 
носителей), второй – покрытие. 

Для тетраэдральных сеток имеется только один столбец, который указывает 
среду (один определенный диэлектрик). 
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Рис. 5.13. Значки, контролирующие среду (модели и сетки) 

 
Для контроля сеток на поверхностях (фасках модели) имеются два столбца, 

относящиеся к фаскам и два дополнительных столбца, которые указывают среду 
(PEC, свободное пространство или одна из определенных диэлектрических сред) 
на передней стороне и задней, соответственно. 

Для контроля сетки разбиения на сегменты имеются также два столбца, 
которые относятся к проводам, а также столбца, указывающего окружающую 
среду (таблица 5.3). 
 

Таблица 5.3. Символы, используемые в столбцах дерева подробностей 
(см. табл. 5.2 g) 

Области (Region) 
Столбец 1 Среда области 

Фаски (Faces) 
Столбец 1 Среда, в которой находится фаска 
Столбец 2 Сторона слоя, лежащего на диэлектрике 

 
Ребра (Edges) (только для проводов) 

Столбец 1 Среда, в которой находится провод 
Столбец 2 Диэлектрический слой, если провод покрыт слоем диэлектрика 

Тетраэдральная сетка разбиения 
Столбец 1 Среда 

Треугольная сетка разбиения 
Столбец 1 Среда в которой находится фаска 
Столбец 2 Диэлектрический слой, в котором находится фаска 
Столбец 3 Среда впереди фаски (по нормали) 
Столбец 4 Среда сзади фаски  

Разбиение провода на сегменты 
Столбец 1 Среда, в которой находится провод 
Столбец 2 Диэлектрический слой, в котором находится повод 
Столбец 3 Окружающая среда 
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5.5  Изменяемые параметры 

5.5.1  Переменные 
CADFEKO поддерживает параметрические модели. Таким образом, 

большинство параметров могут быть определены, используя переменные или 
математические выражения типа W=1+sqrt (x), где x – переменная. 

Когда переменная изменяется, все объекты в зависимости от этого также 
изменяются. Поэтому очень просто изменить модель, используя переменные, 
например, изменить геометрию. Так как возможно редактировать объекты 
геометрии, переменные могут быть введены после построения модели. 

В то время как геометрия полностью параметрическая, сетка разбиения не 
параметрическая, потому что сохранение выражений для вершин сетки 
потребовало бы сохранение очень большого количества данных в ЗУ. Вообще, 
действия, выполняющиеся на уровне компонент, полностью параметрические, но 
действия, которые обращаются к отдельным элементам – нет. При работе с 
элементами сетки в большинство входных полей можно вставить формулы. 
Например, прибавление +1 к координате вершины перемещает её на одну 
единицу. Переменные могут быть добавлены двойным нажатием при введении 
переменных в дереве или выборе Geometry → Add variable  из главного меню. 
Первый символ имени переменной должен быть буквой от 'a' до 'z' и от 'A' до 'Z' – 
или символ подчеркивания; символы сохранения могут также быть числовые – от 
'0' до '9'. Имена переменной не чувствительны к регистру, т.е. 'a', и 'A' 
обрабатываются как тот же самый символ. Выражение определяет значение 
переменной и может быть простым номером (типа 1.23) или математическим 
выражением, которое может использовать круглые скобки, операторы  +,  -,  *,  \,  
^  (экспонента), другие переменные, а также функции, перечисленные в таблице 
5.4. 
 

Таблица 5.4. Функции, поддержанные в выражениях CADFEKO 
fmod Fmod (a,b) возвращает частное от деления a/b 
Sin 
Cos 
Tan 
Cot 

Тригонометрические функции (аргументы в радианах) 

Arcsin 
Arcos 
Arctan 
arccot 

Обратные тригонометрические функции (результаты в 
радианах) 

Atan2 Atan2(y,x) соответствует arctan(y/x)  в диапазоне –π…π 
Deg Преобразование радиан в градусы 
Rad Преобразование градусов в радианы 
Sinh 
Cosh 
tanh 

Гиперболические функции 

Log Десятичный логарифм  
Ln Натуральный логарифм 
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Exp Экспоненциальная функция 
Sqrt Корень квадратный 
Abs Абсолютная величина 
Step Step(x) =1, если  x>0,  иначе равно 0. 
ceil Верхняя граница 
Floor Нижняя граница 
Min Min(a,b) или  max(a,b) дает минимум или максимум 

 
Если имеется ошибка в выражении, 

появится сообщение об ошибках внизу 
диалога и окно окрасится красным цветом. 
Переменная может быть добавлена только 
тогда, когда выражение правильно. Кнопка 
Evaluate (рис. 5.14) рассчитывает и проверяет 
правильность выражения без закрытия 
диалога. 

 
Переменные могут быть изменены 

двойным нажатием на переменной (или 
нажимая правой кнопкой на Properties). 

CADFEKO покажет ошибку, если переменная зависит сама от себя. Все объекты 
в зависимости от переменной будут изменяться одновременно. Если это приводит 
к недопустимой геометрии (например, радиус сферы становится нулевой или 
пересечение или разбиение, которое становится пустым), в информационном окне 
записывается ошибка, и переменная не изменяется. 

 
Переменные в таблице 5.5, которые всегда имеются в списке, являются 

частью новой модели. Эти переменные могут быть удалены и / или изменены 
точно так же как любая другая переменная, если пользователь явно использует их. 

 
Таблица 5.5. Используемые постоянные 

c0 длина волны в свободном пространстве 
eps0 диэлектрическая постоянная в свободном пространстве 
mu0 проводимость в свободном пространстве 
zf0 волновой импеданс в свободном пространстве 
pi константа π 

 
 
 
 
 

 
Рис. 5.14. Диалог создания 

переменной 
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5.5.2  Поименованные точки 

 

Поименованные точки могут быть 
созданы двойным нажатием на Named points в 
дереве, щелкая правой кнопкой и выбирая Add 
named point (рис. 5.15). Точки обычно 
используются для создания геометрии, которая 
должна изменяться.  
 К компонентам точки x, y и z можно 
обратиться. Допускается применять только 
операции вычитания и сложения 
(соответствующие компоненты добавляются и 
вычитаются) и направление может быть 
умножено или разделено на число. Кроме того, 
к отдельным точкам можно применить 
функции, перечисленные выше. Никакие 
другие действия к точкам применены быть не 
могут. 

5.5.3  Калькулятор 
Выберите View → Calculator, чтобы открыть калькулятор, который 

позволяет рассчитать и проверить расчеты переменных или координаты 
поименованной точки без изменений параметров самой модели (рис. 5.16). 

Форматом представления 
результата расчета можно 
управлять. В калькуляторе 
применяется научное 
экспоненциальное представление 
чисел, например, 0.01 
показывается в виде 1.0e-2. 
Формат подобен научному 
калькулятору, за исключением 
того, что показатель степени 
всегда кратен 4. Таким образом, 

число 0.01 представляется в виде 10.0e-4. 
В режиме Decimal число представляется без показателя степени. Такой вид 

представления не рекомендуется для малых чисел, поскольку может привести к 
ошибкам. Например, число 1.0e-6 при представлении его с 5 десятичными 
числами, будет иметь вид 0.00000, что означает потерю информации. Поле 
Decimals показывает количество разрядов после десятичной точки. 

 
Рис. 5.15. Создание 

поименованной точки A 
 

 
Рис. 5.16. Окно калькулятора 
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5.6  Выбор объектов 
Объекты выбираются с помощью мыши или в дереве, или в любом 

трехмерном представлении. Выбранные объекты, подсвеченные в дереве, 
выделяются во всех трехмерных представлениях. Когда исходные объекты 
выбраны в дереве, CADFEKO выделяет каркас этих объектов в трехмерном 
представлении. Если текущий диалог работает с объектами, которые больше не 
выбраны, эти объекты показываются на зеленом фоне в дереве. 

Нажатие клавиши <Ctrl> при выборе объектов в дереве или в трехмерном 
представлении, означает прибавление их к текущему выбору (или удаление их, 
если они выбраны). Нажимая <Shift> при клике на объекты в дереве, выбираются 
элементы одного и то же типа. Так как порядок объектов в трехмерном 
представлении - не очевиден, нажатие <Shift> в этом случае, означает просто 
добавление/удаление выбора нового элемента. Передвигаться в дереве можно 
также клавишами курсора. Можно нажать <Shift>, чтобы выбрать несколько 
объектов. 

Все выбранные объекты должны иметь тот же самый тип, то есть 
невозможно выбрать часть и некоторые из ее фасок одновременно. Однако можно 
выбрать одновременно фаски, принадлежащие к различным частям. 

Если нажата клавиша <Ctrl>, то во время нажатия правой кнопкой мыши 
появляется меню, текущий выбор будет оставлен неизменным. Если нажата 
клавиша <Shift>, новый элемент будет добавлен к выбранным. 

Выбор в трехмерном представлении управляется с помощью 
инструментальной панели Selection (рис. 5.17). 

 
Рис. 5.17. Инструменты выбора объектов 

5.6.1  Выбор компонентов 
Отдельные части конструкции выбираются, нажимая на их имя в дереве или 

же на трехмерном виде всей конструкции. Выбранные объекты подсвечиваются в 
дереве и в трехмерном представлении. 

Когда исходные объекты выбраны в дереве, CADFEKO прочерчивает 
каркасы этих объектов. Эти объекты не самостоятельные части модели, но очень 
полезны для различения исходных объектов. Если текущий диалог работает с 
объектами, которые больше не выбраны, эти объекты показываются на зеленом 
фоне в дереве. 

Нажимая <Ctrl> при выборе объектов, в дереве или трехмерном 
представлении, добавляем их к текущему выбору (или удалим их, если они 
выбраны). Нажимая <Shift>, при клике на объекты в дереве выбираем все 
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элементы одного типа от первого элемента текущего выбора. При работе в 
трехмерном представлении нажатие <Shift> просто добавит или удалит новый 
элемент. Работа в дереве также может быть выполнена с использованием клавиш 
курсора. Можно удерживать <Shift>, чтобы выбрать несколько объектов. 

Все выбранные объекты должны иметь один тип, то есть невозможно 
выбрать объект и некоторые из его фасок одновременно. Можно, однако, 
одновременно выбрать фаски, относящиеся к различным частям. 

Если нажата клавиша <Ctrl>, то при клике правой кнопки мыши для 
открытия всплывающего меню, текущий выбор будет оставаться неизменным. 
Если нажат <Shift>, новый элемент будет добавлен к выбранным. 

Выбор объектов управляется с помощью панели Selection. Она содержит 

два набора кнопок  и кнопки отмены и восстановления. 
Первые три кнопки позволяют выбирать объекты модели. Если включается 

первый режим, объекты выбираются курсором. Если переключиться на Rectangle 
(прямоугольник), то выбираются все объекты, попадающие полностью или 
частично внутрь этого прямоугольника. Наконец, если выбирается Polygon 
(многоугольник), путем последовательного клика мыши в его углах. 
Многоугольник замыкается, после нажатия на первый угол. Для удобства в этом 
углу рисуется синий кружок, когда мышь попадает на него. 

Заметим, что присутствие плоскости сечения cutplanes влияет на выбор 
многоугольника. В отсутствии секущей плоскости выбираются только видимые 
объекты или полностью или частично внутри прямоугольника/полигона. Заметим, 
что, если фаска находится в диалоге Solution, то фаски сразу позади острых углов 
могут быть «видимы». Когда присутствует плоскость сечения, все объекты в 
пределах области выбора – видимые объекты, как и те, что полностью скрыты 
позади других объектов. 

Методы выбора могут быть комбинированными. Например, можно 
выделить всё объекты внутри полигона, затем нажать на кнопку Single и добавить 
дополнительные объекты, нажимая <Ctrl> или <Shift> и кликая на эти объекты. 

При выборе «метки сетки», все элементы с той же самой меткой 
выбираются или не выбираются одновременно. Действия применены к выбранной 
метке. 

В режиме «разбиения на сетку» действия относятся к отдельным элементам. 
Например, если метка сетки выбрана и переименована, имя этой метки изменено. 
Если, однако, ряд элементов сетки выбран и переименован, создается новая метка, 
и все выбранные элементы будут теперь иметь эту метку. Выбор объектов в 
дереве инициируется кнопкой «что выбрать (what to select)». Нажимая <Ctrl> 
<A>, выделяются всё объекты выбора текущего типа. 

Прежде чем изменяется режим выбора, сначала снимается существующий 
выбор. С одним исключением – когда метки сетки выбраны, и режим выбора 
переключен, чтобы выполнить разбиение на сетку, выбранные элементы 
преобразуются. Следовательно, все элементы остаются выбранными, как будто 
они были выбраны как элементы сетки. 
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Если нажимается кнопка Highlight mesh edges (рис. 5.17), высвечиваются 
грани выбранных элементов сетки. Это позволяет находить мелкие элементы, 
поверхность которых может быть невидна сама по себе. При вращении модели (то 
есть перед отпусканием кнопки мыши), поверхности сетки скрыты. 
Следовательно, если геометрия скрыта, при вращении модели можно видеть 
грани выбранных элементов, даже скрытые позади других объектов. 

5.7  Удаление объектов 
Чтобы модель не имела противоречий, CADFEKO не позволяет удалять 

объекты, которые используются другими объектами. Например, невозможно 
удалить переменную, которая используется при определении среды или удалить 
среду, которая используется в какой-то части геометрии. 

Когда операция удаления терпит неудачу, CADFEKO покажет, где 
используется элемент. Этот элемент должен быть сначала удален или 
отредактирован так, чтобы он больше не зависел от исходного элемента. 

Заметим, что иногда зависимость может быть косвенная. Например, 
рассмотрим переменную, используемую для установки размера разбиения на 
Face1 параллелепипеда Cuboid1. 

Пусть параллелепипед далее объединяется с другим и вычитается из 
некоторого другого объекта. Если пользователь теперь попробует удалить 
переменную, появится сообщение с обозначением полного пути этой фаски, 
(Subtract1.Union1.Cuboid1.Face1), в описании которой используется переменная 
и предупреждением, что она недоступна. Итак, невозможно удалить внутренний 
объект, кроме как копируя первоначальные объекты из дерева и восстанавливая 
последние несколько шагов. Таким образом, все параметры настройки зависят от 
геометрии, которые, вероятно в этом случае изменятся. 

Подобная ситуация может произойти, когда конфигурация решения 
определена в CADFEKO и затем блокируется после того, как пользователь 
редактировал файл *.pre. Пользователь больше не может редактировать или 
удалять какие-либо установки, но CADFEKO должен сохранить модель 
непротиворечивой, так как пользователь может в любое время запустить решение 
снова. Это может стать проблемой, если пользователь хочет, например, изменить 
переменную, которая также используется в остальной части модели, но это 
изменение не может быть сделано вследствие того, что это вызывает 
недопустимое состояние в конфигурации. Единственный путь в этом состоит в 
том, чтобы создать конфигурацию снова (CADFEKO автоматически 
переименовывает редактируемый файл *.pre), сделать изменение и затем найти 
переименованный файл *.pre и переименовать его снова. 

5.8  Ввод точки 
В некоторые диалоги можно вводить координаты, нажимая мышью на 

трехмерном представлении. Если поля можно использовать для такого ввода, они 
имеют желтый фон. Нажимая на трехмерную структуру, координаты выбранной 
точки (используя режим активного захвата) вводятся в поле, и метка курсора 
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сдвигается в следующее поле. Это позволяет создавать геометрию серией 
щелчков на трехмерном представлении, и далее нажимая на Create в диалоге. 

Для одномерных полей ввода (типа радиуса сферы), значение 
рассчитывается по выбранной точке и результат вводится в поле. Когда вводится 
вектор, он идет от начала координат до выбранной точки. 

Также можно нажать на поименованную точку или переменную в дереве. 
Тогда эта точка добавляется во всех активных полях или, в случае переменной, в 
текущее поле. Если поля определены, используя поименованные точки, они 
пересчитываются, когда что-нибудь изменяется. 

Например, если поле U vector на РП определяется с помощью привязки к 
точке модели (например, в вершине сетки), то рассчитывается вектор от начала 
координат до этой точки и вводится в поле как число. Если начало координат 
изменяется впоследствии, направление вектора u остается неизменным. Если, 
однако, направление вектора задается захватом к поименованной точке, это 
изменяется всякий раз, когда изменяется начало координат. Координата U vector 
тогда продолжает указывать на заданную точку. 

Поля, в которые вводятся координаты, имеют кнопки Lock рядом с ними 
. Если включается кнопка , то в поле невозможно ввести выбранную точку. 

Это используется, когда нужно, например, кликнуть на точку на РП без 
изменения значения.  

Когда значения введены в поля, показывается предварительная структура 
созданного объекта. Если нажаты <Ctrl><Shift>, при перемещении мыши по 
экрану (без нажатия), значения координат изменяются непрерывно. Это 
называется режимом предварительного просмотра. Активные поля показывают 
значения, которые были бы введены, если мышь была нажата в этой позиции. 
Значения в активных полях отображены, используя курсивный шрифт, чтобы 
указать, что режим предварительного просмотра активен. 

Режим захвата и зафиксированное положение координат (в глобальных 
координатах) показываются в строке состояния. Если клавиши <Ctrl><Shift> 
отпущены без нажатия на представлении, величины устанавливаются такими, 
какими были до режима предварительного просмотра.  

Некоторые размеры могут быть ортогональными к рабочей области. 
(Например, высота цилиндра, когда локальные координаты выравниваются с РП). 
Когда эти величины являются активными, высота определяется как нормаль к 
рабочей плоскости. 

Нажимая кнопку Create, рассчитываются все вводимые данные. Если какое-
нибудь поле содержит недопустимое выражение, или значение, которое неверно 
для этого параметра (например, нуль для радиуса сферы), в окне сообщения 
отображается ошибка. 

5.9  Локальные координаты 
Все отдельные геометрические объекты в CADFEKO определены в 

глобальных или локальных координатах. 
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Заданная по умолчанию система 
координат может быть определена, выбирая 
Options → Preferences из основного меню 
CADFEKO, но эта система может быть 
изменена в каждом диалоге геометрии. Если 
поле Use global coordinates в диалоге создания 
не отмечено, закладка Coordinates, показанная 
на рис. 5.18, становится активной. Задание 
локальных координат очень похоже на задание 
рабочей плоскости. Поле Origin определяет 
начало координат локальных координат. 
Изменение этого значения преобразует 
координаты, и, таким образом, изменяет 
положение, где будет создан новый объект. Поля 
векторов U и V определяют направления 
рабочей плоскости. Третья ось N нормальна к 
осям u и v. Нажатие кнопки Set to workplane 
(рис. 5.18) устанавливает локальные координаты 
к РП в текущем представлении. Таким образом, 
инструмент рабочей плоскости может 
использоваться для определения и 
манипуляцией РП, и затем локальных 
координат, согласованных с ним. 

Если предпочтительнее установить 
локальные координаты, то эти координаты 

привязываются к рабочей области каждый раз, когда открывается диалоговое 
окно создания геометрии. Сделано так, что после открытия диалогового окна, 
координаты преобразуются. Если нет трехмерного представления, локальные 
координаты согласовываются к глобальным. 

Некоторые рассчитываемые характеристики также используют локальные 
координаты. В одних случаях они также используются для примитивов геометрии 
(например, при копировании исходных). В других случаях это добавляет 
возможности просмотра (например, при установке фазового центра при выводе 
характеристик дальнего поля, когда пользователь может изменить начало 
координат, но не ориентацию), или включает дополнительные возможности 
(например, при расчете ближнего поля, который может также быть вычислен в 
других системах координат). 

5.10 Редактор текста описания задачи 
В CADFEKO имеется текстовый редактор (рис. 5.19), в котором 

пользователь может описать задачу и добавить комментарии к модели. Он 
открывается из основной инструментальной панели или, выбирая режим View → 
Notes. 

 
Рис. 5.18. Закладка 

локальных координат, при 
создании параллелограмма 
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Панель редактора сверху содержит 
кнопки: Clear (очистить) и Print (печать) 
примечания, Undo / Redo, а также 
стандартные команды Cut, Copy, Paste 
(вырезать, копировать, вставить). 
Отменить любые изменения в тексте можно 
только командой Undo. Кроме того, 
редактор позволяет установить шрифт, его 
размер, тип и цвет текста. Если ранее 
никакие примечания не были сохранены с 
моделью, то запускается основной шаблон. 

 

5.11  Получение справки 
Выберите Help → CADFEKO manual, чтобы открыть документы в 

ассистенте помощи. Кроме этого, нажатие (F1) в любом диалоговом окне откроет 
справку, связанную с этим окном. 

В меню Help также доступно Руководство пользователя FEKO (User’s 
Manual) и Первые шаги (Getting Started Manual). Эти документы в формате 
PDF. 

В дополнение к сообщениям и информации об ошибках, CADFEKO выдает 
текстовый файл для регистрации в подкаталоге файлов. Если CADFEKO 
сталкивается с внутренней ошибкой, файл регистрации копируется в 
CADFEKO.ERROR.LOG, а текущая модель – в файл CADFEKO.ERROR.CFX. 
Если эти файлы запустить, то сообщается об ошибке. 

 

5.12  Быстрые клавиши 
Перечислим клавиши быстрого доступа, которые реализованы в CADFEKO. 

<Shift> <F1> «Что это?» (расширенная подсказка) 
<F1> помощь в диалоговом окне 
<F2> переименование выбранного элемента 
<F9> редактирование в рабочей области 
<Del> удаление выбранных элементов 
<Shift> <Ins>   вставка текста 
<Ctrl> <Ins> копирование выбранного текста 
<Shift> <Del> вырезание выбранного текста 
<Ctrl> <A> выделение всех элементов 
<Ctrl> <C> копирование выбранного текста 
<Ctrl> <K> для части или элемента проекта позволяет создать копии 

выбранных элементов. Для элементов геометрии новые 
части создаются на корневом уровне 

<Ctrl> <M> создание сетки разбиения 

 
Рис. 5.19. Редактор  

описания задачи 
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<Ctrl> <N> создание новой модели 
<Ctrl> <3> создание нового трехмерного пространства 
<Ctrl> <O> открытие модели 
<Ctrl> <Q> выбор зафиксированной опции (только тогда, когда у 

трехмерного пространства есть центр). Элементы 
выбираются обозначенными клавишами 

<Ctrl> <S> сохранение модели 
<Ctrl> <V> вставить 
<Ctrl> <X> вырезание выбранного текста (только в редакторе 

примечаний) 
<Ctrl> <Y> отмена последней операции в создании модели 
<Ctrl> <Z> отмена созданной модели 
<Alt> <←> манипуляция отменой 
<Alt> > <→> отмена последней операции 

 

5.12.1  Проверка обновлений программ FEKO 
Выберите Help → Check for updates (проверка обновлений) и нажмите 

Check (проверка) в диалоговом окне, чтобы с помощью сайта EMSS обновить 
программу. Эта операция проверяет, были ли какие-нибудь обновления 
добавлены на сайте FEKO, начиная с последней проверки. (Так как CADFEKO 
не знает, есть ли у пользователя лицензия для других платформ, он выдает 
сообщение обновления, независимо для какой платформы предназначено 
обновление). Устройство обновления загружает только список обновлений. Но 
информации на сайт FEKO не посылается, и автоматически обновления не 
загружаются. Если обновление доступно, оно может быть загружено с сайта 
www.feko.info/members.htm 

Если активизируется автоматическая проверка обновления, то CADFEKO 
обращается на сайт каждый раз спустя семь дней после последней проверки. Это 
возможно, если у вас есть доступ к Интернету. Эта установка разделена на 
CADFEKO и EDITFEKO. Закладка Info (информация) относится к возможности 
обновления программного обеспечения. 
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6  СОЗДАНИЕ МОДЕЛИ 

В предыдущей главе был описан интерфейс FEKO. В этом разделе будет 
рассмотрена последовательность черчения конструкции. При решении задач в 
FEKO модели могут быть созданы и решены полностью в интерфейсе 
CADFEKO. Утилита EDITFEKO, которая работает с картами, дает 
дополнительные, более широкие возможности моделирования. По мере 
совершенствования CADFEKO, всё больший класс задач можно решить в ней 
полностью. 

6.1  Создание конструкции в CADFEKO 
Единицы длины в CADFEKO устанавливаются командой Model → Model 

unit из меню Model в интерфейсе программы (рис. 6.1).Помимо стандартных 
единиц, можно выбрать произвольные единицы. Единицы отображаются в строке 
состояний. 
 

Рис. 
6.1. Интерфейс FEKO с деревом проекта анализа отрезка линии 

 
Изменение единиц длины не изменяет самих чисел, а только интерпретацию 

их, следовательно, выбор единиц длины можно сделать в любое время при 
построении модели. 

Операции над геометрией (которые могут привести к выявлению 
одинаковых точек) требуют задания допуска. Этот допуск зависит от размера 
модели. (Например, микрополосковые структуры могут быть созданы с 
точностью нескольких микрон, но такая точность не нужна при изучении 
распространения радиоволн в горах). 

Максимальные размеры модели выбираются в CADFEKO командой 
Geometry → Extents из главного меню. Расширение геометрии выполняется 
одинаково во всех направлениях и, таким образом, нужно задать только одно 
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значение (рис. 6.2). Это максимальная координата, которая дает максимальное 
отклонение модели в любом направлении. Например, если максимальная 
координата равна 500, вся геометрия должна находиться внутри поля 
100010001000 (единиц) с центром в начале координат. 

 
Допуск модели определяется как 

параметр в диалоге Maximum coordinate, 
разделенный на 5108 (рис. 6.2). Если 
значения координат отличаются больше, 
чем на эту величину, они будут иметь 
различные значения. Значения будут 
различаться, если разница между ними – 
меньше, чем сотая часть допуска. 

По умолчанию для расширения 
геометрии выбирается значение 5E+02, и 

это расширение рекомендуется, если модель небольшая. Для величины, отличной 
от 5E+02, экспортируемая модель Parasolid не будет транслироваться в единицах, 
используемых в CADFEKO. 

6.2  Черчение с использованием 3D примитивов 
 Меню Geometry → Solid (рис. 6.3) содержит подменю для черчения кубоида, 
пирамиды (возможно усеченной), сферы, цилиндра или конуса. 

 
Рис. 6.3.Команды черчения примитивов и обработки геометрии 

 
Процесс черчения аналогичен для всех компонентов, так что обсудим этот 

процесс на примере кубоида. 
При создании геометрии используются глобальные или локальные 

координаты и точка ввода. Объекты имеют фиксированную ориентацию в 
выбранных (глобальных или локальных) координатах. Для параллелепипеда все 

 
Рис. 6.2.Задание максимального 
значения координаты, которая 
зависит от размера структуры 
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фаски можно использовать как плоскости для черчения следующей компоненты. 
Для пирамиды, её основание (база) выравнивается с плоскостью xy или осями U и 
V, а высота идет в направлении оси z или N. Для цилиндров и конусов ось идет в 
направлении оси z или N. При произвольном ориентировании, объекты должны 
быть созданы в локальных координатах. 

Выберем курсором команду черчения кубоида Create cuboid (рис. 6.3).  
В диалоге Create cuboid (рис. 6.4) нужно ввести положение одного 

направления и размеров по трем координатам. 
В разделе Definition method (рис. 6.4) 

можно выбрать два варианта создания: 
- координаты начальной (угловой) точки, 

ширина, глубина, высота; 
- Координаты точки центра, ширина, 

глубина, высота. 
Новый объект создается после нажатия 

кнопки Create. После создания одного 
параллелепипеда можно в этом же диалоге 
задать параметры другого. Когда все нужные 
параллелепипеды созданы, нажмите Close или 
<Esc>, чтобы закрыть диалог. Размеры должны 
быть ненулевые, иначе CADFEKO покажет 
ошибку в информационном окне и укажет 
неверное поле красным цветом. Возможны 
отрицательные значения (типа ширины 
кубоида), они принимаются как встречное 
направление от координаты угла. 

В поле Label записывается имя нового 
объекта. Это имя появится в дереве проекта и 

может быть изменено в любое время. 
Если поле Radius для сферы или цилиндра определено точкой, поверхность 

сферы, или расширение цилиндра будет создаваться от этой точки. Для конуса 
радиус определяется как расстояние между началом локальной системы 
координат и направлением в локальной uv плоскости. Чтобы определить 
остроконечный конус, оставьте Top radius =0. 

Трехмерные примитивы – по умолчанию идеальные электрические 
проводники. Они могут быть изменены на диэлектрические объекты или 
структуры в виде внешнего слоя. Эти режимы зависят от установки свойств 
области заполнения диэлектриком. 

 
 

 
Рис. 6.4. Диалог создания куба 
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6.2.1 Черчение двумерных поверхностей 
Все двумерные поверхности создаются как твердые листы. Поэтому они 

требуют ввода ребер. Ребра относятся к отдельным сторонам поверхности или 
определяют границы твердого тела. 

Полигоны создаются с помощью диалога, который вызывается по команде 
DrawCreate polygon (рис. 6.5). Этот диалог использует глобальные или 
локальные координаты и точки ввода. Все указанные точки должны лежать в 
одной плоскости. В простейшем случае можно выполнить выравнивание 
локальных координат с плоскостью полигона, и в этом случае все значения 
координаты Z равны 0. 

 
Нажатием на кнопку Add (рис. 6.5) вводится дополнительный угол формы. 

Углы полигона вводятся последовательно, не допуская пересечение граней. Угол 
показывается синим квадратом на трехмерном чертеже. Кнопка Reverse normal 
переупорядочивает точки таким способом, что вектор нормали (определенный в 
математически положительном смысле от направления граней), реверсируется. 

Когда нажимается Create, все пустые точки удаляются автоматически. В 
закладке Properties можно установить опцию неразбиения этой платы на ячейки 
(Unmeshed plate). Если это свойство устанавливается как True, полигон 
разбивается на ячейки в виде прямоугольников, а не на треугольники. Это 
используется, если полигон рассчитывается методом UTD. 

Параболоид используется для черчения параболической антенны. Этот 
элемент также относится к двумерным поверхностям. Если создается параболоид 
командой Creare Paraboloid, его фокусное расстояние f связано с высотой h: 

 

h
Rf
4

2


 

 
Глубина рефлектора идет от начала координат до точки фокуса F. 

Параболоид (рис. 6.6) ориентируется по оси N. Поле Radius определяет радиус R 
в плоскости, ортогональной к оси N, и должно быть положительным. Если это 
значение отрицательно, параболоид меняет ориентацию по оси N. 

Зачастую в практике проектирования из полного параболоида нужно 
вырезать часть. Тогда создадим объемную форму (параллелепипед или другую 
форму) и вырежем из параболоида «лишние» фрагменты, используя операцию 
Intersection. 
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Рис. 6.5. Диалог создания полигонов  

(страница Geometry (слева) и рабочей плоскости (справа) 
 

 
Рис. 6.6. Размеры параболоида 

 

6.2.2  Создание искривленных форм 
Искривленные части конструкций в CADFEKO могут быть созданы с 

помощью операции смещения spin, вращения sweep или слияния loft. В 
дополнение к сложным конструкция, получающимся из соединений фасок и 
поверхностей, CADFEKO использует ряд простых геометрических компонентов, 
таких как одиночные прямые и ломаные линии, кривые, описываемые функциями 
(рис. 6.7), в форме сплайнов и кривых Безье, эллиптические дуги и спирали. 
Ломаная линия и сплайны состоят из списка точек. 
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Рис. 6.7. Диалог создания искривленной линии,  

задаваемой формулой (слева) и кривой Безье (справа) 
 

Заметим, что радиус провода определяется на ребре (он устанавливается в 
дереве подробностей), а не на примитиве. Задание радиуса провода (ребро, а не 
граничная фаска), который был создан геометрической операцией (типа 
пересечения двух фасок) выполняется таким же образом. 

Сложную форму (например, дугу, растягиваемую по пути, созданном в виде 
параболы), можно создать, использую операцию Path Sweep, для чего нужно 
создать фрагмент параболы, по которой будет двигаться дуга, используя параболу 
как путь. Обе функциональные линии должны быть созданы в проекте, а после 
создания поверхности они могут быть удалены. 

 

6.3  Экспорт и импорт геометрии 
 

CADFEKO выполняет моделирование твердого тела в формате Parasolid. 
Модели Parasolid могут быть импортированы и экспортированы без 
преобразования (Рис. 6.8).  

Выберите File→Export→Parasolid..., чтобы экспортировать геометрию в 
виде файла Parasolid. Нужно сделать выбор между текстовым или бинарным 
форматом (рис. 6.9). 
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Рис. 6.8. Операция экспорта в разделе File 

 
Модели Parasolid ограничены полем 

100010001000 единиц с центром в начале 
координат. CADFEKO вводит масштабный 
коэффициент, чтобы согласовать размеры 
импортируемой модели (см. расширение 
геометрии). Поле Scale factor при экспорте 
модели Parasolid показывает коэффициент, на 
который умножаются все размеры модели, 
чтобы преобразовать её к единицам модели 
Parasolid. Масштабный множитель 0.1 

подразумевает, что размеры сохраненной модели Parasolid составляют десятую 
часть от исходных размеров CADFEKO. Многие программы, которые 
импортируют модели Parasolid, определяют коэффициент, на который модель 
Parasolid должна быть умножена во время импорта. Это должна быть величина, 
обратная масштабному множителю CADFEKO. Для удобства коэффициент 
импорта сохраняется в файле с расширением .info, например 
export_geometry.x_t.info. 

Если модель должна включить больший размер, чем 500 единиц, множители 
должны быть увеличены. Если, однако, модель меньшая, чем 50 единиц, то 
размер может быть уменьшен. 

Модель Parasolid может также быть импортирована в CADFEKO, 
командой File→Import→Geometry→Parasolid... из главного меню (рис. 6.10). 

Появится запрос об имени файла и затем открывается диалог Import 
Parasolid, где можно изменить масштабный множитель. Например, если модель 
антенны была создана в мм и затем импортируется модель автомобиля, созданная 
в м, масштабный множитель будет равен 0.001, независимо от масштабного 
множителя, требуемого по модели. 

Модели Parasolid представляются в файле, в котором записаны координаты 
отдельных вершин структур. Поименованные точки, если они созданы в 
CADFEKO, записываются отдельно, и их можно редактировать непосредственно 
в файле. 

 

 
Рис. 6.9. Диалог выбора типа 

файла экспорта 
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Рис. 6.10. Список файлов импорта 

 
Важно, что импортированная модель должна быть корректной. 
Если выбран режим Import bodies with faults (рис. 6.11), все части в файле 

импортируются, даже если они содержат ошибки. Это может быть, и в этом 
случае после импорта удалите компоненты с ошибками. 
 

CADFEKO может также импортировать 
другие форматы CAD. В настоящее время 
поддержаны ACIS, Catia, ProEngineer, Iges, 
Step и Unigraphics. Импорт геометрии 
выполняется по команде File → Import → 
Geometry. 

CADFEKO запросит об имени файла и 
затем открывает диалог импорта модели. В 
разделе Units в этом диалоге показываются 
единицы импортированной модели, что 
позволяет изменить единицы. Эти единицы 

могут отличаться от единиц модели и согласовываются масштабным 
коэффициентом. Если CADFEKO не устанавливает единицы импортированной 
модели, то значит, что это метры. Чтобы выполнить импорт модели внутри 
модели Parasolid с допуском, может потребоваться выбрать другие единицы. 

Из-за различий в правилах построения, преобразование формата CAD 
может иметь некорректные результаты. Проблемы преобразования записываются 
в файле FEKO_USER_HOME \logs\CADimport.log, который полезно 
просмотреть в случаях сбоев преобразования. 

6.4 Работа с геометрией 
 Сложная геометрия создается последовательностью операций, начиная с 

простых примитивов. Эти процедуры сохраняются в дереве проекта с самого 
начала создания структуры. На любом уровне в дереве проекта можно выбрать и 
изменять объекты, или параметры, или значения переменных, которые описывают 
геометрию. Для удобства выбора материнских объектов, CADFEKO показывает 
каркасное представление всех выбранных объектов. 

 
Рис.6.11. Диалог установки 
единиц импортируемых моделей 
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Любая комбинация объектов, может параметрически изменяться в 
зависимости от параметров. Параметры нужно первоначально ввести в главном 
меню в разделе Variables. 

Редактирование включает Булевы операции (объединение, вычитание и 
пересечение), и другие дополнительные операции (типа проектирований, 
расщепления, свипирования и протаскивания), переименование (чтобы изменить 
метку / название объекта или одной из его областей / фасок / граней – все объекты 
в модели должны иметь уникальные имена), копирование, удаление (доступное 
через клавишу <Del>), реверсирование нормалей фасок и установление свойств (в 
диалоге редактирования, подобном диалогу создания). 

Когда смежные объекты расположены с небольшим нарушением границ, 
могут иметься фаски и / или грани, которые имеют очень малые перекрытия (рис. 
6.12). Если эти секции имеют размеры, того же порядка, как допуск модели, 
булевы операции между этими объектами могут выполниться неверно или 
привести к очень малым сторонам или промежуткам. Для того, чтобы быть 
уверенным, что объекты собраны корректно, нужно использовать операции 
захвата. 

Все объекты в дереве 
(рис. 6.13) получают новые 
номера, когда изменяется 
компонента. Во время этого 
процесса CADFEKO может не 
выполнить создание равных 
областей или граней, 
например, когда несколько 
фасок получены из той же 
самой первоначальной фаски 
во время Булевых операций. 
Эти объекты тогда отмечаются 
как подозрительные (что 
отмечается вопросительным 
знаком рядом с ним в дереве) 

как предупреждение, что свойство, устанавливаемое на него, возможно, не 
поддержано. 
 

 
Рис. 6.13. Проблемные ребра с пояснением: неверное определение исходного 
объекта 
 

 
Рис. 6.12. Топология с небольшим 
нарушением границ включающих 
поверхностей с перекрытием ребер, а также 
короткие непересекающиеся ребра 
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Причина этой проблемы отображается в виде текста, когда курсор 
помещается сверху элемента в дереве. После этого нужно сделать так, чтобы эти 
проблемы исчезли, для чего зачастую операции нужно вернуть и модель создать 
снова. 

Некоторые объекты (например, порты), которые зависят от модели,  также 
отмечаются как подозрительные, если модель изменилась некорректно. Их нужно 
отредактировать или установить снова, чтобы снять проблемы. 

 
 

6.4.1  Булевы операции 
 

В главном меню Geometry и инструментальной панели редактирования 
геометрии имеется доступ к Булевым операциям. Перед выполнением булевых 
операций, должны быть выбраны части геометрии. 

По команде Geometry → Union объединяются все выбранные части (рис. 
6.14). 

При использовании команды пересечения Intersection, в результате 
остается общая часть всех выбранных частей. 
 

 
Рис. 6.14. Список булевых функций и других операций 

 
При операции вычитания Substracte все выбранные части вычитаются из 

последней части, которая должна быть выбрана, когда появится запрос. Когда 
только одна часть выбрана, единственная разрешаемая булева операция – 
вычитание. Никакие булевы операции не доступны, когда не имеется никаких 
выбранных частей. (Поверхности и провода – также части.) Булевы действия не 
могут быть применены к материнскому объекту или к частям: областям / фаскам / 
граням. 

Выбор команды Geometry → Split из главного меню откроет диалог, в 
котором задается плоскость расщепления. По умолчанию плоскость расщепления 
совпадает с рабочей плоскостью. Операция расщепления создает две новые части 
(названные Split_back ... и Split_front ..., определяемые в направлении 
положительной оси N плоскости расщепления). Две половины получаются из 
независимых копий исходной конструкции. 

Если исходные объекты расщепляются, удаляется вид одной половины, а 
другая половина остается неизменной. 

Если нужно синхронно менять конструкцию, исходная деталь должна быть 
создана, используя переменные. Характеристики и разбиение плоскости может 
изменить, выбирая диалог Properties из выплывающего меню. 
 
 



102 
 

6.4.2  Операции свипирования и протаскивания 
Командами Geometry → Sweep или Geometry → Spun из главного меню 

выполняется свипирование (также называемое экструзия) выбранного объекта по 
указанному вектору или вращение его вокруг указанной оси. Эти действия могут 
быть применены только к частям. Операции sweep / spun применяются отдельно к 
каждой из выбранных частей. Если несколько частей перемещаются или 
вращаются, получающиеся новые части становятся самостоятельными и могут 
далее обрабатываться независимо. 

Части, содержащие только грани и/или фаски (не заполненные материалом 
или замкнутые области), можно вращать или перемещать. Однако объекты в виде 
поверхностей (рис. 6.15а) должны иметь одну границу, которая не накладывается 
сама на себя, и никакое ребро не может быть приложено больше, чем к двум 
фаскам (например, Т-образную плату на рис. 6.15б нельзя вращать/перемещать, 
поскольку она имеет три фаски, связанные границей). Перемещение или 
вращение кривой создает поверхности, тогда как применение этой операции к 
поверхности образует заполненное тело. 

  
Рис.6.15a. Создание изломанной 

трехмерной поверхности с помощью 
операции Sweep 

Рис. 6.15б. T-сочленение, имеющее 
три фаски с границей, так что её 

нельзя перемещать и вращать 
 

Когда выбрана команда Sweep, диалог Sweep geometry позволяет задать 
вектор с помощью начальной и конечной точек. В эти поля вводятся точки 
стандартным способом (рис. 6.15а). Нельзя свипировать объекты в направлении, 
перпендикулярном любой из его граней или в плоскости его фасок. 

В диалоге Spin geometry нужно задать ось и угол вращения. Угол в 
градусах идет по часовой стрелке вокруг указанной оси. Кнопки Set to ... axis 
позволяет выбрать параметры оси. Отметим, что кнопка локальной оси активна 
только в том случае, если все выбранные части имеют ту же самую локальную 
систему координат. Нормальные направления получающихся фасок зависят от 
направления кривых. 

Имеется ряд ограничений на соотношения между объектом вращения и 
осью вращения. Никакие свободные грани объекта не должны совпадать с осями, 
и при этом они не могут пересекать ось в любой точке, кроме конечной точки 
ребра. При задании полного вращения фаски, ось не может пересекать фаску ни в 
одной точке, хотя она и лежит на ребре.  
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Рис. 6.16. Пример поверхности с ребром, который 

касается оси вращения 
 
Ось может совпадать с любым ребром стороны, при условии, что все ребро 

находится на оси. Кроме того, ребро не может касаться оси даже в одной точке, 
как показано на рис. 6.16 (это позволяется, если всё ребро лежит на оси). 

 

6.4.3 Поверхности, созданные операцией Loft 
Операция Loft формирует гладкую поверхность, соединяя две кривые части 

прямыми линиями. В результате имеем линейчатую поверхность, но это не 
фасеточная модель, если одна или обе кривые не являются ломаными линиями. 

Для примера, начертим две кривые, состоящие из 3-х точек: (1, 2 и 3) и (1, 
2 и 3). Затем выделим эти две ломанные в дереве проекта и выберем операцию 
Geometry → Loft. Результат создания искривленной поверхности показан на рис. 
6.17. Диалог Loft позволяет реверсировать начальные и конечные точки одного 
ребра в случае, где две грани не созданы в одном (или желательном) направление. 

Искривленные поверхности могут состоять из ряда граней, например, 
ломаных линий. Две соединенные кривые должны иметь то же самое число 
граней (сглаживание может рассматриваться как подключение еще двух граней).  
 

     
 

Рис. 6.17. Диалог черчения полигона и выполнение операции слияния  
двух полигонов или линий 
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Если дело обстоит не так, точки могут быть впечатаны на одной из них, 

чтобы показать этот факт. Нельзя создавать кривые с больше, чем двумя гранями, 
соединяющимися в каждой точке. 

6.4.4  Проекция точек на другую плоскость и впечатывание точек 
В некоторых случаях желательно 

создать специальные точки, грани или фаски 
на данной геометрии. Например, чтобы 
присоединить другие структуры к модели, 
чтобы задать очень узкую искривленную щель 
или создать проводящую полоску на 
диэлектрических объектах. Это выполняется 

нажатием на . Ранее в CADFEKO было 
возможно определить вершину в диалоге 
Edge properties. Теперь такие точки должны 
быть созданы операцией Imprint points (рис. 
6.18). 

Операция Imprint points позволяет 
поместить (впечатать) точки на выбранную 
часть конструкции. Точки могут быть 
впечатаны на одной части только один раз. 
Диалог Imprint points (рис. 6.18) позволяет 
задать список точек, используя ввод точек в 
глобальных или локальных координатах. 
Точки наносятся в самом близком месте к 
выбранной части – или на фаске или ребре. 
Точки не могут быть впечатаны на уже 
существующие точки. 

Операция впечатывания создает новый 
элемент в дереве (позволяет доступ к этой 

части без точек), но использует имя исходного объекта. 
Несколько частей могут быть спроектированы на другой объект, выбирая их 

операцией Project и затем выделяя целевой объект, на который нужно выполнить 
проекцию. Эта последовательность подобна операции вычитания. Как в операции 
вычитания, все спроектированные части выступают как исходные получающейся 
части, то есть они больше не представляются как отдельные части модели. Все 
грани выбранных частей проектируются на фаски целевой части. Любая часть 
(кривые поверхности и твердый объект) может быть спроектирована на любую 
часть, содержащую фаски. Сферы не имеют граней, следовательно, операция 
проектирования сферы (в этом смысле) некорректна. Когда проектируются 
замкнутые формы в виде траектории, создаются новые фаски. 

 
Рис. 6.18. Создание 

впечатываемых точек 
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Направление проекции определяется по нормалям к поверхности цели. 
Проектируемые ребра на выпуклые изогнутые фаски целевой поверхности будут, 
таким образом, иметь тенденцию уменьшать их размер и/или перспективу. 
Выпуклые поверхности могут также «заслонить» другие поверхности, в которых 
все точки на ребре проекции могут проектироваться на изогнутую фаску даже при 
том, что кажется, как будто это должно также проектироваться на другую фаску. 
Поэтому грани проектируются только на нормальную сторону фасок. 

6.4.5  Реверсирование нормали фасок 
Нормали фасок могут быть реверсированы командой Reverse face normals 

из всплывающего меню или Geometry → Reverse face normals (рис. 6.19) из 
главного меню (нормали всех выбранных фасок реверсируются, даже при том, что 
только фаски одной части показываются в дереве подробностей в любое время). 

В настоящее время невозможно 
полностью изменить нормаль на объекте с 
одной замкнутой поверхностью, например, 
сферой. Если такая нормаль была 
реверсирована, то любая последующая 
операция должна показать линию на 
объекте, связывающую две фаски. 
Нормали этих фасок могут тогда быть 
реверсированы. 

 
6.4.6  Удаление деталей и операция 

упрощения 
Лишние стороны (фаски) могут быть удалены из дерева подробностей, 

выбирая их и нажимая клавишу <Del> или команду Delete из выплывающего 
меню. Стороны становятся лишние, если только они имеют ту же самую среду (то 
есть металл, свободное пространство или та же самая диэлектрическая среда) с 
обеих сторон. Когда удаляется эта поверхность, внутренняя область объединяется 
с внешней. Когда внешняя среда – свободное пространство, поверхности могут 
только быть удалены из замкнутых областей. Тогда и внутренняя среда 
становится свободным пространством. 

Также, если компонента или переменная изменяется так, что объект 
повторяется, подозрительные фаски не будут удалены, и некоторые удаленные 
фаски могут вновь появляться. Заметим, что грани не являются лишними, если 
нормали фасок находятся во встречных направлениях. По этой причине передняя 
и задняя стороны фасок окрашены по-другому в режиме просмотра, и возможно 
полностью изменить нормали фасок. Нормали треугольников приобретают то же 
самое направление, как нормали фасок, от которых они произошли. 

 
Рис. 6.19. Операции изменения 
параметров поверхностей,  
включая операцию Reverse face 
normals 
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CADFEKO также позволяет выполнить автоматическое удаление лишних 
фасок и граней. Диалог упрощения геометрии (рис. 6.20) вызывается командой 
Geometry → Simplify. 
 

 
Рис.6.20. Диалог упрощения геометрии 

 
Эти операции позволяют удалять конкретные типы деталей. Упрощенная 

геометрия будет той же самой, как оригинал, но не будет иметь те же самые связи 
разбиений сетки. Если, например, удаляется впечатанная точка, сетка не будет 
иметь одной вершины. (Заметим, что впечатанные точки, которые не находятся на 
сторонах объекта, считаются лишними). Фаски не могут быть удалены, если 
объекты, которые они разделяют, могут быть объединены (рис. 6.21). То же самое 
относится к граням на границах фасок и точкам на концах граней. 

 
Рис. 6.21. Иллюстрация операции упрощения 

 
По умолчанию операция упрощения не удаляет излишние области, фаски 

или грани, на которых заданы опции локального разбиения на сетку. Чтобы 
удалить их, должна быть снята опция Keep ...with local properties. 

Например, рассмотрим объединение двух сфер с диэлектрической средой, 
показанной на рис. 6.21(a). Размер локальной ячейки установлен в области 
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Region1. Если объединенный объект упрощается, отмечая опцию Keep regions 
with local properties, результат показывается в (b). Когда область содержит 
локальные свойства, они не удаляется. Тогда фаска между ней и средней 
областью не также удаляется. Если опция Keep regions with local properties не 
отмечена, результат показан на рис. 6.21(c). 

 
 

6.5  Копирование объектов 
Геометрические объекты, включая материнские объекты, могут быть 

скопированы и созданы как новые части командой Edit → Copy из главного меню 
(или используя  <Ctrl> <C>). Например, если уже создана оболочка сферы, 
вычитая одну сферу из другой (операция удалит обе первоначальные сферы из 
модели и перечислит их как исходные объекты перед булевой операцией), то 
внутренняя сфера может быть скопирована, чтобы создать новую часть, которая 
была бы эквивалентна внутренней оболочке. Скопированные объекты создаются в 
корневом уровне. Также возможно сделать несколько преобразованных и 
скопированных частей. 

Новая часть полностью независима от существующей, и не изменится, если 
изменяется её исходная часть. Если нужно, чтобы они изменялись синхронно, 
первоначальный объект должен быть создан, используя переменные, что будет 
выполняться во время копирования. 

Также возможно выделить фаски или грани частей и выбрать Copy. В этом 
случае новые части создаются как выбранный элемент. Это позволяет, например, 
скопировать ребро сложного объекта и использовать операцию связи loft к 
другому ребру. Заметим, что эти копии – кадры модели, и когда копия сделана – 
они не связаны с исходным объектом и не параметрические. 

 
 

6.5.1  Копирование оригиналов 
Если фаски или грани удалены из части, они удалены из модели. Эти фаски 

могут быть вновь созданы, копируя исходные объекты, из которых получена эта 
часть, или операцией восстановления. Это может быть очень громоздкая 
операция, для которой CADFEKO обеспечивает простое решение. Выберите 
требуемые объекты, и Edit → Copy special → Copy original из главного меню или 
команду Copy special → Copy original из всплывающего меню (рис. 6.22). 
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Рис. 6.22. Операции копирования Рис. 6.23. Символы 

ликвидированных элементов 

6.5.2  Ликвидация частей 
Команда Geometry → Explode ликвидирует все выбранные части 

геометрии. Ликвидация не значит удаление. Отделенные новые поверхностные 
части созданы для каждой фаски и освобождают ребро от первоначальных частей 
(рис. 6.23). Новые части представляют копию геометрии во время операции 
ликвидации. 

6.5.3  Создание примитива с удалением хронологии его создания 
CADFEKO хранит всю хронологию создания каждой части, позволяя 

пользователю изменить хронологию создания в любой точке. Эта полезная 
операция (рис. 6.24) требует существенного объема памяти. 

Если компонента, которая была 
получена, в результате, например, операции 
объединения, модифицируется, CADFEKO 
должен обновить исходные части, чтобы 
повторно выполнить объединение. Так как 
они не сохраняются на каждом уровне, это 

означает построение их снова от самого первого уровня. Однако часто большая 
часть модели никогда не будет изменяться. (Например, модель автомашины не 
будет изменяться, но нужно изменять размещение антенны на автомашине). 
Следовательно, она не должна пересчитываться каждый раз, когда изменяется 
малая часть конфигурации. 

Поэтому CADFEKO имеет опцию, чтобы выбрать эту часть по команде 
Geometry → Make primitive. Это удаляет полную хронологию создания и 
сохраняет модель, как есть. Если пользователь использует эту часть в других 
структура, то эта часть доступна как новый примитив. Можно сэкономить время 
обработки и также уменьшить случаи, когда грани/фаски или области не могут 
быть отображены и становятся подозрительными. 

 
Рис. 6.24. Символ созданного 

примитива 



109 
 

6.5.4  Проверка правильности геометрии 
 

CADFEKO дает возможность выполнить основные проверки на 
непротиворечивость геометрии. Так как должным образом связанные сетки 
только создаются для единой части, важно убедиться, что части не соединяются 
корректно. Части конфликтуют, например, если одна часть находится полностью 
внутри другой. Выделите всё объекты, чтобы это проверить (или нажмите <Ctrl> 
< A > при выборе частей геометрии) и выберите команду Find → Clashing 
geometry (проверка геометрии) из главного меню (рис. 6.25). Тогда проблемные 
части остаются выбранными и перечислены в информационном окне.  
 

 
Рис. 6.25. Выбор геометрий без общих ребер 

 
Команда Find → Unconnected geometry edges находит и выбирает все 

грани выбранных частей, которые являются свободными (не соединены с 
фасками) или приложенными к только одной фаске. Если эта операция выбирает 
ребро, которое, как окажется, связано с несколькими фасками, это означает, что 
имеется больше, чем одно ребро в этой топологии и что фаски не соединены. В 
этом случае указывается проблема в модели. 

 

6.6  Разбиение на ячейки 
 

Выберите команду Mesh → Create mesh или нажмите <Ctrl> <M>, чтобы 
открыть диалог Create mesh, показанный на рис. 6.26. Укажите, будут ли все 
части или только выбранные части структуры разбиваться на ячейки. В отличие 
от других диалогов, выбор может быть изменен, пока диалог открыт. Это 
позволяет, например, разбивать различные части на ячейки с различной 
плотностью без закрытия диалога. 
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Рис.  6.26. Диалог разбиения на ячейки 

 
В поле Triangle edge length вводится размер разбиения для граней 

треугольников и тетраэдров. Заметим, что некоторые грани могут быть на 30% 
больше, чем это значение. Все грани, формирующие границы плоскостей, 
считаются проводящими проводами и разбиваются на сегменты. В поле Segment 
length задается максимальная длина этих сегментов. Обычно радиусы этих 
проводов определены на гранях геометрии. В поле Wire segment radius задается 
радиус, который относится ко всем проводам, для которых не определен 
локальный радиус. Если отмечена опция Tetrahedral edge length, все 
диэлектрические твердые объекты разбиваются на тетраэдры, и они становятся 
областью решения методом конечных элементов (FEM). 

Размер ячейки не может быть меньшим, чем максимальная координата, 
разделенная на 1108. Это – предел численной точности геометрии. Для очень 
малых моделей (требующих соответственно малые размеры), расширения 
геометрии должны быть уменьшены. Отметим, что в диалоге разбиения (рис. 
6.26) имеются кнопки Suggest, нажатие на которые автоматически рассчитывает 
необходимые длины разбиения. 

Группа Small features (рис. 6.26) позволяет выполнить более точное 
разбиение. Поле Small feature size определяет предел размера ячейки разбиения в 
виде процента от части, которой она принадлежит. В режиме Default сетка 
разбивается обычным образом. Это приведет к точному представлению 
геометрии, включая очень малые элементы. Оптимизация полезна, если геометрия 
имеет длинные узкие заусенцы или фаски, лежащие близко друг к другу. Если эта 
опция выбрана, CADFEKO пробует выравнивать вершины на противоположных 
сторонах сетки разбиения, как показано на рис. 6.27. 
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Рис. 6.27. Сетка, выполненная по умолчанию (вверху) и оптимизированная 
(внизу) по узкой ширине элемента (ширина становится минимальным размером 
ячейки) 

 
 
Наконец, можно игнорировать малые детали, выбирая режим Ignore. Тогда 

малые детали игнорируются с точностью, установленной для геометрии. Эта 
опция также иногда позволяет разбивать на ячейки неправильные фаски, которые 
не могут быть разбиты на ячейки, используя настройки по умолчанию. Заметим, 
что игнорирование малых деталей не работает для замкнутых граней. Такие грани 
могут, однако, быть разделены впечатываемыми точками. 

Режим сглаживания сетки Enable mesh smoothing может дать лучшую 
сетку, но увеличит время разбиения на ячейки. 

Размеры, указанные в диалоге Create mesh, используются на всех объектах, 
которые не имеют локального разбиения. Заметим, что если область, которая 
имеет локальный размер ячейки, разбивается на тетраэдры, то размер ячейки 
разбиения будет также относиться к фаскам на границе. Дополнительный 
уменьшенный размер ячейки может, конечно, быть определен на этих фасках 
(используется минимальное значение из всех соответствующих локальных 
размеров ячеек). Аналогично, установка размера ячейки на фаске также 
устанавливает этот размер на его граничных ребрах. Если определен наименьший 
размер ячейки, например, на ребре фаски, то треугольники фаски будут точно 
соответствовать этой длине по ребру, даже при том, что остальная часть фаски 
будет разбиваться на ячейки большего размера. 

Параметр Mesh size growth factor управляет скоростью изменения размера 
ячейки. Можно сделать резкий переход от малых к большим ячейкам, в то время 
как при плавном изменении размера каждый треугольник не будет увеличиваться 
значительно, по сравнению со связанной ячейкой. 

Сетка (рис. 6.28) отражает текущую геометрию. Любые изменения 
геометрии (например, изменение радиуса провода), сделанные после разбиения, 
не будут отражены на сетке. Порты, созданные на геометрии, не будут иметь 
сетки, пока не будет запущено разбиение на ячейки. 
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Рис. 6.28. Диалог разбиения на сетку 

 
Сетка находится в дереве в разделе Meshes с той же самой структурой как 

первоначальные части геометрии. Сетки идентифицированы только их метками. 
При разбиении геометрии CADFEKO даст предупреждение, если сетка с такой 
меткой уже существует (рис. 6.29). 
 

 
Рис. 6.29. Запрос на замену сетки разбиения 

 
Существующая сетка может сохраняться или заменяться. Если сетка или 

геометрия переименованы перед попыткой повторно разбить на сетку, создается 
дополнительная часть сетки геометрии. 

6.6.1  Задание локальных параметров разбиения на ячейки 
Иногда точное решение требует очень мелкую сетку разбиения в некоторой 

части модели. Тогда вместе с заданием глобальной сетки, пользователь может 
определить локальную сетку для этих частей структуры. Например, в изогнутых 
частях структур может требоваться более плотная сетка, чтобы получить точное 
представление геометрии. 

Локальные параметры разбиения для поверхностей или краев 
устанавливаются в группе Global Mesh size в диалоге Mesh Properties (рис. 6.30). 
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Эта группа содержит опцию Local mesh size (локальный размер сетки), которая 
должна быть отмечена, если устанавливается локальный размер сетки. Для 
областей локальный размер ячейки используется только для разбиения на сетку 
области четырехгранника. Размер ячейки в итоге на любом элементе – это 
минимальный из всех размеров разбиения, применимых к нему. Как пример, если 
к граничным краям у поверхности, которая является границей области всех трех 
элементов, применяется локальный размер ячейки, размер петли по краю равен 
минимуму всех трех этих размеров. Локальный размер ячейки может быть 
больше, чем общий размер петли. Отметим, однако, что если никакой локальный 
размер ячейки не назначен на краю, то у треугольников на краю поверхности 
будет общий размер сетки. 

 

Р
ис. 6.30. Диалог свойств сетки разбиения 

 
Первоначально диалоговое окно (рис. 6.30) показывает текущее состояние 

свойств выбранных элементов. Если у некоторых выбранных областей есть 
локальный размер ячейки, и нет других, или если размеры разные, локальный 
размер элемента разбиения становится заблокированным. Если это так, то 
параметры не обновляются, при нажатии кнопок OK или Apply. Это поле может 
все еще быть отмечено, чтобы установить свойства на всех выбранных элементах. 
Тогда рядом с элементом в дереве подробностей будет отображен специальный 
значок, чтобы указать, что были установлены локальные параметры разбиения на 
ячейки (рис. 6.31). 
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Рис. 6.31. Диалог параметров локального 

разбиения на сегменты 
 
 

Радиусы свободных краев 
(то есть краев, не формирующих 

границу поверхности), могут 
быть установлены в диалоге Edge 

properties (рис. 6.32). Отметим, 
что провода в чертеже отображаются 
как линии, то есть их вид от радиуса 
не зависит. 

Радиус может, однако, быть 
отображен для сегментов 
разбиения. Значок в разделе Edge 

в дереве подробностей указывает, 
что был установлен локальный 

радиус провода. 
 
 
 
 

6.6.2 Импорт сетки разбиения 
CADFEKO может импортировать ряд форматов сетки, что выполняется 

командой File → Import → Mesh → ..... 
Для файла *.fek импортируется только часть, относящаяся к геометрии 

(сегменты проводов, треугольники, многоугольные платы и тетраэдры); раздел 
управления игнорируется. Когда CADFEKO определяет границы 
диэлектрической среды, на все фаски она добавляет символ подчеркивания и 
номер, чтобы создать уникальные метки. 

 
Рис. 6.32. Установка размера 
локального разбиения ребер 
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CADFEKO выводит другие форматы сетки, выполняя PREFEKO и 
импортируя получающийся файл *.fek. В настоящее время можно импортировать 
файлы FEMAP neutral file mesh (поверхности, ограниченные кривыми линии, 
чертятся как многоугольные пластины), NASTRAN, PATRAN, STL, Meshed 
AutoCAD DXF (поддерживаются только структуры LINE и POLYLINE, 
сегменты и треугольники), Ansys CBD, ABAQUS и специальный формат ASCII 
(рис. 6.33). 

Для всех форматов файлов, 
кроме *.fek, CADFEKO 
открывает дополнительный 
диалог Import mesh. В нем 
можно установить масштаб и 
управлять выводом структуры в 

виде сетки. (Например, граничные 
элементы в файле FEMAP могут 

быть или частью геометрии – или 
состоять в виде многоугольников, 
только в этом случае они могут 

быть испортированы). Только в файлах 
Ansys CBD имеется информация 

о радиусах сегментов; для всех других форматов значения радиуса по умолчанию 
должно быть определено в диалоговом окне Mesh.  

Так как многие форматы не поддерживают определение диэлектрических 
сред, все сегменты, треугольники и многоугольники являются структурами PEC в 
свободном пространстве, а среда у всех четырехгранников считается неизвестной. 

Также возможно импортировать сетку вручную, создавая файл *.pre в 
EDITFEKO, запуская PREFEKO и затем импортируя файл *.fek в CADFEKO. 
Это дает возможность контроля над процессом импорта. 

 

6.6.3  Проверка и редактирование сетки разбиения 
 

Команда Mesh→Info из главного меню выводит гистограмму 
распределения длин элементов сетки (а также среднюю длину границ и 
дисперсию), а также процентное соотношение различных элементов (рис. 6.34). 

Выбор может содержать части сети, метки или элементы. Разница 
фиксирует качество сетки и показывает, сколько граней лежит по желательной 
длине. Числа различных элементов устанавливают размер задачи и требуемое 
время выполнения.  
 

 
Рис. 6.33. Операции импорта 

сетки разбиения 
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Рис. 6.34. Статистическое распределение размеров сетки разбиения 

 

6.6.4 Радиус элемента сетки 
Если выбраны отдельные сегменты или фрагменты сетки, то радиусы 

сегмента могут быть изменены в диалоге Properties. Если выбранные объекты 
имеют различные значения, поле Radius будет первоначально не заполнено. В 
этом состоянии объекты в этом диалоге могут тогда быть изменены без изменения 
радиусов всех выбранных элементов. Если значение введено в это поле, радиус 
всех выбранных объектов будет равным этому значению. 

Сегменты могут быть показаны их фактическим радиусом в трехмерных 
представлениях. Нажмите стрелку «вниз» рядом со значком Show/hide mesh на 
трехмерной инструментальной панели представления, и убедитесь, что режим 
отмечен как «Show segment radii». 

6.6.5  Перемаркировка элементов сетки 
Отдельные фрагменты сетки могут быть перемаркированы, если они имеют 

тот же самый тип и принадлежат той же самой части сетки. Так, имея метку 
Assembly.Part.Label, невозможно повторно маркировать её элементы на 
различных частях. Заметим, что должны быть выбраны отдельные элементы, а не 
метки. (Если выполнен выбор части сетки, или метка сетки, переключение на 
выбор элементов, автоматически выбирает все элементы). Если исходные 
элементы не имели тех же самых установок (среда, использование PO, и т.д.), 
новая метка отмечается как подозрительная. 

Необходимо быть осторожным при переразбиении на сетку частей, где 
сетка получила метку. Так как вся сетка заменена новой, метка, созданная  
повторно с маркировкой, теряется.  



117 
 

6.6.6  Объединение совпадающих вершин 
Вершины в FEKO считаются связанными, если они находятся в пределах 

малого допуска друг от друга. CADFEKO может объединить вершины в пределах 
указанного пользователем допуска. Чтобы сделать это, выберите одну или 
большее количество частей сетки, и команду объединения совпадающих вершин 
Mesh → Merge coincident vertices из главного меню, чтобы открыть диалог 
слияния совпадающих вершин (рис. 6.35). Здесь может быть определен допуск. 
Любые две точки, отдаленные меньше чем на это расстояние, тогда 
объединяются, а не принимают среднее положение. 

Если отмечены опции Snap to 
geometry points или Snap to named 
points, то вершины сетки, лежащие 

в пределах заданного допуска этих 
точек, будут слиты. Например, если 
поименованная точка находится 
между двумя вершинами сетки, 
которые лежат на расстоянии друг 

от друга, меньше чем заданный допуск 
(рис. 6.35), то они будут объединены 

в этой точке. Если операции привязки 
будут выполнены, вершина, 

лежащая в пределах допуска геометрии, или поименованные точки будут слиты в 
одну вершину. 

Слияние точек может привести к вырождению треугольников. CADFEKO 
пытается избежать этого, давая предупреждение, если допуск является большим 
по сравнению с размером ячейки разбиения. Эта операция также автоматически 
удаляет все выродившиеся элементы после слияния вершин. 

6.6.7  Слияние элементов (удаление вершин) 
Автоматическое упрощение сетки выполняется через слияние вершин, 

которые могут различаться из-за числовых допусков. Если эти точки остаются в 
дальнейшем обособленными, то нужно обязательно определить, какая точка 
удаляется, а какая точка остается. Это также часто удаляет определенные 
элементы, где расстояние между точками может быть большим по сравнению с 
размером треугольника в другом месте в модели. 

Удаление вершины является двухступенчатым процессом, подобно 
операции вычитания. Сначала выделите все вершины, которые должны быть 
слиты и нажмите <Del>. На втором шаге выбирается итоговая вершина. Все 
первоначально выбранные вершины тогда заменяются окончательной вершиной.  

6.7  Удаление дублированных элементов 
Дублированные элементы в пределах части сетки могут быть удалены 

автоматически. Выберите требуемые части сети, и команду Mesh → Remove 
duplicate elements из главного меню. (Вообще, дублированные элементы 

 
Рис. 6.35. Точность слияния 

вершин 
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появляются в импортированных сетках или когда сетки CADFEKO 
редактируются вручную, накладываясь одна на другую.) 

Если дублированные элементы имеют ту же самую метку, CADFEKO 
удаляет все, кроме одной. Если элементы не имеют той же самой метки, может 
быть лучше удалить конкретный элемент. Это определено в диалоге Remove 
duplicate mesh elements (рис. 6.36). Объекты упорядочиваются, нажимая <Ctrl> и 
щелкая и перемещая числа в левом столбце. Для каждой установки дубликатов 
элемент, метка которого самая высокая в этом списке, остается, а все другие 
удаляются (здесь имеется более чем два идентичных элемента.) 

 

 
Рис. 6.36. Диалог удаления дублированных элементов, в котором пользователь 

определяет оставшиеся элементы 
 

 
Выбирая Mesh→Remove collapsed elements из главного меню, можно 

удалить все вырожденные элементы (элементы, где два или больше узлов 
соприкасаются). 

 
 

6.7.1  Обнаружение искаженных элементов и элементов с завышенными 
размерами 

Так как точность расчета FEKO зависит от качества сетки, CADFEKO 
включает проверку правильности сетки. Выбор Find→Distorted mesh elements 
или Find→Oversized mesh elements из главного меню проверяет текущий выбор 
(части сетки, метки или элементы) для искаженных сеток или в случае наличия 
элементов с завышенными размерами (рис. 6.37). Результат – выбор 
несоответствующих элементов. Командами Undo и Redo можно выбирать 
элементы, которые выбирались до и после испытания. 
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Искаженные элементы сетки 
разбиения определяются в терминах 
минимального внутреннего угла. В 
идеальной сетке все внутренние 
равны 60, и если любой из трех углы 
углов намного меньше 60, то 
элемент узкий. Эти элементы могут 

быть удалены при удалении вершины. 
Элементы с большими размерами 
находятся при определении 
максимальной длины ребра. 

6.7.2  Просмотр свободных 
ребер сетки и узлов сегментов 

Другая очень важная проблема – обеспечение соединений. В дополнение к 
проверке геометрии, CADFEKO позволяет найти несвязанные ребра и вершины 
сегментов. Это можно сделать, выбирая Find→Free mesh triangle edges или 
Find→Free segment nodes из главного меню (рис. 6.37). Эти операции проверяют 
только выбранные элементы, и не будут сообщать информацию о свободных 
краях/вершинах, если элемент соединен с другим невыбранным элементом. 

Команда Find→Free segment nodes ищет все вершины, которые не 
присоединены к другому сегменту или углу треугольника. Эти вершины могут 
быть верными, например, на концах проводов. Однако если две таких точки лежат 
очень близко друг к другу, они должны быть объединены. Края треугольника 
считаются свободными, если они не присоединены к другим треугольникам. 
(Край подключен к треугольнику только в том случае, если обе конечных точки 
совпадают с угловыми точками треугольника). Здесь выбираются эти две 
вершины на концах края. Эти вершины могут тогда быть объединены, 
перемещены или изменены, чтобы сделать модель непротиворечивой.  

6.7.3  Редактирование вершин сетки 
Вершина сетки может быть изменена, выбором команды (вершина сетки 

должна быть видимой) Edit→Properties из главного меню (или Properties из 
всплывающего меню). Это открывает диалоговое окно Modify vertex, которое 
содержит координаты вершины (в глобальной системе координат). Ввод точки и 
выражения изменяет эти значения, как только закрывается диалог. Точка может 
быть сдвинута на заданное расстояние, добавкой необходимого сдвига. Например, 
изменение X от 1.2 до 1.2+0.5 перемещает точку на 0.5 единиц в направлении X. 

6.7.4  Создание треугольников в сетке разбиения 
Иногда требуется ручная установка сетки разбиения. Это может быть 

потому, что сетка содержит ряд полостей или потому, что некоторые неудачные 
элементы были удалены. В отличие от удаления вершин, удаление элементов 
оставляет пустоты на поверхности сетки. 

 
Рис. 6.37. Нахождение опций 

ошибок геометрии 
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Вершины треугольников могут быть добавлены вручную, выбором 
Mesh→Create new triangle из главного меню. Эта операция позволяется, если 
выбирается одна метка сетки (и новый элемент добавляется к этой метке), или 
единая часть сетки (когда новый элемент добавлен к новой метке, созданной на 
этой части). В диалоге Create mesh triangle (рис. 6.38) можно задать три угла 
треугольника. Так как эти три поля – стандартные поля ввода, то доступны все 
операции привязки. 

 

 
Рис. 6.38. Диалог создания треугольника сетки 

 
Новые созданные треугольники могут быть «перемещены» в 

существующую метку. (Если элементы выбраны меткой, то командой Select mesh 
element можно преобразовать объект в отдельные элементы). Теперь выбираем 
элемент нажатием правой кнопкой мыши и задаем команду Rename. Это 
объединит все выбранные элементы в одну метку, которая может тогда быть 
переименована. Если все элементы метки переименованы, эта метка удаляется – 
имя метки может тогда использоваться для вновь созданной метки. 

6.7.5  Реверсирование нормалей 
Некоторые характеристики, рассчитываемые FEKO, требуют управления 

нормальными векторами элементов. Например, диэлектрики определяются, 
задавая среду на каждой стороне граничащих треугольников. В этом случае 
сторона треугольника или полигона определяется на основании нормального 
вектора. (Если начальная точка вектора нормали расположена на треугольнике, 
нормальная сторона – сторона ближайшая к основанию стрелки, рис. 6.39). 

В CADFEKO передние стороны элементов сетки окрашены синим цветом, 
а задние части окрашиваются коричневым цветом. 

Если выбрать треугольники или многоугольные пластины (или метки или 
части, которые содержат эти элементы), то командой Mesh→Reverse normals, 
можно инвертировать нормали всех выбранных треугольников и 
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многоугольников. Вектор нормали может быть показан, активизируя Show / hide 
normals на инструментальной панели трехмерного представления. 

 
Реверсирование нормалей 

треугольников на диэлектрических 
границах может неблагоприятно 
повлиять на модель, и CADFEKO 
пытается сохранить модель 
непротиворечивой. Например, если 
нормали всех треугольников в данной 
метке полностью изменены, CADFEKO 
меняет диэлектрические носители на 
этих двух сторонах. Однако, если только 
некоторые треугольники изменены, 

нельзя гарантировать то, что модель является непротиворечивой. 
 
 

6.7.6  Уплотнение и разряжение сетки 
В некоторых случаях геометрия модели доступна только в виде сетки. Если 

такая сетка была создана для показа свойств, то она может содержать большой 
набор размеров элементов, или она может содержать треугольники с очень 
большими отношениями сторон. Даже если сетка была построена для создания 
фрагмента кода программы, она может быть использована для расчета на разных 
частотах (рис. 6.40). Универсальность решения заключается в том, что элементы 
сетки можно раздробить или разрядить, хотя операция дробления и может 
привести к большому количеству элементов, увеличению требуемой памяти и 
увеличению времени расчета. 

Выберите Mesh→Refine/coarsen mesh, чтобы повторно выполнить 
разбиение на сетку треугольников или тетраэдров, не используя основную 
геометрию. Поле Size определяет желательную среднюю длину края, которая 
может быть меньшей или большей, чем текущий размер сетки разбиения. 
Начальное значение Size показывает текущий средний размер сетки. Эта операция 
может быть выполнена только на метках сетки или частях. 

Заметим, что сегменты не разбиваются более плотно. Относительно просто 
провести согласованный сплайн через необходимые вершины сетки, и сетка в 
результате искривляется. 

Свойства уплотнения или огрубления относятся к конкретной метке, это 
гарантирует, что соединения обеспечиваются в основном правильно, но это не 
будет создавать новые элементы между границами метки. 

 

 
Рис.6.39. Нормальная и задняя 
стороны треугольника сетки 
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Рис. 6.40. Иллюстрация грубой сетки. Исходная (слева) сетка содержит две среды, 
показанные разным цветом. В грубой сетке (справа) остается граница между 
средами, но шаг сетки вдоль границы увеличивается.  

6.8  Преобразование геометрии 
Объекты геометрии или части сетки могут быть преобразованы командой 

Edit→Transform из главного меню, или кнопкой на инструментальной панели 
Modify geometry. Преобразование входит в дерево, и находится в списке (в 
порядке создания) всех операций. Они могут быть отредактированы (двойным 
нажатием на определенные операции) или удалены (при нажатой клавише <Del>). 

Преобразование может быть применено к нескольким выбранным объектам, 
и оно будет добавлено отдельно к каждому объекту. Преобразование может, 
конечно, быть определено в терминах переменных. В этом случае изменение 
переменной изменит все элементы. 

Операция Rotate требует задания оси вращения (которая определяется 
началом координат и направлением оси в глобальных координатах), и угла 
вращения (в градусах). Угол измеряется по часовой стрелке вокруг оси. 
Диалоговое окно, которое показано на рис. 6.41, также имеет кнопки, чтобы 
установить ось вращения в основные точки глобальной и локальной систем 
координат. 

В диалоговое окно Translate, (рис. 6.42) вводятся начальная и конечная 
точки, по которым вычисляется расстояние преобразования и направление. 

В диалоге Translate (рис. 6.42) вводится начальная и конечная точки, от 
которых они рассчитывают расстояние преобразования и направление.  

Операция зеркального отражения требует задания плоскости, относительно 
которой выполняется зеркальной отражение. Она определяется в диалоге, 
показанном на рис. 6.43, подобно заданию рабочей плоскости. В диалоге есть 
кнопки, чтобы выбрать её из числа глобальных плоскостей. 
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Рис. 6.41. Диалог вращения 
объектов 

Рис.6.42. Диалог сдвига (смещения) 
геометрии 

 
Преобразование масштаба Scale требует ввода начала координат (в 

глобальных координатах) и масштабного множителя, как показано на рис. 6.44. 
Масштабирование выполняется вокруг начала координат, указанного в диалоге 
масштабирования, а не вокруг центра или начала координат объекта или модели. 

 

 

Рис. 6.43. Диалог зеркального 
отражения Рис. 6.44. Диалог масштабирования 
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6.8.1 Многократные копии 
Части могут быть скопированы и трансформированы несколько раз одной 

командой Copy special из всплывающего меню или Edit → Copy special из 
главного меню. Диалог трансформации содержит поле number of copies. Это 
будет число копий каждой выбранной части. 

При операции вращения n-я новая часть будет вращаться (на заданный угол) 
n раз. При сдвиге выбранная часть модели будет смещена n раз на заданное 
расстояние. Для операции зеркального отражения разрешается только одна копия 
(вторая копия вернулась бы к оригиналу и может быть выполнена обычной 
опцией Copy). 

6.8.2  Преобразование частей сетки 
Части сетки могут быть преобразованы так же, как и части геометрии. 

Преобразование относится ко всей части и может быть отредактировано или 
удалено. Если изменить вершину сетки, то отображаются преобразованные 
координаты, и данные ввода, как предполагается, находятся в преобразованном 
пространстве. Если преобразование является измененным, то это также 
применено к отредактированной вершине. 

6.8.3  Ансамбли (сборки) 
Сборки используются для организации геометрии. Они становятся частью 

геометрической структуры и показываются в первом уровне раздела Geometry в 
дереве. Чтобы создать новую сборку, выберите необходимые составляющие, 
сделайте правый щелчок в дереве или пространстве чертежа и выберите Assembly 
→ Create. Только части (отображенные объекты) могут быть добавлены к сборке. 
(Части сетки и части геометрии не могут быть добавлены к той же самой сборке). 
Части перемещаются между сборками, выбором Assembly → Move to → ... из 
всплывающего меню. А команда Assembly → Move out  возвращает обратно 
выбранные части на исходный уровень. Элемент не может быть в двух сборках 
одновременно. 

Удаление сборки удаляет саму сборку и ее составляющие из модели. Точно 
так же выбор элемента в сборке и нажатие Del удалит элемент из модели. 
(Assembly → Move out). Команда Disassemble перемещает его компоненты назад 
в корневой уровень и удаляет сборку. 

Булевы операции, преобразование, разбиение и т.д. применяются к 
отдельным элементам. Если такие операции применяются к компонентам больше 
чем одного проекта, результат помещается на корневом уровне. Имена сборки 
становятся частью полной метки / имени, например, Assembly1. Union4. Face12. 
Отметим, что имена даются в CADFEKO без учета регистра, то есть Face1 и 
face1 – то же самое. 

6.9  Использование сред диэлектрических и с потерями 
Перед использованием модели, должны быть описаны свойства ее 
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материалов. Диэлектрические материалы в модели задаются установкой 
диэлектрической среды в геометрических областях. 

Потери в проводниках учитываются тем, что проводящие поверхности 
создаются как металлические среды. Покрытия и тонкие диэлектрические листы 
задаются на поверхностях, используя определяемый слоистый диэлектрик из 
отдельных диэлектрических слоев. В некоторых случаях свойства материала 
описываются как поверхностный импеданс на квадрат. 

Все используемые диэлектрики перечисляются в разделе Media (рис. 5.39). 
Каждый тип перечисляется отдельно, но названия сред должны быть уникальны и 
содержать не больше 43 букв. 

Цветной значок рядом с каждой средой указывает, какой цвет используется 
в индикации этой среды на дисплее и в дереве подробностей. Они могут быть 
изменены командой Change из всплывающего меню (цвета сохраняются в файле 
*. cfs.). Первые три значка – идеальный проводник, идеальная магнитная стенка (в 
настоящее время используется только когда установлена магнитная стенка 
земляной платы) и свободное пространство Free space, которые нельзя удалить. 

Хотя тонкий импедансный лист, строго говоря, не среда, параметры 
Impedance sheets (рис. 6.45), также могут быть введены в раздел Media, подобно 
другим средам. 

 
 

Рис. 6.45. Создание среды GRAFIT с тонким диэлектрическим листом 
 

Диэлектрические среды могут быть переименованы или изменены в дереве 
или в диалогах Properties. Эти изменения будут тогда относиться ко всем частям, 
в которых используется этот диэлектрик. Среды могут быть удалены, если они не 
используются в проекте. 

6.9.1 Диэлектрическая среда 
Любая область может быть заполнена диэлектриком. Диэлектрики 

создаются, используя раздел Media в дереве проекта, или выбирая команду Model 
→ Add medium → Dielectric из главного меню (рис. 6.46). 

В качестве параметров диэлектрической среды задаются относительная 
диэлектрическая проницаемость, относительная магнитная проницаемость, 
коэффициент магнитных потерь, тангенс диэлектрических потерь или 
проводимость. 
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Тангенс диэлектрических потерь и 
проводимость определяют потери в 
диэлектрике, но имеют различные частотные 
зависимости. Выбор зависит от задачи. 
Например, небольшие потери в подложках 
обычно определены в терминах коэффициента 
потерь, в то время как потери в биологической 
ткани (при расчете уровня поглощения 
мощности) определены в терминах 
проводимости.  

Плотность массы Mass density 
используется только для расчета уровня 
удельного поглощения (SAR), но это значение 
должно быть больше 0. 

 
 

6.9.2  Металлическая среда 
 Потери (из-за скин-эффекта) учитываются установкой фаски как металла с 

потерями. Но они не могут быть выполнены для фасок, ограничивающих области 
с идеальной электрической проводимостью. 

Металлические среды создаются путем клика правой кнопкой мыши на 
пункте Media и выбором Create metallic medium, или выбирая команду Model → 
Add medium → Metallic из главного меню (рис. 6.47). Отметим, что в FEKO 
невозможно установить твердый объект как металлическую среду. Это можно 
выполнить заданием внутренней области как свободного пространства и 
установке толстого слоя металлической среды на поверхности. Под «толстым 
слоем» здесь подразумевается, что поверхность намного более толстая, чем 
глубина скин-слоя. 

 
Металлические среды характеризуются 

проводимостью Conductivity, относительной 
магнитной проницаемостью Relative 
permeability и коэффициентом магнитных 
потерь Magnetic loss.  

В этом описании определение 
проводящей среды относится и к металлам, и к 
идеальному электрическому проводнику. 

 
 

6.9.3  Слоистые диэлектрики 
Поверхности между областями свободного пространства могут быть заданы 

как тонкие диэлектрические листы или как провода, покрытые диэлектриком (рис. 

 
Рис. 6.46. Создание 

диэлектрического материла 

 
Рис. 6.47. Диалог создания 

металлической среды 
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6.48). 
Это выполняется с помощью слоистых диэлектрических сред, которые 

состоят из произвольного числа диэлектрических слоев указанной толщины. 
Заметим, что диэлектрические среды, составляющие различные слои, должны 
быть определены прежде, чем задается описание слоистого диэлектрика. 

Диалог создания слоистого 
диэлектрика Create layered 
dielectric содержит таблицу с 
толщиной и материалом каждого 
слоя. В этом списке Medium могут 
быть только диэлектрические 
среды. Кнопкой Add добавляется 
новый слой (рис. 6.48), а кнопкой 
Remove слой удаляется. Таким 
образом, можно вставить новые 
слои между любыми двумя слоями. 

Покрытия и тонкие слои 
диэлектрического материала 
должны быть геометрически или 
электрически тонкие в зависимости 
от выбранного решения. 
CADFEKO даст предупреждения, 

если толщина приближается к пределу, и об ошибке, если предел толщины 
превышен. 

6.9.4  Импедансные слои 
Структура поверхностного импеданса определяется как поверхностный 

импеданс на поверхностях между областями свободного пространства. 
Определяется он значениями реальной и мнимой частями поверхностного 
импеданса. Теоретически, те же самые результаты могут быть получены 
установкой соответствующего свойства металла на этой поверхности, но только в 
тех случаях, когда известен его поверхностный импеданс. 

6.9.5  Установка свойств материалов 
По умолчанию все объекты – идеальные электрические проводники. Чтобы 

изменить это, обычно свойства устанавливаются на областях, фасках или 
гранях/проводах. Области – полностью замкнутые объемы, которые перечислены 
в дереве проекта. Они могут быть выбраны из дерева подробностей проекта. 
Некоторые импортированные модели используют поверхностные части, чтобы 
определить границы твердых областей. Эти модели не имеют замкнутых 
областей, и невозможно определить твердый диэлектрик. Однако если 
поверхности объединены операцией Union, чтобы создать замкнутые 
поверхности, CADFEKO автоматически создает соответствующие области для 
новых частей. 

 
Рис. 6.48. Диалог создания слоистого 
диэлектрика из двух слоев Layer1 и 
Layer2 
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Фаски – отдельные поверхности объекта и они также перечислены в дереве 
подробностей. Они могут быть выбраны или в дереве подробностей или при 
трехмерном представлении, когда активен выбор фаски. 

 
Термин «фаска» используется, 

чтобы отличить её от «поверхности», 
которая в CADFEKO является 
двумерной геометрической поверхностью 
типа полигона. Грани, которые 
перечисляются в дереве подробностей 
(рис. 6.49), включают грани фасок, а 
также свободные кривые (называемые, 
как и провода, «wire»). 

Где это возможно, характеристики 
среды сохраняются во время 
геометрических преобразований. 
Например, если фаска разбивается на две 
фаски операцией вычитания, обе 
получающиеся фаски наследуют 
характеристики исходной; или, если две 

накладывающиеся поверхности пересечены, получающаяся поверхность будет 
иметь свойства, одинаковые для обоих поверхностей. Если невозможно 
объединить свойства нового объекта с исходным, то объекты отмечаются как 
сомнительные. 

 
 

6.9.6  Свойства трехмерных областей Region 
Чтобы установить свойства диэлектрика или свободного пространства, 

выберите одну или большее количество областей и команду Properties из 
выплывающего меню. Это открывает диалог Region properties, показанный на 
рис. 6.50. 

Поле Type используется для определения типа среды для области, это 
может быть идеальный электрический проводник, свободное пространство или 
диэлектрик. Установка свободного пространства Free space создает свободные 
окна, а установка на Perfect electric conductor –электрические проводники – 
твердые объекты. Разница очевидна, главным образом, во время создания 
геометрии. Можно, например, удалить фаски, когда они граничат со свободным 
пространством, но нельзя, когда они граничат с диэлектриком и идеальным 
проводником. Некоторые свойства устанавливаются только на тех фасках, 
которые граничат с областью свободного пространства.  

 
 

Рис. 6.49. Фаски и провода в 
дереве подробностей проекта 
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Тип диэлектрической среды 
доступен только тогда, когда в списке 
Media имеются диэлектрические среды. 
Диэлектрик может быть определен, когда 
открывается диалог свойств области – 
тип диэлектрической среды тогда 
становится немедленно доступным (рис. 
6.51). Если тип диэлектрический, 
соответствующая среда должна быть 
выбрана в списке Name.  

В отличие от имен метки, которые 
должны быть уникальны, одно название 
среды может использоваться для 
нескольких областей. В случае 
пересечений, если возникают 
конфликты, материалы областей будут 
отмечены вопросительным знаком. 

Первоначально диалог показывает 
текущее состояние свойства выбранного 
элемента. Если выбрано несколько 
областей, то можно задать их заполнения одновременно одной средой.  Если 
среду изменить, что одновременно меняются среды во всех областях. Это 
позволяет, например, выполнить изменение размера ячейки разбиения для ряда 
различных диэлектриков одновременно. 

 

6.9.7  Свойства фасок 
Диалог Face properties имеет две закладки: Properties and Solution 

(рис. 6.52). Параметры фаски (стороны), находящейся в среде, устанавливаются в 
закладке Properties. 

Опции для поля Face type в группе Face medium зависят от областей с двух 
сторон фаски. Если с обеих сторон свободное пространство, то параметры могут 
быть: Perfect electric conductor, Lossy conducting surface, Impedance sheet, Thin 
dielectric sheet и Default (по умолчанию). Некоторые параметры доступны только 
после того, как были определены соответствующие материалы. 

В данном конкретном случае опция по умолчанию Default – такая же, как 
Perfect electric conductor. Если выбрана опция Lossy conducting surface, то 
должны быть определены металлическая среда и толщина.  

Заметим, что невозможно установить среду Metallic в трехмерных областях, 
но это можно сделать, устанавливая свойства фаски как слоя с поверхностными 

 
Рис. 6.50.  Диалог свойств области 
 

 
Рис. 6.51. Диалог Region properties с 

установкой размера сетки 
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потерями, большими, чем слой с глубиной поверхностного слоя. 


 2

skin

 
Импедансный слой Impedance sheet – бесконечно тонкая проводящая 

поверхность с указанным поверхностным импедансом (отношение между 
тангенциальным электрическим полем на поверхности и электрическом 
поверхностном тока). Если выбрана опция Thin dielectric sheet, поле Medium 
перечисляет все слои Layered dielectric. Это – плоские многослойные 
диэлектрические структуры типа автомобильного окна. (Такой расчет 
выполняется согласно карте SK с сообщениями ошибок, при задании параметров 
Impedance sheet и Thin dielectric sheet). 

 

  
Рис. 6.52. Диалог свойств фаски с двумя закладками 

 
Если фаска формирует границу между двумя диэлектрическими областями 

или между диэлектрической областью и свободным пространством, параметры 
для Face type заданы по умолчанию, Dielectric boundary, Lossy conducting 
surface и Perfect electric conductor. Если выбрана Dielectric boundary, фаска 
представляет границу между двумя различными диэлектрическими областями. 
Опции Lossy conducting surface и Perfect electric conductor используются для 
определения границы проводимости на диэлектрической области. Например, при 
моделировании планарной антенны на подложке конечного размера, стороны и 
все пространство сверху должны быть установлены как Dielectric boundary, в то 
время как плата и земляная плата должны быть проводящими поверхностями. В 
этом случае Default становится Dielectric boundary. 
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Если же все граничащие области – идеальные проводники, единственные 
доступные параметры Face type заданы как Default и Perfect electric conductor. 
Тогда Default становится Perfect electric conductor. 

Выбор Face type сохраняется, когда изменяется соприкасающаяся область. 
Но это может приводить к недопустимым параметрам настройки. Например, если 
на фаске, граничащей со свободным пространством, установлена опция Lossy 
conducting surface, эта установка становится неверной, если область границы 
переходит в Perfect electric conductor. Эти случаи обычно отображаются с 
вопросительными знаками (даже если все выбранные фаски имеют ту же самую 
установку). Таким образом, область может переходить в неизвестную область без 
изменения настройки фаски. Фаска будет отмечена как подозрительная во время 
этого процесса и должна быть переустановлена вручную. 

Установка Default также сохраняется, когда граничащая область изменена. 
Она ведет себя по-разному для различных случаев, предусматривая 
соответствующие опции для каждой комбинации областей. Например, если 
область идеально проводящая, идеально проводящими могут быть только её 
границы. Если они явно установлены как Perfect electric conductor, плоскости 
останутся идеально проводящие, если область граничит с диэлектриком.  
 В большинстве случаев это не соответствует структуре.Так, если имеется 
диэлектрик с замкнутой границей, и диэлектрик описать как металлическую 
среду, то можно считать, но это приведет к более длительному времени решения. 

Однако если фаски на идеально проводящей области установлены как 
Default, они станут диэлектрическими границами, когда область переходит в 
диэлектрик. Заметим, что это означает, что если двумерная поверхность (которая 
по умолчанию идеально проводящая) – объединена операцией Union с 
диэлектрическим объектом, то результатом будет диэлектрическая граница. 

 
Рис. 6.53. Покрытия, приложенные к обеим сторонам проводящей поверхности 

 
Покрытия прикладываются с обеих сторон фаски. Следовательно, эта опция 

доступна только в том случае, когда фаска имеет свободное пространство с обеих 
сторон. Покрытие Coating name выбирается из списка Layered media. Покрытие 
прикладывается так, что слой 1 находится на внешней стороне, как показано на 
рис. 6.53. 

6.9.8  Установка свойств элемента разбиения на сетку 
В идеале свойства объектов должны быть установлены на геометрии, до 

преобразования геометрии в сетку. Любые изменения геометрии (или свойств 
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геометрии), сделанные после объединения, не будут отражены в сетке разбиения. 
Только параметры сред могут быть изменены после объединения, и это будет 
учтено в расчете. 

Например, если область получена объединением и затем материал 
изменяется от Teflon к FR4, объединенные области будет все еще использовать 
среду Teflon. Однако если среда Teflon переименована в Teflon_new после 
объединения, объединенные области приобретут материал Teflon_new. 

Однако можно установить свойства на сетке разбиения. Выберите 
требуемые элементы сетки и далее команду Edit → Properties. 

Для тетраэдрального разбиения может быть определена только среда. Среда 
определяется на каждой стороне. Среда Face и свойства покрытия Coating может 
быть установлена на фаски, но здесь две окружающих среды определяются в том 
же самом диалоге, а не в отдельном диалоге Region. Если среда изменена таким 
способом, что среда фаски или установка покрытия становится недопустимой, то 
установка немедленно становится под вопросом и должна быть модифицирована 
снова. (Определение сред на элементах сетки требуется только для 
импортированных сеток разбиения). Для сегмента, отмаркированного как 
окружающая среда, в диалоге может быть установлен реквизит сетки. Среда 
внутреннего сегмента и покрытие могут быть определены, как и их грани. 

Нужно отметить, что установки по разбиению на сетку не изменяют 
никакие установки геометрии. Если модель повторно разбита на ячейки, такие 
установки теряются. Поэтому не рекомендуется устанавливать свойства сетки, 
когда это можно сделать на геометрии. 

6.9.9  Свойства ребер 
В диалоге Edge properties (рис. 6.54), 

можно установить локальный радиус 
провода (что отменяет установку по 
умолчанию в диалоге Create mesh) и 
параметры среды, в которой находится 
провод, и применить покрытие. Эти 
параметры доступны только в том случае, 
если край – провод, то есть не граница 
фаски. 

Потери в проводах учитываются 
установкой типа провода Wire type как 
Lossy и выбором среды Metallic. Для 
покрытий выбирается Coating name из 
списка сред Layered dielectric, но в 
настоящее время к проводам можно 
применить только однослойные покрытия. 

 
 

 
Рис. 6.54. Диалог свойств ребер  
Edge properties 
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6.9.10  Показ диэлектрической среды, покрытия и тонких слоев 
Кликните указателем курсора на иконку Show / hide geometry objects или 

на иконку Show / hide mesh icon и выберите Colour by medium, чтобы увидеть 
диэлектрические области в цвете. Стороны каждой внутренней поверхности 
окрашиваются как диэлектрические области на каждой стороне. 

При отображении геометрии, цвет области используется на всех внешних 
границах, а сетки разбиения наружных поверхностей отображены в виде цвета 
среды на той стороне (рис. 6.55), которая должна быть свободным пространством. 

Параметры фаски и покрытия 
показываются иконкой в дереве. Фаски 
на диэлектрических областях также 
показываются иконкой в дереве. 

Сегменты разбиения на ячейки 
могут быть показаны с их реальным 
радиусом в трехмерном виде. Этот 
радиус может включать радиус оплетки. 

 
Итак, в этом разделе рассмотрены общие вопросы черчения и описания 

геометрии. Конкретные операции будут разобраны на примерах во второй части 
книги. 

В FEKO версии 6.0 были внесены дисперсионные материалы. Готовые 
дисперсионные характеристики заданы моделью Дебая. Эта модель описывает 
свойства газов и жидкостей с потерями на СВЧ. Она была получена с помощью 
описания свободно вращающихся сферических полярных молекул в 
преобладающе неполярном земляном пространстве. Модель Havrillak-Negami - 
более общая модель и она может успешно моделировать жидкости и твердые 
частицы. Модель Djordevic-Sarkar хорошо подходит как широкополосная модель 
для сложных диэлектриков. Диэлектрические свойства материала могут быть 
заданы таблично, в различных частотных точках. Характеристики диэлектрика 
тогда линейно интерполируются, чтобы получить диэлектрические свойства. 
Таким образом, можно описать плазму, у которой реальная часть 
диэлектрической проницаемости отрицательная. Также, материал в FEKO можно 
задать из файла, импортируя диэлектрические и магнитные свойства диэлектрика. 
 
 
 

 
Рис. 6.55. Отображение информации 

о свойствах фасок (плоскостей) 
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7  ПОДГОТОВКА К РЕШЕНИЮ И ЗАПУСК FEKO НА СЧЕТ 

После черчения структуры или нескольких составляющих структур, или 
импорта части конструкции из программы AUTOCAD, в FEKO нужно задать ряд 
операций, которые подготавливают программу к расчету. Нужно поставить 
граничные условия, порты, источники возбуждения, частоты и выбрать 
характеристики, которые нужно рассчитать. 

7.1 Создание портов, источников и нагрузок  
Порты предназначены для ввода и вывода мощности на границах 

структуры, и правильный их выбор влияет на точность расчета задачи. В FEKO 
имеется несколько портов, которые выбираются командой Create port (рис. 7.1). 

Источники напряжения и 
дискретные нагрузки прикладываются к 
портам, которые должны быть 
определены перед созданием источника 
или нагрузки. 

Созданные порты находятся в 

разделе Ports в дереве проекта. Каждый 
порт содержит подэлементы, указывая 
геометрию и сетку разбиения, с 
которыми он связан. Порты 
устанавливаются на геометрии, 
например, в линии. 

Другая характеристика порта – 
это разбиение на сетку, автоматически 
создается, когда разбивается вся 
структура. Тогда раздел Port в дереве 
проекта будет содержать образы 
геометрической модели и всех 
элементов разбиения порта. 

Порты могут также быть созданы 
на сетке. Эта опция доступна из меню Mesh → Create port и выполняется только 
для импортированной сетки разбиения (рис. 7.2). Если порт создан на сетке 
разбиения, он будет содержать только модель разбиения на сетку. 

Если порт содержит геометрическую модель, то, выбирая Properties из 
всплывающего меню порта, можно открыть описание его геометрии. Если порт 
содержит только раздел разбиения на сетку, это открывает свойства этого 
разбиения. 

Как геометрия, так и сетка не могут быть удалены, пока порт связан с ними. 
Порты тогда отмечаются как подозрительные (со знаком вопроса) и должны быть 

 
Рис. 7.1. Список портов в FEKO 

 

 
Рис. 7.2. Диалог создания проводного 

порта на сетке разбиения 
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переустановлены, чтобы снять эту установку. Геометрия и сеть, связанные с 
портом, должны быть удалены раздельно. 

7.1.1 Проводные порты 
Проводные порты создаются на проводах между точками сегмента или на 

вершине структуры. Выберите команду Geometry → Create port → Wire port из 
главного меню, чтобы открыть диалог Create wire port (geometry) показанный на 
рис. 7.3. 

В поле Edge вводится имя провода, 
на котором будет располагаться порт. Он 
может быть вставлен, выбором его в 
трехмерном представлении или в дереве 
проекта. Диалог порта может быть 
открыт также нажатием правой кнопки на 
имени провода в дереве проекта и 
выбором Create port → Wire port из 
всплывающего меню в дереве 
подробностей. Тогда выбранное ребро 
автоматически вводится в поле Edge. 

Когда провод разбит на ячейки 
(рис. 7.4), порт может быть помещен в 
крайний сегмент или в середине между 
двумя сегментами. Порт на вершине 
главным образом используется, когда 
провода соединены с другими 
структурами, и разность фаз от конечной 
точки до центра первого сегмента может 
значительно изменить входное 

сопротивление. 
В разделе Location (рис. 7.3) задается, в каком месте на проводе будет 

находиться порт. Если точки Segment points определены в начальной точке, 
используется сегмент Start, в середине Middle, и End в конце. Когда выбрана 
опция Other, пользователь должен задать положение по проводу. Поле % 
определяет положение порта вдоль провода, в процентах от длины провода, от 0% 
в начальной точке, до 100% в конечной точке. Если провод изменяется 
впоследствии так, что имеется все еще только один провод с этим обозначением, 
порт будет в том же самом положении. Таким образом, если порт был на 
расстоянии трети от конца провода, и провод закорочен, чтобы работать на 
различных частотах, порт находится на 1/3 от более короткого провода. Если не 
имеется никаких проводов с меткой слева, или если провод разделен на кратные 
части, порт отмечается как подозрительный. 

 
Рис. 7.3. Диалог создания проводного 

порта на геометрии 
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Рис. 7.4. Создание порта на вибраторе антенны Уда-Яги 

 
Положение порта может быть установлено сразу, вводя поименованную 

точку или выражение «pt» в поле % (рис. 7.3). Тогда порт располагается в этой 
точке провода. Если провод впоследствии изменяется, точка порта останется 
насколько возможно близко к этому положению.  

В этом случае, если провод, 
разбитый на кратное число, 
охватывает порт, он будет 
зафиксирован на ребре, где его 
положение - самое близкое к этой 
точке. Если провод исчезает, порт 
становится подозрительным. 
Удачный ввод порта отражается в 
виде точки, и текущее положение 
порта обозначено малым шариком в 
трехмерном представлении (рис. 7.5). 

Проводные порты могут быть 
также установлены непосредственно 
на сетке разбиения, выбирая Mesh → 
Create port из главного меню. 

Диалог создания проводного порта (mesh) на сетке также содержит Locate 
port on group, который имеет поле Segment / Vertex. Если это поле активно, 
можно выбрать сегмент или вершину в трехмерном представлении. Поле segment 
/ vertex тогда показывает обозначение сегмента, в то время как начало и 
координаты конечной точки сегмента или координат вершины отображены 
только в полях для чтения. 

В трехмерном представлении положительная клемма порта отображается 
как красный цилиндр, а отрицательная клемма – как синий цилиндр (рис. 7.5). 
Порты, которые устанавливаются на вершине (в противоположность сегментам), 
отмечаются маленьким шариком на вершине. Если вершина порта подключена к 
поверхности, то сегмент показывается окрашенным. 

 
Рис. 7.5. Порт, созданный на проводе 

вибраторной антенны 
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7.1.2  Порты на ребре 
Порты на ребрах (Edge ports) выбираются вдоль границ между двумя 

прямоугольными площадками (фасками). Фаски должны принадлежать той же 
самой части конструкции проекта. Командой Geometry → Create port → Edge 
port из главного меню вызывает диалог, показанный на рис. 7.6. 

 

  
Рис. 7.6. Диалог создания порта  

на ребрах для геометрии (слева) и сетки (справа) 
 

Диалоги Create edge port (geometry), показанные на рис. 7.6, содержат два 
списка, в которых пользователь может прибавлять и удалять фаски. Если ввод в 
таблице можно выполнить, фон желтый, и можно щелкнуть на фаске в 
трехмерном представлении или в дереве деталей, чтобы ввести эту фаску в 
список. Когда данные добавлены в список, добавляется новая незаполненная 
строка. 

Фаски могут быть переключены между списками, путем клика кнопки 
между списками или выполняя двойной клик. Этот диалог может также быть 
открыт, выбором фаски геометрии или грани, ограничивающие фаски, выбором 
порта командой Create port →Edge port из всплывающего меню в дереве 
подробностей. Выбранные фаски или все фаски, ограничивающие выбранные 
грани, добавляются в список Positive faces. Пользователю нужно только 
переместить соответствующую фаску в список Negative faces. 
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При создании порта на ребре вызываются те же диалоги, которые 
осуществляют выбор на сетке, и на геометрии. К этому образцу разбиения на 
сетку обращаются, выбирая команду Mesh → Create port → Edge port из 
главного меню. 

 
Рис. 7.7. Пример установки порта на ребре 

 
Граница между двумя фасками высвечивается как серый цилиндр. 

Положительные фаски отмечены вторым, красным цилиндром, а отрицательные 
фаски отмечены синим цилиндром. Заметим, что край не должен быть 
обязательно прямым – он может даже замыкаться, и можно, например, создать 
порт в центре толстого вибратора, созданного как цилиндр и разбитый на 
треугольники, а не на сегменты. 

 
 

7.1.3  Микрополосковые порты 
 

Микрополосковые порты (Micristrip ports) используются для включения 
источника на микрополосковых структурах. Они задаются на ребре или на 
нескольких гранях, которые формируют прямое, горизонтальное (то есть лежащее 
при постоянном z) ребро, ограничивающее только одну фаску. Кроме того, 
модель должна содержать плоскую диэлектрическую подложку с проводящей 
земляной платой. Диалог Create stripline port (geometry) содержит список 
граней, который подобен спискам фасок в диалоге Edge port. К этому порту 
обращаются, выбирая Geometry → Create port → Stripline port или выбирая 
несколько фасок и затем выбирая Create port →Edge port из выплывающего 
меню в дереве подробностей. Порт отображен в диалоге рис. 7.8 подобно порту на 
ребре. Положительное направление всегда направлено к ребру. 
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Рис. 7.8. Пример микрополоскового порта на входе фильтра,  
лежащего над земляной платой 

 
 

 
В диалоге параметров разбиения на 

сетку ребро задается между начальной и 
конечной точками, которые должны быть 
вершинами сетки Start vertex и End 
vertex (рис.7.9).  

Поля вершины тогда показывают 
метки элементов, связанных с 
соответствующей вершиной. 

 

7.1.4  Волноводные порты 
Волноводные порты используются для задания плоских волн возбуждения 

волноводных структур (рис.7.10). Поддерживаются три базовых сечения 
волноводов: 

1. Прямоугольный волновод  
2. Круглый волновод  
3. Коаксиальный волновод  

 
Рис. 7.9. Диалог задания 

микрополоскового порта на сетке 
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Рис. 7.10. Создание волноводного порта 

 
Волноводные порты создаются на одной стороне корректно созданной 

волноводной формы. Чтобы задать порт на стороне, эта сторона должна быть 
плоской, не должна содержать каких-либо внутренних ребер, не должна быть 
границей объема PEC или диэлектрика, и не должна иметь каких-либо 
материальных свойств (например, диэлектрического покрытия). На ней также не 
должна быть установка решения (например, задания, что эта плоскость решается 
методом UTD). 

Когда сторона выбрана, направление 
распространения и опорное направление для 
порта выбирается и показывается 
автоматически. 

Его можно изменить в разделе 
Propagation direction opposite to normal или 
установкой соответствующего угла 
вращения в списке Rotate reference 
direction.  

В закладке Advanced диалога порта 
(рис. 7.11) могут быть выбраны 
дополнительные параметры настройки. 
Выбирая ручной выбор числа мод, можно 
установить максимальное число мод. Если 
эта опция не выбрана, то FEKO 
автоматически определит максимальное 
число рассматриваемых мод. Опция 
Manually set the reference vector отменяет 

автоматически выбранный опорный вектор порта. В этом случае опорный вектор 
идет от центра лицевой поверхности порта в направлении указанного вектора. 

 

 
Рис. 7.11. Закладка Advanced 

диалога создания волноводного 
порта на геометрии 



141 
 

Волноводные порты могут быть 
также созданы на плоской стороне сетки. 
Для того чтобы это сделать, нужно выбрать 
из меню порта mesh → Create port → 
Waveguide.  

Требования для постановки 
волноводного порта на сетке очень похожи 
на требования к постановке волноводного 
порта на геометрии, в которой CADFEKO 
автоматически рассчитывает форму порта, 
основанную на форме выбранной лицевой 
поверхности сети (сетка должна 
представить одну из поддерживаемых 
волноводных форм, иначе CADFEKO даст 
ошибку). Для прямого приложения 
волноводного порта к сетке опорное 
направление порта должно быть 
определено вручную в направлении 
вектора от центра лицевой поверхности 
возбуждения. 

Волноводный порт отличается от 
других портов тем, что когда возбуждение 
не прикладывается к порту, он будет 
учитываться при решении как идеальная 
волноводная нагрузка (то есть вся энергия, 

которая распространяется в волноводный порт, будет поглощена). 

7.1.5  Линейные порты, использующиеся в расчете методом FEM. 
 

Линейные порты FEM line, рассчитываемые методом конечных элементов, 
используются, чтобы задать источники возбуждения и нагрузки в областях, 
которые рассчитываются методом FEM. Линейный порт FEM добавляется, 
выбором команды Geometry → Create port FEM line port. Диалог создания 
линейного порта показан на рис. 7.13. 

Положение порта может быть определено двумя способами – на основании 
положения свободного ребра (или нескольких связных свободных граней, 
которые формируют непрерывную прямую линию) внутри диэлектрической 
области в модели, или на основании координат, определяющих начальную и 
конечную точки портов FEM line (в глобальных координатах). 

 

 
Рис. 7.12. Диалог задания источника 

возбуждения волноводного порта 
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Рис. 7.13. Диалог создания линейного порта FEM на геометрии 
 

Если размещение порта определено, как 
основанное на ребре (или на связанных 
ребрах), ориентация порта определяется 
автоматически. Ориентация может быть 
определена визуально в трехмерном виде 
структуры и может быть, если нужно, 
изменена, применением опции ориентации 
порта. Если геометрия, на которой порт 
определен, изменяется (сдвигается или 
масштабируется, например), то положение 
порта FEM и размер также будут изменены. 

Во время разбиения на сетку все грани, 
которые связаны с определением линейного 
порта FEM, будут исключаться из сетки, но 
использоваться для определения начальной и 
конечной точки линейного порта FEM. Сетка 
линейного порта FEM формируется на 
основании координат начальной и конечной 
точек, или прикреплением начальной и 
конечной точек линейного порта FEM к 
вершинам сетки в пределах (или на границе) 

тетраэдральной сетки разбиения. Диалог создания линейного порта показан на 
рис. 7.14. 

Когда порт определен на сетке, его преобразования будут поддерживаться 
через операции на сетке (масштабирование, трансляция и т.д.). Нагрузки и 

 
Рис. 7.14. Диалог создания 

линейного порта FEM в области 
разбиения на тетраэдры 
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источники тока могут прикладываться к линейному порту FEM, и линейный 
порты FEM могут быть включены в расчет S-параметров. 

7.1.6  Порты FEM modal 
Порты FEM modal используются для установки в области, которая 

рассчитывается методом конечных элементов (FEM).  
 

Этот порт по существу 
представляет бесконечно длинную 
структуру канализируемой волны 
(линия передачи), связанную с 
диэлектрическим объемом, 
которая рассчитывается методом 
конечных элементов. FEM 
модальный порт может быть 
возбужден основным типом 
колебаний связанной структуры 
канализируемой волны, или он 
может действовать как пассивный 
порт. S-параметры могут быть 
вычислены между основным 
типом колебаний FEM 
модального порта и другими 
портами в модели. Чтобы 
поставить FEM модальный порт 
на поверхность, эта поверхность 
должен быть плоской и лежать на 
границе области, которая 
считается методом FEM. 

Диалог создания 
модального FEM порта (рис. 7.15) 

позволяет его специфицировать или списком поверхностей или точками. 

7.2 Источники в виде плоских волн 
При описании структуры, возбуждаемой плоской волной, выберите Solution 

→ Add excitation → Plane wave из главного меню или нажмите правой кнопкой 
мыши на папку Excitation в дереве проекта и выберите Add plane wave. 
Появляется диалог (рис. 7.16). 

 

  

Рис. 7.15. Диалог создания порта FEM modal 
port на геометрии 
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Направление падения плоской 
волны определяется в сферической 
системе координат углами θ и φ (в 
градусах). Поляризация определяется 
углом η, идущим вправо от направления 
распространения. Эллиптичность 
должна быть равна 0 для линейной 
поляризации, и 1 для круговой 
поляризации. 

Источник плоской волны имеет 
два режима описания. Если выбрана 
опция Single incident wave, к 
существующим источникам добавляется 
одна плоская волна. 

 
Чтобы создать сложные 

распределения напряженности 
электрического поля, выбирается режим 
Multiple Single incident (падение 
несколько плоских волн). 

Если выбран режим Loop over 
multiple directions, FEKO вычисляет 
решение для каждого указанного 
направления падения. Пользователь 
должен определить начальный, 

конечный угол и приращение угла для каждой угловой координаты. Тогда расчет 
будет выполняться для заданного числа направлений. Заметим, что последний 
угол определяется от начального угла, приращения и числа отсчетов и может не 
совпадать с указанным конечным углом. Такой источник, с циклом по нескольким 
выбранным направлениям Loop over multiple directions, может быть только один. 
Все другие источники (перечисленные в разделе Excitations) активны для 
каждого направления падения плоской волны (рис.7.17). 

 
При редактировании источника направления падения и направления 

поляризации отображаются в трехмерном представлении. 
 

 
Рис. 7.16. Диалог падающей плоской 

волны возбуждения 
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Рис. 7.17. Возбуждение в виде нескольких плоских волн 

 
Напряженность электрической составляющей падающего поля дается 

формулой 
 

  rj
oi eEjvErE


0)()( 00

  ,  
 
где v – эллиптичность, βo – направление падения и Eo – вектор, идущий в 
плоскости XoY, как показано на рисунке 7.11. 
 
 

7.3  Электрические и магнитные диполи 
 

Чтобы создать точечные источники излучения, выберите Solution → Add 
excitation → Electric point source / Magnetic point source из главного меню или 
нажмите правой кнопкой мыши в дереве и выберите Electric point source / 
Magnetic point source. В разделах Position и Orientation (углы в градусах) этих 
диалогов вводятся координаты и ориентации источников (рис. 7.18). 
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Рис. 7.18. Диалог 

электрического точечного 
источника 

Рис. 7.19. Диалог точечного магнитного 
источника в виде петли электрического тока 

 
Ориентация точечного источника излучения влияет на поляризацию 

излучаемой волны. Точечный магнитный источник может быть задан либо петлей 
электрического тока Electric ring current (величина которого задается как 
произведение тока по петле на площадь петли), либо линейным магнитным током 
Magnetic (величина задается как произведение длины диполя на магнитный ток, 
рис. 7.19). 

Петля электрического тока и линия магнитного тока излучает то же самое 
ближнее и дальнее поле, но потенциалы излучения разные. Этот выбор зависит от 
задачи. 

7.4 Точечные источники с заданной ДН 
Чтобы создать точечный источник с определенным видом диаграммы 

направленности в дальней зоне, выберите Solution → Add excitation → Radiation 
pattern point source из главного меню, или нажмите правой кнопкой мыши в 
разделе Excitation в дереве и выберите точечный источник Radiation Pattern. 

Если в закладке Pattern используются глобальные координаты, а локальные 
координаты не отмечены, они могут быть определены и использованы аналогично 
тому, как это делается в геометрии. Положение импортированной модели может, 
таким образом, ориентироваться произвольно. 

В поле Position закладки Pattern (рис. 7.20) определяется положение 
источника в локальных координатах. Положение может быть также установлено с 
использованием поля Origin в закладке Coordinates, но Origin определен в 
глобальных координатах, в то время как положение задается в локальных 
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координатах. Величина масштабного множителя и сдвиг фазы применяются ко 
всей модели. 

 
 

Данные модели могут 
быть импортированы из 
файла *. ffe, созданного 
FEKO или файлом данных 
ASCII. 

Заметим, что модель 
не загружается в 
CADFEKO, а только 
связывается с файлом. Файл 
не заархивирован 
CADFEKO, так как он 
может быть в другом 
каталоге и может 
использоваться другими 
моделями. Если модель 
CADFEKO сохранена в 
другом каталоге командой 
Save as, то CADFEKO 
сначала будет пытаться 
найти файл в том же самом 
пути и, в случае неудачи, 
пробовать находить его в 
исходном пути. 

 
Нужно убедиться, что ДН в файле рассчитана на частоте решения текущей 

модели. Так как модели поля в дальней зоне обычно частотно зависимые, модели 
с источниками диаграммы направленности излучения будут обычно иметь только 
одну частоту решения. Если диаграмма направленности излучения была 
рассчитана в диапазоне частот, файл *. ffe будет содержать несколько ДН. 

 
Поле Start from point number (рис. 7.20) может тогда использоваться, 

выбирая в файле первую линию, с которой начинает читаться диаграмма 
направленности. Например, если ДН первоначально была рассчитана для 50 
направлений поля в диапазоне частот, ДН для третьей частоты первоначального 
решения может быть выбрана установкой 101 в этом поле. 
 
 
 
 
 

 
Рис. 7.20. Диалог задания точечного источника с 

заданной ДН 
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7.5  Возбуждение сферической волной 
 

Возбуждение структуры 
сферической волной может быть 
задано на основании заранее 
рассчитанных сферических мод. 
Возбуждение добавляется, 
нажимая на кнопку Spherical mode 
source на панели инструментов 
Solution, или командой Solution → 
Add excitation → Spherical mode 
source. Диалог Add spherical mode 
source (рис. 7.21) позволяет задать 
положение источника, ориентации 
и направление возбуждение 
сферических мод. Данные об 
источнике могут быть 
импортированы из файла TICRA 
*.sph или определены вручную. 
Для ручной спецификации каждая 
мода должна быть определена 
отдельно в строке таблицы в 
диалоге (рис. 7.22). 

Когда сферические моды 
задаются вручную, отдельные моды могут быть добавлены или удалены 
использованием кнопки Add и Remove. Возможности для ручного введения 
сферических типов волн детализированы следующим образом: 

Propagation direction (направление распространения) 
Параметры определяются, если сферические волны распространяются Inward 
(модель облучается модами, распространяющими от r=0, т.е. используются 
сферические функции Ганкеля первого порядка), или Outward (моды 
излучаются к r=∞, то есть используются сферические функции Ганкеля 
второго вида). Эта опция позволяется только тогда, когда моды вводятся из 
файла *.pre, а не когда моды импортируются из файла TICRA file (*.sph), 
когда используется направление распространения наружу. 

Index scheme 
Схема Normal использует традиционные индексы Smn. Если выбрана эта 

схема, пользователь может определить TE-моды (s=1) или ТМ-моды (s=2) и 
индексы M и N в колонках индексов. Здесь N – индекс типа волны в 
радиальном направлении и должен быть в диапазоне 1,2, … ∞, и M – индекс 
типа волны в направлении азимута. При этом не различаются четные и 
нечетные типы волн (с угловыми зависимостями Cos(M) и Sin(M)), а, скорее, 

 
Рис. 7.21. Диалог описания источника 

возбуждения, заданного во внешнем файле  
 



149 
 

используется угловая зависимость ejM. Таким образом, индекс M может также 
быть отрицательным, но он должен быть в диапазоне -N…N. 

Схема Compressed использует сжатую одномерную схему нумерации типов 
волн. Индекс моды J тогда задается в колонке индексов  

 
J=2[N(N+1)+M-1]+s ,      

где s=1 для TE-моды и s=2 для ТМ-мод. Эта схема нумерации типов волн 
позволяет вычислять расширенные матрицы рассеяния (с неизлучающей 
схемой и портами возбуждения). Индекс J тогда представляет уникальный 
номер порта в матрице рассеяния. 

 

 
 

Рис. 7.22. Диалог для ручного определения типов волн 
 
Mag. sqrt(W) 

Абсолютное значение комплексной амплитуды конкретной сферической моды 
(с использованием нормализации сферических мод, единицы амплитуды равны 
корню из мощности в соответствующих единицах). 

 
Phase (deg.) 

Фаза комплексной амплитуды сферической моды в градусах. 
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7.6  Возбуждение апертуры 
Возбуждения в виде апертуры могут использоваться, чтобы задать плоскую, 

цилиндрическую или сферическую апертуру измеренных или рассчитанных 
данных поля, которые действуют как источники возбуждения. Расчетные данных 
поля преобразованы в эквивалентное множество электрических и магнитных 
диполей в решении.  

 
Возбуждение в виде апертуры 

добавляется, путем клика на символ Aperture 
field source на панели инструментов Solution, 
или выбором Solution → Add excitation → 
Aperture field source, чтобы вызвать диалог 
(рис. 7.23). 

В этом диалоге источник можно 
определить следующим образом: 

 
Magnitude scale factor  
Модуль поля, полученного из файла, будет 
умножен на это число. Это полезно когда 
используются файлы, в которых величины 
поля даны в различных единицах (напр. μV/m). 
Phase of the aperture (deg) 
Это значение фазы (в градусах) будет 
добавлено к фазам поля, полученного из 
файла.  
Aperture data type  
Этот тип данных, заданных на апертуре. 
Апертурное возбуждение может быть задано 
на основании распределения электрических и 
магнитных полей возбуждения, или их 
комбинаций. 
Раздел Source 
Данные для полей E и H могут быть 

импортированы из файлов *.efe и/или *.hfe, рассчитанные в предыдущих 
решениях FEKO (см. карту DA), в виде файла с определенным форматом 
данных:  
 
 6.00000000E-002 -8.00000000E+001  0.00000000E+000   (9.22371930E-001,-1.97874145E+000) (7.80695848E+000,-1.00642802E+001) (3.20834828E-001,-9.20582539E-001) 
 6.00000000E-002 -7.90000000E+001  0.00000000E+000   (1.41257394E+000,-1.51650680E+000) (1.08822710E+001,-7.53361999E+000) (3.26317701E-001,-1.00279672E+000) 
 6.00000000E-002 -7.80000000E+001  0.00000000E+000   (1.78353726E+000,-9.19422984E-001) (1.29105387E+001,-4.09377280E+000) (3.27641512E-001,-1.08761038E+000) 

 
Раздел Source Destination  

В этом разделе задается система координат, в которой определяются данные 
об электромагнитном поле, и число точек по каждой угловой переменной, в 
которых поле рассчитается. Отметим, что данные могут быть определены в 
прямоугольных, сферических или цилиндрических системах координатах. 

 
Рис. 7.23. Диалог описания 

апертурного источника 
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Дополнительно также имеется опция определения поля вдоль ребер 
структуры. Эта опция должна использоваться в зависимости от того, как 
физически расположены точки относительно апертуры, определенной в Source 
Destination. Когда отмеченные внешние точки, как предполагается, лежат на 
краях, то неотмеченные точки лежат на расстоянии половины шага. Используя 
многократные возбуждения апертуры в одной модели, расчетные точки не 
должны лежать на краях двух апертур, которые имеют общую сторону, иначе 
будут включены два элементарных диполя с одной поляризацией в одной точке. 
Если это так, расчет сохранения энергии в FEKO может быть выполнен неверно. 

Заметим, что положение возбуждения апертуры по умолчанию 
определяется в глобальной системе координат. Положение может быть 
скорректировано изменением рабочей системы координат во вкладке Workplane. 

7.7  Источник тока в структуре 

 
Внешний подведенный ток может быть 

определен как источник возбуждения. Это 
специальный тип возбуждения, имеющий 
определенные ограничения. Параметры 
внешнего возбуждения определяются в окне 
диалога Add impressed current (рис. 7.24). 
Окно этого диалога открывается кнопкой на 
панели инструментов Solution, или из меню 
Solution → Add excitation → Impressed 
current. 

В окне диалога могут быть определены 
положения начальной и конечной точек 
сегмента тока, а также модуль и фаза (в 
градусах). Радиус нити тока должен также 
быть определен в окне Radius. Значение 
радиуса может не быть нулевым. Параметры 
выражены в тех единицах измерения, 
которые выбраны в модели. 

Есть опция соединения конечной точки 
с вершиной закрытого треугольника. Если 
она выбрана, конечная точка внешнего тока 

не используется, она будет определена из условия замкнутости на самой близкой 
вершине треугольной ячейки, доступной во время решения. Это полезно, когда 
внешний ток должен ограничивать геометрию модели и быть с ней соединен. 
Вершина ячейки должна быть в точке контакта, но не всегда возможно 
предсказать точное местоположение вершины ячейки, с которой должно быть 
связано возбуждение. Если эта опция выбрана, необходимо удостовериться, что 
возбуждение действительно соединяется в требуемой вершине треугольника. (Это 

 
Рис. 7.24. Диалог добавления тока 

возбуждения 
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может быть визуально подтверждено при запущенном PREFEKO и наблюдении 
возбуждения тока в POSTFEKO). 

Источники тока показываются в 3D представлении в виде красных стрелок. 
Стрелка предварительного просмотра расположена между начальной и конечной 
точками, и имеет указанный радиус нити тока. Когда используется опция 
соединения конечной точки к самой близкой выбранной вершине треугольника, 
ток представлен красным шариком в стартовой точке линии тока. Радиус сферы 
определен радиусом элемента тока. 

7.7.1  Токи в области FEM 
Для задания источника тока в области конечных элементов FEM выберите 

Solution → Add excitation → FEM current source из главного меню или кликните 
правой кнопкой мыши на Excitation и выберите источник FEM current source.  

Этот источник задается модулем и 
фазой, а также начальной и конечной точкой 
(рис. 7.25). 

Линейный ток имеет постоянную 
величину и фазу, поэтому он должен быть 
короткий по сравнению с длиной волны в 
среде в источнике. Так как отсутствуют 
требования на юстировку нити тока с 
элементами сетки (в том смысле, что вершина 
сетки должна находиться в ее конечных 
точках), этот источник не связан с геометрией. 
Нужно убедиться, что этот источник 
находится в области FEM, и что обе конечных 
точки находятся на проводящих поверхностях. 

Ограничение этого источника в том, что 
его радиус не учитывается, поэтому поле 
однородно около линии тока, и это влияет на 
точность вычисления входного полного 
сопротивления источника. В будущем этот 

источник будет применен к портам, которые будут также поддерживать расчет S 
параметров и поэтому включать нагрузки. 

 
 

7.7.2  Источники напряжения 
 

Выберите Solution → Add excitation → Voltage source из главного меню, 
или правой кнопки мыши на Excitation в дереве проекта выберите Voltage 
Source, чтобы задать источник напряжения.  

 

 
Рис. 7.25. Диалог для создания 
источника тока в области FEM 

 



153 
 

Диалог (рис. 7.26) содержит поле Port, в 
котором можно выбрать имеющийся порт и 
ввести величины напряжения и фазы. 
Указанное напряжение дает разность 
потенциалов между положительной и 
отрицательной клеммой. Положительное 
напряжение вызывает ток, вытекающий из 
положительной клеммы. 

Источники напряжения могут также 
быть добавлены нажатием правой кнопки 
мыши на требуемом порту. Тогда этот порт 
автоматически вводится в поле Port в диалоге 
генератора напряжения (рис. 7.26). 

 
 

7.8  Нагрузки 
 

Чтобы прибавить нагрузки к портам, выберите Solution → Add load из 
главного меню или сделайте двойной щелчок на Loads в дереве. 

Комплексный импеданс состоит из постоянной реальной и мнимой части. 
Он может быть приложен к проводному порту, порту на ребре и 
микрополосковому порту. 

Нагрузка, которая состоит из последовательной или параллельной схемы, 
состоящей из резистора (R), конденсатор (C) и индуктивности (L), и может 
применяться только к проволочным портам. 

Для параллельной схемы полное сопротивление (рис. 7.27, справа), 
сопротивление или индуктивность принимаются равными бесконечности, когда 
установлены равными 0 (это не вносит вклад в полное сопротивление). 

 
Заметим, что если несколько нагрузок или источников с нагрузками 

приложены к тому же самому порту, они включаются последовательно. Это также 
относится к параллельной схеме, только в этом случае компоненты соединяются 
параллельно. 

 

 
Рис. 7.26. Диалог создания 

источника напряжения 
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Рис. 7.27. Создание различного вида импедансов  

 

7.9  Моделирование бесконечной земляной плоскости 
 

FEKO может учитывать влияние 
земляных плоскостей и выполнять 
моделирование схем на плоских подложках. 
Выберите Solution → Define infinite planes из 
главного меню, или дважды нажмите на 
Infinite planes в разделе Solution в дереве 
проекта, чтобы открыть (рис. 7.28) диалог 
Infinite planes (ground / planar substrates). 

Если выбрана опция Homogeneous (free 
space), то модель решается в свободном 
пространстве, без земляной плоскости. 

Земляные плоскости могут быть внесены 
двумя способами: используя приближённый 
коэффициент отражения от плоскости или 
точный интеграл Зоммерфельда. Плоскость 
земляной платы совпадает с плоскостью z=0. 

Среда выбирается из списка в разделе 
Ground medium (рис. 7.29). Этот список 
содержит все определяемые пользователем 
диэлектрические среды, и идеальные 
электрическую и магнитную плоскости для 
моделирования плоскости отражения 

(идеальные проводники не поддержаны в режиме земляной плоскости 
Зоммерфельда). В случае использования метода коэффициента отражения, 
компонента отражения добавляется при каждом расчете поля, поскольку интеграл 

 
Рис. 7.28. Диалог установки 

бесконечных плоскостей 
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Зоммерфельда устанавливает идеальное граничное условие, используя ю 
функцию Грина. Метод коэффициента отражения намного быстрее, но менее 
точен, и для реальных земляных плоскостей, все проводящие структуры должны 
быть расположены выше земляной платы более, чем на десятую часть длины 
волны. (Для идеально проводящего основания структуры могут быть соединены с 
основанием, но не ниже его). 
 

          
Рис. 7.29. Режимы установки земляной платы 

 
Метод интеграла Зоммерфельда позволяет иметь проводящие структуры 

внутри земли, но никакой элемент разбиения не может пересечь поверхность 
земляной платы. Она может быть соединена с элементом с другой стороны. 
Например, могут быть частично скрытые провода, если вершина находится в 
точке, где провод проходит сквозь поверхность земли. 

Если выбрана опция Planar Multilayerd Substrate (рис. 7.30), то можно 
задать материал и толщину каждого слоя в планарной конструкции. Задача 
решается тогда с использованием планарных функций Грина для моделирования 
слоистой структуры. Список Medium содержит все определяемые пользователем 
диэлектрические среды. 

Слои могут быть добавлены и удалены кнопками Add и Remove. 
Проводящие плоскости могут прибавляться сверху слоя 1 или ниже слоя Bottom, 
отмечая поля в группе Conducting ground planes. Заметим, что слой Layer 0 
бесконечно тонкий, и он игнорируется, если имеется проводящая плоскость 
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сверху слоистой структуры. Толщина слоя Bottom учитывается только в случае, 
если самая нижняя плоскость проводящая. Иначе этот слой простирается к 
бесконечности.  

Планарная конструкция всегда ортогональна к z оси и каждый новый слой 
кладется поочередно внизу. Плоские подложки используются без земляной платы 
в слоистой реальной модели, с земляной платой для микрополосковых линий и с 
обеими проводящими плоскостями в планарных конструкциях. 

 

 
Рис. 7.30. Многослойная подложка 

 
Сделайте щелчок правой кнопкой мыши на Infinite и выберите Show / Hide, 

чтобы переключить показ земляных плоскостей или слоев на вкл. и выкл. без 
использования изменения фактических установок. Заметим, что чертеж всегда 
показывается существующие установки. Это может несколько запутать, если 
бесконечная плоскость после этого изменяется, поскольку вид будет сохранять 
ранний просмотр вместе с существующей установкой. Поэтому рекомендует 
скрыть показ бесконечных плоскостей при редактировании структуры. 

7.10  Установка частоты 
Выберите команду Solution → Set frequency или дважды нажмите на 

Frequency в разделе Solution в дереве проекта, чтобы открыть диалог Solution 
frequency (рис. 7.31). Здесь имеются четыре опции установки параметров 
частотного диапазона. Режим Single frequency позволяет установить конкретную 
частоту решения. 
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Рис. 7.31. Задание частот расчета 

 
Если выбран режим Continuous (interpolated), (рис. 7.31), все требуемые 

результаты рассчитываются, используя адаптивные выборки в диапазоне частот 
от Start frequency до End frequency. Алгоритм выбора частотных точек 
использует лучший алгоритм частотных выборок для обеспечения точного 
расчета резонансных эффектов. Параметр Maximum number of samples 
ограничивает число решений или время расчета, но если это количество выборок 
будет выбрано недостаточным, результаты могут быть получены неточными.   

Параметр Minimum frequency increment используется для ограничения 
плотности создания частотных точек. Это полезно, если имеются небольшие 
расхождении результатов расчета.  

Используя опции Linearly spaced discrete points и Logarithmically spaced 
discrete points, можно задать фиксированное число точек между начальной и 
конечной частотой. В этом случае расчет будет выполняться с одинаковым шагом 
изменения частоты. 

7.11  Установка мощности источника 
Возбуждение антенны обычно задается источником напряжения, но можно 

задать и общую излучаемую мощность или мощность источника. В FEKO может 
выбрать коэффициент масштабирования, чтобы задать желательный уровень 
мощности. Выберите Solution → Specify power settings, или дважды щелкните 
Power в разделе Exitation, чтобы задать мощность источника (рис. 7.32). Заметим, 
что FEKO использует пиковую (а не среднеквадратичную) величину для всех 
комплексных величин.  
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Рис. 7.32. Установка мощности источника возбуждения 

 
Если выбрана опция No power scaling, FEKO вычисляет результаты с 

указанными величинами источников. Заметим, что плоские волны имеют 
бесконечную протяженность и поэтому бесконечную мощность. Следовательно, 
если модель содержит возбуждение плоской волны, нужно выбрать No power 
scaling. 

Если выбрана установка Total source power, FEKO выполняет расчет так, 
чтобы общая мощность источника (сумма мощностей, поставляемых всеми 
отдельными источниками) равнялась величине, указанной в поле мощности 
источника. Никакое рассогласование не учитывается. Эта опция может 
использоваться с любым возбуждением, кроме плоских волн. 

Если выбран режим Incident power (transmission line model), то считается, 
что все антенны запитываются линиями передачи с комплексным 
характеристическим импедансом Zo. Поле Source power определяет сумму 
падающей мощности от всех этих линий передач. Если имеется рассогласование 
между полным сопротивлением линии передачи и входным сопротивлением 
антенн, часть падающей мощности будет отражена назад к источнику. Это – 
следствие рассогласования. Эта опция может использоваться только в том случае, 
если модель содержит только генераторы напряжения. 

FEKO всегда вычисляет полную мощность всех источников для всех 
решений. Для больших моделей или моделей со многими источниками расчет 
взаимной связи, которая требуется для точного расчета соотношения мощностей 
источников, может быть очень длительный. Если все источники развязаны,  
взаимная связь не рассматривается при вычислении мощности источника. Это 
приемлемо для источников, которые расположены относительно далеко друг от 
друга и от других структур в модели, или когда не требуются точные значения 
мощности (усиление антенны и направленность основаны на мощности, и они, 
вероятно, будут неточными, если установлен этот режим). 
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7.12  Выбор требуемых результатов расчета 
 

Дерево проекта содержит список 
рассчитываемых характеристик. Они 
перечислены в разделе Calculation (рис. 7.33). 
Эти результаты рассчитываются для всех 
частот с заданными нагрузками и 
возбуждениями. Некоторые требуемые 
характеристики могут быть скрыты, 
переименованы и удалены (кроме токов). Они 
могут быть также установлены двойным 
кликом на них, или выборе Properties из 
всплывающего меню. 

Каждая характеристика отмечается 
меткой Label, которая используется, чтобы 
идентифицировать запрос в CADFEKO и для 

показа этой характеристики в POSTFEKO. 

7.12.1  Расчет токов на металлических поверхностях 
Двойной клик на Currents в разделе Solution (или выбором Current output 

из меню) дает возможность выбора режима вывода тока в выходной файл 
(рис. 7.34). Эта опция требуется для показа распределений тока на поверхности, 
но это может приводить к большим выходным файлам. Если выбрана опция 
Export currents to *.out file, токи записываются в файл *.out. 

Если отмечена опция Export currents to ASCII file, токи записываются в 
файл с расширением *.os. 

 

                        
Рис. 7.34. Диалог задания расчета токов на металлических поверхностях 

 

7.12.2  Расчет S-параметров 
Если в результате решения задачи необходимо вывести S-параметры, то в 

разделе Calculation нужно выбрать команду Request S-parameters. Диалог 

 
Рис. 7.33. Выбор 

рассчитываемых характеристик 
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Request S-parameters (рис. 7.35) содержит таблицу, в которой можно задать 
порты и импедансы каждого порта. Если отмечается режим Active в таблице, то 
порт используется как источник. Иначе этот порт служит только для приема 
сигнала. Например, если список содержит два порта и активен только порт 1, 
FEKO вычислит S11 и S21, но не S12 и S22. Если активен также порт 2, также 
рассчитываются S12 и S22. Кнопки Add и Remove позволяют прибавлять или 
удалять порты в списке. Если выбрана опция Export S Parameters to Touchstone 
file, рассчитанные S-параметры записываются в файл *.snp. 

 
 

При расчете S-параметров FEKO 
нагружает все порты указанными 
импедансами. Эти нагрузки обычно 
остаются как нагрузки портов, после 
вычисления S-параметров. В режиме 
Restore loads after calculation нагрузки 
после расчета S параметров удаляются. 
Восстановление нагрузок требует 
полного расчета матрицы и LU 
декомпозиции в методе моментов. Это – 
обычно самый длительный шаг в 
анализе. 

 
 
 
 

 
 

7.12.3 Расчет характеристик антенны в дальней зоне 
 

В закладке Position диалога расчета дальнего поля (рис. 7.36) можно 
выбрать одну из двух опций: расчет поля в направлении излучения во все 
стороны, и расчет поля в направлении плоской падающей волны. В последнем 
случае направление падения используется вместе с возбуждением плоской волны 
с несколькими падающими направлениями, главным образом, чтобы вычислить 
эффективную поверхность рассеяния (RCS). В этом случае никакие параметры в 
закладке Position не требуются, поскольку рассеянные поля рассчитываются 
только в обратном направлении к падающей волне. Если эта опция выбрана, 
модель должна содержать возбуждение плоской волны с несколькими 
направлениями падения. Иначе программа даст ошибку во время решения. 

 

 
Рис. 7.35. Диалог задания расчета 

 S- параметров 
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Рис. 7.36. Диалог дальнего поля когда задан расчет полей 

 
Если выбран режим Calculate field as specified, то задаются начальный и 

конечный углы, а также шаг угла для каждой угловой оси. CADFEKO вычисляет 
и выводит дальнее поле в этих точках. Фактические конечные углы зависят от 
начальных углов, количества точек и приращений, и могут не совпадать точно с 
указанными конечными углами. 

Когда для обоих угловых параметров число приращений больше 1, FEKO 
вычисляет также интеграл вектора Пойнтинга (то есть полную мощность 
излучения) через сегмент, заданный начальным и конечными углами также как 
вторым сектором, который расширяет приращение наполовину всюду вне 
указанного диапазона. Это нужно для ликвидации неоднозначности в 
определении замкнутых поверхностей в сферических координатах. Полный срез 
по углу φ выполняется от 0 до 360, но последнее направление соответствует 
первому. 

Закладка Coordinates позволяет установить начало координат Origin для 
расчета полей. Это обеспечивает позицию опорной фазы. 

В закладке Advanced можно выбрать расчет усиления и направленности. 
POSTFEKO может показывать оба результата, независимо от этой установки – эта 
установка управляет только тем, что записывается в файл *.out. 

Если отмечено поле Export fields to ASCII file, результаты экспортируются 
в файл с расширением *.ffe. Этот файл может использоваться другими 
постпроцессорами или как модель для диаграммы направленности излучения 
точечного источника или приемной антенны. Если отмечены поля Export fields to 
*.out, то поля записываются в файл *.out. Если отмечено Calculate only the 
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scattered part of the field , излучение из приложенных источников (типа 
электрических и магнитных точечных источников) игнорируется, оставляя только 
рассеянные поля. (Для источников плоской волны вклад источника всегда 
игнорируется.) Обычно эту опцию не нужно включать. Если задано излучение 
мощности поля в дальней зоне интегрированием Only determine radiated far field 
power by integration, рассчитываются поля в дальней зоне и полная мощность 
излучения, но поля не записываются в файлы *.bof и *.out. (поля в дальней зоне 
записываются только в файл *. ffe). 

7.12.4  Расчет ближнего поля 
Чтобы вывести ближнее поле на плоскость, нужно задать параметры этой 

плоскости в закладке Position (рис. 7.38), где вводится начальное, конечное 
положения и шаг приращения по каждой оси. CADFEKO вычисляет и показывает 
значения ближнего поля в каждом направлении. Конечное положение зависит от 
начальной позиции, числа отсчетов и приращения и может точно не совпадать с 
указанным конечным положением. В результате предварительного просмотра 
можно видеть сетку маркеров в указанном диапазоне. 

Закладка Coordinates используется для выбора системы координат. Origin 
определяет начало системы координат. В этом случае ближние поля 
рассчитываются на сферической поверхности вокруг точки Origin. 

В закладке Advanced (рис. 7.39) можно выбрать опции поля (Fields) и 
потенциалов для расчета. Если отмечены поля Export to file ASCII, расчетные 
электрические поля записаны в файл *.efe, а магнитные поля – в файл *.hfe. 

 

 
Рис. 7.38. Закладки Position для расчета ближнего поля в растре антенны 
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Рис. 7.39. Закладка Advanced расчета ближнего поля 

 
Эти файлы в формате ASCII могут использоваться другими 

постпроцессорами или как данные апертурного источника. Если отмечен режим 
Export to file *.out, в файл  *.out записываются поля. 

Если отмечен режим Calculate only scattered part of the field, вклад 
излучения из приложенных источников (типа электрических и магнитных 
точечных источников) игнорируется, и остаются только поля рассеяния. Обычно 
эта опция не отмечается. 

 
 

7.12.5  Уровень поглощения мощности в среде 
 

Удельная мощность поглощения в объеме (SAR) чаще всего рассчитывается 
как величина, усредненная в объеме (Volume-average SAR) или как 
максимальное поглощение в 1 г/см3 или 10 г/см3 в заданном объеме пространства 
(Spatial-peak SAR). Эта характеристика может быть выбрана в группе Select 
calculation в диалоге Request SAR (рис. 7.40). 
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Рис. 7.40. Диалог расчета SAR 

 
Для расчета SAR нужно задать область анализа. Это может быть вся 

модель, или области с определенной  средой, в плоской подложке или в указанной 
точке пространства. Последние две опции не задаются для расчета параметра, 
усредненного по объему. Для случая среднего значения в объеме и 
максимального SAR рассчитан отдельно для каждой среды, таким образом, это не 
то же самое, что выбор Entire model. Точно так же для опции In planar substrate 
пользователь может выбирать удельный уровень. Уровень 0 – верхняя область 
свободного пространства, уровень 1 – верхний диэлектрический уровень и т.д., 
или можно выделить всё уровни. 

 

7.13  Анализ кабельных линий 
В FEKO имеется возможность анализа связи кабельных линий со сложной 

проводящей структурой. Диалог установки параметров расчета кабеля вызывается 
по команде Solution → Request cable analysis. В закладке Cable path кабель 
определяется как серия сегментов прямой линии. Точки углов могут быть 
вставлены или удалены кнопками Add и Remove. Если начальная точка 
используется вначале, то последняя определяется в списке (рис. 7.41). Новая 
точка добавлена автоматически. Можно пересекать тракт (и пересекать другие 
кабельные тракты), но не должно быть никакого электрического контакта в этих 
точках пространства. 
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Рис. 7.41a. Две линии передачи с 
различными нагрузками 
установлены на металлической 
земляной плате конечного размера 

Рис. 7.41 б. Индуцированные токи на 
4 портах связанных линий передачи 

 
В закладке Cable Properties (рис. 7.42) можно выбрать заранее заданный 

тип кабеля или определять свойства кабеля вручную. (Заметим, что расчет 
кабелей в настоящее время ограничен частотами от 10 кГц до 500 МГЦ.) Во время 
расчета FEKO разбивает кабель на сетку в виде дискретных сегментов. 
Остальные размеры могут быть изменены в группе Sampling Density (рис. 7.42б). 

 
Можно задать импедансы нагрузок между двумя проводниками кабеля, а 

также между кабелем и самыми близкими проводящими структурами в каждом 
порте в закладке Port Terminations (рис. 7.43). 

 
Результат анализа кабеля – это напряжения, токи, полное сопротивление и 

мощность между внутренним проводом и оплеткой кабеля. Эти данные 
отображаются в POSTFEKO на графике. Заметим, что FEKO вычисляет связь с 
кабелем, но присутствие кабеля не обязательно принимается во внимание в 
вычислении  

 
Многие вопросы электромагнитной совместимости решаются, учитывая 

кабели, которые либо излучаю через неидеальную оплетку, либо воздействуют на 
другие линии, устройства и антенны, которые принимают излучения. Вызванные 
такими возмущениями напряжения и токи могут привести к неправильной работе 
системы. Как источники шума, кабели и линии в современных системах играют 
доминирующую роль (напр. современный автомобиль имеет несколько 
километров кабеля), поэтому необходимо уже на процессе проектирования знать 
излучения в широком диапазоне частот. FEKO представляет инженерам 
инструмент для решения проблемы электромагнитной совместимости с учетом 
кабелей. 
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Рис. 7.42a. Построение пути кабеля по 

точкам 
Рис. 7.42б. Задаваемые параметры 

кабеля 
 

 
Рис. 7.43. Диалог задания нагрузок на портах кабельных систем 
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7.14 Приемная антенна 
При применении в проекте приемных антенн FEKO должен вычислить 

мощность, принятую изотропной антенной с заданной диаграммой 
направленности. Считается, что антенна согласована (т.е. нет потерь на 
рассогласование); и расположена только в точке; и модели не взаимодействуют 
для разных фаз решения (никакая связь не учитывается). Приемная антенна 
обратима к точке источника с указанной моделью и параметрами (рис. 7.44). 
 

 
Рис. 7.44. Параметры идеальной приемной антенны 

 
Рассчитанная полученная мощность может быть выведена на график Power 

data в POSTFEKO. 
 

Итак, в этом разделе были проанализированы установки, которые 
выбираются пользователем при подготовке запуска на счет: порты, установки 
частот анализа, записи в файлы полученных данных, выбор рассчитываемых 
характеристик и т.д. 
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8  ПРОГРАММА ПОСТПРОЦЕССОРНОЙ ОБРАБОТКИ ДАННЫХ 
POSTFEKO ВЕРСИИ 6 

 
POSTFEKO используется для проверки разбитой на сетку геометрии и 

анализа результатов расчета. Проверка правильности разбиения геометрии на 
сетку делается так, чтобы пользователь мог убедиться, что модель корректна, 
прежде чем запустить моделирование. Это особенно полезно, когда модели 
создаются, используя EDITFEKO, но важно и при моделировании в CADFEKO. 

Вывод результатов расчета – другая функция POSTFEKO. Как только 
структура была промоделирована, POSTFEKO может использоваться, чтобы 
вывести на экран и рассмотреть результаты (рис. 8.1). Множество инструментов 
доступно, чтобы помочь визуализировать данные конструктивным способом. 

 

 
Рис. 8.1. Интерфейс программы POSTFEKO версии 6 

 
Несколько моделей с их геометрией (в файлах *.fek) и результатами (в 

файлах *.bof) могут быть выведены на экран в одном сеансе проекта POSTFEKO. 

8.1  Интерфейс POSTFEKO 
Интерфейс POSTFEKO (рис. 8.1) состоит из панели меню, области 

просмотра в середине, браузера проекта слева (Project Browsers) и палитры 
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управляющих элементов, расположенной справа. Лента меню используется, 
чтобы управлять представлениями, их содержанием, и инструментами, которые 
используются для того, чтобы выводить рассчитанные данные на графики. 
Область просмотра может содержать несколько 2D и 3D графиков, каждый с 
собственными контекстно-зависимыми ленточными вкладками. Браузер проекта 
скрыт по умолчанию, но может быть показан командой View → Window → 
Project, и обеспечивает дополнительную информацию о проекте и деталях 
модели. Список рассчитанных характеристик и данных позволяет пользователю 
выбирать компоненты результатов расчета, которые должны быть выведены на 
экран. 

Меню POSTFEKO – основной инструмент управления. Данные 
добавляются или на двумерные графики, или на трехмерные виды. Графики могут 
быть в прямоугольной системе координат, на диаграмме Смита, в системе 
полярных координат и т.д. Когда выбран какой-либо из этих типов вывода, лента 
меню (рис. 8.2) изменяется так, чтобы показать  возможности, которые относятся 
к этому типу представления, и контекстные вкладки, принадлежащие выбранному 
представлению, отмечая их цветной панелью выше. 

 

 
Рис.8.2. Меню POSTFEKO на закладке Home 

 

Представления снабжаются 
вкладками, но могут быть 
перестроены, изменением 
настройки окна во вкладке View 
(рис. 8.3). Контекстно-зависимые 
ленточные вкладки позволяют 
пользователю управлять работой 
по настройкам осей, заголовкам и 
выполнять другие настройки. 

На правой стороне 
интерфейса POSTFEKO 
показывается набор (палитра) 
результатов расчета (рис. 8.4). 
Когда результат добавляется к 
представлению, он добавляется в 
списке наверху панели.  

 
Рис. 8.3. Поле просмотра характеристик 

POSTFEKO 
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Выбранное решение тут же 
выводится на экран. Для выбранного 
результата имеется возможность 
разрезания структуры, когда 
пользователь может предоставить 
более определенную информацию о 
типе данных, которые должны быть 
выведены на экран. Только свойства, 
которые важны для этого результата, 
заполняются в палитре. Палитра 
будет тогда выглядеть по-разному 
для каждого типа результата, 
который может быть выведен на 
экран. 

Панель браузера проекта может 
быть выведена на экран, чтобы 
обеспечить больше управления 
сеансом проекта (рис. 8.4). Это 
обеспечивает дополнительную 
информацию о текущем проекте, 
моделях в проекте и компонентах 
модели. Панель Project Browser 

перечисляет все модели, которые загружаются в текущем проекте, так же как и 
всех сохраненных или импортированных данных. Браузер Model показывает все 
свойства данной модели, включая детали относительно всех конфигураций 
решения, детали оптимизации и объединенные данные. 

Раздел Details Browser (рис. 8.4) слева снизу показывает различные детали 
характеристики модели, выбранной в браузере. 

8.2  Закладки меню POSTFEKO 

Верхняя линия меню делится на два класса, а именно, «закладки по 
умолчанию» и «контекстно-зависимые вкладки». Закладки по умолчанию 
содержат средства управления и инструменты, которые применимы ко всем типам 
представления и обеспечивают центральную точку для того, чтобы она управляла 
приложением. Для каждого типа представления также существуют контекстно-
зависимые вкладки, которые содержат все средства управления и инструменты, 
которые применимы к только этому представлению. Вообще, путь, которым 
пользователь работает с 3D представлением, отличается от того, когда 
пользователь работает с графиком. 

8.2.1  Закладки по умолчанию 

Закладки в POSTFEKO по умолчанию включают: 

 
Рис. 8.4. Браузер POSTFEKO v 6 
(слева) и палитра рассчитанных 
данных (справа) 
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 Home: Эта группа наиболее распространенных действий. В этой вкладке 
можно запустить большинство основных операций, включая: управление 
файлами и проектами, добавление новых представлений, добавление 
результатов к представлениям и запуска приложений комплекта. 

 Format: Настройки шрифта, опции цвета (например, поле легенды или 
цвета фона графика), настройки линий, настройки маркеров и настройка 
падающей тени легенды. 

 Animate: Доступ к настройкам анимации, включая анимации фазы, частоты, 
ракурса, и т.д., настройкам экспорта и опции. 

 View: Установки всех окон просмотра данных. Окна могут быть размещены 
рядом, расположены каскадом, быть перекрытыми и т.д. Браузер видимости 
проекта и палитры результатов также могут быть установлены. Диалоговое 
окно Transform view (рис. 8.5) может использоваться, чтобы вручную 
отредактировать положения структуры. 

 
 

Рис. 8.5. Диалог трансформации вида 
 

Величины углов в разделе View direction (рис. 8.5) устанавливаются так, 
чтобы рассмотреть объект под любым углом. 

 
8.2.2  Контекстно-зависимые закладки 

Контекстно-зависимые вкладки зависят от вида представления данных, и 
они уникальны для каждого трехмерного и двухмерного представления. В 
зависимости от того какой тип представления выбран, делается доступным 
соответствующий набор операций. Это означает, что доступны только те 
действия, которые относятся к текущему выбору.  
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8.2.2.1  Контекстно-зависимые вкладки 3-D вида 

Закладки, которые появятся (рис. 8.6) когда 3-D представление будет 
активным: 
 

 Display: Настройки визуализации для модели. Визуализация объектов 
модели может быть установлена, включая бесконечные плоскости, легенды, 
симметрию, периодические граничные условия и т.д. Инструменты, такие 
как шкала полутонов и плоскость сечения (cutplanes) также доступны. 
Представления могут также быть дублированы или экспортированы от этой 
вкладки. 

 Mesh: Все настройки, имеющие отношение к визуализации сетки разбиения, 
могут быть здесь установлены. Это включает опции окраски и опции 
непрозрачности, а также настройки видимости для каждого  элемента сетки 
разбиения. Здесь также имеются инструменты, такие как измерение 
расстояния, или  элементы сетки, выделение определенных методом 
решения или проверки качества сетки.  

 

 
Рис. 8.6.Интерфейс POSTFEKO с закладкой Home 

 
 Result: Настройки представления выбранного результата расчета. Этот 

список включает настройки видимости, такие как непрозрачность, 
видимость поверхности/сетки, опции цветов и т.д. Требуемые точки могут 
также быть выведены на экран с результатами, на экран могут быть 
выведены стрелки, и все настройки представления лучей распространения 
электромагнитных волн. Можно добавить новые результаты к 
представлению из вкладки Result, скопировать выбранный результат или 
сохранить копию результата текущего проекта для использования и вывода 
на график в другом проекте. 
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8.2.2.2  Контекстно-чувствительные закладки 2D представлений 

Все двумерные графики (то есть декартовая система координат, полярные 
диаграммы и диаграммы Смита) имеют закладки Display и Trace. Параметры 
настройки немного отличаются, но основные функции те же самые. 

 Display: закладка Display позволяет пользователю сделать дублирование 
представления или генерацию эквивалентных копий графика в различном 
формате; редактирование текста диаграммы (например заголовка или меток 
на осях); установку серой шкалы, редактирование условных обозначений, 
осей и настройку сетки разбиения графика; добавление курсоров и экспорт 
данных. Вообще, все параметры настройки, имеющие отношение к 
представлению, могут быть установлены в этой закладке. 

 
 Trace: Дублирование, вывод характеристик, полученных с помощью 

математических действий, создание копий, установки параметров 
настройки характеристик (то есть установки рисунка и выборок), 
масштабирование осей и единиц. Функциональные возможности для 
редактирования и форматирования линий, формирование маркеров и 
создание рассчитанных по математическим выражениям характеристик, 
также повторяются здесь для удобства. 

8.3  Системные операции 
Наряду с инструментальными средствами, которые управляют 

отображением данных, POSTFEKO также имеет набор средств, которые 
работают на системном уровне. Эти инструментальные средства включают 
сохранение и загрузку проектов, анимацию результатов или моделей в 
трехмерном представлении, импортирование и экспорт данных, и сохранение 
данных для дальнейшего использования. 

8.3.1  Кнопки управления и инструменты быстрого расчета 

Кнопки зеленого цвета – это набор наиболее часто используемых 
системных операций, которые позволяют вывести график, выполнить 
модификации, выбрать опции, параметры, показать справку и информацию 
версии POSTFEKO. Также доступен список последних используемых файлов. 

На рис. 8.7 показывается всплывающее 
меню, и оно не зависит от состояния ленты. Его 
можно сравнить с набором команд по кнопке 
START системы Windows. 

Инструментальная панель иконок быстрого 
доступа содержит некоторые операции с 
проектами (New project, Save, Undo и Redo) для 
выполнения их одним щелчком без необходимости 
выбирать операцию в меню. 
 

 
Рис. 8.7. Всплывающее 

меню POSTFEKO 
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8.3.2  Сохранение и загрузка проектной сессии 

Сохранение данных выполняется командами Save или Save As…, в 
зависимости от того, должно ли имя файла быть определено. Окончательный 
проектный файл имеет расширение *.pfs и сохранит все параметры настройки и 
ссылки, чтобы сохранить файлы, которые были представлены. 

 

 
 

Чтобы загрузить сохраненный проект или загрузить модель в 
существующий проект, можно использовать зеленую кнопку в верхнем левом 
углу, нажатие которой обеспечит загрузку модели, а также покажет список 
файлов, к которым пользователь обращался. Кнопка Open project в закладке 
Home восстановит сохраненный проект POSTFEKO. И к моделям и проектам 
также можно обращаться на начальной странице. 

8.3.3  Анимация 

Во время анализа результатов расчета часто используется просмотр в 3D 
виде и изменение свойств во времени. Анимация выполняется при изменении: 

 Фазы(Phase) 
 Частоты (Frequency) 
 Вращения по углу φ (Phi rotate) 
 Вращения по углу θ (Theta rotate) 
 Вращения по обоим углам φ и θ (Theta & Phi) 

 
Например, токи или ближние поля 

могут быть анимированы по фазе или при 
изменении другой характеристики, которая 
рассчитывалась в непрерывном или 
дискретном диапазоне частот. Любая 
трехмерная модель может быть анимирована 
по углам Theta или Phi, что не требует 
дополнительных установок. Рис. 8.8 
показывает диалог, где эти настройки можно 
изменить. 

Анимация при изменении мгновенной 
фазы дает возможность видеть, как 
результаты изменяются во времени. Можно 
показать результаты на нескольких частотах, а 

также на определенной частоте. 

 
Рис. 8.8. Диалог установки 

анимации 



175 
 

8.3.4  Импорт и экспорт 

В POSTFEKO возможны импорт и экспорт данных. Импорт может 
выполняться из файлов текстовых данных, а также данных, который 
сгенерированы FEKO, но не включены в файле результатов модели. Расчетные 
данные могут также экспортироваться для внешней обработки или для 
использования в другом проекте (рис. 8.9). 

 

 
Рис. 8.9. Диалог для выбора (спецификации) столбцов во время импорта 
 

8.3.4.1  Импорт данных 

Данные, которые могут быть импортированы, включают графические 
файлы POSTFEKO (файлы с расширением *.pfg), файлы рассчитанного поля 
FEKO: электрические поля (*.efe); магнитные поля (*.hfe) и дальние поля (*.ffe). 

Эти файлы имеют вид ASCII файла с данными. Для этих файлов 
пользователем должны быть определены форматы данных для импорта. Данные, 
которые были импортированы, могут быть добавлены к 2D графику так же, как и 
любой результат. Для этого есть кнопка Imports в группе Add Results. Браузер 
проекта имеет возможность импорта сохраненных данных, а также удаления 
импортированных данных, если они больше не нужны. 

Для импорта необработанных данных должен быть определен шаблон 
импорта. Необходимо определить, как столбцы данных разделяются (то есть с 
вкладками, пробелами, запятыми, и т.д.), в читаемых строках и присутствуют ли 
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заголовки столбца. Раздел предварительного просмотра покажет, где столбцы 
разделяются и какие у них заголовки. 

Как только формат определяется, пользователь должен определить, какие 
данные содержит каждый столбец. Метка может быть определена, наряду с 
любыми параметрами масштабирования (например, если данные находятся в дБ 
вместо линейного представления, или МГц вместо Гц, и т.д.). Рис. 8.10 
показывает диалоговое окно импорта, где эти свойства определяются. 

 
Для каждого столбца может быть определена его структура, наряду с 

большим количеством деталей относительно определенного содержания данных: 
 Axis (scalar): Если столбец будет использоваться в качестве независимой 

оси на 2-D графике, должна быть выбрана эта опция. По оси Х может 
изменяться частота, положение, радиус, угол или определяемые 
пользователем величины. 

 Scalar: Может использоваться любой скалярный тип результата. Доступные 
величины включают: 

 Дальнее поле, ближнее поле, напряжение, ток, мощность, SAR, 
импеданс/проводимость, S-параметры, осевое отношение, 
усиление/направленность антенны, радарное поперечное сечение RCS, 
КСВ, коэффициент отражения, определяемые пользователем величины и 
несколько других типов данных. 

 Комплексное число (реальная + мнимая части): Если два смежных столбца 
содержат реальные и мнимые компоненты комплексного числа, нужно 
выбрать эту опцию. 

 Complex pair (Real + Imaginary): Когда эта опция выбрана, два смежных 
столбца содержат величину и фазу (в градусах) комплексного числа. 
Комплексными числами могут быть описаны следующие характеристики: 

 Дальнее поле, ближнее поле, напряжение, ток, импеданс/проводимость, S-
параметры, коэффициент отражения, или величины, определяемые 
пользователем. 

8.3.4.2  Экспорт данных 

 Операция Export Data возможна для: 

 Экспорта изображения текущего вида (2D или 3D) 
 Экспорт файла анимации (только 3D) 
 Экспорт данных в текстовом формате (только 2D) 

При экспорте изображения текущего представления, будет сохранена любая 
визуальная копия, которая содержит представление. Пользователь должен 
определить место сохранения файла, имя файла, формат изображения и 
разрешающую способность изображения (рис. 8.10). 
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Рис. 8.10. Диалоговые окна экспорта анимации (слева) 
 и экспорта изображения (справа) 

 
Экспорт анимированных графиков аналогичен экспорту изображения. Для 

мультипликаций должны быть определены размещение файла, имя файла, формат 
файла, качество экспортируемых данных, разрешающая способность 
видеосигнала и скорость изменения рамки (framerate). 

Для экспорта данных в двумерных графиках требуется только место 
размещение файла и имя файла. Если, однако, экспортируются непрерывные 
данные, должно также быть определено число точек. 

 

8.3.5  Запоминание данных и использование сохраненных данных 

Можно сохранить копию большинства расчетных результатов в проекте для 
более позднего использования. Сохраненный результат не будет меняться при 
изменении модели, он полезен, как опорное значение относительно будущих 
данных. 

 
К хранившим данным можно получить 

доступ так же, как и от данных в файле 
(рис. 8.11). Можно добавить в меню новый 
ввод для занесенных данных в виде Stored 
data. 

В общем, все результаты, которые могут 
быть подготовлены для вывода на 2D график, 
могут быть сохранены. Результаты, которые 
не могут быть сохранены, это: пути кабелей, 
оценки ошибок, импортированные данные, 
лучи, уже сохраненные данные, токи и 
заряды. 

 

 
Рис. 8.11. Вызов сохраненных 
данных дальнего поля из меню 
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8.4  Запуск POSTFEKO 
POSTFEKO может быть запущен из командной строки, двойным кликом на 

значке POSTFEKO, или запуском POSTFEKO из других программ типа 
CADFEKO или EDITFEKO. Если пиктограмма программы используется, чтобы 
запустить POSTFEKO, то никакие модели не будут загружены, и будет 
показываться начальная страница. Старт POSTFEKO из других приложений 
автоматически загрузит модель в новый проект. 

Метод командной строки дает пользователям выбор относительно того, как 
они хотели бы запустить POSTFEKO. Если модель (или набор моделей) 
определена, то она будет добавлена к новому проекту; иначе будет дан пустой 
проект. Параметры командной строки могут использоваться, чтобы определить 
дополнительные параметры при запуске POSTFEKO. 

Запуск POSTFEKO из командной строки аналогичен запуску с рабочего 
стола. Никакие модели при этом загружены не будут, будет представлен чистый 
проект.  

 
Отметим, что только файл *.pfs может быть только один, и что аргумент 

файла *.out только покажет сообщение, указывающее, что файлы *.out не могут 
быть загружены непосредственно. Также: 

- Заряды, токи и оценки ошибок на треугольниках сетки не могут быть 
нанесены на 2D графиках 

- Только данные, которые изменяются по углу, могут быть выведены на 
полярную систему координат.  

В группе Display →Duplicate group каждый график имеет опцию для 
дублирования (рис. 8.12 а), или создания другого типа графика (рис. 8.12, b, c, d) 
на основании этого же набора данных. 

 
 

Рис. 8.12. Кнопки: (a) дублирование вида, (b) Cartesian copy, (c) Polar copy  
и (d) Smith copy 

 
Например, можно дублировать график на прямоугольной системе 

координат (рис. 8.12 a), создать копию полярного графика (рис. 8.12 c), или 
создать копию диаграммы Смита (рис. 8.12 d), которая содержит те же самые 
данные. Если характеристики на исходном графике будут несовместимы с 
выбранным графиком, то будет дано сообщение об ошибке с пояснениями 
нужных требований. 
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8.4.1  Управление проектами и моделями 
POSTFEKO может управлять несколькими моделями одновременно в 

одном проекте. Модели могут быть добавлены к проекту, путем клика на кнопке 
Add Model, используя стартовую страницу, или открывая POSTFEKO с файлом 
модели (например, запуская POSTFEKO из CADFEKO). 

 

 
Рис. 8.13. Управление проектами 

 
Чтобы добавить файлы новой модели к проекту, щелкните на кнопку Add 

Project. Модели могут также быть добавлены к проекту из последнего списка 
файлов на стартовой странице. Проект может быть сохранен для дальнейшего 
использования, независимо от того, создавалась одна модель или несколько. 
Команды Save Project или Save позволяют задать новое имя текущего проекта. 
Эти проекты имеют расширение *.pfs. 

8.4.2  Добавление результатов для просмотра 
Результаты для просмотра могут быть добавлены в 2D или в 3D графики. 

POSTFEKO активирует кнопки только для тех результатов, которые 
присутствуют в текущей модели или проекте. Клик по кнопке результата покажет 
список всех результатов того типа, которые могут быть добавлены к текущему 
представлению. Заметим, что трехмерное представление всегда связывается с 
определенной конфигурацией для одной модели. На графики, однако, могут быть 
добавлены любые имеющиеся данные для всех загруженных моделей. 

  Far fields:    Добавление результатов дальнего поля. 

 Near fields:    Добавление ближнего поля 

   Error estimates:  Показ оценки ошибок на 3D виде 

   Currents   Добавление токов  

  Rays    Добавление лучей на 3D вид. 

   Sources:   Добавить источники на представление. 

   Loads/Networks:   Добавить данные нагрузки и цепи на    
    преставление. 

  S-Parameters  Добавление параметров рассеяния     
     (S-параметров). 
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  Power:    Добавление данных о мощности источника. 

   Imported data:    Добавление импортируемых данных    
    на имеющийся график. 

   Optimisation  Добавление результатов оптимизации    
    на графики 

    Receiving antenna:   Добавление данных приемной антенны. 

 Standard absorption rate (SAR):  Добавление расчета удельной   
      мощности  поглощения (SAR). 
 

На трехмерных представлениях можно показать: дальние поля, ближние 
поля, оценки ошибок, токи и лучи. В случаях, когда SAR рассчитан в заданной 
точке пространства, может также быть показан SAR. 

Прямоугольные графики могут содержать все данные, за исключением: 
оценки ошибок и токи на сетке разбиения на треугольники. Полярные графики 
могут содержать данные, когда независимая ось идет под углом, и вывести 
результаты, которые изменяются при изменении Theta или Phi. На диаграммы 
Смита можно вывести данные в виде комплексных чисел, такие как импедансы 
или S-параметры. Для всех 2D графиков возможно импортировать данные, 
которые соответствуют табл. 8.2. 
 
Табл. 8.2: Графики, на которые могут быть нанесены различные результаты 
расчета 

Тип результата Декартовая 
система 

координат 

Диаграмма 
Смита 

Полярная 
система 

координат 
Данные проводного 
сегмента 

X   

Дальние поля X  X 
Импедансы X X  
Нагрузки X   
Ближние поля X  X 
Цепи X   
Мощность X   
Источники X X  
S-параметры X X  
Результаты оптимизации X   

 
Можно преобразовать один график в другой, если данные совместимы с 

выводимыми на них характеристик.  



181 
 

8.4.3  Анимация 3D данных 

Анимация может быть выполнена с помощью изменения какого-либо 
параметра по времени. Параметры, которые могут изменяться при анимации: 
фаза, частота и ракурс. Анимация фазы и частоты требует наличие результата, 
который изменяется по этим параметрам. Анимация ракурса требует присутствия 
геометрии. Ракурс может быть анимирован только по phi, только по thеtа, или 
thеtа и phi одновременно. 

Результаты, на которые будут влиять изменения частоты и фазы, должны 
быть добавлены к представлению и сделаны видимыми. Для анимации ракурса 
требуется только геометрия. Убедитесь, что корректный тип анимации 
выбирается кнопками Type на вкладке Animate→Animation (рис. 8.13). 

Нажатие кнопки  запускает анимацию. Скорость, с которой переменная 
анимации может меняться, управляется кнопками Faster (быстрее) и Slower 

(медленнее). Выбор кнопки  удалит описание внизу экрана. 
Дополнительные настройки анимации позволяют более точно задавать 

скорость и разрешение, с которым переменная меняется. Каждое свойство 
определяет частоту изменения кадров в секунду. Например, Phase (t/s)=30 
означает, что фаза увеличится на 30 каждую секунду, и пройдет полный цикл 
360 через 12 секунд. Аналогично задаются и другие свойства. 

 

 
 

Рис. 8.13. Опции анимации 
 

Отметим, что для модели, которая рассчитывалась в непрерывном 
диапазоне частот, необходимо перевести непрерывный режим на режим с 
дискретными шагами. Комбинация Frequency (points/s) и Continuous frequency 
(# of points) определит разрешение выборки и скорость анимации. 

Экспорт анимации также возможен. Фильмы могут быть сохранены в 
форматах *.avi, *.mov, или *.gif. Установка качества влияет на степень сжатия для 
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указанного размера экрана. Для очень высококачественного экспорта 
рекомендуется максимально уменьшить размер экрана и установить повышенное 
значение параметра Export quality. Установка частоты кадров будет влиять на 
«плавность» анимации. 

8.4.4  Использование 2D графиков (Cartesian, Smith and polar) 

Имеется три типа графиков, которые можно вывести в POSTFEKO, а 
именно: график в декартовой системе координат, полярную диаграмму и 
диаграмму Смита. Однако для каждого графика могут иметься некоторые 
параметры, которые относятся данной диаграмме (таблица 8.2). Закладка Trace 
относится ко всем графикам и обеспечивает контроль над стилем графика данных. 

8.4.4.1  Закладка Display 

Группа Duplicate дает возможность сделать копию текущего графика 
(рис. 8.1a). Просто дублирование представления даст одну копию текущего 
представления, со всеми параметрами настройки (исключая курсоры). 
Функциональные возможности также обеспечивают получение графиков 
различного типа от текущего графика (рис. 8.1 b, c, d). 

Любой текст (кроме текста для записей 
легенды) может быть установлен в группе 
Display с текстовой кнопкой Chart. Другие 
возможности, предоставленные группой, 
включают регулировку представления шкалы 
Greyscale или добавление сетки Minor grid (то 
есть будут добавлены дополнительные линии 
сетки между существующими).  

Названия графиков могут быть добавлены 
или в заранее заданные положения, или 
вручную, выбирая положение и используя 
варианты, имеющиеся в группе Legends (рис. 
8.14). Ввод легенды для выбранной 
характеристики может также быть изменен 
кнопкой Trace. 

Легенды могут быть добавлены или к 
предопределенным положениям, или вручную 
выбирая местоположение, используя 
инструменты из группы Legends. Ввод легенды 
для выбранной характеристики может также 
быть изменен с помощью текстовой кнопкой 
Legends. 
 
 
 

 

 
Рис. 8.14. Команды выбора 

положения легенды 
 (описания графика) 
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8.4.4.2  Группа осей Axes 

Группа Axes предназначена для управления графиками в декартовой 
системе координат и полярных диаграмм. Функции, которые являются 
доступными, включают установку диапазонов данных (рис. 8.15a), нормировку 
(рис. 8.15b, c, d), масштабирование оси к логарифмическому масштабу (рис. 8.15e, 
f, g) или (в случае полярных диаграмм) изменение ориентации графика 
(рис. 8.15h, i). 

     
Рис. 8.15. Группа кнопок для установления параметров осей 

 
Чтобы пронормировать данные, выберите кнопку Normalise (рис. 8.15b). 

Тогда может использоваться один из двух режимов нормировки: 
Нормировка к максимальному значению всех характеристик (рис. 8.15c): 

Эта установка будет относиться ко всем характеристикам на графике, чтобы 
определить максимальное значение. Все характеристики будут тогда 
нормализованы к этому значению, и будут масштабированы относительно друг 
друга.  

Нормировка к максимальному значению характеристик, показанная на рис. 
8.15d показывает, что в результате каждая характеристика будет иметь 
абсолютный максимум 1. 

Полярные диаграммы строятся в диапазоне углов 360̊. Ориентация 
положнеия 0 может быть установлена с помощью опции Orientation (h). 
Ориентация может быть установлена в North, South, East или West. Кроме того, 
направление, в котором угол растет, может быть установлено по часовой стрелке 
(рис. 8.15i) или против часовой стрелки (рис. 8.15j). Направление увеличения 
допускается только в том случае, если ориентация была установлена вручную 
(рис. 8.15h). 

8.4.4.3  Группа характеристик 

Курсоры позволяют прочитать информацию на графике. Курсор вызывается 
путем нажатия кнопки курсора (рис. 8.3a, 8.16). 

У каждого типа графиков есть 
различные типы курсоров. На декартовых и 
полярных графиках можно применить два 
типа курсоров. При нажатии таблицы курсора 
(рис. 8.3b, 8.16), вызывается сводка. Эта 
таблица содержит пару данных в точках для 
всех характеристик, но также и различие 

 
Рис. 8.16. Кнопки группы 

характеристик 
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между двумя точками для всех зависимостей. Заметим, что диаграмма Смита 
может установить один курсор на характеристику. 

Если курсор будет так или иначе перемещен за пределы видимой области 
графа, то в углу графика появится курсор в виде ручки, которую можно 
использовать для перемещения. 

8.4.4.4 Группа Grid 

В разделе диаграммы Смита есть возможность пользователю выбрать 
адмитансную или импедансную диаграмму Смита. 

8.4.4.5  Страница Trace  

Страница Trace (рис. 8.17) управляет моделированием графически 
изображенных данных. Можно также настроить представление графиков в виде 
выборок данных. Можно, например, изменить вид и цвет маркера. Некоторые 
операции дублируются в закладке Format. 

В разделе Units можно установить единицы на оси. 
 

 
 

Рис. 8.17. Закладка Trace интерфейса POSTFEKO 
 
 

8.4.4.6  Группа Manage  

Группа Manage (рис. 8.18) обеспечивает опции для дублирования 
характеристики, создания новой рассчитанной с помощью математических 
выражений характеристики или сохранении копии выбранных данных в 
настоящем проекте. 

Операция дублирования создаст такую же 
характеристику, которая содержит точно те же самые 
параметры настройки как исходный график. 

Характеристики, пересчитанные математически, 
используются, чтобы выполнить математический 
расчет с данными или вывести характеристики, 
рассчитанные чисто математически. Сохранение 

локальной копии набора данных сохраняет текущее состояние отображенных 
данных. Эти данные можно тогда сравнить с рассчитанными позже 
характеристиками измененной модели, или с характеристиками другой модели. 

 
Рис. 8.18. Группа 

управления данными 
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8.4.4.7  Группа представлений (Rendering)  

Опции представления Rendering влияют на то, как линии характеристик 
наносятся на графики. Можно выбрать установки для представления данных в 
виде выборок (рис. 8.19 a). 

    
 

Рис. 8.19. Опции Rendering для характеристик 
 
Можно эти установки выбрать по умолчанию, когда они находятся 

автоматически на основании выбранных данных. Однако количество выборок 
может быть уменьшено или увеличено. Увеличение (рис.8.19 b) или уменьшение 
(рис. 8.19 c) является просто функцией дисплея. Верхние характеристики будут 
видимы лучше при более низких трассировках. 

8.4.4.8  Группа Units 

Для графиков в декартовых и полярных системах координат есть группа 
единиц Unit, которая обеспечивает управление независимой осью, так же как 
выведенные на экран единицы, которые могут быть добавлены на графики. 
Единицы, которые лучше всего соответствуют данным, автоматически 
определяются на основании диапазона данных. Этот режим Auto mode может 
быть перезаписан, вручную задавая желаемые единицы дисплея. Рис. 8.20 
показывает диалог преобразования абсциссы. 
 

        
 

Рис. 8.20. Трансформация оси абсцисс (независимой оси) графика 
 

Независимая ось может быть расширена или сокращена, используя масштаб 
Scale, и можно задать постоянное смещение, используя опцию Offset. 

 

8.4.4.9  Группы Line и Marker 

 В POSTFEKO имеется доступ к инструментам форматирования для линии 
и маркеров. Для линий и маркеров могут быть установлены стиль, цвет, размер. 
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При выводе маркеров на график (рис. 8.21 a), имеются три метода, которые могут 
быть установлены нажатием на кнопке Marker placement. 

 

    
Рис. 8.21. Параметры настройки размещения маркера 

 
Маркеры могут быть расставлены на расчетных частотах (рис. 8.21b), 

размещены как редко расположенные маркеры (рис. 8.21c), могут быть 
расположены с постоянным интервалом, и расположены плотно (рис. 8.21 d). 
Последние два варианта – художественные оформления функции, которые всегда 
будут видимы в представлении, независимо от масштаба изображения. 
 

8.5  Использование 3D видов 
Трехмерное представление – удобный инструмент для анализа поведения 

электромагнитных волн в пространстве. Устанавливая свойства представления 
сетки, теоретической модели и результатов расчета, информация может быть 
представлена наиболее наглядно. Для каждой категории имеется закладка, 
которая помогает выбрать вид поля. 

 

8.5.1  Закладка Display 
Закладка Display (рис. 8.22) используется, чтобы удобно видеть модель и ее 

характеристики. Сюда включены и инструменты управления легендами, 
плоскостями сечений и осями, чтобы помочь лучше представить модель и 
результаты расчета. 

 

 
Рис. 8. 22. Закладка Display – главная управляющая закладка  

для трехмерного представления. 
 

В разделе Duplicate можно также выполнить дублирование и экспорт 
характеристик и представлений. 
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8.5.2  Группа Display 

 

На рис. 8.23 показывается группа 
Display, которая содержит кнопки, 
которые позволяют представить график 
в оттенках серого цвета (b) и в 
ограничивающем боксе (c) видимости. 

Видимость ограничивающего бокса относится к геометрии, но игнорирует 
показанные результаты и геометрию. 

Разрезать модель можно, нажимая на кнопку (a) Cutplanes (рис. 8.23).  
В закладке Plane Definition можно установить расположение плоскости сечения 
(рис. 8.24). 

Кнопка Flip изменяет нормальное направление плоскости, и задает, какая 
сторона плоскости будет скрыта. Можно оставить несколько плоскостей, среди 
которых некоторые могут быть удалены или сделаны невидимыми.  
 

             
 

Рис. 8.24. Задание плоскости (слева) и фильтра видимости (справа) 
 
 

 

Фильтр видимости (справа на рис. 8.24) обеспечивает управление, по 
которому плоскости разреза влияют на объекты.  

По умолчанию, плоскость разреза действует на все, что видно и находится в 
модели. Чтобы изменить это, переместите требуемые компоненты в список 
объектов сечения справа и щелкните Apply. Отметим, что фильтр видимости 
используется совместно всеми плоскостями сечения. 

 

 
Рис. 8.23. Операции сечения (a), 

перевода в оттенки серого (b) и границ 
(c)  бокса граничных условий 
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8.5.3  Группа Legends 
 

На рис. 8.25 показываются кнопки, 
которые используются для управления 
легендами. Легенды могут быть добавлены в 
любой из четырех углов в 3-D представлении. 
Они поясняют данные на графике. 

У каждой кнопки легенды есть список 
объектов, с которыми она может быть 
связана, в зависимости от того, которая из них 
в настоящий момент выводится на экран. 

Диапазоны (и цвет) результатов могут быть установлены, используя настройку 
Individual range, а также другие настройки масштабирования, имеющиеся в 
дополнительном диалоге. 

8.5.4  Группа Entities 

Каждая из кнопок на рис. 8.26 показывает или скрывает все компоненты 
этого типа в трехмерном представлении. По умолчанию, все объекты, кроме 
поименованных точек, видимы. 

 

 
Рис. 8.26. Кнопки показа компонент структуры 

Нажатие на любую кнопку обеспечит видимость этого объекта. Кнопки на 
рис. 8.26, это: источники (a), нагрузки (b), кабели (линии) (c), точки (d), 
многополюсники (e), линии передачи (f) и RX антенна (g). 

Кнопки в диалоге на рис. 8.27 служат 
для показа/скрытия компонентов. Для 
применения других опций видимости 
источников и нагрузок можно использовать 
дополнительный диалог, показанный на 
рис. 8.27. И для источников, и для нагрузок 
имеется столбец Show и Hide. 

Дополнительные опции обеспечивают 
визуализацию источников. Так, можно задать 
цвет источника и его величину. Это часто 
используется в выделения апертурных 
источников, электрических, магнитных 
диполей, и источников тока. 

 
Рис. 8.25. Кнопка добавления 

легенд и кнопка задания 
диапазона изменения величин  

 

 
Рис. 8.27. Дополнительные 

установки показа опций 
источников и нагрузок 
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8.5.5  Группы показа метода решения и бесконечных плоскостей 
На рис. 8.28 показываются кнопки, позволяющие увидеть и скрыть 

плоскости симметрии, периодические границы (PBC) и бесконечную плоскость. 
Для бесконечных плоскостей может 

также быть установлена степень 
прозрачности (opacity), и бесконечные 
слои могут быть разрезаны, чтобы 
улучшить предоставление. 

 
 
 
 

8.5.6  Группы Axes, Export и Duplicate 
В группе Axes можно изменить представление осей (рис. 8.29). Опция 

визуализации оси имеет два основных параметра настройки оси: show/hide the 
global axis (в начале координат модели) и show/hide the mini axis (в левом углу 
нижней части представления).  

     
Рис. 8.29. Меню управлением осями, экспортом и дублированием 

 
Толстые маркеры (Tick marks) могут быть показаны на глобальной оси. Раздел 
Export обсуждается подробно ниже. Нажатие на кнопку Duplicate view создает 
точную копию текущего представления.  

8.5.7  Закладка Mesh 
Закладка Mesh содержит параметры настройки показа свойств сетки, но так 

как есть случаи, когда нужно обратиться к определенной части сетки, эти опции 
разбиты на группы. Группы включают параметры настройки для предоставления, 
прозрачности сетки и видимости разбиение на сетку на фоне модели, вместе с 
рядом инструментов, которые помогают проверить правильность модели. 

 

 
 

Рис.8.30. Линейка в POSTFEKO 
 

 
Рис. 8.28. Показ и снятие видимости 
(a) плоскостей симметрии, (b) PBC 

(периодических граничных условий) 
и (c) бесконечной плоскости. 
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8.5.7.1  Группа Rendering 

Эта группа дает возможность увидеть, 
как сетка разбиения выводится в трехмерном 
представлении. Содержание этой группы 
показано на рис.8.31. 

Опция цвета отображает сетку. 
Доступные параметры включают различную 
окраску: среды лицевой поверхности элемента 
(рис.8.31), среды объема элемента, имени 
элемента, нормали элемента и типа элемента 
(рис. 8.31). Цвет главной кнопки тогда 
изменится и станет соответствовать значку, 
который выбран для окраски. 

Нормали элементов могут также быть 
отображены кнопкой Normal. Для сегментов 
радиус может быть увеличен кнопкой 
Segment radius (рис. 8.32), который умножает 
радиус на коэффициент от 1 до 10. 

 

 
Рис. 8.32. Опции задания 

радиуса сегментов 
Рис. 8.33. Установки визуализации 

анизотропного слоя 
 
Рис. 8.33 показывает диалоговое окно вывода на экран основного 

направления для анизотропных слоев. Для той части геометрии, которая 
покрывается анизотропным слоем диэлектрика, делается доступной опция, показа 
основного направления. Так как могут быть несколько слоев, необходимо 
определить слой для показа. 

 

 
Рис. 8.31. Варианты 

предоставления сетки разбиения 
и опции раскраски сетки 

разбиения 
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8.5.7.2  Группа прозрачности 

 
На рис. 8.34 показана группа 

прозрачности, которая управляет степенью 
прозрачности сетки. 

Как у ветрового стекла, так и у 
апертуры, есть установки непрозрачности, они 
могут быть настроены отдельно. В этой 
группе можно выбрать: непрозрачность сетки, 
применяемой ко всей видимой геометрии (a), 
апертуры (c), ветрового стекла (b). При 
установке 0% элемент будет  прозрачен и не 
будет виден. При 100% прозрачности не 
будет. 

 

8.5.7.3  Группа видимости 

Для большинства элементов сетки разбиения можно отдельно установить 
видимость для поверхностей, краев и вершин треугольников. Элементы 
включают: сегменты проводов (рис. 8.35a), металлические треугольники 
(рис. 8.35b), диэлектрические треугольники (рис. 8.35c), апертурные треугольники 
(рис. 8.35d), треугольники ветрового стекла (рис. 8.35e), тетраэдры (рис. 8.35f), 
кубы (рис. 8.35g), полигоны UTD (рис. 8.35h) и цилиндрические объемы, 
решаемые методом UTD (рис. 8.35i). 

 

 

 
Рис. 8.35. Установки видимости сетки разбиения 

 
В некоторых случаях можно выбрать разные настройки на поверхности, 

ребра и объемы. Эти случаи – проводные сегменты (поверхности, ребра, 
вершины), тетраэдры (поверхности, края, вершины, объем) и цилиндры UTD 
(поверхности, края). 

Фильтр видимости обеспечивает дополнительный контроль над видимостью 
элементов сетки разбиения. Фильтр видимости дает возможность выделить 
области сетки разбиения или конкретные среды. 

 

 
Рис. 8.34. Настройки 

прозрачности 
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8.5.7.4  Группа Tools 

 
Группа Tools имеет ряд инструментов, 

которые могут использоваться, чтобы 
выделить определенные части геометрии или 
установить определенные свойства геометрии. 
Инструмент Measure distance (рис. 8.36) 
позволяет измерить расстояние между двумя 
выбранными точками в 3-D представлении. 

Чтобы измерить расстояние: 
- Щелкните по кнопке Measure distance, включая режим измерения 

расстояния. 
- Переместите мышь через геометрию. Заметим, что координаты 

показываются сверху курсора. 
- Щелкните, чтобы поместить первый маркер в текущую точку. 

Переместите мышь через геометрию. При этом можно видеть расстояние 
между текущей точкой и выбранной точкой. 

Контрольная точка находится всегда в позиции, где сделан последний 
щелчок мышью. Чтобы снять контрольную точку, щелкните в пустом месте 
представления. Опция изменения расстояния будет включена, пока она не будет 
снята. 

Инструмент нахождения элементов Find Elements (рис. 8.36b) 
используется, чтобы идентифицировать элементы сетки разбиения их внутренним 
ID. Это часто используется, когда даются ошибки или предупреждения. Тип 
элемента должен быть определен прежде, чем ввести ID элемента в диалоговое 
окно (рис. 8.37). Несколько ID могут быть найдены одновременно при 
использовании списка разделенных запятой значений. В разделе Element ID 
добавляется аннотация к указанным элементам. Когда нажимается кнопка Add 
annotation(s), аннотация связывается с этими элементами. 

 
Mesh connectivity (рис. 8.38a) – это 

команда, по которой выделяются свободные 
края геометрии красной линией. Этим 
показываются элементы сетки, которые не 
соединяются с другими элементами. Такие 
элементы обычно появляются на краях 
плоскостей или на концах проводов. Когда 
используется сложная или импортированная 
конфигурации, можно показать связь сетки 
разбиения с геометрией, которая не 
разбивается на сетку. 

 

 
Рис. 8.36. Инструменты 

исследования сетки разбиения 
 

 
Рис. 8.37. Элементы 
нахождения сетки 
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Рис. 8.38 показывает опции, которые 
доступны для выделения сетки разбиения, 
если она требуется. Выбранная опция будет 
выделена в 3D представлении, показывая на 
экране желтую сетку по элементам, которые 
решаются тем же методом. Типы решения 

включают: металлы с потерями (b), покрытия (c), CFIE/MFIE (d), EFIE (e), 
импедансные листы (f), PO (g), PO (области Fock) (h), GO (i), UTD (j), FEM (k), 
активные элементы ветрового стекла (l) и планарные апертурные треугольники 
(m). Выделение активируется кнопкой связи (рис. 8.37 d), которая тогда 
изменится и покажет значок, соответствующий выбранной опции. Для снятия 
активации, выберите опцию «none» (рис. 8.37 a). 

8.5.8  Закладка Result 
Закладка Result обеспечивает доступ к результатам расчета. На этой 

вкладке можно выбрать представление, как эта информация представляется. 
Чтобы управлять настройками показа результатов, выберите эту страницу и 
заметьте, какие кнопки становятся активными. 

 

 
 

 
Рис. 8.39. Вывод дальних, ближних полей, токов и др. хар-к 

 
При условии, что эти характеристики рассчитаны, можно выполнить 

настройки дисплея для дальних полей, ближних полей, токов и лучей (рис. 8.39). 
При выводе токов и ближних полей, их можно представить в виде стрелок. Лучи 
будут доступны только в случае, если до моделирования была выбрана опция их 
сохранения. 

 

8.5.8.1  Группа Rendering 

На рис. 8.40 показываются кнопки Rendering на вкладке Result. Группа 
рендеринга применяется к дальним полям, ближним полям, токам и оценки 
ошибок. В большинстве случаев опции рендеринга полезны для ближних и 
дальних полей. 

 
Рис. 8.38. Опции сетки разбиения 

и лучевых характеристик 
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Кнопка (a) определяет 
видимость сетки поверх результата, 
что помогает уточнить данные в 3D 
представлении. Когда опция (b) не 
выбрана, цветная поверхность 
результата скрывается. Дискретное 
распределение цвета (c) удаляет 
интерполированную окраску 
поверхности и использует набор 
цветов. Опция цвета (d) применяется 
к изометрическим поверхностям (для 

3D ближних полей). 
Установки Origin (e) и Size (g) применяются только к дальним полям. 

Размер дальнего поля может быть установлен вручную в диалоговом окне. 
Операция Opacity (рис. 8.40f) устанавливает прозрачность: при установке 

0% элемент будет просто прозрачен и не будет виден. При 100% будет 
установлена полная непрозрачность. 

 
 
 

8.5.8.2 Группа Requests 

 
Прежде чем запускается моделирование, 

нужно задать данные, которые рассчитываются в 
определенных точках. На рис. 8.41 показываются 
кнопки требуемых точек (a), установки (b) и 
границы (c), по которым можно уточнить, какие 
требуются ближние и дальние поля. 
 

 
Чтобы увидеть точки, добавьте 

представление результата и выберите кнопку 
Request points (a). 

 

 

 
Рис. 8.40. Группы видов результатов 

 

 
Рис. 8.41. Группа  
Result requests 
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Рис. 8.42. Диалог выбора точек для вывода характеристик 
 

Отметим, что кнопка Settings (b) теперь разблокирована. Визуализация 
точек может быть установлена с помощью диалога, показанного на рис. 8.42. 
Здесь могут быть установлены тип, цвет и размер маркера для требуемых точек. 
Для ближних полей можно также показать ограничивающий прямоугольник 
выбором кнопки Boundary (рис. 8.41с). 

8.5.8.3  Группа контурного представления графиков 

 

Контурные линии – это линии, каждая 
точка которых соответствует определенному 
значению результата. Кнопка Show contours 
(рис. 8.43a) переключает видимость 
контурных линий.  

 
Рис. 8.43. Группа представления 

графиков в виде контуров 
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Цвет контуров (рис. 8.43c) может быть 
установлен в любое значение, или цвет может 
быть связан с величиной выведенного на экран 
значения. 

Рис. 8.44 представляет диалог для 
задания контура, который выводится кнопкой 
Show contours (рис. 8.43b). В нем имеется 
опция выбора между числом контуров и 
заданием величин, соответствующих каждому 
контуру. Последнюю опцию можно задать для 
любого числа контуров, которые лежат на 
заданных пользователем позициях. Позиции 
могут быть определены значением величины 
или процентом относительно диапазона 

изменения величины. 
 

8.5.8.4 Векторы Arrows 

Векторы указывают направление 
(рис. 8.45) электрического тока или 
направление, в котором переносится поле 
(вектор Пойнтинга). 

Поскольку эти результаты изменяются 
в течение длительного времени, стрелки 

могут быть графически изображены только в случае, если вектор показывается 
при заданном значении фазы. В разделе Quantity в палитре результата должен 
быть выбран Instantaneous, и должна быть определена фаза. Стрелки выводятся 
на экран при использовании кнопки Show arrows (рис. 8.45 a), остальными 
кнопками могут быть выбраны цвет (b) и размер (c, d). Отметим, что стрелки 
масштабируются пропорционально. 

 

8.5.8.5  Группы лучей (Rays) 

Различные свойства лучей могут быть 
выведены на экран независимо друг от друга. 
Линии луча (рис. 8.46a), номера лучей (рис. 
8.46b), номера групп лучей (рис. 8.46c) и 

пересечения лучей (рис. 8.46d) могут быть выведены на экран в любой 
комбинации нажатием соответствующей кнопки. 

Лучи, выводимые на экран, можно по разному окрасить (рис. 8.46f). Порог 
видимости (рис. 8.46e) может быть установлен разрешением вывода на экран 
лучам только более высокой интенсивности. Это помогает уменьшить 
насыщенность лучами и оставить в представлении только самые важные лучи.  

 
Рис. 8.44. Задание положения 

контуров вручную 

 
Рис. 8.45. Представление 

результатов расчета векторами 
 

 
Рис. 8.46. Группы лучей 
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8.5.9  Использование легенд 
 

Для того, чтобы пояснить данные, нанесенные на график, полезно 
использовать легенды. Легенды могут быть помещены и в 2D, и в 3D 
представления. Однако они работают по-разному, так как данные, которые они 
представляют, показываются по-разному. 

 

:Для 2D представлений легенда автоматически добавлена сверху графика 
(ниже названия графика). Чтобы изменить положение легенды, нажмите на 
кнопку Legend и выберите нужное положение из списка. Также можно удалить 
легенду или вручную выбрать ее положение. Записи отразят все показанные 
линии характеристик и их вид. Форматирование можно выполнить в закладке 
Format. Можно изменить шрифт, цвет фона, вид границы и тень. 

Trace text : Легенда для каждой характеристики записывается 
автоматически. Часто это достаточно для того, чтобы понять, что представляет 
характеристика. Иногда нужно вручную задать описание характеристики. Чтобы 
сделать это, нажмите на кнопку Legend. То же самое можно сделать, щелкая 
правой кнопкой мыши на линии характеристики. На рис. 8.47 показывается 
диалог, в котором можно изменить легенду для выбранной характеристики. 
 
 

Вручную можно выполнить 
форматирование и запись легенды 
только для 2D графиков. Внесение 
легенды изменяет размеры графика, 
чтобы открыть место для легенды. 
Например, график будет более 
широким, если легенда будет 
помещена сверху. Когда используется 
ручное положение, график 
максимизируется, и легенда должна 

быть помещена так, чтобы она не закрывала важные данные (рис. 8.48). 
 

 
Рис. 8.47. Диалог Chart text 
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Рис. 8.48. Диалог установки 
максимального и минимального 

значения графика 

Рис. 8.49. Установки дополнительных 
границ диапазона 

: Легенда может быть помещена в любой из четырех углов графика. 
Нажатие на любую из этих четырех кнопок выводит список, с которым может 
быть связана легенда. В названии легенды включены данные и их единицы. Также 
приводится цветовая палитра, которая помогает интерпретировать различные 
цвета, и их связь с данными графика. 

Установку отдельного диапазона 3D легенды можно задать кнопкой 
Individual Range. По умолчанию величина диапазона устанавливается равной 
минимальному и максимальному значению. Диапазон может быть установлен 
вручную для линейных и логарифмических данных. Есть несколько параметров 
настройки, которые влияют на пределы диапазона. К ним можно получить доступ, 
нажимая на кнопку вызова дополнительного диалога в углу группы Legends (рис. 
8.47). 
 

 Scale to peak instantaneous values 
Эта опция используется, когда величины показываются по отношению к 

пиковому мгновенному результату при изменении фазы. Границы минимальной и 
максимальной величин останутся постоянными для каждого шага фазы, означая, 
что определения для цветов всегда те же самые. Это позволяет более просто 
видеть, как величина изменяется по фазе. Когда представляют интерес величины 
только при заданной фазе, эта опция может быть снята, чтобы границы диапазона 
были синхронизированы с показываемыми данными. 
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 Scale to visible results of the same quantity 
Иногда необходимо на один график нанести несколько графиков ближнего 

и дальнего поля. У каждого задания будут свои собственные минимальные и 
максимальные значения. Однако POSTFEKO автоматически измеряет 
выводимые данные, чтобы учитывать все результаты, которые были добавлены на 
график. Это делает более ясным соотношение величин. Снятие этой опции 
выведет каждый результат относительно своих собственных минимальной и 
максимальной значений. 

 
 Scale only to selected frequency  

Эта опция возможна только в том случае, когда расчет был выполнен в 
дискретных частотных точках. Здесь границы определены минимальными и 
максимальными величинами для всех частотных точек. Например, наблюдать за 
изменением усиления антенны в диапазоне частот наиболее удобно, когда поле 
масштабировано во всем диапазоне частот. 

 
 Scale to request slice dimensions  

Иногда невозможно или не нужно выводить на график все запрошенные 
данные результата сразу. Если требуется, показать только часть диапазона, эту 
опцию нужно снять. Этот вывод полезен, если представляет интерес только 
определенный диапазон данных. 

8.5.10  Использование браузера проекта 

Проектный браузер – расширенный инструмент, который обеспечивает 
представление содержания проекта, раскрывает содержание модели и детальное 
представление отдельных элементов. Он состоит из трех отделов, а именно 
проектный браузер, браузер модели и браузер подробностей. 

: К проектному браузеру можно обращаться, открывая закладку View 
кнопкой Project. Она может быть видима, скрыта, а также минимизирована в 
размерах. 

Проектный браузер содержит дерево всех моделей, которые были 
загружены в проект. Он также содержит дерево для любых сохраненных и 
импортированных данных, которые были перемещены в проект. При выборе 
любого пункта из содержания этого окна, браузер модели становится 
заполненным данными, относящимся к этому элементу. Это – единственное 
место, в котором модели могут быть удалены из проекта. Щелкните правой 
кнопкой мыши на модели в дереве, и выберите Remove Model, чтобы удалить 
модель из проекта. 

Когда браузер модели заполняется, дается более детальная информация 
относительно модели. Она включает резюме всех конфигураций решения, любых 
данных, которые могли бы быть объединены по конфигурациям. Расширение 
дерева для конфигурационных выходов далее относится к деталям сетки 
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разбиения, требуемым характеристикам, расчетным результатам, бесконечной 
плоскости и т.д. 

Выбором любой из этих компонентов, браузер подробностей заполняется 
информацией, которая относится к этому элементу. Если результаты были 
рассчитаны для модели, можно добавить данные к текущему представлению, 
щелкая правой кнопкой мыши на компоненте и переводя ее в активный вид. 

Браузер подробностей (Details Browser) дает информацию относительно 
компоненты модели. Например, выбор требуемой характеристики в дальней зоне 
покажет информацию о точках, в которых нужно определить характеристики 
дальнего поля. 

 

8.5.11  Ручное задание свойств осей, диапазонов и заголовков 

На двумерном графике часто необходимо переименовать параметры, 
заголовки или условные обозначения, чтобы лучше описать представляемые 
данные. Диапазоны осей устанавливаются, чтобы автоматически определить 
диапазоны данных и масштаб. 

: Название графика, метки на осях и необходимые надписи 
автоматически получаются из содержания графика. Изменить любое из этих 
содержаний можно в этом диалоге, щелкая на кнопку Chart text, и снимая 
галочку в поле Auto. Эта настройка будет принята при нажатии на OK или 
Applay. Рис. 8.50 показывает диалог, в котором можно сделать эти изменения.  

 
   

Рис. 8.50. Диалог текста графика 

 Axis settings: для графиков в полярной и декартовой системе координат 
осям могут быть заданы различные диапазоны, интервал сетки и нумерация. 
Чтобы изменить любое из этих свойств, снимите опцию редактирования 
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выбранной оси, указывающую, что значения будут определены автоматически. 
Заметим, что в этом случае для увеличения масштаба изображения будет 
использовано значение этого диапазона. На рис. 8.51 показывается диалог, в 
котором выполняются эти изменения. 

 

Рис. 8.51. Диалог установки параметров осей 

Для трехмерного представления иногда полезно задать данные 
промежуточные между двумя значениями. Это изменяет окраску результата, 
синий цвет будет соответствовать минимальной величине, а красный – 
максимальной. Так можно показать изменения между двумя значениями, которые 
иначе были бы пропущены. 

Individual range: Управление диапазоном изменения характеристики 
можно выполнить и для линейных и для логарифмических данных. Для линейных 
данных минимальные и максимальные величины могут быть найдены 
автоматически, а могут быть установлены пользователем. 

При установке опции dB, границы диапазона автоматически определяются 
минимальными и максимальными величинами данных (Automatic range limits). 
Также можно выбрать фиксированные величины и их зависимость от параметров 
настройки линейной шкалы (используя линейные пределы диапазона (с auto 
clamping), хотя в случае дБ может быть задан только фиксированный диапазон 
(Fixed range). Диапазон может также быть определен заданием максимального 
значения динамического диапазона. В этом случае будет использоваться 
максимальная величина, а минимальная величина будет рассчитана как максимум 
минус введенная величина. 
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8.5.12  Использование математических выражения для создания 
зависимостей 

Любой результат, нанесенный на двумерный график, можно обработать с 
помощью математического выражения и вывести на график новую 
характеристику (рис. 8.52). Можно вывести и табличные зависимости на график в 
виде точек. Эти графики выводятся без дополнительного расчета, чтобы 
представить информацию в виде, например, экспериментальных зависимостей. 
Единственная разница между использованием уравнений и математических 
данных, обращенных к характеристике, заключается в том, что математические 
выражения не используют ключевое слово self. 

Уравнения могут быть отредактированы, используя редактор 
математических выражений (рис. 8.52), который содержит список всех 
математических функций, выражений и констант, которые могут использоваться 
в математических действиях. 
 

 
 

Рис. 8.52. Редактор выражения для математических уравнений 
 

Комплексная математика также может использоваться при расчете, но на 
графике могут отражаться только скалярные данные. Если расчет функции не 
может быть выполнен, то появляется значок предупреждения рядом с именем 
характеристики в палитре результатов. Поместив курсор над значком можно 
узнать причину, почему уравнение не показывается. 

Например, нужно вывести на график величину скорректированного 
коэффициента отражения  

6,11,11,1
~ SSS  . 
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Тогда нужно вывести отдельно реальные и мнимые значения обоих 
комплексных числа в правой части выражения, и затем найти модуль суммы двух 
комплексных чисел. 

 

 
Рис. 8.53. Диалог формирования математического выражения 
 
В последних версиях FEKO возможности математических операций 

значительно усилены. 
Одновременно, временной анализ переведен в POSTFEKO. Так, например, 

нужно рассчитать импульсное воздействие антенной системы на объект, 
например, на компьютер или на биологическое тело. Модулированный гауссов 
импульс определяется математически в POSTFEKO для возбуждения сигнала, 
который будет использоваться для временного анализа: 

, 

где fmod-это модуляция частоты импульса; t0-фазовый сдвиг; и T - ширина 
импульса.  Выбирая fmod = 6,5 ГГц, t0 = 500 ps. и T = 140 ps. генерирует типичный 
сверхширокополосный импульс с центральной частотой 6,5 ГГц. При 
использовании временного анализа, результаты будут получены с применением 
обратного преобразования Фурье (IFFT) на частотах в области частот 
моделирования. Важно помнить, что моделирования временного процесса нужно 
выполнить расчет в CADFEKO во всем полосе частот, в котором будет выполнена 
обработка данных в POSTFEKO.  
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9  ВЫПОЛНЕНИЕ ОПТИМИЗАЦИИ В FEKO 

Программа FEKO имеет широкие возможности для оптимизации 
конструкции. Изменяемыми параметрами могут являться геометрические 
размеры, физические свойства материалов и сред. Оптимизация является 
мощным инструментом проектирования антенн и СВЧ структур. В результате 
оптимизации можно улучшить выбранные характеристики, например, КНД 
антенны или её широкополосность. Возможности оптимизации СВЧ конструкций 
рассмотрим на примерах. 

9.1  Подготовка проекта к оптимизации 
Подготовка к процессу оптимизации включает выбор изменяемых 

параметров (геометрических размеров и других параметров конструкции) и 
целевой функции, которая может учитывать одну или несколько характеристик. 
В последнем случае мы выполняем векторную оптимизацию. 

Рассмотрим монопольную антенну, состоящую из трех сегментов, между 
которыми будут включаться реактивные элементы. Будем подбирать длины 
сегментов, а также величины реактивных элементов так, чтобы получить 
наиболее широкую полосу рабочих частот антенны. 

Вызовем командой Model -> Model Units диалог (рис. 9.1), в котором 
выберем единицы измерения конструкции. Начертим первый фрагмент 
монопольной антенны (высотой 150 мм и подъемом над земляной платой 5мм), 
используя команду Draw ->Cilinder (рис. 9.2). 

 

 
 

Рис. 9.1. Задание 
единицы длины 

Рис. 9.2. Диалог черчения цилиндра 
как первого фрагмента 
металлического монополя антенны 

 
Затем командой Solution -> Define InfinitePlane вызовем диалог рис. 9.3 и 

выберем в нем опцию «Ground plane (reflection coefficient approx.)». Это будет 
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означать, что антенна моделируется над земляной плоскостью бесконечного 
размера, которая описывается коэффициентом отражения. 

 

 
Рис. 9.3. Монопольная антенна высотой 150 мм, диаметром 10 мм, 

расположенная над проводящей плоскостью 
 
Пусть вибраторная антенна, расположенная над землей, состоит из трех 

сегментов. Общая высота антенны равна приблизительно 0.25. Между 
отдельными сегментами можно включить контуры, которые настраиваются на 
частоты, расположенные между 200 МГц и 500 МГц. Такое включение контуров 
дает более широкую частотную характеристику антенны. Фактически, антенна из 
односегментной антенны преобразуется в антенну-фильтр. Каждый контур 
реализуется сегментом, связанным с соседним сегментом емкостью в разрыве 
линий. 
 

  
Рис. 9.4. Параметры второго 

фрагмента антенны 
Рис.9.5. Параметры третьего 

фрагмента антенны 
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Начертим второй фрагмент монопольной антенны (рис. 9.4) высотой 75 мм 
командой Draw-> Cylinder и третий (рис. 9.5) высотой 40 мм. 

Теперь между металлическими частями антенны начертим короткие линии, 
на которые установим порты типа Wire_port. Проводники чертятся командой 
Draw -> Line (рис. 9.6). 
 

   
Рис. 9.6. Параметры линий, на которые установим три порта 

 
Объединим все шесть компонентов антенны командой Geometry-> Union. 

Объединение всех фрагментов структуры необходимо выполнять в FEKO для 
правильного разбиения поверхности на связанную сетку треугольников. 

Теперь в дереве подробностей имеются три проводника, обозначенные 
Wire3, Wire6, Wire9. На них поставим три порта командой  Geometry-> Create 
Port -> Wire port. 

 

 

 

 

Рис. 9.7. Постановка порта Port1 Рис.9.8. Добавление источника 
напряжения последовательно с портом 
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Командой Solution ->Add excitation ->Voltage source на порт 1 поставим 

источник напряжения (рис. 9.8). А на остальные два порта поставим реактивность 
командой Solution-> Add Load. По этой команде выводится диалог рис. 9.9, в 
котором можно выбрать тип нагрузки (комплексный импеданс, 
последовательный контур, параллельный контур). 

 

  
Рис. 9.9. Выбор величин емкостей, находящихся между 

сегментами антенны 
 

 
Рис. 9.14. Диалог параметров расчета 
дальнего поля; для задания параметров 
расчета пространственной диаграммы 
направленности нужно нажать кнопку 
3D pattern 
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Выберем частоту 500 MГц в 
диалоге, который выводится командой Solution -> Set frequency, затем выполним 
разбиение на сетку командой Mesh->Create Mesh.  

В результате поверхность антенны, а также проводники портов будут 
разбиты на сегменты, причем без разрывов (рис. 9.15), в одну объединенную 
сетку. Частот 1.6 ГГц 

В качестве результатов расчета зададим расчет тока (выбирая опцию 
Currents All) на поверхности антенны, а также пространственную диаграмму 
направленности (рис. 9.16). 

Запустим расчет, нажимая иконку . Этим запускается программа расчета 
FEKO, в окне которой выводится информация о последовательности выполнения 
расчета. В случае ошибок программа останавливается и в этом окне можно 
видеть информацию о причине остановки. После выполнения расчета, запустим 
программу POSTFEKO, нажимая на иконку . 

 
 
Интерфейс программы POSTFEKO v.5.5 показан на рис. 9.15. Выведем ток 

на поверхности антенны. Для этого создадим новое трехмерное представление, 
нажимая на  и на значок . 

 
 

 

Рис. 9.15. Вывод плотности тока на поверхности антенны 
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На это же трехмерное представление можно вывести пространственную 

диаграмму направленности (рис. 9.16), нажимая на иконку в вертикальном 
столбце интерфейса POSTFEKO.  

 
Командой View ->Add 2D Graph->Far Field выведем сечение диаграммы 

направленности. 
 

 
Рис. 9.16. Пространственная диаграмма направленности 

вибраторной антенны в интерфейсе POSTFEKO 
 

После расчета на одной частоте ДН, вернемся в CADFEKO и зададим 
расчет в диапазоне частот от 200 МГц до 500 МГц, ограничивая число точек 20-ю 
в этом диапазоне (рис. 9.17б). 

 

  



210 
 

Рис. 9.17. Задание расчета в диапазоне частот 

 
После выполнения расчета в диапазоне частот снова зайдем в POSTFEKO и 

выведем полученную частотную характеристику в прямоугольной системе 
координат (рис. 9.18). 

Отметим, что приближение о бесконечном размере плоскости под антенной 
является удобным, поскольку в этом случае в программе используется расчет, 
использующий метод интеграла Зоммерфельда.  

 
Рис. 9.18. Частотная характеристика антенны по S11 

Для того, чтобы получить нужную частотную характеристику, выполним 
оптимизацию, а для этого зададим целевую функцию, которая будет 
рассчитываться как разница между рассчитываемыми характеристикам и маской. 
В разделе Optimization зададим команду Optimization->Add Mask. Появляется 
диалог рис. 9.19.  
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Рис. 9.19. Заполнение маски: по оси Y заносим желаемые 
значения S11, по оси X – частота от 400 до 600 МГц 

В этом диалоге задается кусочно-ломанная аппроксимация нужной 
частотной характеристики, вводя точки частот и значения S11. 

Теперь командой Optimization->Add Search, выведем диалог, показанный 
на рис. 9.20. 

 В этом диалоге (рис. 9.20), выбирается метод оптимизации и установки, 
относящиеся к этому методу. Как только метод был выбран, он представляется 
под ветвью Optimisation (рис. 9.21). 

 

  

Рис. 9.20. В разделе методов перечисляются 4 метода поиска 

В одной задаче можно определить несколько целей поиска, которые будут 
представлены как отдельные ветви в разделе Optimisation дерева модели. Но 
может быть запущен одновременно только один процесс оптимизации (если 
имеется только один поиск, то он будет всегда активен). Установки и параметры, 
выбранные на каждом поиске полностью независимы, и только установки, 
указанные на активном поиске будут сохранены в файлах *.opt и *.pfg. 
Информация от всех неактивных исследований не будет влиять на процесс 
оптимизации, но сохранена как часть модели CADFEKO так, чтобы любой поиск 
мог быть инициирован позже.  
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Рис. 9.21. Раздел оптимизации в 
дереве проекта 

Рис. 9.22. Активизация и 
дезактивация отдельных методов 

расчета 
 

Чтобы выбрать метод поиска, щелкните правой кнопкой мыши на пункте 
Seach в дереве, и выберите Activate search (рис. 9.22). Активный поиск обозначен 
зеленой меткой в дереве проекта.  
 Целевая функция задается по команде Goal, и выбирается по импедансным 
характеристикам (рис. 9.24), характеристика дальнего или ближнего поля.  

 
Рис. 9.23. Выбор целевой функции как  

характеристики КСВ 
В диалоге рис. 9.23 нужно выбрать характеристику, на основании которой 

рассчитывается целевая функция, критерий поиска, маску и весовую функцию. 

9.2 Опции описания целевой функции  
При установке целевой функции используют следующие опции:    

No processing  
 Если ЦФ не комплексное число, но не требуется дополнительной 

обработки. Тогда задается опция «No processing».  
x→x  

Real/Imaginary/Magnitude/Phase  
Эти опции задают компоненты для значений целевой функции 

комплексного типа – для массивов, берется значение каждой компоненты 
массива, delivering a non-complex array.  
x→Re(x)/Im(x)/Phase(x)/Mag(x)  

Unwrap  
Unwraps a phase component – для массивов значений фаз, весь массив 

рассматривается в процессе unwrap. Этот оператор может быть определен 
только для изменяемых фаз.  
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(x→unwrap(x))  
Absolute value  

Абсолютная величина берется для каждого элемента массива чисел.  
x→|x|  

Average/Minimum/Maximum  
Нахождение среднего, минимального или максимального числа из набора – 

эта операция не изменяет значения чисел в наборе.  
x→ave(x)/min(x)/max(x)  

Normalise  
Нормировка всех чисел к максимальному числу в наборе данных - для 

одной величины будет возвращено  '1'.  
x→xmax(x)  

Log  
Взятие десятичного логарифма для каждого элемента этого массива. Этот 

оператор возможен только не для комплексных чисел массива.  
x→log_10(x)  

Offset  
Добавление заданной некомплексной величины. В массиве эта величина 

добавляется к каждому элементу массива. Этот оператор применяется только к 
некомплексным числам в массиве массива.  
x→x+n  

Scale  
Умножение на коэффициент масштабирования - для массива чисел каждый 

элемент массива умножается на этот коэффициент.  
x→nx  

Exponent  
Применяется как экспонента – для набора величин, экспонента берется для 

каждой величины в наборе.  
x→exp^x 

Undefined  
Когда применяемая операция является недопустимой, она больше не имеет 

силу, значения возвращаются к неопределенному состоянию Undefined. Перед 
выполнением дальнейших действий, шаги, приводящие к состоянию Undefined, 
должны быть удалены или переопределены.  

Цель оптимизации  
Цель оптимизации может быть определена в каждом отдельном разделе 

Goal как единственное значение или как маска. 
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Значение целевой функции Goal определяется в текстовом блоке Value. 
Целевая функция рассчитывается как разница полученной и заданной 
характеристики с учетом определенного оператора. Величина цели будет 
накапливаться, когда она рассчитывается, суммируя все ошибки.  

 
The Mask Objective  

Целевая функция может определяться, используя двумерную маску. Маска 
– это функция с заранее определенными данными на каждом шаге оптимизации. 

Построенная на основании разницы с маской, целевая функция изменяется с 
положением, углом наблюдения или частотой. Величина маски не обязательно 
должна быть согласована с массивом рассчитанных данных, и в случае различия 
их размерности, FEKO будет использовать кусочные вставки.  

 
Оператор 

Имеется 5 типов операторов, которые используются для оценки целевой 
функции.  

1. Equal – в этом случае рассчитанный Focus должен быть равен 
целевому значению Objective.  

 

(7-1) 

Любое отклонение цели от рассчитанного значения увеличивает целевую 
функцию 

2. Greater than – показывает, что рассчитываемый фокус должен быть 
больше чем Objective.  

  
(7-2)

 
Если цель уже удовлетворена, то вклад этой разницы в целевую 

функцию полагается  равным нулю. 
3. Less than – показывает что рассчитанная ЦФ должна быть меньше, 
чем Objective.  

  
(7-3)

4. Maximise – показывает, что в процессе оптимизации целевая функция 
должна быть максимизирована.  

5.  Minimise – указывает, что ЦФ должна быть минимизирована.  
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Когда целевая функция рассчитана, отклонения целевой функции, в виде 
разницы, определяется согласно типу оператора оценки целевой функции. 
Рассчитанная разница между фокусом и целью для каждой точки массива чисел, 
определяет накопленную ошибку. 

С учетом оператора сравнения (равно, больше чем, меньше чем), цель 
удовлетворяется того, когда ошибка становится нулевой.  

9.2.1  Выбор параметров оптимизации 
Параметры изменяются в пределах границ, которые задаются в диалоге 

параметров оптимизации (рис. 9.24). К этому диалогу обращаются, дважды 
нажимая на Parameters в дереве проекта. При запуске поиска нужно иметь по 
крайней мере один изменяемый параметр. (Важно заметить, что все установки, 
включая выбор параметров, являются локальными для каждого поиска).  

Для каждого параметра должно быть задано максимальное и минимальное 
значение. Они могут быть заданы в виде функциональных выражений с 
использованием переменных CADFEKO.  

Неверное поле с выражением будет высвечено и информация об этой 
ошибке будет выведена в окне информации. Рассчитанное с помощью выражения 
максимальное значение должно быть больше, чем рассчитанное с помощью 
выражения минимальное значение.  

В дополнение к требуемому минимальному и максимальным значениям для 
каждого параметра, для каждого параметра может быть установлено стартовое 
значение и количество точек сетки.  
  

 

Рис. 9.24. Изменяемые параметры антенны: емкости C1  и  C2, а 
также длины отдельных фрагментов антенны 

 
Величина Grid points определяет число точек, которое используется для 

параметра в методе Grid search. Если никакое значение здесь не выбрано, будет 



216 
 

использоваться значение по умолчанию, указанное в установках метода поиска 
сетки. Стартовое значение определяет первую точку, который оптимизатор 
должен использовать для того параметра. Это особенно полезно, если некоторая 
информация имеется относительно приблизительного положения оптимального 
значения для того параметра и поиск  может быть запущен близко к 
оптимальному значению.  

Начальное значение имеет особенно большое значение для процесса поиска, 
когда используются методы случайного поиска (PSO и GA). Если начальное 
значение для данного параметра не выбрано, в его качестве будет использовано 
среднее значение из заданного диапазона. 

9.2.2 Сохранения отношений между оптимизируемыми параметрами  
Диалог Optimisation parameters содержит закладку Constraints (рис. 9.25). 

Эти ограничения могут быть установлены на каждый параметр оптимизации, 
задавая границы для этого параметра во время процесса оптимизации.  

 

 
Рис. 9.25. Установка границ в диалоге Optimisation parameters 

 
Для каждого параметра в таблице параметров или ограничении в списке 

связей параметра, имеется опция Use, которая может использоваться для 
включения и выключения ограничений каждого параметра в процессе 
оптимизации. Снятие определенного параметра или ограничения в установках 
параметра одного поиска не будет снимать этот параметр или ограничение в 
любой другой оптимизации.  

9.3  Методы оптимизации в FEKO 
Во время оптимизации, значения изменяемых параметров находятся на 

основании алгоритма выбранного метода оптимизации. FEKO имеет несколько 
методов оптимизации, каждый с различными характеристиками, которые лучше 
всего подходят для различных задач. 

Найти наиболее подходящий метод для решения данной задачи - не 
тривиальная задача. В неё входит задача подобрать количество частотных точек, 
маску целевой функции и пределы изменения параметров, границы их изменения.  

Рассмотрим методы оптимизации, реализованные в OPTFEKO.  
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9.3.1  Симплексный метод 
Симплексный метод находит минимум целевой функции, изменяя на 

каждом шаге пространство оптимизации, рассчитывая каждый раз целевую 
функцию в N+1 пространственных точках, где N – количество изменяемых 
параметров. 

Для оптимизации процесса сходимости в симплексном методе можно 
изменять: размер базиса, коэффициент уменьшения базиса, критерий остановки и 
критерий сходимости. Дополнительно задаются коэффициент отражения и 
растяжения базиса симплекса, во время процесса изменения базиса, т.е. объема 
пространства, которых охватывает точки переменных.  

Симплексный алгоритм «Simplex Nelder-Mead» можно отнести к методу 
поиска локального экстремума, когда окончательный оптимум сильно зависит от 
положения исходной точки. 

Геометрическая фигура, которая создается на N+1 точках в N-мерном 
пространстве называется симплексом. Идея симплексного метода состоит в том, 
чтобы сравнить значения целевых функций в N+1 точках (где каждая точка 
представляет один набор значений параметров). Во время итерационного 
процесса симплекс движется постепенно к точке оптимума. Движение симплекса 
выполняется, используя три операции: отражение, сокращение и расширение 
(рис. 9.26). 

При сокращении, симплекс меняется подобно отражению, но становится 
или меньшим (отрицательное сокращение) или несколько большим 
(положительное сокращение), чем его исходный размер. Сокращение выполнено, 
когда нормальное отражение дает узел, целевая функция в котором, не меньше, 
чем значение симплексного узла со вторым самым высоким значением целевой 
функции.  

Расширение размера симплекса имеет место только в случае, когда значение 
целевой функции (ЦФ) на обычно отражаемом узле меньше, чем на узле с 
предварительно самым маленьким значением ЦФ. 

Начальный симплекс представлен точками X1, X2 и X3. 

 
Рис. 9.26. Отражение, растяжение и сокращение в симплексном методе 
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Отражение. Из рис. 9.24 можно видеть, что если Xh – точка, соответствует  
худшему значению ЦФ среди точек начального симплекса (X1, X2 и X3), можно 
ожидать, что точка Xr получается при отражении точки Xh вокруг оси, 
определенной другими точками в симплексе (X1 и X2) может дать лучшее 
значение ЦФ. Если это так, то можно создать новый симплекс, отражая точку Xh 
от симплекса, и получая новую точку Xr.  

Этот процесс показывается на рис. 9.24, где точки X1, X2 и Xr формируют 
новый симплекс. Так как направление движения симплекса всегда удаляется от 
самого плохого результата, движение будет всегда в благоприятном направлении. 
Если глобальная целевая функция не имеет крутых точек минимума в 
пространстве изменения параметров, повторение процесса отражения приведет к 
зигзагообразному пути в общем направлении оптимума.  

Расширение (Expansion). Если в результате отражения получена точка Xr, 
целевая функция в которой лучше, чем в любой точке в симплексе (новая 
оптимальная точка), можно ожидать, что ЦФ можно улучшить еще, перемещаясь 
по направлению от X0 до Xr. Поэтому выполняется расширение симплекса от Xr до 
Xe. 

Если целевая функция в Xe лучше, чем в Xr, изменение было успешно, Xh 
тогда заменяется на Xe, и процесс отражения повторяется. Если ЦФ в точке Xe, 
более худшая, считаем, что попытка расширения потерпела неудачу; Xh 
заменяется Xr (полученной на предыдущей операции отражения) и процесс 
отражения продолжается. 

Сокращение (Contraction). Если при отражении симплекса расчет целевой 
функции показывает, что точка Xr имеет лучшую ЦФ, чем вторая лучшая точка в 
текущем симплексе Xnh, будет выполняться операция сокращения. 

Если процесс сокращения дает точку Xc, в которой имеется лучшая ЦФ, чем 
в любой другой точке симплекса, то сокращение было успешно, и Xh заменяется 
на Xc перед продолжением процесса отражения. Если процесс сокращения 
производит направленный Xc, который имеет худшую целевую функцию, то 
процесс сокращения потерпел неудачу, и ядро симплекса уменьшается, 
масштабируя все точки в симплексе на внутренний коэффициент, перед 
перезапуском процесса отражения.  

Операции симплексного метода могут быть в итоге описаны, как показано в 
Табл. 9-1. (Оператор F(X) представляет изменение согласования в точке X в 
пространстве параметров.) 

Табл. 9-1. Операции симплексного метода 
Как изменилась целевая функция? Операция, которая выполняется: 
F(Xr)<F(Xl) Расширение 
F(Xl) ≤ F(Xr) < F(Xnh) Отражение 
F(Xnh) ≤ F(Xr) < F(Xh) Положительное сжатие 
F(Xh) ≤ F(Xr) Отрицательное сжатие 
 
Параметры метода  SIMPLEX  
Base of the simplex: 0.15 База симплекса 
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Reduction factor of the base: 0.5 Коэффициент уменьшения базы 
Termination at minimal base: 0.005 Минимальная база симплекса 
Termination at standard deviation: 1 Приведение к стандартной 

девиации 
Standard reflection coefficient (R): 1 Стандартный коэффициент 

отражения 
Contraction coefficient (-C, +C):  0.5 Коэффициент сжатия 
Expansion coefficient (E): 2 Коэффициент расширения 

Коэффициенты (Табл. 9-1), управляющие процессом оптимизации  в 
предыдущих версиях FEKO можно было задать в EDITFEKО. В версиях FEKO 
5.5 и 6 – можно задать только режимы точности расчета, при выборе которых 
определяются (рис. 9.27) оптимальные значения параметров поиска (High - 
наиболее медленный, но наиболее точный, Normal – средний, Low – с 
наименьшей точностью и наиболее быстрый). Процесс оптимизации  можно 
проследить по промежуточным результатам. 

                

Рис. 9.27. Диалог установки точности оптимизации  
 

Для включения оптимизации в проект, зададим команду Solution -> Add 
Optimization. В дереве проекта, в разделе оптимизации теперь появляются 
значки: 

 

 

 

Маска оптимизации 
Метод поиска  
Параметры 
Цели поиска 
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Создадим две переменные C1 и C2 (емкости) и внесем эти переменные в 
значения емкостей в контурах между отрезками антенны (в нагрузки Load1 и  
Load2) 
 

 

Рис. 9.28. Выбор параметров C1 и C2, 
длины фрагментов антенны, которые 

будут меняться во время оптимизации 

Рис. 9.29. Задание маски для 
оптимизации по критерию |S11| 

 
 
Теперь нужно сформировать целевую функцию. Для этого командой 

Optimization -> Add Impedance Goal вызовем диалог, показанный на рис. 9.29. 
 
Далее запустим оптимизацию, командой Run->Run Optimization, или, 

нажимая на иконку . В появившемся окне расчета можно видеть, как меняются 
переменные и каждый раз выполняется процесс обращения к решающему 
устройству FEKO. 

 
После выполнения оптимизации нужно перейти в OPTFEKO и там открыть 

файл оптимизации, командой File-> Load optimizations. Затем можно вывести 
график (рис.9.30), на котором видно, как изменялась целевая функция в процесс 
процесса оптимизации. 
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Рис. 9.30. Изменение целевой функции по мере поиска минимума целевой 
функции методом Simplex 

 
В результате поиска после 40 шагов получаем параметры, приведенные в 

Табл.9-2. 
 
Табл.9-2. Начальные и окончательные значения параметров антенны, полученные 

разными методами оптимизации. 
 L1 (мм) L2 (мм) L3 (мм) C1 (пФ) C2 (пФ) 
Нач. значения 100 75 40 2 5 
Кон. значения 
(симплекс-метод) 69 32 21.8 19.2 3.1 

Метод PSO 62 23 26 60 30 
Метод GA 68 35 25 12 10 

 
В эту же таблицу внесены данные по методу PSO, полученные ниже. При 

оптимизации в полосе частот время растет пропорционально количеству 
частотных точек. 

 

9.3.2  Метод роя пчел  
Метод роя пчел (Particle swarm optimization PSO) - метод оптимизации, 

основанный на случайной эволюции совокупности данных, похожей на движение 
и интеллекте роя пчел. Это метод поиска глобального экстремума показал на 
некоторых моделях, что он превосходит по быстродействию другие методы 
оптимизации, например алгоритм  генетического поиска. 

Метод PSO можно понять через аналогию, подобную той, которая была 
предложена при реализации этого метода. Вообразите рой пчел в поле. Их цель - 
найти в поле место с самой высокой концентрацией цветов. Без априорного 
знания поля, пчелы начинают в случайных размещениях со случайными 
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скоростями (направление и скорость) поиск цветов. Каждая пчела может помнить 
место, в котором она находит наибольшее количество цветов, и знает места, в 
которых каждая из других пчел находит некое распространение цветов. 

На основании собственного опыта (лучшее локальное значение pbest) и 
известной лучшей позиции (глобальной переменной gbest), каждая пчела 
корректирует траекторию (положение и скорость), чтобы лететь куда-нибудь 
между двумя точками в зависимости от того, влияет ли ранее записанная в память 
информация, или текущее положение (т.е. суммарная добыча) на решение. Когда 
каждая пчела выполняет доставку меда, она сообщает остальной части роя эту 
информацию, чтобы выработать новую стратегию, для коррекции положения и 
скорости для этой оставшейся части роя.  

В пути полета пчела может найти место с более высокой концентрацией 
цветов, чем это имело бы место на основании предварительных данных. Тогда это 
привлечет её к этому новому месту, также как место с большим количеством 
цветов привлекает любую пчелу во всем рое. Иногда, одна пчела может пролетать 
над местом с наибольшим количеством цветов, чем известно пчелам роя. Весь рой 
будет тогда стремиться в это место.  

В конечном счете, полет пчел приводит их в такое место поля, где 
наблюдается самая высокая концентрация цветов. 
 
Размер популяции и число итераций 

По умолчанию размер роя/популяции Population size=20, и число итераций 
Maximum number of iterations=50, в то время как максимальное число 
обращений к FEKO установлено равным 1000. Слишком малому размеру роя 
трудно исследовать все пространство параметров, большие размеры роя и области 
требуют большего времени расчета. По сравнению с GA, метод PSO имеет 
тенденцию сходиться более быстро с меньшими размерами области популяции. 

Когда максимальное число обращений к решающему устройству достигает 
предела (C), заданного пользователем, оно должно быть преобразовано в размер 
популяции (А) и число итераций (В), с A*B<=C.  А выбирается как функция числа 
параметров (Np), с внутренним верхним пределом, поскольку должно быть 
удовлетворено требованию B ≥ 5.  
 
 
 

Табл.9-3. Параметры метода оптимизации PSO 
Maximum number of iterations:  50 Максимальное число итераций 
Population size:  20 Размер популяции 
Acceleration constant 1:  2.8 Постоянная ускорения 1 
Acceleration constant 2:  1.3 Постоянная ускорения 2 
Termination at standard deviation: 0.0001 Остановка при девиации 
Pseudorandom number generator 
seed  

1 Генератор псевдослучайных 
чисел 
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Параметры методов оптимизации можно задавать в программе EDITFEKO 
(это реализовано в версиях FEKO до 5.4). 
 

 
Рис. 9.31. Процесс изменения целевой функции в методе роя пчел 

 
Метод роя пчел характеризуется сильными отклонениями от шага к шагу и 

приближением к конечному значению (рис. 9.31). 

9.3.3  Генетический алгоритм (GA) 
Генетический алгоритм (GA) основан на устойчивом методе случайного 

поиска, использующий принцип Дарвина и концепцию естественной селекции и 
эволюции. Подобно методу PSO, GA является методом поиска глобального 
экстремума.  

Метод GA заимствуется из естественного мира выбором различных путей. 
Концептуально, во время оптимизации GA, выбирается набор испытательных 
решений (генерирований). Эта генерирование играет роль “матери”, от которой 
порождается новое поколение “дочерние записи” (пасынки). В эволюционном 
процессе “survival-of-the-fittest”, каждое последовательное генерирование набора 
параметров приближается к оптимальному решению под действием выбранных 
критериев целевой функции.  
 
Размер популяции и число итераций 

По умолчанию, размер генерации для метода GA установлен равным 20, 
максимальное число итераций 50, а общее число расчетов ограничено 1000. 

Если пользователь задает максимальное число запусков решающего 
устройства C, оно должно быть преобразовано в размер генерации A и число 
итераций B, так, что A*B ≥ C. Величина А выбирается как функция числа 
параметров в задаче оптимизации Np, с внутренним верхним пределом. Также 
требуется, чтобы B ≥ 5. 
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Поиск методом генетического алгоритма завершается, когда: 
•достигается максимальное число обращений к FEKO, 
•среднеквадратичное отклонение между текущими отклонениями значений 

параметров становится достаточно малой, 
•достигнута цель оптимизации.  
В случае неудачи во время расчета новой ЦФ и разбиение на сетку (в 

инструменте разбиение на сетку CADFEKO или в PREFEKO) для отдельного 
набора параметров, пишется соответствующее сообщение об ошибках в файле 
*.log перед вычислением нового случайного набора параметров, чтобы заменить 
неудачный. Из-за характера методики, параметры всегда изменяются в пределах 
границ, определенных в пространстве параметров. 
 

Табл. 9-4. Параметры метода оптимизации генетического алгоритма GA 
Maximum number of iterations: 20 Максимальное число итераций 
Population size: 50 Размер популяции 
Creep mutation with probability: 0.5 Мутация сползания с вероятностью 
Elitism, i.e. best individual 
replicated into next generation  Elitism, то есть лучший индивидуум, 

сносимый в следующее генерацию 
Uniform crossover with 
probability:  0.5 Однородное  пересечение с 

вероятностью 
Termination at standard 
deviation:  0.0001 Прекращение поиска при достижении 

дисперсии значения 
Pseudorandom number generator 
seed 1 Начальное число генератора 

псевдослучайных чисел 
 

Свойства генетического алгоритма, который можно видеть из рис. 9.30 – 
большой размах изменения целевой функции. 
 

 
Рис. 9.32. Генетический алгоритм оптимизации.  
Изменение целевой функции на одной частоте 
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Сеточный метод (перебора) заключается в том, что в разделе точки задается 

количество изменений переменных.  
 

 
Рис. 9.33. Значение целевой функции (в данном случае |S11| на частоте 500 МГц) 

при различных изменениях переменных, в соответствии с заданным шагом: 
 

 
Рис. 9.34. Переменные C1, C2, L1, L2, L3 и количество точек (Grid points) на 

которые делится диапазон значений от Min до Max. 
 

В разделе Grid point (рис. 9.32) задается количество точек, на которые 
будет делиться диапазон изменения переменных, и в этих точках будет 
выполняться расчет целевой функции. 

После выполнения сеточного поиска в программе POSTFEKO все заданные 
рассчитываемые характеристики, а также их алгебраические объединений 
выводятся на график в зависимости от номера итерации, т.е. точки изменения 
переменных. 
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9.4 Сравнение методов поиска 
 Для сравнения методов поиска по скорости и процессу сходимости, нужно 

выполнять расчеты на компьютерах одинаковой конфигурации, а также оставить 
постоянными максимальное число параметров. 

Интересно наблюдать, как изменяется целевая функция в ходе оптимизации 
разными методами. Как правило, начальные и конечные значения целевых 
функций для всех рассматриваемых методов близки. Но, скорость сходимости и 
траектории движения к оптимальным точкам могут различаться. Для данной 
задачи видим, что наиболее эффективным алгоритмом является симплексный 
метод (рис. 9.35, 9.36). 

Из данных рис. 9.36 видно, что решения сходятся к одной точке. 
 

 

 
Рис. 9.35. Изменение целевой функции по мере оптимизации  

(симплексный метод достиг цели быстрее) 
 
Из рис. 9.35 также видно, что ни один метод не уменьшает ЦФ меньше чем 

до 0.1. Это и понятно. Любой метод оптимизации не может превзойти 
предельную характеристику. 
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Рис. 9.36. Изменение высоты антенны по мере поиска минимума целевой 

функции для трех методов поиска (изменение параметров) 
 

 

9.5 Оптимизация диаграммы направленности антенны Уда-Яги 

В этом примере рассматривается оптимизация антенны Уда-Яги (состоящая 
из диполя, рефлектора и двух директоров) для получения заданной диаграммой 
направленности и требуемого КНД. Частота равна 1 GHz. Антенна была 
спроектирована по базовым формулам, но далее выполнена ее оптимизация так, 
чтобы направленность была больше 8 dB в главном лепестке (-30 <= phi <= 30) и 
ниже -7 dB в боковых лепестках (62 <= phi <= 298).  

 

9.5.1 Создание модели антенны 
 
 Создадим две оптимизационные маски (рис. 9.37).  
 Первая маска (Mask_max) определяет верхнюю границу требуемой 
направленности  
  (D < 10  между 0 и 30;   D < -7 между 62 и 180).  
 Вторая маска (Mask_min) определяет нижнюю границу требуемой 
направленности   

  (D > 8 между 0 and 30;   G > -40 между 62 and 180).  

 Две цели оптимизации по дальнему полю добавляются на основании 
требуемого расчета в плоскости H_plane. Требуется, чтобы величина 
усиления антенны (10*log[] dB) по вертикальной поляризации на всех углах 
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в требуемом диапазоне, была больше, чем Mask_min и меньше, чем 
Mask_max.  

Весовой коэффициент, равный 10, увеличивает вес цели Lower_limit. 
Весовой коэффициент используется для формирования цели оптимизации. 

Методы оптимизации, реализованные в FEKO, обладают широкими 
возможностями для проектирования СВЧ систем и антенн. В качестве целевой 
функции в FEKO можно использовать любой параметр, включая параметры 
ближнего и дальнего поля.  
 

        

Рис. 9.37. Созданные две маски 

 Если сравнивать различные методы синтеза, то они отличаются тем, какое 
решение принимается, когда имеется несколько выборок расчета целевой 
функции, полученные с такими-то параметрами. Скажем, если получено 
положительное, т.е. улучшение целевой функции, то можно просто отбросить 
старый вариант структуры. А что делать, если целевая функция хуже. 
Современные методы обычно не отбрасывают это решение, а продолжают 
накапливать информацию. К таким методам можно отнести метод синтеза,  в 
котором используется метод горизонта, т.е. просчет на несколько шагов вперед, 
как в шахматной игре. Перспективным можно считать метод синтеза, в котором 
не выбираются оптимальные параметры, а в процессе синтез создается новая 
структура, реализующая заданные характеристики. 
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Рис. 9.38. Выбор цели оптимизации как усиления антенны по вертикальной 
поляризации  

 
 

Остается важным вопрос, насколько точны результаты расчетов, 
полученные электродинамическим методом. Имеется ряд путей проверки 
точности расчета: 

• сравнение с точными результатами, если они доступны 
• сравнение с другой программой, которая основана на другом методе 

вычисления 
• сравнение с измеренными результатами 
• правдоподобие, например отрицательные реальные входные полные 

сопротивления не существуют.  
• Выполнение базовых физических законов, таких, как закон сохранения 

энергии, теорема взаимности  и т.д. 
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10  МОДЕЛИРОВАНИЕ ЗОНТИЧНОЙ АНТЕННЫ  
НАД ПОВЕРХНОСТЬЮ ЗЕМЛИ 

10.1 Общие положения 
Возможности FEKO хорошо подходят для анализа проволочных систем. 

Например, в антенне, создаваемой на практике из труб и перемычек между ними, 
главным являются продольные токи, поэтому такую антенну можно 
анализировать, используя модель в виде отдельных проводов. 

Анализируемая антенна для загоризонтной РЛС состоит из вертикальных 
проводов и оттяжек (рис. 10.1). Высота антенны около 100 м, что намного 
меньше длины волны (на частоте 100 кГц  длина волны 3000 м). Поэтому её 
входной импеданс очень маленький. Антенна питается от генератора, который 
подключается к ней на высоте 2 м. 

При проектировании такой антенны, необходимо определить оптимальное 
число оттяжек и длину каждой оттяжки и рассчитать электродинамические 
характеристики такой антенны; диаграмму направленности и входной импеданс 
антенны в диапазоне 70 – 130 кГц. 

 Опорная мачта имеет в своем основании опорный изолятор. Оттяжки 
верхней секции электрически соединены с мачтой, образуя совместно с ней 
зонтичную конструкцию. Под мачтой создано заземляющая структура в виде 
звезды, лучи которой совпадают с проекциями оттяжек верхней секции. 

Мачтовая конструкция работает совместно с катушкой индуктивности, 
служащей для компенсации реактивной части ее входного сопротивления.  

  
Рис. 10.1. Зонтичная антенна с 

растяжками 
Рис. 10.2. Некоторые типы  

проводных ДВ антенн 
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Излучение электромагнитной энергии антенны сопровождается тепловыми 
потерями в металлической мачтовой конструкции, потерями за счет конечной 
проводимости грунта (земли), тепловыми потерями в катушке, которая 
включается между антенной и генератором. 

Важный момент, который надо учитывать при проектировании 
длинноволновой  антенны, состоит в том, что поляризация излучаемых антенной 
волн должна быть исключительно вертикальной. Это связано со свойствами 
земли: на низких частотах она близка к идеальному проводнику. 

На рис. 10.2,а показана антенна в виде вертикального провода; на рис. 1,б— 
вертикальная антенна с емкостной нагрузкой в виде "зонтика", который является 
частью оттяжек, поддерживающих мачту; на рис. 1 в — трех-лучевая Т-антенна; 
на рис. 1 г — однолучевая Г-антенна; на рис. 1 д — однолучевая Т-антенна с 
наклонным лучом. 

Для анализа эффективности функционирования антенны, и оценки её 
предельно возможных характеристик, целесообразно рассмотреть упрощенную 
модель. 

Например, если рассмотреть простейшую систему, состоящую из 
вертикальной мачты высотой 100 м, расположенной на бесконечной 
горизонтальной идеально проводящей плоскости, то в такой мачте ток 
распределен по линейному закону (рис. 10.3). 

 

Рис. 10.3. Вертикальный вибратор над бесконечной плоскостью (показано 
распределение тока вдоль вертикального провода) 

 
 Для расчета сопротивления излучения такой модели на низких частотах 

служит приближенная формула [1] 

 2 240 ( )изл
HR 


 , (10.1) 

где H - высота мачты. На частоте 100 кГц (длина волны 3000 м) формула (10.1) 
дает для антенны высотой 100м значение излR  = 0.439 Ом.  

Сопротивление излучения увеличивается, если изменить распределение 
тока, делая его более равномерным вдоль антенны. 

При постоянном вдоль антенны (рис. 10.4) токе вместо формулы (10.1) 
справедливо соотношение 

 2 2240 ( )изл
HR 


 . (10.2) 



232 
 

 

Рис.10.4. Вертикальный вибратор с постоянным распределением тока над 
бесконечной плоскостью 

На частоте 100 кГц  формула (10.2) дает излR  = 1.775 Ом. 
На практике к распределению, показанному на рис.10.4, можно только 

стремиться – это предельно возможное значение.  
Распределение тока вдоль мачты, показанной на рис. 10.3, можно сделать 

более равномерным, снабдив ее насадкой на верхнем конце, имеющей как можно 
большую емкость относительно земли. В качестве такой насадки используется 
система из 12 горизонтальных проводов, равномерно распределенных по азимуту 
(рис. 10.5).  

 

Рис. 10.5. Схема зонтичной антенны с горизонтальными лучами 

  С увеличением длины проводов растет емкость насадки; при достаточном 
увеличении длины можно приблизиться к значению входного сопротивления 
антенны 1,775 Ом.  

Однако на практике построить показанную на рис. 10.5 схему с помощью 
только одной мачты невозможно: оттяжки обязательно провисают, и угол этого 
провисания не может превышать значения 550 (рис. 10.6).  

  
Рис. 10.6. Схема зонтичной антенны с наклонными растяжками 



233 
 

Но когда провода расположены наклонно, в системе появляется 
вертикальная составляющая токов, направленных противоположно токам в мачте. 
Их излучение частично компенсирует излучение токов в мачте. Расчеты 
показывают, что из-за этой причины с увеличением длины проводов l 
сопротивление излучения всей конструкции вначале растет, но затем этот рост 
замедляется и с некоторого значения l сопротивление излучения начинает падать.  

10.2  Расчет входного импеданса антенны с растяжками, стоящей 
на земляной поверхности с идеальной проводимостью 

Конструкция антенны состоит из вертикальной части с высотой 100 м  и 18 
растяжек, идущих под  углом 55º. Для черчения и моделирования используем 
провод (а не цилиндр).  Такой подход выделяет главное – длину антенны. А 
диаметр провода, и даже сечение ствола антенны менее влияют на 
характеристики антенны. Зададим команду Model-> Model Unit, по которой 
появится диалог рис. 10.7, в которой выберем единицы длины «метр». Начертим 
антенну и растяжки как провода, используя операцию Draw->Line. По этой 
команде вызывается диалог рис. 10.8, в который вводятся начальная и конечная 
точки вертикальной части антенны.  

Начальную точку вертикальной части антенны (Start point) приподнимаем 
над землей на параметр Podjem_nad_zemley=0.001 м. 

 

 

 
 

Рис. 10.7. Параметры структуры 
проекта: 
Длина оттяжки L_ottjaz=100 м; 
Подъем над землей 
Podjem_nad_zem=0.001м; 
Угол натяжения оттяжек Theta=55град;  
Центральная частота = 100 кГц 

Рис. 10.8. Структура антенны 
высотой 100 м с растяжками и 
диалог установки параметров 
вертикального вибратора 
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Антенна стоит над землей, которую сначала зададим как идеально 
проводящую плоскость. 

Далее нужно выбрать количество оттяжек, составляющий зонтик 
(например, если выбрать 18 оттяжек, то они будут идти через 20° вокруг 
вертикальной оси). Каждая оттяжка начинается с вершины вертикальной части 
антенны. С учетом того, что угол между вертикальным штырем и оттяжкой равен 
Theta, а длина оттяжки L_ottjazh, координаты второй точки рассчитывается по 
формуле 
 

X_ott=L_ottjazh*Sin(Teta_rad),     (10.3) 
 
где   Teta_rad=Theta*2*Pi/360  - угол в радианах. Уравнение (10.3) вносим в 
разделе переменных, используя математическое выражение (рис. 10.7). 

Для черчения первой оттяжки используем также операцию Draw->Line и 
вводим координаты точек проволочных линий, которые показаны в диалоге на 
рис. 10.9. 

 

 
Рис. 10.9. Черчение оттяжек антенны-зонтик 

 
Затем выполним копирование растяжек и распределение их вокруг оси Z. 

Это выполняется операцией Edit->Copy Spatial-> Rotate (рис. 10.10). 
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Рис.10.10. Модель антенны с оттяжками в FEKO. Копирование и размножение 

оттяжек антенны вокруг вертикальной части антенны 
 

Создадим зонтичную модель антенны, состоящую из вертикального 
провода и проводных оттяжек, количество которых 18. Земляная поверхность 
идеально проводящая.  

Внизу под антенной растягиваются земляные оттяжки, по количеству 
оттяжек, на высоте 0.01 м над земляной плоскостью. Начертите их командой 
Draw->Line, вводя координаты первой оттяжки в диалоге, показанном на рис. 
10.11. 

 
Рис. 10.11. Черчение 18 оттяжек, идущих параллельно земле 
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После черчения одной оттяжки, ее можно 

аналогично растяжкам, размножить вокруг оси Z. 
Для уменьшения объема задачи можно 

использовать плоскости симметрии - 
электрическую стенку и магнитную стенку. В 
данной задаче выберем магнитные стенки, 
совпадающие с осью Z и идущие вдоль оттяжек и 
растяжек. Диалог рис. 10.12, вызывается 
командой Model->Define symmetric planes. 

Теперь нужно выделить все части антенны, 
объединить командой Geometry->Union. Порт 
возбуждения ставится внизу проволочной 
антенны. Порт ставится на линию Wire1, которую 

нужно найти и выделить в дереве подробностей (рис. 10.13). 
 

 
Рис. 10.13. Постановка порта на расстоянии 2% от низа вертикальной части 

антенны Wire1 
 

Кроме этого, на порт 
поставим источник напряжения в 
диалоге рис. 8.9 (командой 
Excitation->Voltage Source) (рис. 
10.14) и установим частоту, 
дважды нажимая на Frequency в 
дереве проекта. 

Как видно из диалога 
рис. 10.15, частоты можно 
установить несколькими 

способами: единственная частота 100 кГц (Single frequency);  непрерывный 
диапазон частот 50 кГц – 150 кГц, точки в котором будут выбираться в 

 
Рис. 10.12. Диалог установки 

условий симметрии 
 

 
Рис. 10.14. Постановка источника 

напряжения в порту 
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результате интерполяции; а также диапазон с дискретными точками в диапазоне 
частот. 

 

 
Рис. 10.15.Диалог установки частот 

расчета 

Рис. 10.16. Диалог установки опций 
сетки разбиения. Suggest-  кнопки 

установок длин по умолчанию 
 

Зададим команду Mesh->Create mesh и в диалоге выбора длин отрезков 
сетки установим опции разбиения, показанные на рис. 10.16. 

Пусть длина оттяжек будет переменной и равна 30 м, 40 м, 50 м, 60 м, 80 м 
и 100м. Чтобы вывести результаты расчета на один график (рис. 10.15), нужно 
после каждого расчета сохранять результаты. 

 
Рис. 10.17. Частотные характеристики антенны-зонтик для разных длин оттяжек 

 
Для того чтобы в FEKO (ранних версий) нанести на один график несколько 

функций, рассчитанных на разных этапах расчета (рис. 10.17), можно запомнить 
отдельные расчеты и затем нанести их на один график. Например, выполним 
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расчет для длины оттяжек 30 м. Далее откроем программу постпроцессорной 
обработки POSTFEKO и в нем сохраним двумерный график Re(Zin) от частоты 
командой File Export Data.  

Затем, после расчета задачи с длиной оттяжек 40 м, командой File-> Import 
Data выведем диалог рис. 10.18. 
 

 
Рис. 10.18. Добавление данных на текущий график 

 
В этом диалоге выберем опцию  «Add to current graph» для того, чтобы 

добавить эти данные на график. В этом случае получаем график с двумя 
зависимостью. 

 
 
 

10.3  Моделирование антенны, включающей нижние растяжки, 
лежащие на заданном расстоянии от земли 

 
В реальной конструкции нижние растяжки заканчиваются на некотором 

расстоянии от земли.  
Теперь можно запускать задачу на счет, нажимая на значок . После 

окончания расчета запустим POSTFEKO, в которой можно вывести частотные 
зависимости реальной и мнимой части входного импеданса антенны (рис. 10.13). 
Для этого нужно выбрать в POSTFEKO команду  
View->Add 2D graph -> Source Data. Мы попадаем в закладку Source data (рис. 
10.13), в которой выбираем опции Impedance и Real. 

Из расчетов видно, что при длине оттяжек 40 м, реальная часть входного 
импеданса принимает максимальное значение на всех частотах. 

Поскольку величина реальной части входного импеданса антенны намного 
меньше, чем мнимая часть антенны, построим ее на другом графике (рис. 10.19). 

Из рис. 10.19 мы видим, что реактивная составляющая входного 
сопротивления антенны имеет емкостной характер. Зависимость реактивной 
составляющей входного сопротивления антенны от частоты имеет монотонный 
характер в диапазоне частот от 70 кГц до 130 кГц.  
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Рис. 10.19. Мнимая часть входного импеданса антенны 

10.3.1 Оптимизация  количества оттяжек 
Выполним предыдущие расчеты входного и мнимого импеданса антенны на 

частоте 100 кГц для разного количества оттяжек, для N=12, 15  и 18 оттяжек. 
Расчет антенны для таких вариантов дают входной импеданс, который приведем 
в Табл.10.1. 
 

Табл. 10.1. Входные импедансы зонтичной антенны для различных длин и 
количествава оттяжек 

Длина 
оттяжек 

N=12 N=15 N=18 
R   Ом X   Ом R   Ом X  Ом  R  Ом X   Ом 

30 м 1.0 -900 1.01 -908 1.01 -800 
40 м 1.0 -680 1.02 -708 1.04 -670 
50 м 0.98 -620 0.997 -566 1.0 -530 
60 м 0.95 -510 0.95 -460 0.95 -430 
80 м 0.84 -356 0.83 -313 0.82 -230 
100 м 0.71 -260 0.69 -217 0.68 -190 
120 м 0.58 -181 0.56 -149   
 

Из этой таблицы можно выбрать длину оттяжки и количество оттяжек. Из 
нее видно, что наибольшее значение входного сопротивления имеет место при 
N=18. Это количество оттяжек и примем в дальнейшем расчете. 

10.4  Моделирование вертикального штыря с оттяжками 
Модель антенны состоит из вертикального штыря высотой 100 м. Сверху 

под углом 55° к нему электрически соединяются 18 оттяжек с длиной 100 м 
(переменное значение). Внизу ставим проекции оттяжек в виде проводов. 
Антенна находится в свободном пространстве. Оттяжки в виде проводов 
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моделируют состояние земли (рис. 10.20). Нужно рассчитать сопротивление 
излучения, а не реальную часть входного сопротивления антенны. Реальная часть 
входного сопротивления антенны включает потери. Нам же нужно исключить 
потери, и считать полезной мощностью только мощность, излучаемую в дальнее 
поле. 

 
Рис. 10.20. Антенна с 18 оттяжками и 18 растяжками на земле 

 
   

В качестве бесконечной земляной платы можно установить Ground plane 
(рис. 10.21). Однако при описания реальной земли этим условием накладывается 
ограничение на удаление антенны от земли. Точный интеграл Зоммерфельда 
также решает такую задачу. Однако для моделирования антенны над реальной 
антенной можно использовать опцию Planar multilayer substrate (рис. 10.21), 
которая позволяет учесть потери земляной поверхности. 

 
 

 
 

Рис. 10.21. Установка свободного пространства, окружающего антенну  
(без какой-либо земляной плоскости) 
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Рис. 10.22.Реальная часть входного импеданса при длине оттяжек 100 м меняется 

от 0.1 до 0.6 Ом 

 
Рис. 10.23. Частотная характеристика  мнимой части входного импеданса. На 

частоте 100 кГц  примерно соотв. 1600 пФ (-400 Ом) 
 

Используя расчет, приведенный на графике рис. 10.23 (значение X=400 Ом 
на частоте 100 кГц), рассчитаем эквивалентную емкость антенны по формуле 

 

400*10*1*28.6
1

2
1

5
fX

C


    (10.4) 

 
Если это так, то индуктивность приемника, которую нужно поставить 

последовательно с антенной для компенсации реактивной части, можно 
рассчитать по формуле 
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510*1/28.6/400
2


f

XL
      (10.5) 

Теперь рассчитаем частотные характеристики реальной части входного 
импеданса для длин оттяжек от 30 м до 120 м. Результаты приводятся на 
рис. 10.18. 

 
Рис. 10.24.Частотные характеристики реальной части входного импеданса при 

различных длинах оттяжки (18 оттяжек)  R=0.45  Ом. 
 
Установим длину оттяжки 105 м и посчитаем реактивную часть входного 

импеданса X на частотах 70 и 130 кГц (границы полосы пропускания). 
Это нужно для того, что  обеспечить эквивалентную емкость антенны 

равную 5500 пФ (пусть это будет требование, на основании которого находится 
индуктивность удлинительной катушки). 

Таким образом, на основании рис. 10.24 нужно выбрать длину оттяжек 40 м, 
но для согласования антенны с передатчиком нужна длина оттяжек 105 м.  

10.5  Формулы расчета КПД антенны 
Излучение электромагнитной энергии антенной сопровождается тепловыми 

потерями в металлической мачтовой конструкции, потерями за счет конечной 
проводимости грунта (земли) и тепловыми потерями в катушке, включенной 
последовательно с антенной для придания ей резонансных свойств. При полной 
компенсации реактивной части входного сопротивления мачтовой конструкции 
реактивностью катушки и равенству сопротивления генератора активному 
сопротивлению мачтовой конструкции подводимая мощность пP  чисто активна, и 
для нее можно записать 

 п изл зем мет катP P P P P    , (10.6) 
где 

излP  - мощность, отбираемая на излучение в верхнее полупространство, 
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метP  - мощность потерь в металле мачтовой конструкции, 
земP  - мощность потерь в земле, 
катP  - мощность тепловых потерь в катушке. 

По аналогии с обычной линейной цепью входящие в (10.6) мощности можно 
представить в виде 

 2
0

1
2пP I R , (10.7) 

 2
0

1
2изл излP I R , (10.8) 

 2
0

1
2зем земP I R , (10.9) 

 2
0

1
2мет метP I R , (10.10) 

 2
0

1
2кат катP I R , (10.11) 

где  
0I - ток в точке питания, которую в данном случае можно считать 

совпадающей с пучностью тока в мачте, 
 R  - активная часть входного сопротивления антенны, 

излR  - сопротивление излучения антенны, 
метR  - эквивалентное сопротивление в металлических конструкциях, 
земR  - эквивалентное сопротивление потерь в земле, 
катR  - активная часть эквивалентного сопротивления катушки, учитывающая 

джоулевы потери в ее проводнике и окружающих конструкциях. 
Под к.п.д. антенны будем понимать отношение излученной в верхнее 

полупространство мощности к полной мощности, подводимой к антенне: 

 изл

изл зем мет кат

P
P P P P

 
   . (10.12) 

Учитывая (10.2)-(10.6), можно записать 

 
изл изл

изл зем мет кат

R R
R R R R R




 
   . (10.13) 

Таким образом, эффективность ДВ антенны определяется соотношением 
сопротивления излучения и суммы других составляющих, вносящих вклад во 
входное сопротивление.  

10.6 Расчет КПД и сопротивления излучения антенны 
Коэффициент полезного действия антенны, равен отношению мощности, 

которая поглощается в дальнем поле (полезная часть), к мощности, которая 
поглощается антенной полностью 
 

КПД=rизл/ Rвх     (10.14) 
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Сопротивление излучения равно 
rизл = 2*Pдал* (Xвх

2+Rвх
2)    (10.15) 

 
Это выражение находится следующим образом: 

 
P=I2*Rизл,   отсюда    Rизл = P/I2  ,   (10.16) 

а ток определяется через источник напряжения  
 

I2 = (U/2)2 / |Z|2     (10.17) 
КПД учитывает и рассогласование антенны, которое можно учесть в виде 

КСВ между антенной и передатчиком. Сопротивление передатчика полагаем 
равной реальной части сопротивления. Приведем фрагмент файла *.out (рис. 
10.25), в котором приводятся данные о мощности и потерях мощности в антенной 
системе.  

 
 

Рис. 10.25. Фрагмент из файла *.out, в котором приводятся рассчитанные 
интегральные поля, поглощенные в верхней полуплоскости 

 
Расчет по приведенным формулам удобно выполнить в таблице Excel. 

Результатом расчета на FEKO являются реальная и мнимая части антенны в 
частотных точках (столбцы R и X в табл. 10.2). Кроме этого, в файле *.out нужно 
найти мощность P, поглощаемую в дальней зоне. 

Табл. 10.2. Частотные характеристики параметров антенны 

 
 

Как следует из данных табл. 10.2 на центральной частоте 100 КГц реальное 
сопротивление входного импеданса равно R=5.768 Ом. Примем, что передатчик 
согласован с антенной и имеет импеданс, равный R=5.768 Ом.  
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Тогда, в соответствии с табл. 10.2, величина S11 =0 на этой частоте, а на 
других частотах имеет место рассогласование. 

Для проводимости почвы σ =0.1. 
При L=105 m, на частоте 100 кГц имеем: 
 

Табл. 10.3 

Длина оттяжки Rвх Xвх 
Pдп сверху 

(в файле *.out) r 

105 m 4.28 -0.04 1.622*10-2 Вт 0.59 ом 
 

В соответствии с формулой (10.14) КПД=13.9 %.  
 
 

10.7 Учет влияния проводимости грунта 
 

Свойства грунта (земли) могут значительно изменить значения 
сопротивления излучения показанной на рис.10.8 конструкции, причем это 
изменение существенно зависит от свойств грунта.  

В таблице 10.4 приведены значения проводимости и относительной 
диэлектрической проницаемости различных грунтов, взятые из [3]. 

 
Табл. 10.4 

Вид поверхности з , Сим/м   
Сухие почвы и мерзлые грунты 10-4 3 
Пески с влажностью около 20% 10-3 5 
Глины с влажностью около 40% 10-2 7 
Суглинки с влажностью около 60 % 5*10-2 11 

 

Как видно, проводимость грунтов может на практике меняться в широких 
пределах – от σ =10-4 до σ =5*10-2 Сим/м. Рассмотрим влияние проводимости 
грунта на входное сопротивление и  сопротивление излучения антенны.  

На рис. 10.26 показаны результаты расчетов на частоте 100 кГц зависимости 
действительной части входного импеданса и сопротивления излучения от 
значения з  проводимости нижнего полупространства показанной на рис.10.8 
схемы с количеством «спиц зонтика» N=18, длиной L=40 м, углом их наклона 
 =550 и длиной проводов «звезды заземления» 140 м. Количество проводов 
«звезды заземления» равно количеству «спиц зонтика». По вертикальной оси 
отложено значение сопротивления в Омах, по горизонтальной – значение 
проводимости грунта з . 
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Рис. 10.26. Зависимости входного сопротивления и  сопротивления излучения (по 

оси Y) от проводимости грунта (по оси X) 
 
Как видно из рис. 10.26, при относительно больших значениях з  входное 

сопротивление составляет около 0.95 Ом и близко к значениям сопротивления 
излучения, что говорит о небольших потерях в грунте в этом случае. Отметим, 
что эта величина согласуется с максимальным значением сопротивления 
излучения, соответствующего антенне над идеально проводящей плоскостью. С 
уменьшением з  входное сопротивление возрастает в рассмотренном случае до 
12 Ом, а сопротивление излучения падает до 0.36 Ом, что означает значительное 
увеличение потерь в грунте. 

Мнимая часть входного импеданса от проводимости грунта в исследованном 
случае зависела слабо и составляла около 650 Ом. 

10.8 Учет потерь в конструкции антенны 
Предыдущие расчеты проводились в предположении, что материал самой 

антенны является идеально проводящим. Для расчета КПД необходимо знать, как 
влияет конечная проводимость материала на входное сопротивление и 
сопротивление излучения. FEKO позволяет учитывать такое влияние. На рис. 
10.27 показаны результаты расчетов зависимости входного сопротивления и 
сопротивления излучения от значения з  проводимости нижнего 
полупространства, показанной на рис.10.10 схемы с теми же параметрами, что и в 
предыдущем случае, но с учетом потерь в металле АМУ на частоте 100 кГц. По 
вертикальной оси отложено значение сопротивления в Омах, по горизонтальной – 
значение проводимости грунта з . При расчетах в качестве материала для самой 
мачты и «спиц зонтика» использовалась сталь, а для «звезды заземления» - медь. 
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На графике приведены данные как для отсутствия потерь в металле (тонкие 
кривые), так и с учетом этих потерь (утолщенные кривые).  

По вертикальной оси отложено значение сопротивления в Омах, по 
горизонтальной – значение проводимости грунта з . 

 

 
Рис. 10.27. Зависимости входного сопротивления и  сопротивления излучения от 

проводимости грунта с учетом потерь в металлоконструкциях 
 
Как видно, потери в металле конструкции антенны привели к заметному 

возрастанию входного сопротивления, но практически не отразились на 
сопротивлении излучения. Отметим, что на достаточно влажных грунтах 
( з  <0,01 ) потери в металлоконструкциях превышают потери в почве. 

10.9 КПД антенны в зависимости от состояния грунта 
Используя результаты расчетов, учитывающих потери в почве и в 

металлоконструкциях антенны, с помощью соотношения (10.8) можно оценить 
коэффициент полезного действия схемы, показанной на рис. 10.8. 
Соответствующие результаты приведены на рис. 10.13. Расчеты проводились для 
конструкции с количеством «спиц зонтика» N=18, длиной L=40 м, углом их 
наклона   =550 и длиной проводов «звезды заземления» 140 м. 

Для того, чтобы воспользоваться соотношением (10.8), необходимо знать 
также активную часть катR  эквивалентного сопротивления катушки, учитывающая 
джоулевы потери в ее проводнике и окружающих конструкциях. На рис. 10.28 
представлены результаты расчетов КПД на частоте 100 кГц для катR  = 1.5; 2.5 и 
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3.5 Ом. Предполагается, что на этой частоте достигнуто идеальное согласование с 
передатчиком. 

 

 
Рис. 10.28. Зависимость КПД зонтичной антенны от проводимости грунта 
 
Как видно, при действительной части импеданса катушки 2.5 Ом КПД 

достигает 21,6 % для наиболее влажных грунтов (см. табл.1) . Для, например, 
песков с влажностью 20% КПД составляет около 11%. Для мерзлых грунтов и 
совершенно сухих почв КПД может упасть до 3%.  

Наиболее эффективна работа рассматриваемой антенны над очень влажной 
средой. Как указано в [3], проводимость морской воды составляет около 2 Сим/м, 
поэтому при работе над морской поверхностью КПД при действительной части 
импеданса катушки 2.5 Ом достиг бы 22%. 

Коэффициент полезного действия существенно зависит от длины «спиц 
зонтика», поскольку от этой длины зависит сопротивление излучения. На 
рис. 10.29 приведены зависимости КПД антенны от длины L «спиц зонтика» для 
различных почв. По горизонтальной оси отложены значения длины L «спиц 
зонтика». При проведении этих расчетов действительная часть импеданса 
катушки была принята равной 2.5 Ом. 
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Рис. 10.29. Зависимость КПД от длины «спиц зонтика» 

 
Рассмотрим вопрос о частотной характеристике КПД. На рис. 10.35 

представлены расчетные частотные зависимости действительной части входного 
сопротивления и сопротивления излучения для рассмотренной системы с 
количеством «спиц зонтика» N=18, длиной L=40 м, углом их наклона  =550 и 
длиной проводов «звезды заземления» 140 м. 

Проводимость грунта взята равной 10-3 (пески с влажностью 20%), 
сопротивление потерь катушки 2.5 Ом. По горизонтальной оси отложена частота 
в кГц, по вертикальной – значения сопротивления в Омах. 
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Рис. 10.30. Частотные зависимости действительной части  входного 

сопротивления и сопротивления излучения 
 
Как видно из рис. 10.31, с ростом частоты действительная часть  входного 

сопротивления растет, что обусловлено главным образом увеличением потерь в 
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металле. Растет и сопротивления излучения, так как возрастает электрическая 
длина антенны. В результате отношение сопротивления излучения к 
действительной части  входного импеданса, т.е. КПД с учетом только джоулевых 
потерь, при идеальном согласовании передатчика с антенной  меняется слабо 
(рис.10.31). 
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с учетом потерь на рассогласование

при идеальном согласовании

  
Рис. 10.31. Частотные характеристики КПД  

с учетом согласования и без него 
 
Однако обычно идеальное согласование возможно только на одной – 

центральной – частоте. По мере отхода от этой частоты появляются потери на 
рассогласование, вызванные отражением части энергии от АМУ. На рис.10.31 
показано также значение КПД с учетом потерь на рассогласование. При расчете 
этой кривой предполагалось, что выходной импеданс тракта передатчика имеет 
только частотно-независимую действительную часть, равную действительной 
части импеданса АМУ на центральной частоте. 

На рис. 10.32 и 10.33 представлены результаты расчета частотных 
зависимостей КПД с учетом потерь на рассогласование для различных типов 
грунтов. Результаты приведены для двух значений длины «спиц зонтика»: L=40 м, 
когда достигается максимум сопротивления излучения, и L=105 м, когда 
достигается заданная в техническом задании собственная емкость АМУ. По 
горизонтальной оси отложена частота в кГц.  
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Рис. 10.32. Частотная зависимость КПД для H=100 м и L=40 м 

 
Как видно из рис.10.32 и 10.33, несмотря на то, что при L=40 м КПД на 

центральной частоте 100 кГц выше, при L=105 м сохраняется более высокое 
значение КПД в полосе более 2%. КПД в полосе 3% составляет около 8%. 

На рисунке 10.35 приведены результаты для случая, когда высота мачты 
увеличена до 110 м. 

Как видно из сравнения рисунков 10.33 и 10.34, максимальное значение КПД 
для почвы типа суглинков с влажностью 60% возросло с 13% до 16.8%. Теперь в 
полосе 3% КПД для такой почвы составляет величину не хуже 9.3 %.  
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Рис. 10.33. Частотная зависимость КПД для H=100 м и L=105 м 
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Рис. 10.34. Частотная зависимость КПД для H=110 м и L=105 м 

 

10.10 Удлинительная катушка и ее расчет.  
Поскольку антенна имеет емкостной характер входного импеданса, 

последовательно с ней ставится индуктивность, которая называется 
удлинительной катушкой. Эта катушка имеет потери и эти потери определяют ее 
добротность и рабочую полосу антенны. Для прикидочных расчетов можно 
считать, что на частоте 136 кГц реактивное сопротивление емкости 1000 пФ 
составляет 1000 Ом и пропорционально увеличивается при уменьшении емкости 
по сравнению с 1000 пФ. Соответственно для индуктивности каждая микрогенри 
дает около 1 Ом. Такие цифры легко запомнить. Большая точность расчетов очень 
часто и не нужна, поскольку рассчитанные величины все равно придется уточнять 
экспериментально. 

Может возникнуть вопрос, почему бы не найти индуктивность удлиняющей 
катушки, зная емкость антенны и используя формулу для обычного 
колебательного контура? Конечно, можно и так. Но расчет через реактивные 
сопротивления позволяет оценить, например, напряжение на антенне при 
заданном токе и сопротивление потерь удлинительной катушки при известной ее 
добротности. Так, в приведенном примере сразу ясно, что напряжение на антенне 
будет порядка 2000 В на каждый ампер тока в антенне. Поскольку активная часть 
входного сопротивления антенны много меньше реактивной части, напряжение на 
антенне в вольтах приблизительно равно току антенны в амперах, умноженному 
на реактивное сопротивление антенны в омах. Сопротивление потерь катушки, ее 
реактивное сопротивление и добротность связаны простой формулой: RKaT=XL/Q. 
При добротности Q = 200 сопротивление потерь будет 2000/200 = 10 Ом. 



253 
 

10.11  Напряжение на элементах конструкции 
Исследование распределения напряжения на элементах антенны необходимо, 

в частности,  для решения вопросов, касающихся электрической прочности – 
выбора изоляторов и т.п.  

Были проведены расчеты распределения напряжения относительно провода 
«звезды заземления» вдоль вертикальных линий. Эти линии проходят через 
«спицу зонтика», расположенную над проводом заземления, и отстоят от мачты 
на расстояние sA, где А-длина горизонтальной проекции «спицы зонтика» (рис. 
10.35). Методика заключается в том, что рассчитывается ближнее поле вдоль 
вертикальной линии. 

 

      
Рис. 10.35. К расчету напряжения между горизонтальной частью антенны и 

землей на расстоянии A 
Это ближнее поле записывается в файл c расширениями *.efe (электрическая 

компонента) и *.hfe (магнитная компонента), режим записи которых задается в 
диалоге рис. 10.36. 

 

  

Рис. 10.36. Диалог задания 
ближнего поля вдоль линии 

Рис. 10.37. Установка опций 
экспорта файла ближнего поля 

вдоль линии 
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Результаты расчетов для s=0.5 и s=0.98, т.е. для двух линий (пунктир на 
рис. 10.35), одна из которых отстоит от мачты на половину расстояния А, а вторая 
проходит через «спицу зонтика» вблизи ее конца, приведены на рис. 10.41. 
Расчеты проводились для варианта конструкции высотой H=100 м, длиной «спиц 
зонтика» L=105 м и их количеством N=18, длиной проводов «звезды заземления» 
l=140 м и их количеством n=18. 

По вертикальной оси отложены значения отношения напряжения к э.д.с. 
генератора, по горизонтальной – высота подъема точки наблюдения над проводом 
«звезды заземления». 

Расчет выполнен с помощью программы Excel, в которой удобно ввести в 
виде таблицы данные электрического поля, рассчитанные с помощью FEKO и 
затем выполнить арифметические действия последовательного суммирования 
напряженности электрического поля (рис. 10.38, 10.39). 

 

 
Рис. 10.38. Заполнение таблицы Excel данными ближнего поля, 

экспортированными из программы FEKO для расчета напряжения 
 
1-й столбец – номер сегмента, на который делится вертикальная линия, вдоль 

которой выведена напряженность электрического поля. 
Столбец А:  Напряженность электрического поля 
Столбец B:  =ПРОИЗВЕД(A1;0,02) 
Столбец D:  =SIN(C1*3,1415/180) 
Столбец E:    =B1*D1 
Столбец F:   SUM (    )    
По горизонтальной оси нужно выставить ряд1, для чего зададим команду 

«выбрать данные», затем нажмем «Изменить данные горизонтальной оси» и 
выделим курсором тот диапазон расстояние от центра антенны до тестируемой 
точки, которые нужно выбрать на горизонтальной оси.  

Расчеты показывают, что для подобных структур можно добиться хорошей 
точности вычислений, когда точка наблюдения находится на достаточном 
удалении от проводов, а при приближении к проводам точность вычислений 
снижается. Таким образом, следует ожидать, что точность графиков на рис.10.40 
невелика вблизи всплесков напряжения. С учетом сказанного примем, что 



255 
 

напряжение вблизи «спицы зонтика», в т. ч. вблизи ее конца, может достигать 
значений порядка 40...65е, где е – напряжение на выходе передатчика.  

Если исходить из того, что ток на выходе передатчика может достигать 550 
А,  то с учетом того, что входное сопротивление антенны при резонансе 
составляет около 4.5 Ом (на хорошо проводящих грунтах), напряжение вблизи 
«спицы зонтика» может достигать 60-70 кВ (рис. 10.40). 

 

 
 

Рис. 10.39. Диалоговое окно программы EXCEL 
 

 
Рис. 10.40. Распределение напряжения между антенной и землей на различных 

расстояниях от мачты (горизонтальная ось в м) 
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10.12 Расчет напряжения на концах растяжек 
 

Выведем расчет ближнего поля вдоль вертикальной линии высотой 47 м, на 
которой заканчиваются растяжки зонтичной антенны. 

Исходными данными является напряженность электрического поля вдоль 
линии. Эти данные можно вывести на график во время постпроцессорной 
обработки данных, в программе POSTFEKO (рис. 10.41), а также получить в 
файле. 

 

 
Рис. 10.41. Распределение ближнего поля вдоль вертикальной линии 

 
 

  
Рис. 10.42. Распределение ближнего 
поля вдоль вертикальной линии. 
Ближнее поле рассчитывается через 1м 

Рис. 10.43. Задание 4001 точки 
вдоль вертикальной линии, по 
которой рассчитываются  
напряженность поля в точках 
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Рис. 10.44. Распределение ближнего поля вдоль линии, по которой 

рассчитывается напряжение (по оси X – номер точки, в которой рассчитывается 
ближнее поле) 

 
Это рассчитанное поле в этих точках переносим в табличном виде в 

программу Excel, в которой выполняем интегрирование (суммирование 
произведения напряженности на размер ячейки), чтобы получить суммарное 
напряжение (рис. 10.45). 
 

 
Рис. 10.45. Напряжение в точках пространства по линии от земляной платы 

параллельно оси Z (по оси Y единицы в кВ). 
 

Программа FEKO хорошо подходит для анализа излучающих структур, 
которые можно представить в виде проводов. Программа FEKO восходит к 
известным программа MNAMA и NEC, в которых структура полностью 
представлялась в виде проводов. В «тандеме» с Excel  программа FEKO 
позволяет решить задачу проектирования, расчета КПД и напряжений пробоя в 
СВЧ структурах. Алгоритм решения рассмотренной задачи разработал к.т.н. 
Давыдов А.Г, которому авторы приносят большую благодарность за 
предоставленный материал. 
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11  МОДЕЛИРОВАНИЕ АНТЕННОЙ РЕШЕТКИ В FEKO 

Анализ бесконечной антенной решетки можно свести к  анализу одного 
периода благодаря теореме Флоке [13]. Поэтому анализ антенной решетки можно 
выполнить на основании моделирования только одного элемента. Наложение 
периодических граничных условий в этом случае приводит к бесконечной 
антенной решетке. Отметим, что для бесконечной решетки понятие диаграммы 
направленности (ДН) некорректно, так как оно вводится только для источников 
излучения с конечными размерами. ДН бесконечной решетки описывается 
дельта–функцией и физического смысла не имеет. Тем не менее, применение 
периодических граничных условий позволяет  использовать результаты анализа 
бесконечной структуры для оценки ДН конечной решетки (рис. 11.1-11.2). 

 
 

Рис. 11.1. Антенна решетка, встроенная в металлический корпус 
 
 

Элементы решетки можно расположить вдоль одной линии (одномерная 
решетка), или на плоскости (двумерная решетка). Так, на рис. 11.1 представлена 
одномерная антенная решетка, которая состоит из нескольких рядом 
расположенных планарных антенн.  На рис. 11.2 показана антенная решетка, 
составленная из микрополосковых антенн, которая включает цепи разводки, 
обеспечивающие возбуждение каждой из антенн с нужной амплитудой и фазой. 
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Рис. 11.2. Антенная решетка, работающая на частоте 4.6 ГГц и состоящая из 32 

излучаемых элементов (4 блока по 8 элементов) 
 
 Диаграммы направленностей отдельного элемента антенной решетки и всей 
антенной решетки показаны на рис. 11.3. 
 

 
Рис 11.3. Диаграммы направленности элемента ФАР и всей решетки 
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Для расчета диаграммы направленности и других характеристик решетки 

большого размера используются периодические граничные условия. В этом 
случае достаточно выполнить анализ одного элемента антенны, и при расчете ДН 
всей решетки, учесть ее параметры.  

Рассмотрим пример антенной решетки, в качестве элемента которой 
используется планарная антенна (рис. 11.1), запитанная в точке, смещенной от 
центра на расстояние pin_pos. Частота 3 ГГц. 
 

 
Рис. 11.4. Структура и размеры одной пач-антенны антенной решетки.  

Точка питания смещена от центра на 7.5 мм 
 
В проекте используются следующие переменные, которые введем, нажимая 

правой кнопкой на Variables в дереве проекта, и выбирая команду Add Variable 
(размеры в метрах): 

Табл. 11.1. Переменные проекта 
lambda = 0.1  (длина волны , равная шагу для периодических 

граничных условий), т.е. 100 мм=10 см (3 ГГц) 
freq = c0/lambda  рабочая частота пач-антенны (3 ГГц) 
er = 2.55  относительная диэл. проницаемость подложки 
base_width = 0.5*lambda  ширина подложки пач-антенны  50 мм 
base_length = 0.5*lambda  длина подложки пач-антенны    50 мм 
base_height = 0.02*lambda  высота подложки пач-антенны  2 мм 
path_width = 0.3*lambda  ширина пач-антенны   30мм 
patch_length = 0.3*lambda  длина прямоугольника пач-антенны    30 мм 
pin_pos = patch_length/4  смещение точки питания от центра пача   7.5 мм 
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Командой Model ->Add medium dielectric создадим в диалоге рис. 11.5 

материал с именем substrate и относительной диэлектрической проницаемостью 
εr и без потерь. 

Начертим подложку, используя примитив параллелепипед (cuboid). Размер 
стороны  равна base_width  и   base_length и её толщина base_height thick (рис. 
11.5). 

 
 

 
Рис. 11.5. Диалог подложки пач-антенны 

 
Начертим на поверхности подложки форму пач-антенны как прямоугольник 

с длиной patch_length  и шириной patch_width. (рис. 11.6). Толщина поверхности 
равна 0. Центром антенны выберем точку  (0,0,base_height). 

Далее выполним объединение подложки и прямоугольника. Это нужно 
сделать для верного разбиения поверхности на сетку. 

Для того, чтобы возбудить антенну дискретным портом, начертим командой 
Create line провод между пач-антенной и низом подложки.. В диалоге линии (рис. 
11.7) установим начальную точку на (-pin_pos, 0, 0), а конечную точку (-pin_pos, 
0, base_height). 

 
Далее объединим все начерченные элементы пач-антенны командой 

Geometry -> Union и дадим конструкции имя antenna. Эта общая структура 
может включать несколько объемов. В области подробностей установите область 
(Region) параллелепипеда подложки на substrate (рис. 11.8). 
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Рис. 11.6. Черчение металлической поверхности пач-антенны 
 
 

 
 

Рис. 11.7. Черчение линии для создания проводного порта 
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Рис. 11.8. Установка области подложки материалом substrate 

 
 

Кроме этого, в дереве подробностей установим свойства (Face type) фасок 
пач-антенны и земляной стороны подложки как PEC (рис. 11.9). В этом случае 
потери в металле отсутствуют. Для того чтобы внести потери в металлические 
поверхности пач-антенны, стороны металлического листа нужно установить как 
поверхности с потерями. 

 
 

 
Рис. 11.9. Задание свойств поверхности пач-антенны  

 
 

Добавляем проводной порт командой Port-> Create port на середину 
(Middle, рис. 11.10) провода с источником, напряжение которого(1 В, <0º) 
устанавливается командой Excitation->Add voltage source. 
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Рис. 11.10 . Создание порта и установка источника напряжения 

 
Командой Solution -> Set frequency выведем диалог рис. 11.12, в который 

установим частоту freq. 
 

 
Рис. 11.11. Задание частоты расчета  

 
Расчет выполняется за несколько минут. ДН одного элемента показана на 

рис. 11.12. 

 
Рис. 11.12. ДН одного элемента на частоте 3.1 ГГц 
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Для того, чтобы рассчитать характеристики элемента антенной решетки в 
диапазоне частот, зададим диапазон расчета от 2.7 ГГ до 3.2 ГГц. Частотная 
характеристика одного элемента  антенной решетки показана на рис. 11.13. 

 
Рис. 11.13. Частотная характеристика одного элемента ФАР 

 
Для создания антенной решетки задайте команду Model -> Define periodic 

condition и в появившемся диалоге (рис. 11.14), установите периодические 
граничные условия модели, точно идущими по краю подложки. 
 

 
Рис. 11.14. Установка периодических граничных условий  

(справа – для версии FEKO v.6 - добавлен угол луча Beam angle) 
 

Периодические граничные условия устанавливаются по двум векторам, 
начало одного из которых идет от точки Start point до конечной точки первого 
вектора, а второго – до конечной точки второго вектора. 

Периодичность по двум направлениям определяется на основании двух 
плоскостей, проходящих через начальную и конечную точки, и нормаль к 
вектору, которая формируется между ними. Если шаг между соседними 
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элементами в решетке нужно установить большим, то увеличивается расстояние 
между этими плоскостями. 

При определении линейной (1D) антенной решетки, вектор имеет вид 1D, 
периодичность может иметь любую ориентацию, но должна иметь ненулевую 
длину. Для двумерного случая, требуются два вектора. Эти векторы формируют 
две границы из элементарной ячейки, которая является бесконечной в 
направлении нормали к плоскости, на который лежат оба вектора (рис. 11.15). 
Векторы, которые определяют элементарную ячейку для двумерной 
периодичности, должны иметь ненулевую длину, и не могут идти в одном 
направлении.  
  

 

Рис. 11.15. Периодические граничные условия для решетки, 
 периодической по двум направлениям  

 
 

CADFEKO позволяет задавать фазовый сдвиг в направлении каждого из 
векторов, определяющих элементарную ячейку. Заданные величины для сдвига 
фаз используются только в случае, если не задается возбуждение плоской волны. 
(Если фазы определены, и возбуждение плоской волны присутствует, FEKO 
укажет на ошибку во время решения.) 

Для моделирования решетки, использующей периодические граничные 
условия, угол направления луча может быть определен, заданием углов θ и φ (рис. 
11.16). 
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Рис. 11.16.Формирование отклоненного луча антенной решетки 

 
Фаза вдоль векторов периодической решетки будет вычислена 

автоматически, чтобы обеспечить указанное направление луча. 
Если рассматривать случай одномерной решетки, разность фаз между двумя 

границами и угол направления плоской волны излучения находится (в радианах)  
из выражения, которое получается из рис. 11.16: 

 
Ф=2d/*sin() 

 
Теперь зададим требуемые рассчитываемые характеристики дальнего поля: 

 Вертикальное сечение ДН (E-plane) дальнего поля для одного элемента 
антенной решетки; 

 Вертикальное сечение ДН (E-plane) дальнего поля для решетки 10 на 10 
элементов. 

 

 
Рис. 11.17. Задание для расчета дальнего поля антенной решетки 

 
Перед расчетом нужно задать разбиение конструкции на треугольную сетку. 

Разбиение на треугольники токонесущей поверхности выполним со следующими 
параметрами: 

-Triangle edge length: lambda/20, (длина стороны треугольника) 
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-Wire segment length: lambda/100 (длина проводного сегмента), 
-Tetrahedral edge length: Not applicable (не применяется), 
-Wire segment radius: lambda/1000 (радиус проводного сегмента). 

Зададим команду Create->Create Mesh, и в диалоге рис. 11.18 внесем эти 
параметры. 
 

 
 

Рис. 11.18. Диалог ввода параметров сетки разбиения 
 

Далее запустим FEKO на расчет и рассмотрим два случая: 
 

1. Диаграмма направленности антенной решетки рассчитывается на основании 
заданного сдвига фаз между соседними элементами. Для этого используем 
ту же самую геометрию как для первой модели. Инструкции по разбиению 
на сетку также те же самые. Изменения периодических условий 
устанавливаются, заданием сдвига фаз в обоих направлениях, например 
u1=30 и u2=0. 
 

2. Диаграмма направленности рассчитывается на основании заданного угла 
направления излучения  
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Рис. 11.19. Задание количества элементов:  

1 элемент - вдоль вектора 1, и четыре элемента вдоль вектора 2. 
 

Используем ту же геометрию, как в первой модели. Инструкции по 
разбиению на сетку те же самые. Изменим установки периодических граничных 
условий следующим образом:  

Удобно также просмотреть ДН на трехмерной структуре элемента антенной 
решетки (рис. 11.20). Диаграммы направленности показаны в виде «петель», 
которые начинаются в фазовом центре антенны. Петля на рис. 11.21 более узкая. 

  
Рис. 11.20. ДН одной  

пач-антенны 
Рис. 11.21. ДН антенной решетки  

из 10 элементов  
 

Изменение угла наклона луча антенной решетки выполняется, установкой 
угла в разделе «Specify phase shift» (рис. 11.22) 
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Рис. 11.22. Задание сдвига фаз на 30º вдоль первого вектора антенной решетки 

 
В результате расчета при задании сдвига фазы 20º вдоль первого вектора 

определяем, что ДН сместилась на угол, показанный на рис. 11.23. 
Определим фазовый сдвиг установкой угла луча для Theta=20 и Phi=0. 

 
 

Рис. 11.23. Сечение ДН одного элемента антенной решетки и решетки размером 
10 на 10 при направлении луча на угол Tetha=20 

 
Из рис. 11.23 видим, что ДН антенной решетки, состоящей из 10 на 10 

элементов, имеет направление излучение при Tetha=-20 град. 
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12  ПРОЕКТИРОВАНИЕ ЗЕРКАЛЬНОЙ АНТЕННЫ С ПОМОЩЬЮ 
ANTENNA MAGUS 

12.1 Общие положения 
Зеркальные антенны использовались, начиная с открытия 

распространения электромагнитной волны Герцем в 1888 г. В дни Второй 
мировой войны эта конструкция использовалась в СВЧ радиолокаторах. 
Развитие связи в дальнем космосе в 1960-ых привело к широкому 
распространению зеркальных антенн. Чаще всего в качестве зеркала 
используются параболические рефлекторы. 

 

 
 

Рис. 12.1. Рупорная антенна и 
зеркальная антенна 

Рис. 12.2. Ближнее поле в сечении 
зеркальной антенны 

  
Рассматриваемая антенна состоит из симметричного параболического 

отражателя с круглой апертурой и пирамидальной рупорной антенной, лежащей 
"на оси луча". Рупорная антенна должна быть расположена так, чтобы её 
фазовый центр совпадал с фокусом рефлектора. Однако наличие фазового пятна 
приводит к тому, что положение антенны часто фокусируется 
экспериментально, находя оптимальное положение, при котором 
минимизируется уровень боковых лепестков. 

Рупорная антенна может быть запитана волноводным портом или  штырем, 
к которому подключен коаксиальный кабель. 

Антенна с параболическим отражателем, показанная на рис. 12.1, состоит из 
двух крупных узлов, исключая стойки опоры и коаксиальную или волноводную 
линию питания. Диаметр D параболической  отражающей поверхности больше 
длины волны λ. Например, рефлектор с D=1.5м, работающий на частоте 10 ГГц, 
имеет D/λ=150. В противоположность этому, размеры апертуры рупорной 
антенны в большинстве случаев равны несколько длин волны. Например, 
оптимальный пирамидальный рупор с усилением приблизительно 22 dB в X-
диапазоне имеет размеры апертуры приблизительно 4 λ x 5 λ. 
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Рис. 12.3. Сечение параболоида вращения 

 
В декартовой системе координат параболическая поверхность записывается 

в виде уравнения (начало координат совпадает с вершиной параболоида) 

    (12.1) 
где f – фокусное расстояние.  

 
В сферической системе координат (начало координат совпадает с фокусом) 

расстояние от фокуса до параболы изменяется, при изменении угла ϴ по закону 

    (12.2) 
f< R/2 - короткофокусные антенны, фокус находится внутри антенны, 
f> R/2 - длиннофокусные антенны, фокус находится вне антенны, 
f=R/2 – сфокусированная параболическая антенна. 

Если положить θ=0º, то, согласно (12.2), расстояние до зеркала антенны равно 
фокусному расстоянию. 

Назначение рефлектора состоит в том, чтобы преобразовать широкую 
диаграмму направленности рупорной антенны (первичная ДН) к ДН с узким 
лучом (вторичная ДН). Это достигается использованием оптических свойств 
параболоида, согласно которому все лучи, излучаемые из фокуса облучателя, 
суммируются после отражения и направляются параллельно оси рефлектора. 
Таким образом, в плоскости апертуры поле всюду имеет одну фазу. 

Однако, интенсивность поля в плоскости апертуры не одинакова, из-за 
ослабления по закону 1/r поля сферической волны при распространении от фокуса 
до поверхности рефлектора (r - функция угла освещения). Это приводит к 
спаданию интенсивности поля до нуля к краю апертуры. Ширина луча 
определяется отношением f/D. Кроме того направленность первичного излучения 
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способствует дополнительному изменению формы амплитудного распределения. 
Наконец, на амплитудное распределение в апертуре действует эффект затенения 
облучателем и опорными стойками.  

Существует зависимость между формой амплитудного распределения поля 
в апертуре антенны, КНД антенны и уровнями боковых лепестков ДН. Чем 
сильнее спадает амплитуда поля к краю раскрыва, тем более низкие уровни 
боковых лепестков формируются в ДН, но за счет уменьшения эффективности 
использования апертуры. 

Когда электромагнитное поле падает на рефлектор точно из фокуса, антенна 
может обеспечить очень узкий луч с небольшими задними лепестками и 
хорошими характеристиками кросс поляризации. 

Ширина частотной полосы параболического отражателя ограничена на 
нижней частоте конечными размерами рефлектора. На самых высоких частотах 
характеристики ограничены из-за увеличения апертурных фазовых искажений, 
вызванными систематическими и случайными отклонениями от идеальной 
параболической поверхности рефлектора. 

Импедансные характеристики этой антенны зависят от рупорной антенны. В 
большинстве случаев, импеданс антенны будет определяться волноводно-
коаксиальным переходом рупорной антенны. Антенны с параболическим 
отражателем имеют высокий коэффициент усиления и способны к формированию 
узкого луча.  

Будем решать задачу разработки зеркальной антенны, работающей на 
частоте 10 ГГц, которая бы использовала в качестве облучателя рупор. На первом 
этапе используем программу Antenna Magus. 

Antenna Magus - это библиотека более сотни уже разработанных 
конструкций антенн, позволяющая использовать готовые решения на первом 
этапе проектирования антенных систем. Antenna Magus не проводит 
электродинамический расчет антенн, это выполняет FEKO. Ее использование 
позволяет оценить базовую топологию антенны для заданного приложения, 
применяя уже отработанную конструкцию, и тем самым уменьшить время 
разработки. 
       Краткая характеристика программы Antenna Magus: 

• Имеется коллекция более чем из 100 антенн; 
• Надежные алгоритмы проектирования гарантируют, что имеющиеся 

конструкции реализуют заданные характеристики; 
• Многие характеристики антенны, такие как S-параметры, КСВ, коэффициент 

усиления и диаграммы направленности можно выводить на графики. 
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Рис. 12.4. Интерфейс программы Antenna Magus 

 

12.2 Задание характеристик в программе Antenna Magus 
Активизируем (нажмем) на кнопку Design Mode (рис. 12.5). И выберем 

среди многих вариантов антенн, которые моделирует и анализирует Antenna 
Magus, зеркальную антенну Horn-Fed Paraboloic Antenna.  

Ширину луча в  E- и  H-плоскостях можно увеличить (или уменьшить) 
уменьшая (или увеличивая) диаметр рефлектора. 

Для максимальной эффективности антенны, хорошее приближение для 
расчета дает выбор параметра edge taper= 10 dB. Различные величины edge tapers 
создают различные величины illumination и spillover loss. Другие параметры 
будут влиять на эффективность и могут изменять однородность девиации 
фазового центра и поляризации, а также апертуру [Balanis, pp. 813-823]. 

Фазовый центр рупорной антенны должен быть расположен в точке фокуса 
параболоида. Для пирамидального рупора фазовый центр находится близко к 
апертуре рупора, однако желательно определить фазовый центр 
экспериментально. Более того, рупор должен быть очень точно сфокусирован, 
рассматривая вторичную диаграмму направленности и подстраивая положение 
точки питания (по оси и по смещению) для достижения максимума усиления и 
минимума уровня первого бокового лепестка. Наиболее чувствительным 
критерием является глубина и первый нуль. 

Типичное значения отношения F/D находится между 0.3 и 0.65. 
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Рис.12.5. Интерфейс программы Antenna Magus 

 
В окне Design Objectives в разделе Design for: выберем желаемые 

характеристики антенны по критерию усиления антенны Gain:  
• Центральная частота  f =10 ГГц; 
• Ширина луча рупорной антенны, облучающей параболическую антенну  60 

град; 
• Желательное усиление системы 30 dBi. 

 
При внесении исходных данных высвечивается диапазон возможных величин 

характеристик. Например, угол в плоскости E можно задать в диапазоне 

 от 40º до 120º. После внесения этих данных 
можно нажать кнопку Design Antenna. Через некоторое время получим все 
размеры структуры. 

Можно также задать другой критерий проектирования. Например, угол луча 
будущей зеркальной антенны. Тогда в окне Design for: выберите характеристику 
beamwidth по уровню 3 дБ. 
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Рис. 12.6. Проектирование антенны по критерию ширины луча:  

в строке Design for: выберем критерий beamwidth  (ширина луча) 
 

Третья возможность задания критерия синтеза конструкции антенны – по 
углу первого лепестка ДН. Для задания критерия на синтез такой антенны в 
разделе Design for: выберем опцию ширины первого нуля  first null beam width. 

 
 

Рис. 12.7. Выбор угла первого бокового лепестка зеркальной антенны 
 

Результаты расчета, полученные в Antenna Magus, сведем в табл. 12.1.  



277 
 

Таблица 12.1 

Параметр Наименование параметра 
1  

критерий расчета 
(усиление 30 dBi) 

2  
критерий 
расчета 

3  
критерий 
расчета 

F Фокусное расстояние 334.1 мм 540.8 мм 391.6 
D Диаметр параболоида 358.1 мм 579.6 мм 419.7 
S Расстояние до рупорной 

антенны 
334.1 мм 540.8 мм 391.6 

Wg Ширина волновода 23.53 23.53 23.53 
Hg Высота волновода 11.77 11.77 11.77 
Lg Длина волновода 29.98 29.98 29.98 
Wa Ширина апертуры 

(раскрыва рупорной 
антенны) 

 60 мм 60 

Ha Высота апертуры 43.5 43.5 мм 43.5 
Lf Длина раскрыва рупорной 

антенны 
103.5 103.5 мм 103.5 

     
 Общие габариты антенны    

X  358.1 мм 579.6 мм 419.7 
Y  358.1 мм 579.6 мм 419.7 
Z  467.6 мм 674.3 мм 525.1 

 
Программа Antenna Magus позволяет собственными средствами рассчитать 

и вывести на график характеристики дальнего поля: Gain (Theta), Gain (Phi) в 
прямоугольной или полярной системе координат.  

Для того чтобы рассчитать и вывести на графики характеристики, нажмите 
на кнопку Estimate Perfemance. Рассчитанные (через некоторое время, до минут) 
характеристики выводятся на графики (рис. 12.5- 12.7). 

 
Рис. 12.8. ДН в диапазоне меридиональных углов от -20 до +20 град 
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На рис 12.8 можно видеть, что уровень боковых лепестков находится в 
пределах -25 дБ. 

Теперь нажмите на кнопку экспорта модели . В интерфейсе программы 
Antenna Magus появляется раздел импорта модели (рис. 12.9), в котором выберем 
закладку FEKO.  

Имеется 2 опции: Выбор типа модели, экспортируемой в FEKO: полная 
параметрическая модель рупорной антенны, запитываемой в точке и 
рассчитываемой методом MLFMM;   

- расчет методом MoM и PO, в котором рупорная антенна считается 
методом моментов, а зеркальная параболическая – методом физической оптики. 

Нажмите кнопку Export Model. Выберите путь и имя сохранения файла 
задачи с расширением  *.cfx (CADFEKO Model). Теперь программу Antenna 
Magus можно закрыть, нажимая Exit Magus. 

Запустим программу FEKO и откроем задачу, созданную в результате 
работы Antenna Magus. В интерфейсе FEKO открывается полностью 
параметризованная модель зеркальной антенны, облучаемой рупорной антенной. 
 

 
 

Рис. 12.9. Интерфейс Antenna Magus  с результатами расчета зеркальной 
антенны.  
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Рис. 12.10. Геометрия и размеры антенной структуры 
 

 
 

Рис. 12.11. Интерфейс программы FEKO и диалог выбора единиц черчения  
 

Отметим, что размер переменных дан в метрах, и размеры конструкции в 
метрах. Так что масштабирование выполнять не нужно. Для расчета диаграммы 
направленности зададим:  
• в вертикальной полуплоскости ZOX  расчет ДН от -90º до 90º с шагом 2º; 
• в вертикальной полуплоскости ZOY (для чего ставим φ=90°); 
• а также две ДН более подробные, с шагом 0.2°. 



280 
 

 
 

 
 
 

 

Рис. 12.12.  
Вывод характеристик 
дальнего поля в 
плоскости XOZ 
В верхней 
полуплоскости с 
шагом 2 º. 

 

Рис. 12.13.  
Вывод характеристик 
дальнего поля в 
плоскости XOZ 
В пределах от -20º до 
20º в верхней 
полуплоскости с 
шагом 0.2º. 
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Рис. 12.14. 
В плоскости YOZ 
С шагом 2º 

 

Рис. 12.15.  
В плоскости YOZ   
с шагом 0.2º 

 
В конструкции имеются 2 объекта – рупорная антенна и зеркальная антенна. 

Эти объекты могут быть по отдельности решены разными методами. Так, 
возможно задать решение зеркала методом физической оптики PO. Другая модель 
расчета, выбираемая в Antenna Magus – предусматривает метод расчета 
MLFMM. 

 
Выполним разбиение на треугольники всю поверхность, по которой 

протекает ток. При этом поверхность зеркала разбивается на треугольники с 
длиной стороны wavelength_centre/4.5, а поверхность рупорной антенны - на 
более мелкие треугольники с длиной стороны wavelength_centre/8. 
 В результате расчета получает диаграмму направленности антенны, 
показанную на рис. 12.16. 
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Рис. 12.16. ДН зеркальной антенны в диапазоне углов -20°  - 20° 

 
Решения, полученные на FEKO в данном случае, близки решениям, 

полученным на Antenna Magus. 

12.3  Расчет отдельных антенн разными методами 
Используем для расчета рупора метод моментов, а для расчета зеркала – 

метод физической оптики. Можно рассчитать методом моментов обе антенны, а 
можно разделить, и рупорную антенну рассчитать методом моментов, а все 
плоскости зеркальной антенны описывать как PO – в этом случае для расчета 
зеркальной антенны используется метод физической оптики. 

В случае расчета методом моментов, структуру нужно разбить на 
треугольники (сетка разбиения, mesh). Задача требует внутренней памяти RAM 
48 МБ. 

 
 

Рис.12.17. Ток на поверхности зеркальной антенны.  
Решение методом MOM обоих частей задачи 
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Рис. 12.18. Задание расчета  поверхности антенны  

методом физической оптики 
Свойство зеркала устанавливаем на PO - методом физической оптики (рис. 

12.18).  

 
 

Рис. 12.19. Диалог последовательности расчета  антенной системы 
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Расчет методом PO уменьшит требуемый объем памяти и ускорит 
вычисления по сравнению с расчетом зеркала методом моментов. 

Развязка между методом MoM и PO (Decouple) означает, что при расчете 
объектов разными методами, связь между ними не будут учитываться. 
Количество взаимодействий 3 луча означает, что вклад в характеристики будут 
учитываться от трех лучей, которые вносят наибольший вклад. 

После выполнения расчета запустим POSTFEKO, в котором, в первую 
очередь, можно проверить геометрию и выяснить, каким методом будут 
рассчитываться зеркальная и рупорная антенны. Это видно по цветовой раскраске 
компонентов. 

 
Рис. 12.20. Выбор опций расчета методом геометрической оптики  

(расчет методом PO и MoM ведется раздельно) 
 

 
 

Рис. 12.21. Развязки между методом PO и методом MOM  нет 
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Рис. 12.22. Зеркальная антенна, имеет красный цвет, что означает, что она 
рассчитывается методом физической оптики  

 

Рис.12.23. Результаты расчета ДН зеркальной антенны, облучаемой рупором. 
 

ДН, а также другие характеристики, рассчитанные разными методами, 
должны совпадать. 

Итак, в этом разделе с помощью программы Antenna Magus была 
разработана конструкция в виде зеркальной антенны и облучающей рупорной 
антенны. С помощью FEKO рассчитаны электродинамические характеристики 
этой структуры. 
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13  МЕТОД ФИЗИЧЕСКОЙ ОПТИКИ И ЕГО РЕАЛИЗАЦИЯ В FEKO 

Метод физической оптики применяются при анализе объектов с большими 
электрическими размерами. В задачах, связанных с радиолокацией, 
распространением радиоволн, учетом влияния окружающих предметов на работу 
антенн, а также задачах расчета больших апертурных антенн, непосредственное 
использование строгих методов, например, МОМ и МКЭ весьма затруднительно, 
так как они создают системы линейных алгебраических уравнений очень 
большого порядка.   

Одним из наиболее известных асимптотических подходов является метод 
физической оптики (МФО). Он хорошо встраивается в схему МОМ и поэтому 
неслучайно МФО реализован в FEKO. 

13.1  Теорема эквивалентности  
Теоретической основой МФО служит теорема эквивалентности. Пусть даны 

поверхности S и  , ограничивающие объем V. И пусть некоторые сторонние 
источники в виде электрических и магнитных токов me JJ ,  создают на 
поверхностях S и   поля Е и Н (рис. 13.1). 

 
Рис. 13.1. К теореме эквивалентности 

 
Тогда теорема эквивалентности утверждает, что поле в объеме V может 

быть выражено через поле на поверхностях следующим образом: 

 
,

,

 

 









V S

mmm
V S

eee

GdsIGdvJA

GdsIGdvJA
    (13.1) 
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где eA , mA  - векторные электрический и магнитный потенциалы, G – функция 

Грина свободного пространства, а eI  и mI  - эквивалентные источники, заданные 

на поверхностях S и   следующим образом: 
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      (13.2) 

где Е и Н указанные  вектора поля, а n вектор нормали к поверхностям. 

Считаем, что поверхность   это сфера радиуса R стремящегося к 
бесконечности. Тогда согласно условиям излучения, поля, наведенные токами, 
убывают при R  не медленнее чем R

1 . Это достаточное условие для того, 
чтобы утверждать, что интеграл в (13.1) по поверхности   равен нулю. 

Дополнительно формула (13.1) упрощается, если источники находятся вне 
объема V: 
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Теорема эквивалентности в форме (13.3) становится эффективным 
средством решения задач электродинамики, если удается найти хорошие 
приближения для полей на поверхности S. Рассмотрим несколько случаев 
применения теоремы эквивалентности. 

13.2  Излучение из открытого конца прямоугольного волновода. 
Одним из таких примеров является задача об излучении из открытого конца 

прямоугольного металлического волновода (см. рис. 13.2). 
Пусть сторонние источники находятся внутри волновода. Эти источники 

возбуждают основную волну волновода, которая набегает из области z<0 на 
открытый конец волновода, расположенный при z=0. Необходимо найти поле, 
излученное из волновода в открытое пространство. 

 
Рис. 13.2. Излучение из открытого конца волновода 
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Для применения теоремы эквивалентности введем поверхность S 
следующим образом. Она представляет собой параллелепипед, включающий в 
качестве своих граней боковые стенки волновода, выходную апертуру Sa и 
заднюю стенку волновода. Аппроксимируем поле на поверхности S полем 
падающей волны. Оно равно нулю везде за исключением выходной апертуры (на 
внешней поверхности волновода поля падающей волны нет). Для поля основной 
волны волновода можно записать следующее выражение: 

,

, ,cos

2
2 














 

a
k

ЕHe
a
xЕ y

a
x

zi
y




 

    (13.4) 

где a – размер широкой стенки волновода.  
Из формулы (13.2) получаем: 
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Подстановка (13.4), (13.5) в (13.3) приводит к следующему результату: 
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Функция Грина свободного пространства в трехмерном случае 
представляется следующим образом: 
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где координаты со штрихом соответствуют координатам источника, а без 
штрихов координатам точки наблюдения.  

Введем сферическую систему координат как показано на рис. 13.2 и 
преобразуем функцию Грина для случая дальней зоны, то есть когда точка 
наблюдения характеризуется радиусом  : 
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    (13.8) 

Подставим формулу (13.8) в (13.7) и получим выражение для векторных 
потенциалов в дальней зоне: 
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 (13.9) 

Соотношения (13.9) позволяют найти диаграмму направленности открытого 
конца волновода. Таким образом, применение теоремы эквивалентности, 
составляющее основу МФО позволило достаточно просто, по крайней мере, без 
решения интегральных уравнений получить решение сложной задачи. Вопрос в 
том какова точность этого решения. Ответить на него определенно достаточно 
сложно. Дело в том, что строгого аналитического решения для данной задачи 
неизвестно. Такое решение найдено для другой, но весьма близкой структуры. 
Имеется в виду излучение из открытого конца плоского волновода (см. рис. 13.3).  

13.3  Излучение из открытого конца плоского волновода 
 Это двумерная структура, в которой возможно существование полей двух типов. 
Точные решения получены как для Е так и для Н-волн методом Винера-Хопфа.  

 
Рис. 13.3. Излучение из полубесконечного плоского волновода 

 
Проанализируем эти результаты. Рассмотрим сначала расчеты для волны 

Н01 (в этом случае 0xE ). Электрический размер волновода характеризуется 
параметром  


dq  , 

где d – размер волновода,   - длина волны. На рис. 13.4 представлены диаграммы 
направленности рассчитанные по строгой теории и МФО для разных значений 
q=0.51;0.6;1. Из рисунков видно, что уже начиная с размера волновода равного 
длине волны (q=1) диаграммы направленности практически совпадают, особенно 
для излучения вперед (окрестность угла 0 ). При уменьшении размеров 
волновода наблюдается расхождение приближенного метода (Fk) со строгой 
теорией (Fv). Это расхождение (рис. 13.4) значительно сильнее для обратного 
излучения. Последнее легко объяснимо, если учесть, что МФО не учитывает 



290 
 

эффект затекания токов на внешнюю поверхность волновода. В тоже время 
именно эти токи преимущественно определяют обратное излучение.  

 
Рис. 13.4. Диаграммы направленности для 51.0q  

 
Тем не менее, сравнение МФО с методом Винера-Хопфа дает весьма 

обнадеживающий результат, ведь согласование наблюдается уже, начиная с 
апертуры в одну длины волны. Конечно такого же блестящего результата не 
следует ожидать для всех задач рассеяния. Видимо надо признать, что данная 
частная структура хорошо подходит для применения теоремы эквивалентности. 

  
Рис.13.7.Волновод, щелевая 
линия, порт. На сторонах 
метод моментов 

Рис.13.8. Диаграмма направленности, 
рассчитанная на основании метода 
моментов. Размер волновода 23 мм на 10 мм 

 
А теперь рассчитаем эту задачу, используя метод физической оптики. В 

отличие от MoM, решение в котором требовало RAM 300 Mb, в этом случае 
расчет ведется, используя RAM 13 Mб.  
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Рис. 13.11. Диаграмма 
направленности в полярной 

системе координат 

Рис. 13.12. 3-D Диаграмма 
направленности 

 
Часто стоит задача расширить диаграмму направленности открытого конца 

волновода или рупорной антенны, для того, чтобы использовать эту рупорную 
антенну для облучения зеркала и максимального использования площади зеркала. 
Это можно показать на следующем примере. 

 

13.4  Излучение параболической антенны 
Обсуждаемый МФО часто используется для расчета поля излучения 

параболических антенн (рис. 13.13). В этом случае поверхность S проводится так, 
как показано на рис. 13.13. Она охватывает апертуру антенны и продолжается на 
задней поверхности параболоида. Поле на поверхности находится приближенно 
методами геометрической оптики. Для этого рассчитывают траектории лучей, 
исходящих из облучателя антенны (см. рис. 13.13). Далее процедура расчета поля 
излучения не отличается от рассмотренной выше. 
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Рис. 13.13. Параболическая 

антенна с облучателем 
Рис. 13. 14. Ближнее поле в 

сечении параболической антенны 
 

 
 
 
 
 
 
 
 
 
 
 
 

13.5 Рассеяние плоской волны на металлическом цилиндре 
 

В качестве еще одного примера использования МФО для решения 
электродинамической задачи рассмотрим двумерную задачу о дифракции плоской 
волны на металлическом цилиндре (рис. 13.17).  

Для такой структуры целесообразно провести поверхность S по 
поверхности металлического цилиндра. Тогда из граничных условий следует, что 
касательное к поверхности электрическое поле равно нулю и, следовательно, 
равны нулю магнитные токи. Электрические токи задаются следующим образом. 
Цилиндр разделяется на две части: освещенную область и область тени. Для этого 
падающая плоская волна представляется набором параллельных лучей. Точка, в 
которой луч касается поверхности цилиндра, служит границей двух областей. Мы 
видим, что размеры области тени (света) и ее положение зависят от типа 

  

Рис. 13.15. Сечение диаграммы 
направленности парабол. антенны  

Рис. 13.16. Параболическая 
отражательная суммарно-разностная 

антенна 
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источника. Для случая плоской волны каждая из областей занимает половину 
поверхности цилиндра. Если же в качестве источника взять точечный облучатель, 
то размеры областей будут зависеть от расстояния от цилиндра до облучателя.  

 
Рис. 13.17. Дифракция плоской волны на металлическом цилиндре  

(показывается освещенная поверхность и область тени) 
 

 
 

Рис. 13. 18. Падающая плоская волна 
на идеально проводящий цилиндр 

Рис. 13. 19. Ток на поверхности 
идеально проводящего цилиндра 

 
В любом случае для вычисления электрических токов используют 

соотношение, полученное из анализа отражения волн от бесконечного 
металлического экрана. Для такого экрана ток всегда равен удвоенному 
магнитному полю падающей волны. Обобщая этот результат для произвольного 
источника, можно сказать, что ток равен удвоенному значению первичного 
магнитного поля, возбужденному в отсутствие экрана. 
 Математически данное правило можно записать следующим образом: 

 nHJ e ,2 0 .     (13.10) 
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Пусть на цилиндр падает плоская волна Е-типа, имеющая компоненту ziE . 
Для этой компоненты можно записать следующее выражение: 

,)sin()cos(
0

00 yikxik
zi eEE      (13.11) 

где 0  - угол между направлением распространения волны и осью 0х.   
Далее нам потребуется полярная система координат zr : 

z.z ),sin( ),cos(   ryrx    (13.12) 
 В этой системе координат поле (135.11) перепишется следующим образом: 

.)cos(
0

0 ikr
zi eEE      (13.13) 

 Падающая волна имеет единственную тангенциальную к поверхности 
цилиндра компоненту магнитного поля H : 

.
)cos( )cos(0

0
0
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 Отсюда получаем формулу для электрического тока: 
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 Подставляем формулу (13.15) в формулу (13.3): 
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где a – радиус цилиндра. При r  можно получить выражение для векторного 
потенциала в дальней зоне: 
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Для цилиндра большого электрического радиуса 1ka  интеграл в (5.17) 
вычисляется аналитически методом перевала: 
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Таким образом, формула (13.18) представляет собой диаграмму рассеяния 

цилиндра большого электрического радиуса. Приведенные выше примеры 
показывают, что МФО является эффективным инструментом решения задач 
рассеяния на сложных телах. Поэтому неудивительно, что в последнее время он 
все более интенсивно используется в различных системах электродинамического 
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моделирования для описания дифракции на объектах с большими электрическими 
размерами. 

 
Рис. 13.20. Поле излучения цилиндра, облучаемого плоской волной 

 

 
 

Рис. 13.21. Радиолокационный коэффициент отражения от цилиндра 
 

Итак, метод физической оптики, реализованный в FEKO, позволяет 
включить в расчет металлические объекты больших размеров. Эти объекты 
разбиваются на треугольники также, как и в методе моментов, но на центр 
каждого треугольника, составляющего часть поверхности МФО, падает 
оптический луч, который создает ток (13.15). Ток зависит от угла падения. Таким 
образом, в МФО не решается система уравнений, как в методе моментов. 
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14  РАСЧЕТ ДВУХЗЕРКАЛЬНОЙ АНТЕННЫ 

FEKO может решить задачи расчета электродинамических характерис-тик 
конструкций с очень большими геометрическими размерами. Для этого, во 
первых, в FEKO реализованы асимптотические методы расчета (методы 
физической и геометрической оптики), мультипольный метод расчета, а также 
метод сохранения ближнего поля в раскрыве или на заданной поверхности и 
описание излучения в этом  раскрыве, используя поле, сохраненное в файле. 
Применим это для расчета двухзеркальной антенны. 

Выполним моделирование двухзеркальной антенны по схеме Коссегрена, 
состоящей из двух зеркал, верхнего зеркала диаметром 40 см и внешнего зеркала 
диаметром 2 м (рис. 14.1).  

 
 

Рис. 14.1. Двухзеркальная антенна по схеме Коссегрена 
 

Последовательность расчета будет 
заключаться в том, что после расчета рупора 
методом моментов, антенна заменяется своим 
ближним полем.  

Так, круглая рупорная антенна имеет 
круглый раскрыв, и если в этом раскрыве 
запомнить, и записать в файл значения ближнего 
поля, то на следующем шаге можно удалить 
рупорную антенну, и заменить её полем 
излучения.  

Запустим программу Antenna Magus и 
выберем круглую рифленую антенну 
«Waveguide-fed corrugated conical horn», 
работающую на частоте 10 ГГц (рис. 14.2). 

Рупорная антенна может быть спроектирована на центральную частоту, по 
уровню ширины луча 10dB beamwidth (E&H) или КНД (gain). Глубина щелей 

 
Рис. 14.2. Иконка в Antenna 
Magus для проектирования 
волноводного круглого 
рупорной антенны  
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(рис. 14.3) Sd1 выбирается < 0.5λ на наивысшей частоте fmax и для последней 
щели SdN = 0.25λ на частоте f₀. Минимальная и максимальная частоты 
рассчитываются, используя ширину полосы частот как соотношение верхней и 
нижней границ 1.5:1. 

КНД (gain) антенны может быть увеличен с помощью увеличения  длины 
рупора, а также диаметра рупора.  

Ширина луча уменьшается одновременно с увеличением усиления. Для 
получения большей ширины луча и низкого усиления, рупорная антенна должна 
иметь короткий рупор. Для получения  стабильности ширины луча в диапазоне 
частот, а также стабильности фазового центра, можно использовать 
широкополосную версию такой антенны. Увеличение числа гофрирований 
узкополосного рупора может реализовать тот же результат, однако, 
результирующая ширина луча/усиление изменится от исходного проекта.  
 

 
 

 
 

Рис. 14.3. Интерфейс программы Antenna Magus 
 

Для расчета диаграммы направленности с помощью Antenna Magus, 
нажмем на кнопку Estimate Performance (рис. 14.4). 
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Рис. 14.4. Рассчитанная средствами Antenna Magus диаграмма направленности 
рупорной антенны 

 
Затем выполним экспорт модели из программы Antenna Magus и откроем 

эту антенну в FEKO (рис.14.5). 
 

 
 

Рис. 14.5. Гофрированная антенна 
 

Проект, импортированный из Antenna Magus, включает в себя порт на 
круглом волноводе антенны (рис. 14.6). 

Выполним разбиение на сетку и расчет ближнего и дальнего поля круглой 
антенны на частоте 10 ГГц. Сечение диаграммы направленности антенны 
приведено на рис. 14.8. 
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Рис. 14.6. Диалог описания волноводного порта 
 

 
 

Рис. 14.7. ДН рупорной антенны, рассчитанной в FEKO методом моментов  
 

Расчет ближнего поля в раскрыве круглой антенны можно задать в виде 
точек на квадратной плоскости, а можно задать точки на сфере (рис. 14.9). 

Для того чтобы запомнить магнитные и электрические поля в 11 x 37 
точках, необходимо в закладке Advanced  выбрать опцию «Export fields to ASCII 
file” . Эти файлы с расширением *.efe и *.hfe  будут записаны в папку, в которой 
находятся все файлы проекта. 
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Рис. 14.8. Задание расчета ближнего поля в раскрыве антенны 
 

 

 
 

Рис. 14.9. Выбор опций для экспорта данных поля в файлы *.efe и *.hfe 
 

При расчете ближнее поле запишется в файл. Ближнее поле в раскрыве 
круглой антенны показано на рис. 14.11.  
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Рис. 14.10. Ближнее поле в раскрыве круглой антенны.  
Крестиками обозначены сохраняемые точки ближнего поля 

 
Содержание файла Rupor_krug.efe приведено на рис. 14.12. 

 

 
 

Рис. 14.11. Фрагмент файла, в котором сохраняются данные о ближнем поле 
 
Теперь создадим новый проект и исключим из него рупорную антенну. В 

дальнейшем при построении зеркальной антенны будем использовать файлы, в 
которых записано ближнее поле в раскрыве рупорной антенны (элемент 
Гюйгенса). 

В этом новом проекте в качестве источника возбуждения зеркальной 
антенны задаем апертуру Apertura Exitation. 

Параметры апертуры определяются в диалоге рис. 4.12, который вызывается 
командой Apertura field Source. 
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Рис. 4.12. Задание поля в апертуре по данным из файлов 
 

Установим опции такими, как показано на рис. 4.12. Теперь в проекте нет 
иных структур, кроме источника излучения. 
 

После проверки и получения таких же характеристик по дальнему полю, 
определяем зеркальную антенну. 

Начертим в этом проекте параболическое зеркало, которое будет облучаться 
этим ближним полем. Такое зеркало чертится командой Draw -> Paraboloid. В 
появившемся диалоге рис. 4.13 зададим размеры зеркала и фокусное расстояние. 
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Рис. 14.13. Зеркальная антенна, возбуждаемая рупорной антенной 

 
Выделим в окне подробностей фаску зеркальной антенны и зададим на ней 

решение в виде метода физической оптики. 
  Установки на решение методом физической оптики выполняются в 
диалоге, который появляется по команде Solution.  

Теперь окружим сферой систему из рупорной антенны (которая уже 
удалена) и первого зеркала, и рассчитаем на этой сфере значения ближнего поля в 
точках.  

 

 
Рис. 14.14. Сфера, на поверхности которой рассчитывается ближнее поле 
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Рис. 14.15. Выбор сферической системы координат 

 
После расчета можно видеть ближнее поле на поверхности этой сферы. 
Теперь запустим новую задачу и зададим в пространстве задачи источник, 

параметры ближнего поля которого задаются в файлах электрического и 
магнитного поля.  

 

     
 

Рис.14.16. Задание апертуры в точках на поверхности шара 
 

Теперь начертим второе зеркало большого размера (рис. 14.17). 
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Рис 14.17.Черчение второго зеркала в проекте двухзеркальной антенны 
 
Зеркало в виде параболоида строим по той же оси Z, по которой ранее 

располагалась рупорная антенна. 
Зададим также линии, по которым будут рассчитывать дальние поля. 

Выберем метод физической оптики для расчета большого облучателя. Для этого 
выберем поверхность антенны в дереве подробностей и в свойствах поверхности 
зададим метод PO (рис. 14.18). 

 
Рис. 14.18. Задание метода расчета (метод физической оптики) 

 

 
Рис. 14.19. Задание расчета дальнего поля в сечении 
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В результате расчета дальнего поля в программе POSTFEKO можно 

вывести как трехмерную ДН, так и срез ее на двумерный график. 
Теперь окружим излучающую антенну полусферой (рис. 14.27), в точках 

которой точках рассчитаем ближнее поле и занесем эти значения в файл. 
 

 
Рис. 14.20. Параметры полусферы ближнего поля в закладке координат 

 
Установка сферических координат с определенной высотой, в которой 

будем создавать полусферу с точками, в которых нужно выполнить расчет и 
запись поля в файл. 

Следующие шаги: убираем малое зеркало, а вместо его излучения задаем 
излучение из файла. Далее чертим большое зеркало. Это большое зеркало будет 
облучаться апертурой, созданной из файла. 
 

 
Рис. 14.21. Черчение большого зеркала 
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Это большое зеркало можно описать методом физической оптики.  
Окончательные результаты расчета диаграммы направленности показывается на 
рис. 14.30, из которой видно, что КНД более 20 дБ.  

 
Рис. 14.22. Результат расчета ДН двухзеркальной антенны 

 
 Таким образом, был построен алгоритм расчета двухзеркальной антенны. 
Оптимизация, выбор положения зеркал позволяет значительно увеличить КНД 
системы. 

Заключение 
 Метод геометрической оптики имеет меньшую точность при анализе 
зеркальных антенн, чем метод физической оптики, так как в нем не учитываются 
поляризационные эффекты (в частности, при анализе зеркальных антенн 
апертурным методом). Метод геометрической теории дифракции по точности 
примерно эквивалентен методу физической оптики. 
 Анализ и проектирование зеркальных антенн выполняется обычно на 
уникальных, приспособленных для решения конкретных задач, программах. 
Коммерчески распространяемой специализированной программой для расчета 
зеркальных антенн является программа GRASP, разработанная в компании 
TICRA [5], которая представляет собой промышленный стандарт для точного 
моделирования зеркальных антенн.  
 Другой программой, которая была разработана для решения таких 
специализированных задач, можно назвать программу «Mirror» [6]. Эта 
программа предназначена для решения задачи облучения рефлектора системой 
излучателей. Скорость решения задач на подобных специализированных 
программах очень большая. Это позволяет пользователю просчитать большое 
количество вариантов уже на этапе эскизного проектирования. 
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15  ГЕОМЕТРИЧЕСКАЯ ТЕОРИЯ ДИФРАКЦИИ И МЕТОД КРАЕВЫХ 
ВОЛН 

15.1 Общие положения 
Развитием МФО и геометрической оптики (ГО) являются геометрическая 

теория дифракции (ГТД) и метод краевых волн (МКВ). Оба метода направлены 
на уточнение МФО и ГО в той области параметров, где они дают неточные 
результаты. Основой для ГТД и МКВ служит решение электродинамической 
задачи о дифракции плоской волны на металлическом клине, а также ряд других 
задач, называемых ключевыми. Несомненно, что задача о клине занимает среди 
них основное место. Авторы как ГТД, так и МКВ анализируют рассеянное 
клином поле и разделяют его на две части. В рамках ГТД выделяется 
геометрооптическая часть поля, по существу, это плоская волна, отраженная от 
граней клина и цилиндрическая волна, порождаемая кромкой клина. Таким 
образом, ГТД уточняет геометрооптическое решение задачи о дифракции на 
клине, добавляя к нему поле в виде цилиндрической волны. В рамках МКВ 
разделяется на части не рассеянное поле, а токи на поверхностях клина. 
Выделяется равномерная часть и неравномерная части токов. Под равномерной 
частью понимается ток равный удвоенному магнитному полю падающей волны, 
то есть ток, используемый в рамках МФО. Неравномерная часть тока – краевая 
волна это добавка к равномерной части, обусловленная дифракцией на кромке 
клина. Далее в рамках МКВ находится поле, порожденное обеими частями тока и, 
таким образом, к решению по МФО добавляется новое слагаемое, учитывающее 
вклад краевой волны.  

Для бесконечного клина оба метода дают одинаковые результаты, 
совпадающие с точным решением. Однако основной смысл применения ГТД и 
МКВ состоит в распространении результатов, полученных для ключевых 
структур на объекты более общего вида. Например, в задаче о клине мы имеем 
дело с бесконечной и прямолинейной кромкой. Методы ГТД и МКВ позволяют 
пусть и приближенно описывать рассеяние волн на телах с искривленными 
кромками конечной длины, таких как диск, цилиндр конечной длины, лента, щель 
и т.д.  

Поле в рамках ГО представляется совокупностью лучей (рис. 15.1)  или 
лучевых трубок. Поле вдоль траектории луча меняется по следующему закону: 

 
iksesAu  )( ,      (15.1) 

где s – координата вдоль луча, называемая эйконалом, k – волновое число среды, в 
которой распространяется луч. Для определения эйконала ГО использует 
уравнение эйконала: 

  ndls ,      (15.2) 
где n – показатель преломления среды, являющийся функцией координат. 
Интегрирование в (5.20) ведется вдоль луча.  
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Рис. 15.1. Лучи, падающие на отражающую поверхность для формирования 
излучения 
 

Для амплитуды луча справедлив закон сохранения потока энергии в 
элементарной лучевой трубке: 
 

 0)( 2 nSA
dl
d

,     (15.3) 

где S – площадь лучевой трубки. Уравнение (5.21) иллюстрируется рис. 15.2. 
 

 
Рис. 15.2. Лучевая трубка 

 
Пусть лучевая трубка имеет сечение в виде прямоугольника. Площадь 

сечения в точке 1 равна S1, а в точке 2 – S2. Закон сохранения потока энергии 
утверждает, что энергия, проходящая через оба сечения одинакова, то есть поток 
энергии через боковые стенки лучевой трубки равен нулю. Поток энергии при 
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0S  определяется произведением nSA2 . Следовательно, амплитуды в точках 1 
и 2 связаны соотношением: 

11

22

2

1

Sn
Sn

A
A

 .      (15.4) 

 При отражении от идеально проводящего тела луч меняет направление 
распространения в соответствии с законом отражения, утверждающим, что угол 
падения равен углу отражения.  
 С помощью ГО легко решается, например, задача о дифракции плоской 
волны на щели (рис. 15.3). 

 
Рис. 15.3. К дифракции плоской волны на щели 

 
Плоская волна представляется совокупностью параллельных лучей. Часть 

лучей проходит сквозь отверстие, а часть отражается от металлических 
полуплоскостей. Отметим, что в результате поле имеет скачки, поскольку вне 
области занятой лучами по ГО оно равно нулю. Очевидно, что реальное поле, 
подчиняющееся уравнениям электродинамики, не может иметь скачков. Оно 
изменяется непрерывно. Данное противоречие между ГО и электродинамикой 
устраняется в рамках ГТД. Для этого ГТД вводит кроме геометрооптических 
лучей еще и дифракционные лучи, подчиняющиеся законам (постулатам) ГТД. 
Перечислим их. 

1. Совокупность дифракционных лучей порождается лучами, падающими на 
неоднородные участки тела: острия, ребра, линии разрыва кривизны, а 
также лучами, которые касаются поверхности тела. 

2. Каждый луч первичного поля порождает бесконечное множество 
дифракционных лучей. При падении луча первичного поля на острие 
(вершина конуса) дифракционные лучи уходят от него во всех 
направлениях, образуя сферическую волну. При падении луча на ребро 
дифракционные лучи в каждой точке ребра образуют конус, который 
показан на рис. 15.4. 
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Рис. 15.4. Формирование конуса дифракционных лучей 

 
На рис. 15.4 угол раствора конуса   равен углу падения луча  .  
Закон образования дифракционных лучей в области тени гладкого 
выпуклого тела отличен от закона образования лучей у остриев и ребер. В 
этом случае лучи срываются с поверхности теневой части тела. 
Дифракционные волны этого типа получили название волн соскальзывания.  

3. Амплитуда дифракционного луча пропорциональна амплитуде 
порождающего его первичного луча в точке падения. Для амплитуды 
дифракционного луча du  справедливо следующее соотношение: 

idi

iks

d uttD
J

eu ),(


      (15.5) 

где iu - амплитуда падающего луча, J – якобиан перехода к лучевым 
координатам, величина пропорциональная площади поперечного сечения 
лучевой трубки, it  и dt  направления (орты) падающего и дифракционного 
лучей. Функция ),( di ttD  называется коэффициентом дифракции. Она 
вычисляется в соответствии с четвертым постулатом ГТД. 

4. Коэффициент дифракции определяется локальными особенностями 
геометрии тела в окрестности падающего луча (в случае ребра, острия) или 
геометрии тела в окрестности точки отрыва дифракционного луча (в случае 
гладкого тела). Коэффициент дифракции находится из решения 
соответствующей ключевой задачи.  
Самую простую форму дифракционный коэффициент имеет для частного 
случая клина – полуплоскости.  
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Рис. 15.5. Лучевая структура поля при дифракции плоской волны на 

полуплоскости 
 

На рис. 5.15 показана лучевая структура поля в данной структуре. 
Геометрооптическая часть поля определяется следующим соотношением: 
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Знак плюс соответствует Н-волнам, а минус Е-волнам, 0A  - амплитуда 
падающей волны. В случае Е-волн это амплитуда компоненты zE , а в случае Н-
волн компоненты zH .  

Строгое решение задачи для полуплоскости отличается от 
геометрооптического только тем, что разрывная функция   заменяется 
непрерывной функцией – интегралом Френеля )(xF : 
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     (15.7) 
Вычитая из формулы (15.7) формулу (15.6), находим поле краевой волны: 
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Соотношение (15.8) верно для любых углов наблюдения и любых углов 

падения. В ряде случаев используют другое представление для поля краевой 
волны. Чтобы получить его надо рассмотреть асимптотическое представление 
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интеграла Френеля при r . В результате получается, так называемое, 
неравномерное представление: 
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Принципиальное отличие (15.9) от (15.8) в том, что последняя формула 

описывает разрывную функцию. Разрывы имеют место при углах, 
соответствующих границам света и тени. При других углах формула (15.9) 
правильно описывает поле краевой волны. 

Из формулы (15.9) можно получить следующее выражение для 
коэффициента дифракции: 
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   (15.10) 

Рассмотрим далее, как ГТД справляется с такой типовой задачей как 
дифракция плоской волны на щели. Данная структура показана на рис. 15.6. 
 

 
Рис. 15.6. Лучевая структура поля при дифракции плоской волны на щели 

 
Она состоит из двух полуплоскостей с номерами 1 и 2. Ребро каждой 

полуплоскости формирует свою краевую волну. Для простоты записи поля 
краевых волн мы будем записывать в системах координат, связанных с 
вершинами полуплоскостей. Углы отсчитываются от полуплоскости. Поэтому, 
например угол падения в системе координат, связанной с первой полуплоскостью 
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01  не равен углу падения в системе координат связанной со второй 
полуплоскостью 02 .  

Отметим следующее обстоятельство. На каждую полуплоскость падает не 
только возбуждающая плоская волна, но и лучи, порожденные соседней кромкой. 
Поэтому при вычислении амплитуды краевой волны необходимо учитывать это 
обстоятельство. Геометрооптическое поле легко записывается с помощью 
соотношений похожих на формулу (15.7). Нашей задачей является определение 
поля краевых волн.  

Запишем поле краевых волн следующим образом: 
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  (15.11) 

где B и C неизвестные пока коэффициенты. Они описывают слагаемые, 
порожденные взаимодействием кромок полуплоскостей. Слагаемые 
пропорциональные 0A  соответствуют краевым волнам, порожденным падающей 
волной. Из уравнения (15.11) для неизвестных коэффициентов следуют 
уравнения: 
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Решая систему (15.12), получаем: 
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     (15.13) 

Соотношения (15.12)-(15.13) полностью определяют поле краевых волн. 
Отметим, что в более общем случае, когда в качестве ключевой задачи 

выступает дифракция на клине общая схема ГТД остается прежней. Меняется 
только конкретный вид функции, описывающей дифракционный коэффициент.  
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Метод краевых волн. Основные принципы МКВ были разработаны Уфимцевым 
П.Я. и изложены в его книге. Отправной точкой для МКВ, так же как и для ГТД 
является дифракция на клине (рис. 15.7). 

 
Рис. 15.7. Дифракция плоской волны на клине 

 
Поле, создаваемое равномерной частью тока, которая равна удвоенному 

магнитному полю на освещенной части клина определяется при kr  
следующими выражениями: 
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если освещена одна грань клина  (15.14) 
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f если освещены две грани клина. 

Верхняя строчка в (15.32) соответствует Е-волнам, а нижняя Н-волнам.  
 

Поле неравномерной части тока записывается аналогично (15.14) только 
вместо 0f  следует использовать функцию 1f : 
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Формулы (15.14),(15.15) имеют смысл при всех углах за исключением 

следующих случаев: 
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 При анализе более сложных структур МКВ использует следующие 
принципы. 

1. Ток на поверхности тела представляется в виде суммы равномерной и 
неравномерной частей. Равномерная часть тока вычисляется, как и всегда, 
как удвоенное значение магнитного поля падающей волны.  

2. Неравномерная часть тока в каждом сечении изогнутой кромки или кромки 
конечной длины вычисляется также как на эквивалентной бесконечной 
прямолинейной кромке касательной к искривленной кромке в данной 
рассматриваемой точке. Таким образом, если взять разные точки на 
реальном изогнутом ребре, то каждой точке будет соответствовать по-
разному ориентированная относительно направления распространения 
волны эквивалентная кромка.  

Последнее утверждение поясняется рис. 15.8. Рассматривается дифракция на 
диске. 

 
Рис. 15.8. К дифракции на диске 



317 
 

 
Видно, что в разных точках на границе диска (1,2,3) вектор падающей 

волны по-разному ориентирован относительно эквивалентной кромки 
(касательная к образующей диска линия). В точке 1 он параллелен ей, в точке 2 
перпендикулярен, а в точке 3 ориентирован под некоторым углом. Точно также 
меняется и угол падения волны на эквивалентную кромку. 

Решение для уже обсуждавшейся выше задачи о дифракции плоской волны 
на щели записывается с помощью МКВ следующим образом: 
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   (15.17) 

 
Итак, можно сделать вывод, что ГТД и МКВ весьма близки друг к другу. 

Оба метода основаны на одном строгом решении ключевой задачи о дифракции 
на клине. Но они по-разному интерпретируют это решение. Один метод делает 
это с позиции ГО, а второй с позиции МФО. В простых ситуациях, таких как 
дифракция на щели или ленте, оба метода дают тождественные результаты. 
Отличие между ними сказывается в сложных случаях. Таким случаем является 
дифракция на теле с нерегулярными кромками. Возьмем в качестве примера 
дифракцию на пирамиде (рис. 15.9).  

 
Рис. 15.9. Дифракция на пирамиде 

 
В рамках ГТД рассеянное пирамидой поле представляется в виде 

совокупности лучей: отраженных от плоских граней, дифракционных лучей, 
порожденных кромками и сферической волны, созданной вершиной пирамиды. 
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При таком полном учете всех компонент поля оно должно достаточно хорошо 
описываться в рамках ГТД.  

Рассмотрим реализацию метода геометрической оптики и однородной 
теории дифракции в FEKO. Для обработки определенных частей проекта этими 
методами, их нужно писать, т.е. выбрать решения, которыми они считаются. 
Кроме этого, в диалоге установки решения нужно выбрать опции, которые 
зависят от степени гибридизации решения. Рассмотрим этот диалог (рис. 15.10) 

   

Рис. 15.10. Диалог выбора решения FEKO 
 
В диалоге рис. 15.10 устанавливаются опции метода ГО.  



319 
 

В разделе UTD/GO parameters устанавливается метод, который будет 
применяться (UTD/GO) как связанный и раздельный с методом моментов.  
 
Max no. of ray interactions - Этот параметр устанавливает максимальное число 
взаимодействий луча (т.е. комбинаций отражения и дифракций). Если, например, 
этот параметр равен 3, луч может дать 3 отражения, или 2 отражения и 
дифракцию. Если этот параметр установлен равным 0, учитываются только 
прямые лучи.  
Export UTD ray data for later viewing - Когда эта опция отмечается, информация 
о лучах экспортируется в файлы *.bof и в файл  *.ray, так, чтобы распространение 
лучей могут быть показаны в POSTFEKO.  
 
Select ray contributions - В этом разделе определяется, какие вклады лучей нужно 
принять во внимание в расчете:  
• GO (direct and reflected rays, shadowing): прямые и отраженные лучи, а также 
теневые области, которые принимаются во внимание.  
 
• Edge and wedge diffracted rays:  Дифракция волн на ребрах и на клиньях 
принимается во внимание. Луч может включать произвольное число изломов, но 
только одну дифракцию.  (Общее количество взаимодействий - число отражений 
плюс одно для дифракции - не должно быть больше, чем указано в поле Max no. 
of ray interactions)  
 
•  Corner diffraction terms:  Дифракция волн на углу.  
 
•  Double diffractions and diffraction/reflection:  Двойная дифракция на краях и 
клиньях и комбинациях изломов учитываются. Только лучи дифракции не 
включены в этот пункт.  
 
•  Creeping waves:  Поверхностные волны на кривых поверхностях.  
 
•  Cone tip diffraction:  Дифракция на острие конуса (на клине).  
 
Uncoupled with moment method - Этот пункт определяет, нужно ли учитывать 
связь между полями, рассчитываемыми методами UTD и полями, 
рассчитываемыми методом MoM. Этот выбор должен только использоваться, 
когда области UTD и области MoM находятся близко друг к другу. 
 
Max no. of ray interactions -  максимальное количество взаимодействий луча ,то 
есть на отражение и дифракцию. Если, например, параметр установлен равным 3, 
у луча может быть 3 отражения, или 2 отражения и дифракция.  Если установлено 
в 0, только прямые лучи приняты во внимание.  
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Export UTD ray data for later viewing – экспорт информации о луче в файл *.bof 
и в специальный файл *.ray, так, чтобы пути лучей могли быть показаны в 
POSTFEKO. Информация о лучах может стать очень большой, и таким образом 
всю эту информацию не нужно экспортировать, если нужно исследовать только 
определенные пути луча.  

 
Рис. 15.11. Лучи, которые идут на ребра и на вершины (клинья) 

 
Select ray contributions - Выбор лучей, которые определяют вклады:  
 
- GO -прямые и возвратные лучи, затенение, отраженные и переданные лучи 
приняты во внимание. 
 
- Ray launching settings - В этом разделе устанавливаются параметры лучей:  

- Automatic determination:  Параметры запуска луча будут автоматически 
определены во время процесса решения  

- Specify angular increment (in degrees): Углы приращения Specific Theta и углы 
приращения Phi могут быть определены для процедуры запуска луча в методе 
геометрической оптики.  
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Рис. 15.12. Лучи, преломляющиеся через диэлектрическую линзу и падающие на 
слой металла. Расчет ближнего поля и диаграммы направленности 

Corner diffraction. В этой опции можно увеличить тип и число взаимодействий 
луча, что увеличивает точность расчета, но также увеличивает время вычисления. 
Поэтому нужно найти компромисс между числом взаимодействий луча и 
вкладами луча. Выбор, сделанный в этой опции, должен быть сделан из 
физических соображениях, чтобы получить оптимальное использование от 
формулировки UTD.  
 
 Следующие ограничения имеются в гибридном методе MoM/UTD:  

 Не должны быть диэлектрические объекты и диэлектрическая земля.  
 Только идеально проводящие плоские многоугольные пластины или 

единственный цилиндр позволяются выбрать в области UTD.  
 Одновременно нельзя выбирать решения  UTD и PO. 

 
Для структур, которые использует асимптотические методы решения (UTD, 

PO и GO) применяются специальные разбиения. Металлические  поверхности, 
которые используют аппроксимацию UTD, не разбиваются на ячейки. 
Металлические или диэлектрические поверхности, которые используют PO 
аппроксимацию, используют разбиение на треугольники, аналогичные 
стандартному разбиению на сетку.  
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Разбиение на сетку поверхностей, которые нужно рассчитать, используя GO 
(с запуском лучей) – выполняется на треугольники, но размер сетки должен быть 
частотно-независимым. Для GO поверхности, должен использоваться самый 
большой, из возможно малых размеров, что обеспечит приемлемое представление 
геометрии поверхности.  

FEKO объединяет основанный на расчете тока базовый метод MoM с UTD 
, учитывая связь между MoM и UTD, поддерживаемым в решении, то есть 
обеспечивает точность и модификацию матрицы взаимодействий.  

Практическим примером может быть изменение входного импеданса 
вибратора, рассчитываемого методом MoM, находящегося в близости к большой 
структуре, обработанной методом UTD. Частота не влияет на ресурсы ЗУ, 
требуемые для UTD обработки структуры, как только точки отражения от 
поверхностей и дифракции от граней или углов рассматриваются без разбиения 
структуры на сетку. Учитываются дифракция на ребре и угле, двойная дифракция, 
и огибающие (цилиндрические) волны. 

Выявление особенностей в распространяющихся лучах выявляются в 
постпроцессорной обработке POSTFEKO. В настоящее время численные расчет 
UTD можно выполнить на плоских многоугольных пластинах с минимальной 
длиной границ порядка длины волны или к одному цилиндру. UTD - таким 
образом весьма хорошо подходит для анализа кораблей с радами и, но не очень 
подходит для анализа сложных объектов с кривыми поверхностями, например 
автомобилей.  

 

15.2 Пример: параболическая антенна 
Выберем единицы черчения – мм и командой Draw Paraboloid  начертим 

параболоид с фокусом в точке (0,0,0). 
В фокус параболической антенны поставим вибратор длиной 15 мм, т.е. 

полуволновой (для частоты 10 ГГц). На весь параболоид поставим метод 
физической оптики PO(allways). Параболический рефлектор будет разбиваться с 
сеткой 8 мм 

Вместо конкретного вибратора, который рассчитывается методом 
моментов, можно поставить источник поля (рис. 15.14). Положение и 
ориентацию, а также модуль и фазу этого источника можно менять и сделать 
параметрически изменяемым. Возможно поставить источник возбуждения 
сферического излучения. 
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Рис. 15.13. Параболическая антенна и диалог, в котором чертится парабола 
 

 
 

Рис. 15.14. Постановка в фокус источника сферического излучения 
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Далее покажем, как выполнить подобный же расчет в случае смещения 
питающей антенны в пространстве, а также создание более сложной вырезки из 
параболического зеркала. 

Для этого создадим  цилиндр, который будет пересекаться с параболоидом 

 
 

Рис. 15.15. Черчение эллипса, который будет вырезать из параболоида 
эллиптическую форму. Длина большой и малой оси 502 мм и 450 мм 

 
Теперь создадим под углом 20̊ плоскость, пересекающую параболоид (рис. 

15.15). Эта плоскость создается в глобальной системе координат, но в закладке 
Workplane  нужно прокрутить ее на 20̊ относительно оси V (рис. 15.15). 

Параметры самого прямоугольника устанавливаются в закладке Geometry. 
Далее этого прямоугольник просвипируем вниз, чтобы создать скошенный 

параллелепипед, командой Sweep. 
В результате этой операции будем иметь срезанный параболоид (рис. 15.15) 

 
 

Далее создадим возбудитель для облучения зеркала (рис. 15.17).  
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Рис. 15.16.Черчение под углом отрезка волновода, используемого как 
облучающая антенна  

 
 Картина тока на поверхности параболоида, а также картина ближнего поля в 
сечении показаны на рис. 15.17. 

 
Рис. 15.17. Картина мгновенного распределения тока и ближнего поля 
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Сечение рассчитанной диаграммы направленности  этого волновода можно 
видеть на рис. 15.18. 
 

 
Рис. 15.18. Сечение диаграммы направленности зеркала, облучаемого 

прямоугольным волноводом 
 

Эту структуру можно также рассчитать методом геометрической оптики. В 
этом случае можно показать, что D =28 дБ. Группы пучков лучей формируются от 
каждого сегмента из 10 сегментов, на которые разбивается вибратор. 

15.3 Пример с линзой 
Диэлектрическая линза облучается источником, который задается ранее 

рассчитанным дальним полем (рис. 15.19). 

 

Рис. 15.19. Линза, на которую падает эм поле 
источника, с ДН, показанной в файле рис. 15.20 
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Рис. 15.20. После нахождения дальнего поля, и сохранения его, поставим 

этот источник в начало глобальной системы координат (рис. 15.21) 
 

 
Рис. 15.21. Постановка источника в центр глобальной системы координат 

 
В диалоге отмечено, что число точек по Theta=91, число точек по Phi=181. 

Этот файл создается в виде файла дальнего поля, выбирая опцию в диалоге 
Request far fields (рис. 15.21) 

Линза чертится так, что ее геометрия зависит от диэлектрической 
проницаемости. При изменении материала линзы, т.е. диэлектрической 
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проницаемости, ее геометрия изменяется так, что она продолжает фокусировать 
лучи, идущие от источника в виде параллельных лучей в дальнем поле 

 
Рис. 15.23. Черчение профиля окружности с равными большой и малой 

полуосями, равными фокусу F=149,896229 мм 
 

Начальный угол 90, конечный угол 180 град (рис. 15.24). 
 

 
Рис. 15.24. Диалог черчения фрагмента эллипса 
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В окнах диалога рис. 15.24 находятся следующие переменные:  
u0=101,001292309,  v0*n=  110,641372269  и смещение  v0= 45,169510835 
u0= sqrt (n2-1)*v0    (длина малого радиуса оси эллипса) 
v0=(F+T)/(n+1)                   (расстояние смещение эллипса) 
T=(2*F-sqrt(4*F2 –D2 ))/2(n-1)   (толщина линзы) 
n=sqrt(Eps)                         (коэффициент преломления) 
D=λo*10                                (диаметр цилиндра) десять длин волн 
F=1.5*D …………………….  (длина фокуса) 
w0=n*v0                          (длина большого радиуса оси эллипса) 
λ0

 =c0/freq/sc ……………….  (длина волны в свободном пространстве) 
sc=10-3 
 Затем профиль свипируем его по оси Z (рис. 15.25). 
 

 
 

Рис. 15.25. Черчение цилиндра с диаметром, равным диаметру линзы 
 

Вырезаем часть сферической окружности. После создания сечения линзы, 
ее свипируем на 360 град. Относительно оси Z. 

Лучи от источника показываются на рис.15.27. Чем более искривленная 
линза, и чем больше угол пучка каждого луча, тем больше накапливается ошибка 
расчета. Можно видеть эффект затенения, отраженный на диаграмме 
направленности. 
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Рис. 15.26. Черчение эллипса как среза нижней части линзы 

   
Рис. 15.27. Волна от источника падает на линзу 

Итак, в этой главе были рассмотрены методы геометрической оптики, и 
метод однородной теории дифракции, реализованные в FEKO. Асимптотические 
методы геометрической оптики и теории дифракции хорошо поддерживаются 
возможностями FEKO. 
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16  РАСЧЕТ МЕТОДОМ ФИЗИЧЕСКОЙ И ГЕОМЕТРИЧЕСКОЙ 
ОПТИКИ 

16.1 Общие положения 
Для решения больших задач рассеяния используются асимптотические 

(приближенные) методы. Приближенными эти методы называются по 
отношению к точным электродинамическим методам. К асимптотическим 
методам относятся методы физической оптики, метод геометрической оптики  и 
метод однородной теории дифракции. 

По умолчанию FEKO использует метод моментов (MoM) для всех 
поверхностей (диэлектрических и проводящих) в модели. Другие методы решения 
могут быть, однако, установлены на каждую фаску в модели.  

Например, некоторые области модели могут быть решены с помощью 
метода физической оптики PO. Этот метод решения задается в закладке Solution 
диалога свойств фаски Face properties для фасок геометрии или в диалоге Mesh 
properties для отмеченных треугольников разбиения.  

В методе физической оптики (PO) используется понятие луча, энергия 
которого не накапливается в какой либо точке лучевой трубки, а 
распространяется прямолинейно, подобно свету. Падение таких лучей 
возбуждает отраженную и преломленную волну. Отражение будет определяться 
законами оптики, т.е. угол падения равен углу отражения  

Пользуясь методами геометрической оптики, нетрудно заключить, что 
степень концентрации электромагнитной энергии, переносимой волной в каком-
либо направлении в пространстве, будет тем больше, чем ближе направления 
лучей к параллельным. Применяя этот вывод к антеннам, имеющим плоский 
излучающий раскрыв, можно сказать, что в плоскости раскрыва поле должно 
быть синфазным. Таким образом, чтобы создать антенну, которая концентрирует 
излучаемую электромагнитную энергию в определенном направлении, используя 
в качестве источника электромагнитных волн простейший излучатель, например 
полуволновой вибратор или рупор, необходимо иметь такое устройство, которое 
преобразует радиально расходящиеся лучи в параллельные или, что равносильно, 
преобразует сферический фронт в плоский. В качестве одного из таких устройств 
можно использовать металлическое зеркало, если его профиль подобрать 
соответствующим образом.  

Итак, будем искать профиль зеркала, которое в результате отражения 
преобразует сферический фронт в плоский. Для этого, очевидно, достаточно 
рассмотреть планарную задачу, поскольку сферический фронт имеет осевую 
симметрию.  

Пусть лучи, определяющие сферический фронт, исходят из точки F 
(рис.16.1), т.е. пусть эта точка совпадает с фазовым центром источника 
электромагнитных волн.  

Предположим, что L есть сечение отражающей поверхности зеркала, форма 
которого должна быть такой, чтобы лучи после отражения от зеркала по законам 
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геометрической оптики (угол отражения равен углу падения), оказались 
параллельными. При выполнении этого условия сферический фронт будет 
преобразовываться в плоский, так как волновая поверхность пересекает лучи под 
прямым углом.  

 

Рис.16.1. Определение профиля зеркала. 
 
Для определения профиля зеркала воспользуемся тем, что оптическая длина 

пути вдоль любого луча, начинающегося на одной эквифазной поверхности и 
оканчивающегося на другой, имеет одно и тоже значение. Введём полярные 
координаты r и  с полюсом в точке F, где r есть радиус-вектор точки профиля 
зеркала, а  - угол, составляемый радиус-вектором r с полярной осью, которая 
проходит через точку F и параллельна отражённым лучам (рис.16.2). Рассмотрим 
два луча - один луч, идущий по направлению полярной оси, и второй луч, идущий 
под углом . Оптические длины путей вдоль этих лучей от точки F до любой 
прямой, перпендикулярной полярной оси, должны совпадать. Обращаясь к 
рисунку 16.1, имеем:  

Q = f + l = r + r cosf - l) , 
откуда  

r = 2f / (1+ cos. 
 

Полученное выражение представляет собой уравнение параболы в 
полярных координатах. Таким образом, чтобы преобразовать сферический фронт 
в плоский, отражающая поверхность зеркала должна иметь форму параболоида 
вращения, а источник электромагнитных волн (облучатель) должен быть 
расположен так, чтобы его центр совпал с фокусом параболоида (пологая при 
этом, что зеркало находится в дальней зоне облучателя).  Точка пересечения 
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параболы и её оси называется вершиной параболы. Отрезок OF (рис.16.1) есть 
фокусное расстояние параболы f .  

 
Рис.16.2. Длиннофокусное (а) и короткофокусное (б) параболические зеркала 

 
Максимальное значение , определяемое краем зеркала, называется 

радиусом раскрыва зеркала  , а плоская поверхность, ограниченная краем 
зеркала, называется раскрывом параболического зеркала (рис.16.2). Наряду с 
радиусом раскрыва можно говорить о диаметре зеркала, который будем 
обозначать через d, так что d = 2 . Пусть значению  соответствует угол 
 . Угол 2 называется углом раскрыва зеркала. Если угол раскрыва меньше 
180о, зеркало называется короткофокусным (рис.16.2). Для длиннофокусных 
зеркал f; для короткофокусных зеркал >f . В антеннах применяются 
главным образом длиннофокусные зеркала.  

 Можно оценить память, необходимую для решения зеркальной антенны, 
формулой RAM (в байтах) = 16xN2, где N= число базисных функций (например 
для металлических поверхностей N  100 * (A/2) с площадью A) 

В FEKO точный метод моментов MoM был объединен с PO и UTD. 
Объединение MoM с PO значительно уменьшает размер матрицы решения и 
допускает решение больших задач на меньших компьютерах. В методе 
физической оптики используются: 

• Треугольные базисные функции (те же самые, какие применялись в методе 
MoM, то есть может использоваться та же самая сетка разбиения.). 

• Коррекция по ребру и коррекция по клину для улучшения точности. 
 Fock-токи, для учета огибающих волн (то есть по ребрам добавляются токи, 

отличные от нуля в теневых зонах PO и выпуклых структурах). 
• Полная гибридизация, то есть модификация матрицы взаимодействий, что 

существенно для точности, когда на  распределение тока источника можно 
повлиять связь между  объектами. 
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• Принцип эквивалентной поверхности для обработки диэлектрических сред 
может также использоваться с PO (то есть  на диэлектрических платах 
могут быть заданы треугольники PO). 

16.2 Пример расчета методом физической оптики 
Анализируемая модель идентична модели, которая рассчитывается методом 

MoM. Только заменяется метод решения, с помощью которого обрабатывается 
плоскость. В этом методе расчета на обрабатывающую можно поставить 
следующие опции: 

• Physical optics (PO) - full ray-tracing:  В этом случае при вычислении токов 
на поверхности используется метод физической оптики. В этом методе, 
существенная часть времени решения тратится на трассировку лучей 
(алгоритм определяет, какие элементы сетки разбиения платы являются 
видимыми от каждого сегмента с током излучения). Дополнительные опции 
PO позволяют вручную оптимизировать трассы лучей.  

• Physical optics (PO) - always illuminated: Эта опция применяется, когда 
модель такова, что вся поверхность будет всегда облучаться (как например 
при анализе базового рефлектора антенны). Затенение не анализируется, а 
поверхности, которые не заданы, как решающиеся методом физической 
оптики, считаются прозрачными. Трассировку лучей можно таким образом 
избежать, ускоряя решение. 

• Physical optics (PO) - only illuminate from front: Эта опция применима ко 
всем замкнутым телам, но нормальный вектор должен указывать 
направление наружу (из внутреннего пространства объекта) от каждой 
фаски.  

 
Рис. 16.3. Задание обработки плоскости методом физической оптики 

 

После изменения метода решения платы на метод PO (рис. 16.3), модель 
нужно разбить снова. Длина ребер треугольников выбирается равной lambda/6 
(PO позволяет выбрать эти размеры большими, чем в методе MoM). В отличие от 
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плоскости, когда она обрабатывается методом  UTD, плоскость будет разбита на 
треугольники для использования метода PO. Отметим, что разбиение 
выполняется аналогично разбиению при решении методом моментов. 

16.3 Метод геометрической оптики 
Geometrical optics (ray launching): Метод геометрической оптики (c 

запуском лучей) применим к моделированию тонкого диэлектрика или 
металлических объектов, типа обтекателей антенны и диэлектрических линз.  

Uniform theory of diffraction (UTD):  UTD будет использоваться для 
данной фаски. Этот метод применяется к плоским электрически большим PEC 
фаскам.  

Windscreen: Для обработки стороны в этом случае будет использоваться 
метод ветрового стекла. Этот метод применим для моделирования нескольких 
антенн на ветровом стекле на различных определениях диэлектрика ветрового 
стекла. Заметим, что свойства стекла этих нескольких ветровых стекол должны 
быть идентичны.  

Когда эти свойства просматриваются для выбора нескольких сторон, 
который содержит несколько фасок, если любой из этих параметров отличен для 
выбранных лицевых поверхностей, то поле открыто в троичном состоянии.  

В поле Integral Equation можно выбрать формулировку, которая 
используется во время решения. По умолчанию интегральное уравнение 
установлено на Electric field (Electric field-EFIE). Это - наиболее общая 
формулировка и может применяться и для открытых и закрытых объектов. 

Установка Combined field (CFIE) может использоваться только на 
замкнутых объектах, и затем это вообще более устойчиво. Заметим, что нормали 
треугольников должны быть направлены от нулевого поля.   

CFIE особенно полезен когда используется с MLFMM, поскольку в этом 
случае требуется меньшее RAM, и сходимость может быть намного быстрее чем 
решение, основанное на EFIE. Возможно использовать комбинированную 
установку Combined на часть модели, но поверхность должна быть замкнутая 
идеально металлическая поверхность, и все нормали должны указывать 
направление наружу (от точки, где поле равно нулю). 

 

16.3.1 Пример: Вибраторная антенна, излучающая на металлическую 
плоскость. 

 
Метод расчета плоскости задается в этом случае как метод геометрической 

оптики (рис. 16.4). В этом методе строятся лучи, которые используются для 
расчета характеристик такой излучающей системы. 

Создадим дипольную антенну с помощью провода длиной 1.5 м, стоящей на 
высоте 2.25 м над плоскостью размером 9 м x 9м. Частота 100 МГц. 



336 
 

 

 
Рис. 16.4. Плоскость чисто металлическая и обрабатывается методом 

геометрической оптики 
 

Дипольную антенну разбиваем на сегменты длиной 0.107 м, т.е. получается 
14 сегментов. В результате расчета методом ГО получаем 14 групп лучей, каждая 
группа по 2290 лучей. 

 

 
Рис. 16.5. Лучевое преставление электромагнитной волны, падающей на плоскую 

металлическую поверхность 
 

Гибридный анализ методами MoM/PO/UTD позволяет с большой 
скоростью выполнить анализ электрически больших структур, что позволяет 
также выполнить оптимизацию диаграммы направленности и минимизацию 
интерференции антенны. 

Расчет показывает, что в данном примере S11=0.46, и эта величина зависит 
от того, есть отражающая поверхность или нет ее, а также от размеров ее. 

Выполним поворот антенны, стоящей над проводящей плоскостью на 90̊. 
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Рис. 16.6. Диалог вращения объекта на заданный угол 90̊ 

 
Коэффициент отражения антенны в этом случае становится равным 

S11=0.394. 
Метод геометрической оптики считает очень быстро. Поэтому этот метод 

можно использовать для оптимизации. В качестве целевой функции можно 
использовать как критерий по согласованию, так и результирующую диаграмму 
направленности. 

Альтернативные методы решения - быстрый мультипольный метод  или 
асимптотический высокочастотный метод, типа PO (метод физической оптики) 
или UTD (метод однородной теории дифракции). В методе PO токи на 
металлических поверхностях просто рассчитываются по падающему полю. В 
методе UTD можно моделировать только замкнутую форму, состоящую из 
плоскостей, и рассчитываются коэффициенты отражения и дифракция (по краю и 
углу). Размер объекта, поэтому, не влияет на требование памяти. Коэффициенты 
и число взаимодействий, однако, влияют на время расчета. Формулировка UTD 
требует, чтобы самый маленький размер объектов UTD был по крайней мере 
порядка длины волны. 

16.4 Однородная теория дифракции 
UTD – асимптотический метод, в котором размер платы не влияет на 

требования памяти, поскольку важны только прямые лучи, отражения и 
дифракция от граней и плат. Число направлений и отражений луча будет, однако, 
влиять на время выполнения. Особенности метода UTD заключается в том, что 
геометрия строится из плоских многоугольных планарных плоскостей и 
цилиндров. В расчете учитывается дифракция по ребру и по углу, удвоенная 
дифракция и огибающие волны (цилиндры). UTD - полностью объединен 
(гибридизирован) с MoM (когда в методе MOM модифицируется матрица 
взаимодействий, учитывая влияние лучей). 
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Просмотр лучей UTD может быть очень информативен, чтобы видеть 
рассеяние СВЧ поля. Это может быть полезно для анализа развязки внутренней 
антенны, нарушение диаграммы направленности излучения и т.д., например 
антенн на кораблях или антенн сотовой телефонии на зданиях. 
 

 
Рис. 16.7. Трассы лучей, падающих из каждого источника ближнего поля растра 
рупорной антенны на поверхность малого отражательного зеркала. 
 

16.4.1 Пример применение метода теории дифракции. 
На расстоянии четверть длины волны от вибраторной антенны поставим 

отражательную плоскость и выполним расчет методом UTD. На сетку 
разбивается только вибраторная антенна. Плоскость (рис. 16.8) не разбивается. 
Учитывается вклад лучей только от ребер и углов.  

 
Рис. 16.8. Дипольная антенна находится на расстоянии ¾ от длины волны. 

Частота 100 мГц, длины волны 3 м 



339 
 

 
 В методе UTD программа рассчитывает ход лучей, который показан на рис. 
16.9. 

 
Рис. 16.9. Падающие (красные) и отраженные (синие) лучи. 

Вывод и просмотр лучей выполняется для контроля установок FEKO.  

16.5 Проводная антенна 
 На рис. 16.10 показан пример корабля, на котором находится проводные 

антенны и находится диаграмма направленности и связь между антеннами. 
Корабль выполнен в виде слоев материала с конечной проводимостью. 
Использование гибридного метода MoM/PO или MoM/UTD позволят выполнить 
анализ антенн на корабле большого размера. 

�  
Рис. 16.10. Модель корабля, все стороны которого аппроксимируются 

плоскостями, подготовленными для расчета методом UTD 

16.6 Сравнение методов решения 
В табл. ниже для примера вибратора перед платой размером 10 x 10 длин 

волн, .дается сравнение между решениями, использующими стандартный MoM, и 
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методы решения MoM/PO и MoM/UTD.  Преимущество использования 
MoM/PO и MoM /UTD увеличивается с размером задачи. 
 

Методы решения: 
 
 
Металлические 
треугольники: 
 
Металлические 
сегменты: 
 
Требуемая помять: 
 
Время счета (сек): 

 

Antenna (MoM),  
Plate (MoM) 
 
7422 
 
 
11  
 
 
1892 MByte 
  
9314 сек 

 

 

Antenna (MoM),  
Plate (PO) 
 
7422 
 
 
11 
 
 
24 MByte 
  
300.00 сек 

 

 

Antenna (MoM),  
Plate (UTD) 
 
1 UTD Plate 
 
 
11 
 
 
0.056 MByte 
  
5.00  сек 

 

 
Различные методы решения можно взаимоисключить. Выбор между 

методами решения выполняется в закладке Solve со специальным 
раскрывающимся списком метода решения (рис. 16.6).  

В результате расчета методом теории дифракции рассчитываются те же 
характеристики излучающих систем, что и другими методами. 

16.7 Заключение 
В этом разделе на нескольких примерах было показано, как при обработке 

плоскостей, входящих в проект, выбираются методы расчета. Использовались 
методы физической оптики, геометрической оптики и методы теории дифракции. 
 Последние десятилетия ознаменованы созданием новых математических 
подходов и установок, внедренных и ожидающих своего воплощения в 
вычислительных алгоритмах и технологиях. Кардинально меняется понятие 
«большой» задачи, предполагающей применение сеток уже с миллионами, 
десятками и сотнями миллионов узлов. Прогноз развития говорит, что через 40 
лет вполне реально создание многопроцессорных вычислительных систем с 
миллионами вычислительных ядер. 
       В связи с этим актуальным является выработка новых концепций и моделей 
программирования для компьютеров экстремального уровня. Именно глобальные 
проблемы разработки программного обеспечения (включая операционные 
системы, компиляторы, базы данных и всевозможные инструментарии) являются 
главными на ближайшее десятилетие, поскольку существующее программное 
оснащение вычислительных систем своими корнями связано с 
последовательными вычислениями на суперкомпьютере, а наступающая эра  
«массового параллелизма» неизбежно требует перехода количества в качество. 
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17  РЕАЛИЗАЦИЯ В FEKO МЕТОДА КОНЕЧНЫХ ЭЛЕМЕНТОВ 

В последних версиях FEKO реализован метод конечных элементов FEM, 
который ранее был основным в программе HFSS, и применяется при 
моделировании электрически больших или неоднородных диэлектрических 
структур, которые с трудом решаются с помощью метода моментов, основного 
метода, реализованного в FEKO. FEM - этот метод, когда объем разбивается на 
тетраэдры для лучшего разбиения на элементарные объемы искривленных форм. 
В процессе решения методом конечных элементов в каждой вершине тетраэдра 
находятся компоненты поля E и H. 

В методе FEM решаемые матрицы являются разряженными, тогда как 
матрицы в методе MoM матрицы плотные. Таким образом, системы уравнений в 
методе FEM решаются значительно лучше на высоких частотах. 

В рамках совместного гибридного решения MoM/FEM, металлические 
провода и поверхности относятся к области MoM и неоднородные 
диэлектрические тела - области FEM. Сначала рассчитывается часть MoM, что 
дает в результате эквивалентные магнитные и электрические токи, которые 
формируют границу излучения области FEM. Такой гибридный метод 
использует преимущества и метода MoM и метода FEM следующим образом: 

• MoM используется для эффективного моделирования открытых  
излучающих структур, где не требуется дискретизация в трехмерном 
пространстве. 
• FEM используется для эффективного моделирования неоднородных 
диэлектрических тел в терминах составляющих поля внутри объема. 

17.1 Разбиение на сетку объемов 
Когда выполняется разбиение диэлектриков на тетраэдральные элементы 

для обработки методом FEM, стороны согласованно заполняются стороная 
тетраэдральных элементами. Дополнительно, когда в области FEM выполняется 
моделирование проводящих поверхностей, металлические треугольники должны 
быть согласованы к пространству тетраэдров (рис. 17.1). 

При разбиении на элементы области FEM в тетраэдральные объемные 
элементы, длина ребра тетраэдра должна быть примерно равна пятой части длины 
волны с учетом диэлектрической проницаемости среды. Известно, что в методе 
MoM рекомендуется разбивать сетку более плотно, до десятой части средней 
длины волны. Но внутри среды можно использовать более грубую сетку 
разбиения, потому что в методе FEM можно использовать базисные функции 
более высокого порядка.  
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Рис. 17.1. Пример объединения элементов FEM:  

слева неправильно, в центре и справа - корректно. 
 
Иногда требование к оперативной памяти можно уменьшить, добавляя 

малую воздушную область или буфер вокруг диэлектрического объекта. Эта 
область также разбивается на сетку в тетраэдральные элементы (то есть буферная 
область также решается методом FEM). Так как длина волны в воздухе большая, 
чем в диэлектрике, в этих буферных областях можно использовать большие 
тетраэдральные элементы и более грубую сетку разбиения. Это уменьшает 
требуемую RAM - обычно намного больше, чем дополнительная память, нужная, 
чтобы включить дополнительные тетраэдры в воздушном промежутке.  

В некоторых случаях точное моделирование геометрии требует 
существенно более мелкую сетку, чем указано в рекомендациях выше. Пример 
того, где более плотная сетка разбиения может требоваться - когда провод идет 
параллельно проводящей пластине. Если провод ближе, чем десятая часть длины 
волны к пластине, размер треугольников в направлении, ортогональном к проводу 
должен быть подобен интервалу от провода до пластины, чтобы дать точное 
представление поверхностного распределения заряда. Другой случай, где более 
тонкая сетка может требоваться, относится к волноводным портам, где размер 
сетки должен быть достаточно малым, чтобы зафиксировать распределение 
напряженности электрического поля самого высокого типа волны, который 
включен в разложение по модам в порту.  

17.2 Гибридный метод FEM/MoM 
При гибридизации, т.е. одновременном использовании методов FEM/MoM, 

выполняется полное разбиение на сетку металлических поверхностей, 
рассчитываемых методом MoM и разбиением в виде тетраэдров диэлектрических 
объектов, которые рассчитываются методом FEM. Сначала вычисляется часть, 
решаемая методом MoM, это решение дает в результате эквивалентные 
магнитные и электрические токи, которые формируют границу излучения для 
области FEM. Эта гибридная техника использует преимущества и MoM и FEM 
следующими способами: 

• MoM используется для эффективного моделирования открытых структур, 
когда не требуется дискретизация трехмерного пространства.  
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• FEM используется для эффективного моделирования неоднородных 
диэлектрических тел в понятии полевых распределений в объеме. 

•  

•  
Рис. 17.2. Структура, которая эффективно решается 
гибридным методом: объем диэлектрика методом FEM, а 
плоскость и диполь – методом моментов 

 
 
Область, которая решается методом FEM может включать сложные 

поверхности, включая: 
 

• Металлические поверхности, где существенным является скин-эффект.  
• Тонкие диэлектрические листы.  
• Металлические поверхности с конечным поверхностным импедансом.  
• Металлические поверхности с электрически тонким поверхностным 

покрытием. 
  

Преимущества метода FEM могут также использоваться для решений 
внутренних задач, когда анализируемые объекты закрыты металлическими 
поверхностями. Когда части, решаемые методом FEM и MoM, разделены, и 
анализируется структура, ограниченная металлическими поверхностями, другая 
часть задачи полностью разбивается на тетраэдры, и FEKO решает области, где 
задача может быть решена методом FEM, то есть решением сильно разреженной 
матрицы. Этот метод требует очень небольшую память и решает очень быстро, 
по сравнению с гибридным FEM/MoM. 
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  T-образный 
волноводный 
разветвитель 

Волноводный 
фильтр Ku-
диапазона с 

выемкой 

Волноводный 
фильтр с 

разветвлением на 
высших типах волн 

Время решения 
(3 GHz CPU) 
(на одной 
частоте) 

33.4 сек 17.2 сек 13.7 сек 

Память 62.3 MByte 99.2 MByte 31.3 MByte 

Тип порта FEM порт 
(основная мода) 

FEM порт 
(основная мода) 

FEM порт 
(основная мода) 

Модель  

 
 

17.3 Ускорение расчетов методом FEM/MoM – с помощью 
параллелизации и гибридизации методов FEM/MLFMM 

 
Параллелизация гибридных методов FEM/MoM, имеет две существенных 

особенности решения: 
 Все фазы решения гибридным методом FEM/MoM выполняются раздельно 

и таким образом выполняются за меньшее время. 
 Большие задачи и с сложным диэлектрическим заполнением методом 

FEM/MoM могут быть решены простыми вычислительными средствами. 
Это достигается с помощью распределения памяти.  
  
Гибридный метод FEM/MoM можно реализовать, подключая метод 

MLFMM. Метод MLFMM решает часть MoM объединенной задачи очень 
эффективно, что позволяет, например, решать следующие задачи: 
 Анализ сложных диэлектрических антенн на больших платформах, 

например микрополосковой антенны на самолете.  
 Анализ опасности излучения для людей в непосредственной близости от 

антенн, на которых подается большая мощность (рис. 17.3). 
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Рис. 17.3. Анализ поля излучения для людей, находящихся внутри 

автомобиля с передающими антеннами связи 
 

17.4 Типичные примеры применения метода FEM 
Типичные применения FEM/MoM и гибридных методов FEM/MLFMM 

включают моделирования антенны, исследования радиоизлучения приборов, с 
которыми работают исследователи,  моделирование волноводных фильтров с 
диэлектрическими вставками в фильтре и моделированием  микрополосковых 
пач-антенн на диэлектрических подложках конечного размера и т.д. 

 
Рис. 17.4. Диэлектрическая модель человека 

 
Расчет максимальной удельной мощности, поглощаемой в биологическом 

теле рассчитывается, используя фантом (модель тела) человека (рис. 17.4). Можно 
рассмотреть случай, когда фантом одет в металлический жакет и с персональным 
радиоприемником. В этих расчетах рекомендуется использовать метод конечных 
элементов FEM 
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17.5  Создание портов для расчета методом FEM 

Для задания источника тока или нагрузок в области FEM используются 

линейные порты FEM . Линейный порт FEM может быть добавлен 
командой Geometry → Create port → FEM line port, либо нажимая на кнопку 
FEM line port в линейке Ports или нажимая правой кнопкой на Ports дерева 
проекта и задавая команду Create port → Line port. По этой команде появляется 
диалог Create FEM line port (geometry), показанный на рис. 17.5. 

                
Рис. 17.5. Диалог Create FEM line port (geometry)  
для создания линейного порта FEM в области FEM 

 
Положение порта может быть определено одним из двух способов - на 

свободном ребре (или наборе связанных свободных граней, которые формируют 
непрерывную прямую линию) внутри диэлектрической области в модели, или 
основании определения координат начальной и конечной точки линейного FEM 
порта (в глобальных координатах).  

Если порт размещен на ребре (или на связанных гранях), ориентация порта 
определяется автоматически. Ориентация может быть визуально определена в 
трехмерном виде представления порта, и может быть выполнено реверсирование, 
отмечая опцию смены ориентации порта. Если геометрия, на которой задан порт, 
изменяется (преобразованием или масштабированием и т.д.) размещение 
линейного FEM порта и размер будет изменяться соответственно. Если 
линейный FEM порт определен на основании координат, пользователь должен 
быть убежден, что координаты остаются правильными.  

Во время разбиения на сетку, все грани, которые связаны с линейным 
портом FEM, будут исключены в сетке, но используются, чтобы определить 
начальные и конечные точки линейного FEM порта. Линейный FEM порт имеет 
разбиение на сетку, которая может быть непосредственно задана или 
отредактирована (после того, как она сгенерирована из геометрии порта во время 
разбиения на сетку).  
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Сетка линейного FEM порта определяется по начальной и конечной 
координатам, или, прикрепляя начальную и конечную точку линейного FEM 
порта к определенной вершине сетки в пределах (или на границе) тетраэдральной 
сетки FEM.  

Сетка линейного FEM порта выравнивается с точками сетки, созданной на 
геометрии во время разбиения на сетку, и будет определена по узлам сетки, или 
на основании значений координат.  

Диалог создания линейного  FEM порта показывается на рис. 17.6.  

          

Рис. 17.6. Диалог Create FEM line port (mesh)  для задания линейного порта FEM 
в области тетраэдральной сетки разбиения 

 
Если порт создан на сетке, используя вершины, то он будет сохраняться при 

изменении сетки (масштабирование, трансляция и т.д.). Во время разбиения на 
сетку, модель сетки линейного FEM порта, которая основана на заданных 
координатах точек, сгенерированных с меткой 'определяемой пользователем', не 
наследуют название от геометрической модели порта.  

Нагрузки и источники тока могут прикладываться к линейному порту FEM, 
и линейные порты FEM могут быть включены в расчет S-параметров.  

 
Рассмотрим пример решения отрезка микрополосковой линии методом 

FEM. Установим единицы - мм. Далее начертим диэлектрическую подложку 
длиной 20 мм, шириной 10 мм и толщиной 1 мм (рис. 17.8). 
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Рис. 17.7. Черчение диэлектрической платы 

 
Далее начертим параллелепипед в виде канала, идущего внутри подложки 

(рис. 17.8). 
 

 
Рис. 17.8. Черчение канала микрополосковой линии в виде параллелепипеда 

 
Создадим диэлектрический материал с проницаемостью 10 (рис. 17.7). 
Начертим линии, на которых будут создаваться порты FEM командой 

Draw-> Line (рис. 17.9) 
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Рис. 17.9. Черчение линий на входе и выходе, на которые будут устанавливаться 

FEM порты 
 
 

 
 

Рис. 17.10. Вид порта FEM 
изнутри. 

Рис. 17. 11. Вид порта FEM 
 

 
Теперь объединим всю конструкцию операцией булевой функцией. 

Установим опции метода FEM (рис. 17.12) 
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Рис. 17. 12.Установка метода 
решения FEM 

Рис. 17. 13.Задание свойств 
диэлектрической подложки 

 
На этой странице диалога можно выбрать порядок базисной функции, 

максимальное число итераций, а также выбрать решающее устройство «Iterative 
solver», который во многих случаях может решить задачи намного быстрее, и без 
значительной потери точности. 

Заполним пространство диэлектрическим материалом (рис. 17.13). 
Установим нужные фаски как металлические и на них установим метод 

решения FEM (рис. 17.14) 
 

 
 

Рис. 17. 14. Задание метода решения методом конечных элементов  
на область полосковой линии 

 
Выберем метод решения в объеме как метод FEM и установим порты как 

порты FEM (рис. 17.15). 
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Рис. 17.15. Установка линейного порта FEM на провод 
 

Далее на этот порт нужно задать источник тока (рис. 17.15). 
 

 

 
Рис. 17.16. Установка 

источника тока на порт 
Рис. 17.17. Создание опций 

разбиение на сетку 
 
Выполним разбиение структуры на тетраэдры и запустим задачу на расчет. 

Это выполняется так же, как и в базовом методе моментов. Результаты расчета 
видим в POSTFEKO. В файле с расширением .out  можно видеть все данные во 
время решения задачи. В нем показаны данные конструкции, опции методов 
расчета и пошаговый расчет задачи. 

Итак, в этом разделе на примере анализа отрезка микрополосковой линии 
был показан реализованный в последней версии FEKO метод конечных 
элементов. Теперь покажем конкретный пример, в котором используется 
одновременно и метод MOM и метод FEM.  
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17.6 Решение задачи SAR – расчета мощности поглощения в 
голове пользователя сотового телефона 

Удельный коэффициент поглощения (Specific Absorption Rate — SAR) 
электромагнитной энергии — показатель, определяющий энергию 
электромагнитного поля, выделяющуюся в тканях тела человека за одну секунду. 
Этой величиной оценивают вредное воздействие мобильных телефонов на 
человека.  
 Единицей измерения SAR является ватт/ килограмм. 

 В Европе допустимое значение излучения составляет 2 Вт/кг для 10 граммов 
тканей.  

 В США используется другое предельное значение — SAR не должен 
превышать 1,6 Вт/кг для 1 грамма тканей.  

 В России своя система измерения излучаемой мощности — в ваттах на 
квадратный сантиметр.  

Удельный коэффициент поглощения вычисляется по формулам: 

1. Используя напряженность поля в тканях: , 

2. Используя плотность тока в тканях: , 

3. Задавая повышение температуры в тканях: , 
где: 

E — электрическое поле (в В/м)  
J — плотность тока (в А/м²), вызванная электрическим и магнитным 
полями; (предельно допустимый уровень для людей, подвергающихся 
подобным воздействиям в профессиональной деятельности — 10 мА/м²; для 
остальных — 2—10 мА/м²)  
ρ — плотность человеческих тканей (в кг/м³)  
σ — электрическая проводимость человеческих тканей (в См/м)  
ci — теплоёмкость ткани  человека (в Дж/(кг·К))  
dT/dt — временна́ я производная температуры человеческих тканей (в К/с)  
Нужно отметить, что значение SAR определяется при работе телефона на 

максимальной мощности. На практике мощность передатчика телефона зависит 
от конкретных условий, при этом, как правило, чем лучше качество связи в точке 
местонахождения абонента, тем меньше мощность. 

На практике мощность передатчика телефона зависит от конкретных 
условий, при этом, как правило, чем лучше качество связи в точке 
местонахождения абонента, тем меньше мощность. Диапазон регулировки 
мощности в GSM-телефонах - примерно от 2 Вт до 20 мВт - т. е. разница между 
максимальной и минимальной мощностью около ста раз.  

Величина SAR (Specific absorption rate) рассчитывается как усредненная 
мощность поглощения во всем объеме (the Volume-average SAR) или 
максимальное поглощение в кубике с весом 1 грамм или 10 грамм, либо в 
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заданном объеме (the Spatial-peak SAR). Задание на расчет удельной мощности 
поглощения выполняется в диалоге Request SAR (рис. 17.18).  
 

  
 

Рис. 17.18. Диалог задания опция 
расчета SAR 

 
Рис. 17.19. Черчение сферы радиусом 

48 мм (область мозга) 
 
В диалоге рис. 17.18 определяется заданный тип SAR . В разделе Specify the 

search region задаются:   
 

Область (или объем) в котором должна быть рассчитана величина SAR, 
среди которых может быть:  
 Entire model: Все диэлектрические области в модели будут учитываться, и 

будет рассчитана усредненное и пиковое значение величины SAR.  
 By medium: Будет рассматриваться набор областей с заданным типом 

среды. Могут быть выбраны все, или определенная среда. Для всех сред 
усредненная (average) или максимальная (peak) SAR рассчитываются 
отдельно для каждой среды, и таким образом это отличается от выбора 
модели Entire model.  

 В планарной подложке: В этом случае в расчета SAR могут быть включены 
заданный слой (layer 0 – это верхняя область свободного пространства (upper 
free space region), слой layer 1 – диэлектрический слой сверху, или все слои 
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(All layers). Однако в этом случае не может быть использовано усреднение по 
объему.  

Выбираем единицы черчения модели (рис. 17.20) мм и чертим  модель 
головы в виде сферы радиусом 51 мм. 

 
 

 
 

Рис. 17.20. Выбор диэлектрической проницаемости и тангенса потерь материала 
(мозг), а также плотности, используя частотную зависимость, используя кусочно 

ломанную аппроксимацию. 
 

Затем, копируя объемы, и вычитая один из другого, создадим еще два слоя 
над сферой мозга: кость и кожа толщиной 1 мм. Эти слои нужно объединить и 
задать каждой области Region свои свойства.  

Отметим, что в диалогах рис. 17.20 - 17.22 можно задать частотную 
зависимость характеристик слоев. 
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Рис. 17.21. Задание параметров кости, 
в которой можно задать частотную 

зависимость  характеристик 
материала и плотность 

Рис. 17.22. Задание параметров кожи 
в диапазоне частот 
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Рис. 17.23. Установка элементарного электрического вибратора в виде точечного 
источника вблизи диэлектрического объема 

 
Чтобы рассчитать ближнее поле вдоль линии, в диалоге Request near field 

зададим 100 точек через 1 мм (рис. 17.24). 
 

 
Рис. 17.24. Задание точек, в которых считается ближнее поле 

 
Выполним разбиение и запустим на расчет. В результате постпроцессорной 

подготовки выведем ближнее поле на графики.  
В заданных точках в POSTFEKO можно вывести любую компоненту поля, 

в том числе продольную компоненту поля Ez (рис. 17.25). 
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Рис. 17.25. Изменение ближнего поля вдоль линии (в дБ) 

 Распределение ближнего поля в среде можно видеть на рис. 17.26. Картина поля 
показывает, в каких точках пространства имеет место максимальная 
напряженность электрического поля. 

 

Рис. 17.26. Вид объемного распределения ближнего поля  
в сечении модели головы 

  Величина SAR зависит и от плотности материала, поэтому в FEKO можно 
задать расчет характеристик, показанных в диалоге рис. 17.8. Мощность, 
поглощаемая в средах, будет зависеть от мощности, излучающей антенной, 
которая устанавливается в диалоге рис. 17.28. Необходимые запросы расчета SAR 
перечисляются в дереве проекта рис. 17.29. 
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Рис. 17.27. Вывод информации о 
рассчитанной в FEKO величине SAR 

Рис. 17.28. Установка мощности 
сотового телефона 

 

 

Рис. 17.29. Выбор среды для расчета SAR (Specific Absorption Ratio) 
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Рис. 17.30. Вывод рассчитанных данных  и удельной поглощаемой мощности в 
отдельных средах 

При выборе опции At specific position величина SAR может быть 
рассчитана в заданной точке в объеме весом 1 грамм. Эта опция не может быть 
применена при усреднении в объеме (volume averaging) 

Величину SAR можно также рассчитать в диапазоне частот и вывести на 
график (рис. 17.31). 

 

Рис. 17. 31. Частотная зависимость SAR 

17.7  Пример расчета SAR из раздела Examples программы FEKO 
Рассмотрим пример, в котором используются экспериментальные 

параметры материала (мозга) головы человека в виде сферы и рассчитывается 
поле, создаваемое излучением дипольной антенны в диапазоне частот 0.1-1 GHz. 
Для характеристики биологического материала используются три метода.  
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Первая модель использует постоянные материальные свойства для 
биологического материала (мозг) во всей полосе. Используемые свойства 
соответствуют таковым из ткани человека на частоте 550 МГц. Для второй 
модели, 21 точки определены вручную в CADFEKO для свойств мозга по 
частоте. Для третьей модели, 101 точки выборок определены вручную в 
EDITFEKO. Результаты сравниваются, чтобы показать влияние материалов 
зависящих от частоты, моделируемых по широкой полосе.  

 

17.7.1  Диполь и модель головы 
 

При моделирование вокруг головы чертится также слой воздуха. Это 
делается для уменьшения числа треугольников, требуемых на границе между 
областями FEM и MoM. Это не строго необходимо, но если этот метод не 
используется, ресурсы, требуемые для расчета области взаимодействия между 
областями FEM и  MoM становятся очень большими без улучшения точности 
результатов.  
Создание модели. Выполним следующие шаги для моделирования:  

 Определим следующие переменные:  
o f_min = 100e6  (минимальная частота.)  
o freq = 900e6  (рабочая частота)  
o f_max = 1e9  (максимальная рабочая частота.)  
o d = 0.1   (расстояние между диполем и сферой головы.)  
o rA = 0.03   (радиус внешней сферы.)          
o rM = 0.025   (радиус внутренней сферы.)  
o epsr = 56.18  (относительная диэлектрическая проницаемость 

материала muscle)  
o tand = 0.4863  (тангенс угла потерь мозга.)  
o lambda = c0/freq (длина волны в свободном пространстве)  

 
 Создание среды.  
o Создадим диэлектрик с именем muscle с относительной диэлектрической 

проницаемостью  epsr и тангенсом диэлектрических потерь  tand.  
o Создадим диэлектрик с именем air с относительной диэлектрической 

проницаемостью  1 и тангенсом потерь 0.  
• Создание сферы с началом координат в 0 и радиусом равным переменной 

rM и с именем Sphere1.  
• Создание сферы с центром в начале координат и радиусом, определенным 

переменной rA. Установить имя Sphere2.  
• Вычесть Sphere1 из Sphere2.  
• Создать сферу с центром в начале координат и радиусом rM.  
• Объединить обе сферы.  
• Задать свойства области внутренней сферы диэлектрику с именем muscle.  
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• Установить свойства области между внутренней и внешней сферой как 
диэлектрик с именем air.  

 
Рис. 17.32. Задание метода решения FEM для области 

 
 Создание линии длиной  d от центра сферы. Установите начальную точку 

как (0,-lambda/4,-d) и конечную точку (0,lambda/4, -d).  
 Добавьте порт на сегменте провода в центре провода.  
 Добавить источник напряжения на порт. (1 V, 0)  
 Установить общую мощность источника (без согласования) равным  1 W.  
 Установить диапазон частот и дискретные 11 точек в диапазоне от f_min до 

f_max.  
 

17.7.2  Рассчитываемые характеристики 
Требуемые решения:  

 Рассчитать  ближнее поле воль оси Z  в 31 точке между точками  -0.075 м и  
+0.075 м (шаг равен 0.15 м /30).  

Разбиение на сетку объема нужно выполнить так, чтобы сферы были разбиты 
на тетраэдры, и можно использовать гибридный метод MoM/FEM. Установите 
метод конечных элементов FEM в закладке Solution  диалога Region properties.  
Заметим, что в расчете используется интерактивное решающее устройство.  

 Длина ребра треугольника (Triangle edge length): not applicable.  
 Длина сегмента провода (Wire segment length): lambda/10/sqrt(epsr).  
 Длина ребра тетраэдра: lambda/6/sqrt(epsr).  
 Радиус сегмента провода (Wire segment radius): 1e-3.  
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Рис. 17.33. Среда воздуха (зеленая) и muscle (синяя) 

 
После окончания расчета:  

 Сохраните файл диэлектрической модели из 21 точки под другим именем.  
 Откройте файл *.pre  в  EDITFEKO.  
 Отредактируйте карту DI в которой определяются свойства материала 

«muscle». Вручную задайте 101 точку и установите свойства, найденные в 
файле  muscle_101pts.txt.  

 
В результате расчета получаем распределение ближнего поля вдоль линии, 
проходящей через диэлектрическую сферу. 

 
 
Рис. 17.35. Зависимость ближнего поля вдоль линии по оси Z. Радиус сферы 3 см. 
 

Данные, приведенные на рис. 17.35 можно использовать для расчета 
удельной поглощаемой мощности SAR. Кроме SAR, для оценки воздействия 
радиоизлучения на организм человека можно выбрать увеличение температуры 
тела при длительном воздействии облучения.  
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Повышение температуры тела зависит от мощности, поглощаемой и 
рассеиваемой в виде тепла в теле. 

 В 1948 г. H.H.Pennes предложил математическую модель для передачи 
тепла в биологическом теле, обусловленного диффузией крови. Хотя были 
разработаны и более сложные модели для моделирования процесса 
теплопередачи, этот подход был уточнен и всё еще используется в настоящее 
время. Модель описывает влияние тока крови на температуру ткани в 
стационарном состоянии. Поэтому источник и канал передачи введен в уравнении 
теплопроводности: 

              )()( TTCSARMRT
t
TС abbP 

  , 

где: 
 ρ - плотность массы биологического материала,  кг/м3 , 
Cp - теплоемкость биологического материала, Дж/кг,  
λ - теплопроводность материала, t°/м, 
MR - скорость генерации тепла в соответствии с метаболическими 
процессами, t°/сек, 
скорость диффузии тепла, t°/сек, 
ρb -плотность массы крови,  кг/м3 , 
Сb - теплоемкость биологического материала,  Дж/кг, 
Ta  - артериальная температура, °С. 

 
Из этой формулы видно, что SAR является стационарной характеристикой 

оценки изменения температуры. Рассматриваемая версия FEKO не дает 
возможности рассчитывать распределение температуры. В настоящее время это 
можно сделать в вычислительных системах CST и HFSS ANSYS. 
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18  МОДЕЛИРОВАНИЕ ФИЛЬТРА С МИКРОПОЛОСКОВЫМИ 
ПОРТАМИ 

 
 
 
Интеграция микросхем СВЧ, в виде создания единой конструкции, или при 

применении встроенных дискретных компонентов, развиваются, дополняют друг 
друга, и конкурируют в разных решениях. Рассмотрим пример проектирования 
входного узла СВЧ системы спутникового наведения, в который входит антенна 
и система аналогового обработки сигнала (селекция и усиление). 

Современная конструкция представляет собой сложную СВЧ антенну, 
использующая формирование сложной излучаемой структуры и дискретные 
компоненты – чипы, объединенные с антенной в единую конструкцию. 

Отказ от аналитических методов расчета и переход на проектирование с 
помощью современных продвинутых коммерческих программ типа FEKO 
позволяет резко усложнить конструкцию антенны и получить новое техническое 
качество. 

 
С учетом того, что современный инженер располагает, кроме 

узкоспециализированных программ расчета СВЧ конструкций, также 
универсальными платформами, Microwave Office или Ansoft Designer, основой 
современного проектирования становится синтез. Однако выполнить синтез на 
FEKO требует больших временных затрат, поэтому в рамках решения 
поставленной задачи, выбираем следующий алгоритм: оптимизацию проводим на 
MWO, причем на первом этапе выполняем синтез фильтра с помощью ассистента 
Syntes. В исходные данные входят также параметры подложки, на которых будет 
располагаться структура (форма) фильтра. Отметим также, что при задании 
целевой функции в MWO можно устанавливать наклонные целевые функции 
(рис. 18.1), что значительно ускоряет процесс сходимости. 

 
Объектом синтеза задается фильтр, который затем реализуется в виде 

структуры, показанной на рис. 18.2. При выборе исходных данных на синтез, 
остается много степеней свободы, одной из которых является порядок фильтра. 
Выбор начинаем с наименьшего порядка, и не только потому, что этот фильтр 
будет и более простым. Одним из важных качеств является то, что такой фильтр 
будет иметь наименьшие потери в полосе частот.  
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Рис. 18.1. Частотная характеристика фильтра 3-го порядка, рассчитанная на 

MWO и отмеченные желаемые характеристики фильтра, устанавливаемые как 
цель оптимизации 

 
Из-за большой скорости оптимизации в программе MWO, её можно считать 

основным инструментом на первом этапе проектирования фильтра. 
Для выполнения этого используем утилиту Syntes программы MWO, 

существующую как ассистент проектирования. В результате синтеза получаем 
схему фильтра, показанную на рис. 18.2. 

После анализа фильтра в MWO, ее рекомендуется оптимизировать так, 
чтобы частотная характеристика не имела паразитных резонансов, выпадающих 
из полосы пропускания фильтра. Затем структуру фильтра начертим в 
интерфейсе FEKO (рис. 18.2). 
 

 
Рис. 18.2. Структура фильтра 3-го порядка на связанных резонаторах 
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Двухзвенный фильтр на связанных микрополосковых линиях. 
Подложка Флан толщиной 1 мм; проницаемость 10, тангенс потерь 0.001. 
На входе и выходе фильтра рис. 18.3 необходимо поставить волноводные 

порты. В результате расчета получим частотную характеристику фильтра, 
показанную на рис. 18.3. 
 

 
Рис. 18.3. Частотная характеристика фильтра на связанных резонаторах, 

рассчитанная FEKO. Эта характеристика с высокой степенью точности совпадает 
с результатом, полученным в MWO 

 
Программы электродинамического моделирования дают точность решения, 

соизмеримую с экспериментом.  
Как было показано, особенности определенных задач требуют различных 

описаний граничных условий. Выяснить, где сосредоточены основные потери в 
фильтре и сравнить с теми данными, которые получены при анализе потерь в 
пач-антенне – это важная задача, стоящая перед разработчиком и пользователем 
программы электродинамического моделирования. 

 

18.1 Анализ одного резонатора СВЧ фильтра 
Рассмотрим резонансный элемент фильтра, который состоит из полосковой 

линии, в середине которой включен порт (рис. 18.4). 
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Рис. 18.4. Структура одного резонатора, разомкнутого на концах 

 
Если элемент фильтра замкнут на концах (рис. 18.5), то порт, питающий эту 

линию, смещается к одному из короткозамкнутых концов, чтобы обеспечить 
согласование. 

Отметим, что распределение тока и напряжения вдоль линии для 
резонансного элемента имеют вид синусоиды, а ток достигает нулевых значений 
на концах. Входной импеданс такого элемента равен 

 
 

 
Рис. 18.5. Фрагмент фильтра, с емкостью на одном конце имеет наименьшие 

размеры 
 

Рассмотрим один элемент фильтра и случаи, когда линии образуют КЗ с 
земляной платой; линии разомкнуты и линия замыкается на конденсатор, образуя 
короткий резонатор. 
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Рис. 18.6. Частотная характеристика одной секции фильтра без потерь 

 

 
Рис. 18.7. ЧХ секции фильтра в виде линии с ХХ и большими потерями R=0.02 

18.2 Расчет фильтра методом FEM 
В следующем примере используем микрополосковые порты, реализованные 

в FEKO. Диалог создания микрополоскового порта на геометрии показан на рис. 
18.8 и содержит список ребер (подобный списку фасок при обсуждении порта по 
ребру (Edge port)). Этот порт создается выбором команды Geometry → Create 
port → Microstrip port или выбором набора ребер и выбором команды Create 
port → Microstrip port из выплывающего меню в дереве подробностей. В 
трехмерном виде такой порт показывается аналогично порту на ребре. 
Ориентация или полярность микрополоскового порта  показывается в трехмерном 
виде. 
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Если возбуждаемое ребро выделено синим цветом, положительная сторона 
порта соединена с выводом порта, а отрицательная сторона присоединена к 
земляной плоскости. Если край выделен красным цветом, то отрицательная 
сторона порта соединена с краем. Ориентация порта может быть изменена, 
выбирая  или снимая опцию Reverse polarity.  

Микрополосковый порт можно создать также и непосредственно на сетке 
разбиения. Диалог в котором ставится микрополосковый порт на сетку 
вызывается командой Mesh → Create port → Microstrip port  из 
главного меню. В диалоге (рис. 18.8) задается ребро, к которому приложен порт, 
определенный по его начальной и конечных точкам.  

Они должны быть вершинами сетки разбиения и должны быть выбраны, 
щелкая по соответствующим вершинам в трехмерном представлении, в то время 
как Start vertex и области End vertex являются активными.  

 

 

 
Рис. 18.8. Диалог создания 

микрополоскового порта на сетке 
разбиения 

Рис. 18.9. Диалог создания 
микрополоскового порта в геометрии 

 
 

Микрополосковые порты используются, подключая линии питания на 
микрополосковых структурах. Они задаются на ребре или на нескольких ребрах, 
которые формируют длинное, прямое, горизонтальное (при постоянном значении 
z) ребра, ограничивающие только одну фаску. Кроме того, модель должна 
содержать плоскую диэлектрическую подложку с проводящей земляной платой 
внизу.  

Диалог создания микрополоскового порта содержит список граней, 
подобный списку фасок порта на границе выше. К этому порту обращаются, 
выбирая Geometry → Create port → Stripline port или выбирая несколько фасок 
и выбирая Create port →Edge port из всплывающего меню в дереве 
подробностей. На структуре порт отображается аналогично порту на границе. 

Положительное направление идет всегда к краю.  
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В диалоге разбиения на ячейки ребро определяется начальной и конечной 
точками. Они должны быть вершинами в трехмерном представлении, в то время 
как поля начальной и конечной вершины активна. Поля вершин тогда 
показывают обозначение элементов, связанных с соответствующей вершиной. К 
этому диалогу обращаются, выбирая Mesh → Create port → Stripline port из 
главного меню. В результате показывается та же самая  модель геометрии.  
 

 
Рис. 18.10. Выделение ребра для постановки микрополоскового порта 
 

Теперь на этот порт поставим источник напряжения (рис. 18.10). 

18.3 Пример моделирования микрополоскового фильтра с 
микрополосковым портом 

 Создание геометрии (Microstrip_Filter_Infinite_Ground) 
-Установим единицы модели на mm  
-Определим следующие переменные: 

fmax =4e9       (максимальная частота) 
fmin =1.5e9    (minimum frequency) 
epsr =2.33     (относительная проницаемость  
      диэлектрической подложки) 
lambda = c0/freq/sqrt(epsr)*1000  (длина волны в диэлектрике) 
shielding_height = 11.4    (высота экранирующего бокса) 
substrate_height = 1.57    (высота подложки) 
port_offset = 0.5    (смещение точки питания порта) 
strip_width = 4.6    (ширина микрополосковой линии) 
strip_offset = 23     (смещение микрополоска от ребра  

земляной  поверхности) 
stub_length = 18.4    (длина шлейфа) 
stub_offset = 41.4    (длина вставки от угла земляной платы  

до шлейфа) 
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gnd_length = 92      (длина стороны подложки) 
  

18.4 Последовательность создания модели 
1. Начертим диэлектрик substrate (с относительной диэлектрической 

проницаемостью 2.33, тангенс потерь = 0) 
2. Начертим микрополосковую линию line в виде параллелепипеда  с длиной  

gnd_length-port_offset и глубиной подложки.  
3. Внутренняя область этого кубоида устанавливается на "Free space" и 

ненужные фаски удаляются  (все фаски кроме верхней фаски). 
4. Линия чертится между точками (27.6,41.4,0) и (27.6,46.0,0), и затем 

свипируется от x = 0  до  x = 18.4. Это будет плоская линия - шлейф "stub". 
5. Эти части объединяются и объект называется "filter". 
6. Добавляется многослойная бесконечная подложка с земляной платой внизу, 

толщиной  height, с верхней границей при z=0 и материалом подложки. 
7. Микрополосковые порты (Microstrip ports) (A и B)  добавляются  к ребрам, на 

которых требуется установить источники (рис. 18.10). 

 
Рис. 18. 11. Микрополосковая форма в виде многоугольника, с одного ребра 

которого устанавливается микрополосковый порт 
 

8. Все объекты объединяются и результирующий называется  
"Shielded_Filter" 



372 
 

9. Создается кубоид с базовым углом на substrate_height ниже начала системы 
координат и с шириной gnd_length, глубиной  gnd_length и высотой  
shielding_height. Это экранирующий бокс. Его среда устанавливается на 
"Free space" и нижняя фаска удаляется. 

 
     Требуется рассчитать характеристики в частотном диапазоне между 1.5 ГГц и 
4 ГГц. S-параметры рассчитываются с активным портом PortA и с опорным 
импедансом 50 Oм. 
 

 
Рис.18.12. Задание земляной подложки внизу диэлектрической платы 

 
Далее зададим выводимые данные: ближнее поле и частотные 

характеристики S21. 
 

 
Рис. 18. 13.Задание расчета ближнего поля вблизи микрополосковой антенны 
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Результаты расчета фильтра (рис. 18.2) при включении различных 
механизмов потерь в фильтре приведены в таблице 18.1. 

 
Табл. 18.1. Полоса секции фильтра для разных потерь в подложке и в металле 

№  Вид структуры Потери в 
подложке 

Потери в 
металле 

Полоса 

1 КЗ на концах tg δ=0 σ=0 8 МГц 
2  tg δ=0.001 R=0 8 МГц 
3  tg δ=0.001 R=0.005 18 МГц 
4  tg δ=0.001 R=0.01 21 МГц 
5  tg δ=0.001 R=0.02 25 МГц 
6 КЗ на концах 

(эксперимент) 
tg δ=? σ=? 40 МГц 

7 ХХ  на концах tg δ=0 R=0 18  МГц 
8  tg δ=0.001 R=0 24  МГц 
9  tg δ=0.001 R=0.005 28 МГц 
10  tg δ=0.001 R=0.01 31 МГц 
11  tg δ=0.001 R=0.02 49 МГц 
12 ХХ на концах 

(эксперимент) 
tg δ=? σ=? 23 МГц 

13 КЗ+3.3 пФ tg δ=0 R=0 2 МГц 
14  tg δ=0.001 R=0 2 МГц 
15  tg δ=0.005 R=0 3 МГц 
16  tg δ=0.001 R=0.01 15 МГц 
17  tg δ=0.001 R=0.02 31 МГц 
18 КЗ+3.3 пФ  

(эксперимент) 
tg δ= σ=? 48 МГц 

 
 
Эта таблица охватывает все режимы: ХХ, КЗ и укороченного размера 

шлейфа с емкостью. Рассмотрим режим ХХ для шлейфом и, используя 
рассчитанные данные, приведенные в Табл. 18.1, построим графики, которые 
позволяют оценить зависимости ширины полосы от потерь в подложке и потерь в 
металле (рис. 18.4). Этот вариант интересен потому, что ХХ соответствует 
важному практическому случаю – пач-антенне. Как можно видеть – пач-антенна 
по структуре соответствует  разомкнутой секции СВЧ фильтра. 
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Рис. 18. 14.Зависимость полосы секции фильтра от потерь в диэлектрике и потерь 

в металле для фиксированной толщине подложке 1 мм 
 

 Проектирование СВЧ-структуры произвольной формы остро ставит задачу 
описания, выбора и подтверждения достоверности модели. Построение 
достоверной модели связано с задачей анализа характеристик физической 
системы, реализуемой на этом устройстве. Это важный вопрос, решаемый в 
процессе проектирования, и умение построить модель, адекватную реальной 
задаче, является крайне важным для разработчика. Так, для анализа фильтра в 
корпусе можно использовать электродинамические методы расчета а также метод 
Олинера, основанный на теории цепей. Сравнение результатов расчета 
показывается на рис. 18.16.  

 
Рис. 18.15. Структура фильтра в корпусе 
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Рис. 18.16 Частотные характеристики полосового фильтра, рассчитанные 

несколькими методами 
 

 Современный уровень развития электродинамических методов 
расчета позволяет говорить о возможности исключить расчеты, основанные на 
теории цепей и других приближенных методах расчета, например метода 
Олинера. Метод Олинера активно использовался на протяжении десятилетий с 
момента его предложения. Реализация этого метода в MWO ускорило процесс 
проектирования СВЧ микросхем, в том числе усилителей, смесителей, 
генераторов. Особенно значимость этого метода полезна для расчета нелинейных 
СВЧ схем. Однако с появлением современных мощных компьютеров и 
программного обеспечения, реализующего электродинамические методы точного 
решения поля, наступает время исключить его из проектирования.  

В этом разделе был показан алгоритм проектирования СВЧ фильтра, 
который можно включить как в интегральной СВЧ схеме, так и в излучаемую 
структуру. При проектировании фильтра на керамической подожке учитывались 
тепловые потери в СВЧ фильтре, которые напрямую влияют на полосу 
пропускания фильтра. 
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19  МОДЕЛИРОВАНИЕ ТРАНЗИСТОРНОГО СВЧ-УСИЛИТЕЛЯ 

19.1 Однотранзисторный СВЧ усилитель на диэлектрической 
подложке 

Электродинамический расчет СВЧ-структур, в которые включены активные 
элементы, позволяет рассчитать и улучшить характеристики таких структур, как, 
например, микрополоскового многотранзисторного СВЧ-усилителя. Одной из 
задач, которую можно решить с использованием электродинамического подхода, 
является проектирование транзисторного усилителя СВЧ (ТУ СВЧ) в корпусе. 
Известно, что от размера экранирующего корпуса зависит устойчивость его к 
самовозбуждению, а также его шумовые и усилительные свойства, включая 
частотную характеристику и согласование в широком диапазоне частот. В этом 
разделе выполним электродинамическое моделирование ТУ СВЧ в корпусе. 
Типичный однокаскадный ТУ СВЧ (рис. 19.1) выполнен в виде микрополоскового 
усилителя в дискретными элементами, включая  транзисторы. Как показала 
практика, ТУ СВЧ в микрополосковом исполнении хорошо работают до 
миллиметрового диапазона волн.  

 
 

 
 

Рис. 19.1. Фотография однотранзисторного СВЧ-усилителя на диэлектрической 
подложке c согласующе-трансформирующими цепями (СТЦ) на входе и выходе 

 
С помощью FEKO мы выполним расчет так, что будет использован 

электродинамический подход, тогда как до сих пор использовались методы 
теории цепей, к которым, можно отнести и метод Олинера [1]. Метод Олинера, 
который используется для моделирования распределенных СВЧ элементов, 
включаемых вместе с дискретными активными СВЧ элементами в схему 
усилителя, использует формулы расчета модели распределенных цепей, и не 
учитывает связь по ближнему полю между отдельными элементами, входящими в 
структуру. Такой подход реализован, например, в широко распространенной в 
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практике проектирования программы MWO, в которой расчет ведется в схемном 
и топологическом представлении (рис. 19.2). 
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Рис. 16. 2. а) Топология 

транзисторного СВЧ-усилителя, 
созданная в MWO 

 

Рис. 16.2. b) Схема транзисторного СВЧ-
усилителя, составленная из узлового 

включения распределенных элементов 

 
Внедрение электродинамического метода расчета, реализованного в 

EMSight MWO, требует обязательного экранирования этой структуры. Для 
удаления боковых стенок от портов применяется операция разгерметизации. 
Порты-перемычки, реализованные в этой программе должны обязательно быть 
соединены с земляной платой. Все это накладывает ограничения при построении 
сложных СВЧ структур с активными элементами. 

При расчете в FEKO транзистор будет включен во внутренние порты, 
созданные в разрыве микрополосковой линии. В СВЧ-усилителе используем 
транзистор фирмы NEC N700. Его параметры в формате Touchstone показаны в 
табл. 19.1. 
 

Табл. 19. 1. Параметры СВЧ-транзистора N700 
 
#                    S11               S21                  S12                  S22 
        1.000       .964  -20.52  4.820  160.76   .032   78.26   .345  -21.71 
        2.000       .961  -26.26  4.502  157.35   .037   73.92   .335  -24.17 
        3.000       .933  -38.84  4.324  147.62   .054   67.19   .326  -36.08 
        4.000       .896  -50.81  4.114  138.19   .068   61.39   .317  -46.29 
        5.000       .859  -62.88  3.880  129.07   .080   55.08   .305  -57.68 
        6.000       .826  -74.02  3.641  120.74   .090   50.16   .297  -67.64 
        7.000       .794  -84.09  3.403  113.12   .098   45.62   .287  -75.73 
        8.000       .768  -93.82  3.176  105.99   .105   41.69   .283  -83.76 
        9.000       .747 -102.69  2.958   99.36   .111   38.36   .279  -90.05 
      10.000       .725  -109.21  2.71    93.75   .116   35.96   .274  -95.59 
  

Модель транзистора, заданная в виде таблицы S-параметров, включается в 
структуру усилителя СВЧ в виде четырехполюсника. Этот четырехполюсник (на 
СВЧ четырехполюсник реализуется как двухпортовая структура) называется 
неизлучающей цепью и подключается к портам, заданным в структуре. 
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Расчет электродинамическим способом в программе FEKO (в отличие от 
MWO, где для моделирования отдельных частей согласующей структуры  (СТЦ1 
и СТЦ2) нужно создавать отдельные экранирующие боксы) выполняется на 
полной структуре, в которую включаются активные элементы (рис. 19.3). Таким 
образом, связи между согласующими структурами учитываются. 

 

Рис. 19.3. Структура микрополоскового усилителя на транзисторе на 
диэлектрической подложке, рассчитываемая как открытая электродинамическая 
структура в FEKO 
 

Пусть ширина линий согласующей структуры, расположенной на подложке 
толщиной 1 мм (диэлектрическая проницаемость подложки равна 10), равна 1 мм. 
Выполним расчет в диапазоне частот от 1 до 10 ГГц.  

Выбираем единицы длины: мм и чертим подложку командой Draw->Box (рис. 
19.4).  

 

 
Рис. 19.4. Черчение диэлектрической подложки 

 
Особенность построения портов на ребрах заключается в том, что порт не 

должен лежать на поверхности какой либо стороны, а должен быть «внедрен» в 
подложку. 
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Начертим командой Draw->Box  параллелепипед, верхняя и нижняя 
стороны которой будут микрополосковыми линиями (рис. 19.5). 

 

 
Рис. 19.5. Создание параллелепипеда, который будет основой линии 

 
Этот кубоид нужно разрезать параллельно плоскости XOY для того, чтобы 

получить две соприкасающиеся фаски, которые будут образовывать порт на 
ребре. Это выполняется комадой Split. 

            
 

Рис. 19.6. Операция разрезания (расщепления) параллелепипеда  
в  плоскости XOY 

 
На поверхности диэлектрической подложки начертим также шлейфы 

шириной 1 мм и длиной 5 мм командой Draw-> Rectangle (рис. 19.7). 
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Рис. 19.7. Черчение шлейфа 1  и шлейфа 2 

 
Теперь объединим все компоненты командой Unite.   
Создадим диэлектрик с проницаемостью 10 и заполним все области 

диэлектриком. 
Вторую линию создадим аналогично первой линии, командой Draw->Box с 

параметрами, которые приведены на рис. 19.9. 
 

 
Рис. 19.8. Черчение второй микрополосковой линии в виде бокса-канала. 
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И этот бокс также разрежем вдоль плоскости XOY.  

  
Рис. 19.9. Заполнение всех областей 
средой типа Dielectric  с именем Sub 

Рис. 19.10. Описание всех 
токонесущих поверхностей как 

Perfect electric conductor 
 

В результате получаем структуру согласующих цепей, показанную на рис. 
19.11. 

 
Рис. 19.11. Структура пассивной части согласующей структуры ТУСВЧ 

 
Для того, чтобы рассмотреть внутреннее содержание структуры и разрез 

линий, зададим команду Cut. Параметры разрезания установим в соответствии с 
рис. 16.13. 
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Рис. 19.11. Диалог операции разрезании бокса вдоль длинной оси 
 

Сделаем разрез так, чтобы видеть  две поверхности, касающиеся фасками. 
Эти поверхности нужно также сделать токонесущими, и на них поставить порт, 
командой Ports-> Edge. 
 

 
Рис. 19.12. Задание свойств отдельных поверхностей конструкции ТУ СВЧ 
 

Среднюю линию, которая создалась в результате расщепления нужно убрать, 
чтобы ребра касались только по одному ребру. И эти поверхности вносятся в 
диалог создания порта. 

Неизлучающая цепь добавляется в модель CADFEKO, в диалоге, который 
выводится по команде Networks->Connect Non-radiating networks, как показано 
на рис. 19.13. Но сначала нужно импортировать многополюсник GeneralNetwork 
в виде S-, Y- или Z-параметров, как внешний файл Touchstone или вручную задан 
в CADFEKO. Это выполняется с помощью команды Add general Network, по 
которой появляется диалог рис. 19.14.  

Опорные импедансы портов будут определены в файле S-параметров. Если 
параметры задаются вручную в CADFEKO, то можно использовать максимум 4 
порта, и для каждого порта должны быть определены опорные импедансы. 
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Рис. 19.13. Подключение S-параметров 

транзистора (GeneralNetwork1) к 
внутренним портам  Port2 и Port4 
транзисторного СВЧ-усилителя в 

диалоге программы FEKO 

Рис. 19.14. Диалог импорта S-
параметров неизлучающей цепи (S-

параметров транзистора) 

 
Для моделирования транзисторного СВЧ-усилителя в случае классического 

крепления транзистора на микрополосковой плате, применим порты Edge port на 
ребре. Такие порты создаются между двумя наборами фасок (рис. 19.15).   

  
а) б) 

Рис. 19.15.  Порты, между которыми включается активный 
элемент 

Заметим, что ребро, на котором задается порт, не обязательно должно быть 
прямым – порт может быть создан на срезе цилиндра, который разбивается на 
сетку треугольников. Микрополосковая линия создается на верхней поверхности 
параллелепипеда, который заполняется диэлектрическим материалом. Нижняя 
поверхность параллелепипеда объединяется с земляной платой. Боковые стенки 
этого параллелепипеда удаляются. Граничный порт (рис. 19.15а) создается 
командой Geometry  Create port  Edge port. Положительная и отрицательная 
фаски порта на ребре – это верхняя и нижняя вертикальные фаски, на которые 
разрезается параллелепипед по горизонтальной плоскости посредине (рис. 19.15. 
б) [4,5]. 

Если длину шлейфов выбрать очень маленькой, то это будет означать, что 
транзистор включен в микрополосковую линию с характеристическим 
сопротивлением 50 Ом, и в этом случае  коэффициент усиления равен G=|S21|2, [2]. 
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Этот случай можно проверить, используя 
моделирование электродинамическим 
методом и методом теории цепей, 
рассчитывая простейшую структуру, 
состоящую из транзистора, включенного в 
линию с характеристическим сопротивлением 
50 Ом. Результаты совпадения можно видеть 
на рис. 19.17. 

Представив согласующие структуры 
усилителей в виде отрезков микрополосковых 
линий и шлейфов, в результате расчета 
получаем частотные характеристики, 
показанные на рис. 6, на которые нанесена 
также частотная характеристика одного 

транзистора (синяя линия). 

 

Рис. 19.17. Частотные характеристики транзисторного СВЧ-усилителя с 
согласующими структурами в виде микрополосковых линий и шлейфов. Расчет 

выполнен  с помощью MWO и с помощью FEKO 
 

На рис. 19.17 приводятся характеристики усилителя без корпуса. Расчет на 
FEKO и MWO приводит к близким результатам. Однако учет связи по ближнему 
полю можно выполнить, только применяя 3D программу электродинамического 
расчета FEKO. 

Известно, что усилитель работает в корпусе не так, как без корпуса. Верхняя 
крышка может привести к возбуждению усилителя. Поэтому после окружения 
усилителя металлическим корпусом (рис. 19.18) выполним расчет ТУ СВЧ в 
корпусе. Как показал расчет, в этой структуре характеристики усиления 
получаются более изрезанными в диапазоне частот. Изрезанность частотной 

 
Рис. 19.16. Задание сетки 

частот расчета, согласованной с 
файлом S-параметров 
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характеристики показывает влияние высших типов волн, которые могут 
распространяться в корпусе транзисторного СВЧ-усилителя.  

19.2 Анализ работы транзисторного СВЧ-усилителя в корпусе 
При проектировании ТУ СВЧ очень важным является обеспечение 

устойчивости его работы в широком диапазоне частот. Устойчивость работы 
структуры, в которой включен активный элемент (например, транзистор), 
оценивается инвариантным коэффициентом устойчивости: 

1221

22
22

2
11

2
S1

k
SS

S S
 ,     (1) 

где:   S=S11S22-S21S12.  
Расчет по этой формуле для транзистора, S-параметры которого приведены 

в табл. 19.1, дает коэффициент устойчивости, меньший 1. Это означает, что 
должны быть предприняты специальные условия, чтобы увеличить устойчивость 
работы усилителя. Одной из таких возможностей является установка 
поглощающей крышки в транзисторном СВЧ-усилителе. Для оценки 
устойчивости ТУ СВЧ в корпусе также используем формулу инвариантного 
коэффициента устойчивости.  

 

Рис. 19.18. Модель транзисторного СВЧ усилителя в корпусе (в срезе) 

Для моделирования ТУ СВЧ в корпусе охватываем микрополосковую плату 
проводящим боксом, свойства которого могут меняться от идеально проводящей 
до среды с сильным поглощением (рис. 19.18). 

Расчет на программе FEKO микрополоскового усилителя в корпусе показал, 
что высота положения крышки незначительно влияет на частотную 
характеристику транзисторного СВЧ-усилителя. Применяя поглощающее 
покрытие, (материал =100 См/м) удалось увеличить коэффициент устойчивости 
до величины, большей единицы в анализируемом диапазоне частот (рис. 19.18). 
Параметры поглощающего покрытия выбираются в диалоге (рис. 19.19). 
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Рис. 19.19. Частотная зависимость коэффициента устойчивости транзистора, 

используемого в ТУ СВЧ 

В реальном усилителе, кроме внутренней обратной связи действует внешняя 
обратная связь. Для увеличения коэффициента устойчивости и устойчивого 
усиления, можно выполнить оптимизацию конструкции корпуса, как его 
размеров, так и свойств покрытия. Таким образом, были проанализированы 
характеристики транзисторного СВЧ-усилителя в корпусе в режимах: 1) крышка с 
потерями, 2) открытая крышка, 3) крышка без потерь, и получено, что при 
наличии крышки без потерь коэффициент устойчивости усилителя уменьшается 
при уменьшении высоты над подложкой. Поэтому в общем случае нужно 
применять поглощаемое покрытие, что, как показано, увеличивает устойчивость 
работы усилителя. Закрытая крышка обеспечивает больший коэффициент 
устойчивости.  

19.3 Выводы 
Современные программы электродинамического моделирования открывают 

широкие возможности для электродинамического моделирования СВЧ-структур с 
внедренными в них активными элементами: диодами и транзисторами, что 
показано на примере транзисторного СВЧ-усилителя. Учет влияния крышки 
корпуса с нанесенным поглощаемым материалом, а также обратные связи между 
входным и выходным портом в этом случае учитываются автоматически. Такой 
подход можно считать перспективным для проектирования волноводных 
транзисторных СВЧ-усилителей, активных антенн и активных антенных решеток 
и структур, которые выполняют роль согласующих и излучающих элементов 
одновременно.  
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20  МОДЕЛИРОВАНИЕ ВОЛНОВОДНОГО СВЧ УСИЛИТЕЛЯ 

 

20.1 Однокаскадный волноводный транзисторный СВЧ 
усилитель 

В этом разделе выполним проектирование транзисторного усилителя  СВЧ 
(ТУ СВЧ) в корпусе в виде волноводной структуры. Рассмотрим типичный 
однокаскадный  волноводный ТУ СВЧ (рис. 1), который состоит из отрезка 
волновода, микрополосковой платы на диэлектрической подложке с высокой 
диэлектрической проницаемостью, согласующих структур. 
 

    
 

Рис. 20.1. Фотография волноводного однокаскадного транзисторного СВЧ 
усилителя на диэлектрической подложке 

 
Как выполнить моделирование устройства, состоящего из СВЧ структуры, в 

которую включены активные элементы, имеющие несколько проводов, по 
которым течет ток? Активные элементы включаются в СВЧ структуру в точках, и 
следовательно речь идет об объединении электродинамического метода расчета и 
метода, основанного на теории цепей.  

Метод Олинера [17], который чаще всего применяется для расчета активных 
СВЧ схем, является, по сути, методом теории цепей, который использует модели 
распределенных цепей в виде дискретных элементов, и не учитывает связь по 
ближнему полю между элементами, входящими в структуру. Такой подход 
реализован в широко распространенной в практике проектирования программе 
MWO (рис. 20.2). Здесь СВЧ структура рассчитывается в утилите EMSight [17], 
используя электродинамический расчет методом моментов, а S-параметры или 
модель активных элементов добавляются на уровне схемы. Т.е. узлы активных 
элементов  подключаются во внутренних портах структуры ТУ СВЧ. 
Аналогичное объединение решений, полученных разными методами, 
выполняются в HFSS Designer (первая линия рис. 20.2). 
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Рис.20.2. Два метода объединения неизлучающей цепи (транзистора и 

электродинамической структуры) 
 
Подход, реализованный в FEKO предполагает включение активного 

элемента в электродинамическую структуру (вторая линия рис. 20.2). Здесь 
сначала выполняется расчет методами теории цепей, а затем выполняется 
электродинамический анализ. В этом случае взаимная связь входной и выходной 
согласующей структуры учитывается автоматически, и появляется возможность 
рассчитать характеристики ближнего и дальнего поля структуры, в которую 
включены активные элементы.  Транзистор будет включен во внутренние порты, 
созданные в разрыве входной и выходной согласующей структуры. В расчете 
волноводного СВЧ усилителя используем транзистор N700, параметры которого в 
формате Touchstone показаны в табл.20.1. 
 

Табл. 20.1. Параметры СВЧ транзистора N700 
 

#                    S11               S21                  S12                S22 
1.000       .964  -20.52  4.820  160.76   .032   78.26   .345  -21.71 
2.000       .961  -26.26  4.502  157.35   .037   73.92   .335  -24.17 
3.000       .933  -38.84  4.324  147.62   .054   67.19   .326  -36.08 
4.000       .896  -50.81  4.114  138.19   .068   61.39   .317  -46.29 
5.000       .859  -62.88  3.880  129.07   .080   55.08   .305  -57.68 
6.000       .826  -74.02  3.641  120.74   .090   50.16   .297  -67.64 
7.000       .794  -84.09  3.403  113.12   .098   45.62   .287  -75.73 
8.000       .768  -93.82  3.176  105.99   .105   41.69   .283  -83.76 
9.000       .747 -102.69  2.958   99.36   .111   38.36   .279  -90.05 

            10.000       .725  -109.21  2.71     93.75   .116   35.96    .274  -95.59 
  

Модель транзистора, заданная в виде таблицы S-параметров, включается в 
структуру СВЧ усилителя в виде четырехполюсника. Этот четырехполюсник 
называется неизлучающей цепью и подключается к внутренним портам 
структуры. 
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Зададим единицы длины (мм) и командой Draw->Box  начертим отрезок 
волновода размером 23 мм x 10мм, в который будет включаться транзисторный 
СВЧ усилитель. Длина этого отрезка волновода 25 мм, т.е. на 5 мм больше, чем 
диэлектрическая плата, на которой будет наноситься согласующая структура. 
 

  
Рис.20.3. Выбор 

размерности длины Рис. 20.4. Черчение отрезка волновода 

 
Далее в этот волновод установим отрезок диэлектрической платы  

(рис. 20.5) и на него нанесем металлическое покрытие с одной стороны в виде 
трапеции (рис. 20.6). Это будет согласующая структура, которую можно считать 
антенной, включенной на входе активного элемента. 
 

 
Рис. 20.5. Черчение диэлектрической подложки 
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На одной поверхности этой подложки начертим металлическую форму в 
виде трапеции командой Geometry->Surface->Polyline по точкам, координаты 
которых приводятся в табл. 17.1. 

Таблица. 17.1   
Точки 1 2 3 4 
U 5 5 4 -0.5 
V -0.5 -0.5 -0.5 -0.5 
N 0.5 20 20 0.5 

 

 
Рис 20.6. Параметры диэлектрической платы и формы согласующей структуры 

 
Командой Copy Special -> Copy and Rotate скопируем и прокрутим вокруг 

оси копию, чтобы создать вторую часть согласующей структуры (рис. 20.7). 
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Рис. 20.7. Копирование и вращение второй части согласующей структуры 
 

Создадим два прямоугольника один над другим, в сечении, где должен 
находиться порт, к которому подключается транзистор. Прямоугольники 
создаются в плоскости XOY командой Draw-> Rectangle, причем так, чтобы эти 
прямоугольники находились «внутри» платы, на расстоянии 0.5 мм от края 
(N=0.5). 
 

       
   

Рис. 20.8. Параметры верхней и нижней части порта на ребре 
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Объединим все компоненты структуры. В окне подробностей заполним 

диэлектрик материалом Diel с проницаемостью 10. 
Для моделирования транзисторного СВЧ усилителя, как и в случае 

классического крепления транзистора на микрополосковой плате, применим 
порты Edge port на ребре (рис. 20.9). В этих точках подключается транзистор, а 
сами фаски выполнены в виде вибраторных антенн, или антенн Вивальди.  

  
а) б) 

Рис. 20.9. Порты, между которыми включается активный элемент 
 

Верхнюю и нижнюю фаску, на которых ставится порт (рис. 20.9б), создадим 
так, чтобы они были продолжением вибраторов согласующей структуры. 

 
Рис. 20.10. Создание внутреннего порта на ребре для подключения транзистора 

 
Порт на ребре создается командой Ports-> Create Edge Port, по которой 

появляется диалог рис. 20.10.  
Поверхностям согласующих структур придадим свойство Perfect Electrical 

Conductor. На сторону, на которую ставим волноводный порт, также задаем 
граничное условие Perfect Electrical Conductor. Волноводный порт создаем 
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командой Port->Create Port-> Waveguide ports, по которой появляется диалог 
рис. 20.11. 

 
Рис. 20.11. Создание волноводного порта 

 
Теперь нужно провернуть с копированием эту часть волноводного 

усилителя на 180° относительно оси Y  и на 90° относительно оси Z, чтобы 
создать выходной волновод. 

 
Рис. 20.12. Первый разворот части волновода на 180 град 
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Рис. 20.13. Разворот на 90° 

 
Рис. 20.14. Конструкция волноводного ТУ СВЧ, у которого входная и выходная 

согласующая структура повернуты на 90° 
 

Объединим эти две части структуры волноводного усилителя. После 
объединения четыре фаски, связывающие волноводы, удалим. 

Теперь получаем структуру (рис. 20.14), на которую нужно поставить 
второй внутренний порт и второй волноводный порт. 
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Рис. 20.15. Вид со стороны внутреннего сечения волноводного транзисторного 

СВЧ усилителя 
 

Теперь порты будут развернуты на 90 градусов, что, как предполагается, 
уменьшит внутреннюю обратную связь внутри структуры. 

Для удобства можно порты переименовать так, что Port1  и Port2 будут 
внешними волноводными портами усилителя, а Port_tran1  и  Port_tran2 – 
подключаться к транзистору (рис. 20.16). 
 

 
Рис. 20.16. Список портов в дереве проекта 

 
Основная волна (мода) в волноводе должна быть распространяющейся. 

Поэтому расчет нужно задачи в диапазоне частот, в котором волна на волноводе 
становится распространяющейся. Для нашего размера волновода частота среза 
меньше 7 ГГц, поэтому зададим расчет с 7 ГГц. 

Для сравнения пассивной структуры и структуры, в которую будет включен 
транзистор, выполним расчет в диапазоне от 7 до 20 ГГц 

Соединение неизлучающей цепи (транзистора) с СВЧ структурой 
выполняется в диалоге, как показано на рис.20.17. Многополюсник может быть 
определен в терминах S-, Y- или Z-параметров, может быть импортирован как 
внешний файл Touchstone, или вручную задан в CADFEKO.  

Опорные импедансы портов будут определены в файле S-параметров. Если 
параметры задаются вручную в CADFEKO, то можно использовать максимум 4 
порта, и для каждого порта должны быть определены опорные импедансы.  
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Рис. 20.17. Подключение S-параметров транзистора к внутренним портам 2 и 4 
транзисторного СВЧ усилителя в диалоге программы FEKO 

 
Антенна Вивальди является широколополосной антенной. Плавное 

изменение её формы позволяет согласовать входной импеданс транзистора, 
который может быть порядка единиц Ом  и линию с характеристическим 
импедансом 50 Ом. В области, где щель между проводниками маленькая, по 
сравнению с  длиной волны в свободном пространстве, волны сильно связаны, и 
когда расстояние между ними увеличивается, взаимодействие становится все 
более слабым, и волны излучают от антенны. Это случается, когда расстояние 
между линиями на краю становится больше половины длины волны (λ/2).  

      
Рис. 20.18. Волноводный СВЧ усилитель, в котором транзистор находится на 

микрополосковой плате 
 

Заметим, что ребро, на котором задается порт, не обязательно должно быть 
продолжением согласующей структурой. Микрополосковая линия создается на 
верхней поверхности параллелепипеда, который заполняется диэлектрическим 
материалом. Нижняя поверхность параллелепипеда объединяется с земляной 
платой. Боковые стенки этого параллелепипеда удаляются. Граничный порт (рис. 



397 
 

20.9а) создается командой Geometry → Create port → Edge port. Положительная 
и отрицательная фаски порта на ребре – это верхняя и нижняя вертикальные 
фаски, на которые разрезается параллелепипед, по горизонтальной плоскости 
посредине (рис. 20.9б). 

Пусть ширина линий согласующей структуры 1 мм, расположенной на 
подложке толщиной 0.5 мм (диэлектрическая проницаемость подложки  равна 
10). Выполним расчет в диапазоне частот от 1 до 10 ГГц (рис. 20.19). Этот же 
расчет транзисторного СВЧ усилителя выполним с помощью программы MWO. 

Если длину шлейфов выбрать намного меньше длины волны, то это будет 
означать, что транзистор включен в измерительную линию с характеристическим 
сопротивлением 50 Ом, и в этом случае можно утверждать, что коэффициент 
усиления равен  G=|S21 |2  . 

 

Рис. 20.19. Частотные характеристики отдельного транзистора и волноводного 
усилителя, созданном на этом транзисторе 

Расчет электродинамическим способом (в отличие от MWO, где для 
моделирования отдельных частей согласующей структур: входной СТЦ1 и 
выходной СТЦ2 нужно создавать отдельные экранирующие боксы), в FEKO 
чертится вся структура, в которую вставляются активные элементы (рис. 20.18). 
Таким образом, связи между согласующими структурами сохраняются. 

20.2 Устойчивость волноводного СВЧ усилителя 

Очень важным параметром является устойчивость работы в широком 
диапазоне частот. Устойчивость работы структуры, в которой включен активный 
элемент (транзистор, например), оценивается инвариантным коэффициентом 
устойчивости [17]. Этот коэффициент показывает степень пересечения 
окружности неустойчивой работы с плоскостью диаграммы Смита входного и 
выходного коэффициента отражения. Известно, что для получения абсолютной 
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устойчивости нужно, чтобы коэффициент устойчивости был больше 1 во всем 
рабочем диапазоне частот. 

1221

22
22

2
11

2
S1

k
SS

S S


,     (1)   

где  ΔS=S11*S22-S21*S12. 

Расчет по этой формуле, для транзистора, S-параметры которого приведены 
в Табл.1, дает коэффициент устойчивости, меньший 1 (рис. 20.20, расчет на 
программе MWO). Это означает, что должны быть предприняты специальные 
условия, чтобы увеличить устойчивость усилителя.  

 

Рис. 20.20. Коэффициент устойчивости  транзистора и волноводного усилителя, 
реализованного как показано на рис. 17.5 

Расчет коэффициента устойчивости волноводного усилителя, 
реализованного по схеме рис.20.18 показывает, что в диапазоне от 15 до 17 ГГц 
он имеет K-1, что означает его склонность к самовозбуждению. В эксперименте 
была отмечена высокая чувствительно усиления от напряжения питания. Таким 
образом, нужно использовать развязку входной и выходной согласующей 
структуры, чтобы повысить, таким образом, устойчивость волноводного 
транзисторного усилителя. 

В реальном усилителе, кроме внутренней обратной связи, действует 
внешняя обратная связь. Для увеличения коэффициента устойчивости и 
устойчивого усиления, можно выполнить оптимизацию конструкции корпуса, как 
его размеров, так и свойств покрытия. Поворот выходного волновода на 90º (рис. 
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20.21) значительно уменьшает внешнюю обратную связь за счет смены 
поляризации.  

 
Рис. 20.21. Волноводный транзисторный СВЧ усилитель, состоящий из двух 
повернутых волноводов и имеющий дополнительную развязку по поляризации 

 
Современный подход проектирования любых СВЧ конструкций включает 

оптимизацию. В качестве функции цели в FEKO можно задать несколько 
целевых функций, и такие образом выполнить векторную оптимизацию, выбирая 
весовые коэффициенты этих целевых функций. Кроме того, используя критерий, 
который называется «Маска целевой функции», можно задать сложную 
зависимость целевой функции, не только в частотном диапазоне, но и диапазоне 
других параметров. Например, можно задать требуемую сложную форму 
диаграммы направленности активной антенны. 

Поскольку антенна Вивальди можно построить с различными 
конфигурациями вибраторов (скачки, экспоненциальный раскрыв), то количество 
изменяемых параметров может достигать десяти. 

 

Рис. 20.22. Оптимизация волноводного СВЧ усилителя по критерию согласования 
на входе и выходе и коэффициенту передачи 

На рис. 20.22 приводятся графики, которые показывают, как изменяются 
характеристики волноводного транзисторного усилителя (на одной частоте) в 
процессе оптимизации, как изменяется и сходится процесс оптимизации. 
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В результате постпроцессорной обработки данных получаем, используя 
расчет по (1), что коэффициент устойчивости усилителя имеет значения, 
приведенные на рис. 20.23. Диапазон коэффициента устойчивости от 0 до 1 
означает, что усилитель становится потенциально неустойчивым только в том 
случае, если он нагружается на импедансы портов, отличные от 50 Ом. Величина 
k>1 указывает абсолютную устойчивость усилителя. 

 
Рис. 20.23. Коэффициент устойчивости волноводного усилителя с повернутыми 

на 90º отрезками волноводов 
 

Увеличение устойчивости усилителя обычно связано с согласованием. 
В заключении приведем также рассчитанные на FEKO комплексные 

коэффициент отражения волноводного транзисторного СВЧ усилители, на входе 
и выходе. 

 

  
Рис. 20.24. Частотные 

зависимости параметров S11  
и  S22  на диаграмме Смита 

Рис. 20.25. Частотные характеристики модуля 
прямой передачи S21  и обратной передачи S12 
волноводного транзисторного СВЧ усилителя 

 
Экспериментальные результаты показаны на рис. 20.24 и 20.25 в виде 

крестиков. Эксперимент показывает более широкую полосу пропускания, чем 
расчет. При каскадировании отдельных каскадов ширина полосы пропускания 
уменьшается. Можно отметить, что результаты расчета значительно зависят от 
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поглощения и потерь в реальных металлах и подложках. Нелинейные 
зависимости от входной мощности и шумовые свойства в рамках данной работы 
не исследовались. 

20.3 Выводы 
Программа электродинамического моделирования FEKO показывает  

широкие возможности для электродинамического моделирования СВЧ структур с 
внедренными в них активными элементами: диодами, транзисторами, что 
показано на примере транзисторного СВЧ усилителя. Обратные связи между 
входным и выходным портом в этом случае учитываются автоматически. Такой 
подход можно считать перспективным для проектирования волноводных 
транзисторных СВЧ усилителей, активных антенн и активных антенных решеток, 
и структур, которые выполняют роль согласующих и излучающих элементов 
одновременно.  
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21  МОДЕЛИРОВАНИЕ АНТЕННОЙ РЕШЕТКИ НА 
ДИЭЛЕКТРИЧЕСКОЙ ПЛАТЕ 

21.1 Моделирование 5-канального излучателя 
Выполним анализ антенны, которая работает на поверхностных волнах. 

Антенная решетка состоит из нескольких антенн, которые возбуждаются 
щелевыми линиями, переходящими в двумерный раскрыв в виде апертуры 
антенны Вивальди (рис. 21.1). 

 

 
Рис.21.1. Структура антенной решетки с раскрывом 4 мм 

 
Антенная решетка создается на диэлектрической плате, снизу и сверху 

которого наносится металлические формы. Структура антенной решетки имеет 5 
портов вверху, и 5 портов снизу диэлектрической платы (рис. 21.1). 

Программа FEKO позволяет выполнить моделирование металлических 
структур, лежащих на бесконечной диэлектрической плоскости. Структура 
антенны задается в диалоге рис. 21.2, где указано, что внизу и вверху 
диэлектрического слоя располагается бесконечные слои свободного пространства. 
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Рис. 21.2. Бесконечная диэлектрическая плоскость с проницаемостью 

 
Чтобы возбудить каждый из 5 каналов, нужно поставить по два дискретных 

порта сверху и снизу щелевых линий, и запитать их синфазно. 
Эти дискретные порты возбуждают щелевую линию внизу и над 

бесконечной диэлектрической плоскостью. Можно было бы оставить один порт, 
если бы бесконечную диэлектрическую плоскость можно было бы пересечь 
бесконечной магнитной стенкой, но этой возможности в текущей версии FEKO 
нет. 

Режим бегущей волны в плоски антенн реализуется так, что направленность 
антенны совпадает с осью. Для этого нужно подобрать диэлектрическую 
проницаемость подложки так, чтобы поле вдоль линии спадало с минимальной 
вариацией. 

Чтобы получить КСВ по каждому порту, нужно учесть взаимную связь 
между связанными структурами, которые оцениваются коэффициентами связи 
между портами. Для этого нужно объединить элементы матрицы, относящиеся к 
портам на одном слое и на противоположном слое. Каждый откорректированный 
элемент равен: 

5,,,
~

 mnmnmn SSS
    (1), 

и для десяти портов решетки формулу (1) можно расписать в виде пяти формул: 
 

6,11,11,1
~ SSS   

7,12,12,1
~ SSS   

8,13,13,1
~ SSS   
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9,14,14,1
~ SSS   

10,14,15,1
~ SSS   

 
Таким образом, кроме расчета полной матрицы 5x5, нужно выполнить 

расчет по указанным формулам, которые учитывают влияние линий вверху и 
внизу бесконечной пластины. 

Однако нужно начать с расчета характеристического сопротивления такой 
структуры. Для этого выполним моделирование структуры, показанной на рис. 
21.3. Построим линию с четырьмя портами. Нужно узнать характеристическое 
сопротивление этой щелевой линии, и обеспечить согласование между портами. 
Это аналогично тому, что нужно получить наименьшее |S11| с учетом связи между 
портами. 

Зададим единицы – мм и параметры диэлектрика с именем sub_inf 
проницаемостью 10. Расчет выполним в диапазоне 33 – 37 ГГц.  

 

 
Рис. 21.3. Коэффициент отражения со стороны входе отрезка щелевой линии 

 
В этой щелевой линии стоят 4 порта. Здесь нужно найти ширину щели и 

расстояние от порта до замыкания линии, при которых выполняется полная 
передача энергии между портами. Еще важно рассчитать ближнее поле вдоль 
продольной линии по центру антенны. Ближнее поле должно быть спадающим (на 
рис.21.4 показано спадающее поле на нескольких частотах). 
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Рис. 21.4. Ближнее поле, рассчитанное вдоль линии для серии частот 

 
Изменяя опорное сопротивление, можно показать, что наибольшая передача 

выполняется при сопротивлении 190 Ом. Это сопротивление и было выбрано как 
характеристический импеданс щелевой линии.  
 

 
Рис. 21.5. Частотные характеристики антенной решетки 

 
  Используя этот характеристический импеданс при расчете S параметров, 
получилим (рис. 21.5), что лучшее согласование на частоте 35 ГГц. 

Теперь нужно начертить и выполнить анализ одного элемента будущей 
антенной решетки. Между двумя планарными рупорами стоит диэлектрическая 
плата бесконечного размера. 
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Рис.21.6. Установка импедансов портов, нагруженных на щелевую линию 
 

 
Рис. 21.7. Задание расчета ближнего поля на расстоянии 40 мм от фазового центра  
 

Эти значения в точках можно записать в файле в виде электрических и 
магнитных полей, а затем выполнить суммирование полей, вызывая файлы, в 
которых занесены поля. 

Черчение одного элемента (замкнутый полигон) выполним командой  
Geometry->Surface->Poligons по точкам (рис. 21.8). 
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Рис.21.8. Диалог черчения полигона и созданная как единая форма планарная 

щелевая антенна. 
 

Начертим также линии, на которые будут поставлены дискретные порты, 
командой Draw->Line (рис. 21.9) 
 

 
 

Рис. 21.9. Черчение линии, на которую ставится проводной порт. 
 

После создания формы антенны, этого многоугольник можно скопировать с 
переносом на 1 мм вниз по оси Z, и аналогично по оси Y. 

Полученная антенная решетка из щелевых антенн с нумерацией портов 
показана на рис. 21.10. 
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Рис. 21.10. Нумерация портов в антенной решетке, состоящей из двух групп 

сверху и снизу бесконечной диэлектрической платы  
 
На 3-й и 8-й порты задаем источники напряжения. На остальные порты 

задает нагрузки 190 Ом (рис. 21.11). Такая расстановка возбуждения позволяет 
рассчитать ДН решетки, которая будет соответствовать диаграмме сканирования, 
при управлении фазами сигнала, подаваемого на каждый из входов. 

 
 

Рис. 21.11. Задание импедансов портов, включенных между пучностями поля в 
щелевой линии 
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Итак, мы имеем 8 портов, с опорными импедансами 190 Ом. Расчет будем 

выполнять в диапазоне частот от 29 ГГц до 40 ГГц, который зададим в диалоге 
рис. 21.12.  

Поскольку решетка моделируется на бесконечной диэлектрической 
плоскости, это исключает возможность расчета дальнего поля. Поэтому 
диаграмму направленности излучения будем оценивать по рассчитанному 
ближнему полю. 

Зададим расчет ближнего поля по дуге, охватывающей антенную решетку 
(рис. 21.7) 
 

 
 Рис. 21.12. Задание частотного диапазона анализа 

 
 

В результате электродинамического моделирования можно вывести на эту 
дугу любую из компонентов электрического и магнитного поля (рис. 21.13). 
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Рис. 21.13.Ближнее поле вдоль дуги с радиусом 4 мм 
 

Для того, чтобы выполнить верный расчет отражения от отдельных 
элементов антенной решетки, необходимо учесть связь между ними, что 
выполняется с помощью калькулятора математических выражений (рис. 21.14)  
 

 
Рис. 21.14. Применение математических выражений для постпроцессорной 

обработки данных (FEKO 5.5) 
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Рис. 21.15. Частотные характеристики коэффициента отражения со стороны 
порта антенной решетки (черная - с учетом связей между всеми портами). 

 

 
Рис. 21.16. Поле, излучаемое антенной решеткой 
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21.2 Анализ решетки на диэлектрической плате конечного 
размера 

В выполненном выше анализе выводится ближнее поле, а возможности 
рассчитать характеристики дальнего поля нет. Для расчета дальнего поля 
рассмотрим один элемент решетки на маленькой диэлектрической плоскость. Для 
этого командой Infinite plate вызовем диалог рис. 21.17. и переведем структуру в 
свободное пространство. 
 

     
        Было                                                Стало 

Рис. 21.17. Включение и выключение бесконечной диэлектрической платы 
 

В результате расчета можно получить трехмерную диаграмму 
направленности решетки (рис. 21.18), сечение которой показано на рис. 21.19. 
 

 
 

Рис. 21.18. Объемная диаграмма направленности элемента антенной решетки 
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Рис. 21. 19. Диаграммы направленности на трех частотах 
 

В последнее время в развитии техники миллиметрового и 
субмиллиметрового диапазонов (ММД и СММД) наблюдается устойчивая 
тенденция перехода от волноводных принципов формирования и 
пространственной обработки полей к оптическим принципам. Такая тенденция 
является продолжением наблюдавшейся ранее тенденции перехода от 
«проводного» механизма передачи электромагнитной энергии, связанного с 
использованием линий передачи с Т- и квази–Т–волнами к волноводному 
механизму, связанному с использованием диэлектрических, металлических, 
щелевых, полосковых и т.д. волноводов. Поскольку концентрация поля в 
волноводе существенно ниже, чем в линии передачи, то и затухание волн, в 
особенности обусловленное потерями в металлических элементах конструкции, в 
волноводах значительно меньше, чем в линиях передачи. Развивая эту идею 
дальше, можно отказаться от направляющих структур полностью и перейти к 
обработке и передаче волновых пучков, поле которых распределено в еще 
большей области пространства, чем в случае волновода. Основными элементами 
таких оптических или точнее квазиоптических устройств, являются различные 
зеркала и линзы. 
 Указанная тенденция затронула не только объемные устройства, но и 
интегральные схемы, которые также могут строиться с использованием 
оптических принципов. Устройства указного типа активно исследуются сейчас в 
связи с повышением актуальности технического освоения коротковолновой части 
ММД и СММД. Таким образом, можно говорить о появлении нового направления 
в данной области науки и техники, которое можно назвать планарной или 
интегральной СВЧ оптикой. Отметим, что наиболее вероятной областью 
практического использования обсуждаемых устройств является проектирование 
различных антенн ММД и СММД. 
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22 ЗАКЛЮЧЕНИЕ 

Тенденции, методы и стратегии проектирования сложных СВЧ 
устройств с использованием современных программ 

 
Современные радиотехнические устройства фактически состоят из 

волнового канала распространения, преобразования и усиления радиоволн и 
цифровой части. Цифровые компоненты – цифровые фильтры, усилители, 
генераторы, компараторы, обнаружители и распознаватели сложной 
последовательности цифровых сигналов, системы разделения полезных и 
вредных сигналов – переходят в разряд микросхем и программируемых 
процессоров, созданные как отдельные радиотехнические узлы, в будущем все 
чаще будут входить в канал распространения СВЧ радиоволн. 

Поэтому проектирование систем приема и обработки радиоволн включает 
анализ коммутационных, модуляционных и прочих узлов, управляемых на уровне 
цифры. Эти и другие особенности современных радиосистем требуют разработки, 
выбора и исследований и развития новых методов анализа, синтеза и 
проектирования как всей системы, так и отдельных узлов. 

В условиях высокого темпа производства, когда нужно быстро ответить на 
возникающий вопрос, как организатору научной работы, так и исполнителям, от 
научных сотрудников до инженера, о соотношении аналитических и численных 
методов для решения поставленной задачи, и получить однозначный ответ: какой 
метод нужно выбрать для решения конкретной задачи с заданной степенью 
точности. 

Решение одной и той же задачи методами, принципиально отличающимися 
друг от друга, например методом конечных элементов, методом FDTD и методом 
моментов, реализованным в FEKO, позволяет прийти к точному решению. 

Отметим тот факт, что необходимый темп исследований и разработок 
бортовых и наземных антенных систем невозможен без создания новых 
информационных технологий проектирования устройств произвольной топологии 
на электродинамическом уровне. Подобные технологии не сводятся только к 
усовершенствованию распространённых методик аналитического и 
параметрического синтеза, использующих для анализа и оптимизации на 
вычислительных системах электродинамические программы, созданные для 
конкретных топологий устройств на основе численных методов решения 
уравнений Максвелла. 

Альтернативным подходом является методика топологического синтеза с 
использованием универсальных электродинамических программ, базирующихся 
не на решении уравнений Максвелла для конкретной краевой задачи, а на 
импедансных или потоковых дискретных сеточных операторах. В таком подходе 
имеется возможность нелинейного анализа СВЧ схем, используя алгоритм 
SPICE. 
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В основе топологического синтеза лежит разделение математических 
моделей: эвристических и компьютерных. Человек занимается проблемами 
поиска оптимального решения, используя предельно простой математический 
аппарат (теория на уровне инвариантов) и геометрическую (образную) интуицию. 
Решение краевых задач полностью автоматизируется и поручается компьютеру. 
Именно при таком подходе появляется возможность построения антенных систем 
с уникальными характеристиками. 

При этом встает задача создания эффективных алгоритмов (и программ на 
их основе), позволяющих выполнить анализ электромагнитных процессов 
прямыми алгебраическими методами в частотной или временной областях. 
Построение таких эффективных алгоритмов возможно на основе метода 
импедансного аналога электромагнитного пространства. При подобном подходе 
возникает проблема увеличения вычислительной мощности программ и 
повышения точности анализа сложных систем. Несмотря на увеличивающуюся 
производительность современных компьютеров, универсальные программные 
средства, которыми располагает инженер, позволяют исследовать с требуемой 
точностью трехмерные задачи с весьма ограниченной областью анализа (объемом 
порядка 101010). 

Современный этап проектирования радиосистем остро ставит следующие 
задачи, которые решаются только при использовании высокоскоростных 
компьютеров и суперкомпьютеров. 
 
1. Структурный синтез СВЧ-устройств произвольной формы. В эту задачу 
входит освобождение понятия синтеза от любых ограничений, переход от 
структурно-параметрического к параметрическому и полному генетическому 
алгоритму синтеза, выполнение скалярной и векторной оптимизации и получение 
в результате решения задачи структуры произвольной формы. 
 
2. Сравнение и анализ особенностей методов моделирования СВЧ устройств. 
Быстрое развитие различных методов моделирования, включая методы, 
основанные на теории цепей, метод Олинера, а также электродинамические 
методы в частотной и временной области, в которые входят метод моментов 
МОМ, методы FDTD, FEM, TLM, многомодовых блоков, требуют оценки 
точности расчета, времени и компьютерных ресурсов для реализации различных 
методов электродинамического решения поля. 

Здесь возможны различные цели – либо выбор наиболее перспективного 
метода и отказа от других, либо объединение нескольких методов в одной 
оболочке, как сделано в FEKO, с объединением нескольких методов (оптических, 
радиотехнических и физических). 
 
3. Совместное моделирование (косимуляция) радиотехнических устройств, 
т.е. моделирование в одном процессе СВЧ узлов (каналов распространения, 
фильтров, линейных и нелинейных усилителей, антенн) и цифровых, а также 
коммутационных узлов. 
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Эскизное проектирование по современным критериям искажения верхней и 
нижней границы динамического диапазона. Амплитудные и фазовые искажения в 
тракте значительно зависят от характеристик антенн. Связь между 
характеристиками системы и характеристиками антенных и СВЧ узлов. 
Электромагнитная совместимость в различных сечениях радиосистемы. 
 
4. Методические подходы и рекомендации выбора методов расчета при 
проектировании радиотехнических устройств и сложных систем (система 
радиоидентификации, сотовая телефонная и ближняя связь, беспилотный самолет, 
системы слежения и управления, медицинские приборы), включающих 
радиочасть и часть цифровой обработки. Пространственные подавители помех. 
Управление и адаптация многолепестковой диаграммы направленности. 
 
5. Решение электродинамических задач совместно с задачами с физической 
формулировкой (моделирование на уровне нано и микроструктуры, включая 
воздействие сигнала оптического диапазона, распространение радиоволн в 
плазме). В этих случаях нужно выработать подходы к решению физических задач, 
используя численные методы проектирования. К таким задачам можно отнести 
слабо разработанные пока методы расчета ферритовых устройств с учетом 
свойств магнитного смещения, оптоволоконных линий, диэлектрических 
резонаторов. 
 
6. Решение задач распространения, объединенных с биологическими и 
физическими задачами (например, поглощение мощности в биологическом теле, 
которое может иметь полезное и вредное влияние на жизнь биологического 
организма). Биология и медицина продолжает ставить перед разработчиками 
антенн и СВЧ конструкций самых разнообразных объектов, необходимых для 
медицинских радиолокационных приборов, например, измерителя сахара в крови, 
обнаружителя химических веществ и др. Анализ и оптимизация этих 
радиолокационных систем имеют специфичные требования и цели. Управлением 
ДН таких излучателей остро нуждаются  в системах био- и нанотехнологии, при 
создании сложных управляемых излучающих антенных систем. 
 
7. Композиция и декомпозиция сложных СВЧ устройств при решении задач 
анализ и проектирования. Решение этих задач актуально, например, при 
моделировании фазированных антенных решеток. Расчет связи между 
элементами антенной решетки охватывает моделирование нерегулярных 
антенных решеток. Уже сейчас ставится задача цифрового управления антенными 
решетками, в которых излучатели имеют сложную форму и расположены 
неэквидистантно. Современные системы требуют получения улучшенных 
фазовых и импульсных характеристик. 
 
8. Практические аспекты внедрения новых, численных методов решения 
электромагнитных задач в практику проектирования сложных радиосистем 
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включают решение задач электромагнитной совместимости, разноса каналов 
передачи информации и создания сверхмалых антенн, проектирование систем 
локальной и глобальной радиолокации. Так, развитие методов моделирования 
многоканальных носителей передачи информации (самолеты, корабли) идут 
параллельно с широким распространением дистанционно пилотируемых 
летательных аппаратов, изучением распространения радиоволн в комплексной 
среде. 

В настоящее время можно сказать, что идея внедрения в процесс 
проектирования численных методов, реализованных на персональных 
компьютерах, получает всё более полную реализацию. 

К концу 20 века методы электродинамического моделирования получили 
достойное воплощение в программы ведущих компаний мира. Это программы 
HFSS, CST, MWO, ADS и другие. Выход на коммерческий уровень программы 
FEKO был несколько задержан потому, что она была реализована в виде набора 
карт, что затрудняло внедрение её в университетские курсы. Однако появление 
CADFEKO, а главное, мультипольного метода MFLMM, усилило интерес к 
этому комплексу. Поэтому внедрение в процесс обучения системы FEKO можно 
считать завершением важного этапа инженерного образования. 

Программа FEKO уникальна еще и тем, что освоение её предполагает 
глубокое знание теоретической базы. Всё это ставит FEKO в лидирующее 
положение как в плане обучения, так и в плане внедрения в процесс 
проектирования и производства современных радиотехнических систем. 
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23 СПИСОК СОКРАЩЕНИЙ 

 
MoM – метод моментов, базовый метод решения электродинамической задачи в 
FEKO 
FEM – метод конечных элементов 
FDTD – метод конечных разностей во временной области 
MLFMM - Многоуровневый быстрый многопольный метод расчета 
TLM – метод линий передачи 
САПР – система автоматизированного проектирования 
Сегмент – часть анализируемой структуры, часть линии 
Кубоид – автономный блок в виде параллелепипеда 
Тетраэдр- автономный блок в виде четырехвершинного тетраэдра 
RAM – Random Excess Memory – оперативная память компьютера 
CADFEKO – программа черчения структуры и задание на анализ  
EDITFEKO – программа организации цикла работы FEKO 
POSTFEKO – программа постпроцессорной обработки 
FEKO происходит от немецкой фразы «FEldberechnung bei Korpern mit beliebiger 
Oberflache» (Расчет поля структуры произвольных форм). 
UTD  - однородная теория дифракции (ОТД) 
PO – физическая оптика 
MФO - метод физической оптики, в котором распространение электромагнитных 
волн представляется в виде пучков лучей 
GO – метод геометрической оптики, в котором электромагнитные волны 
представляются в виде лучей, распространяющихся прямолинейно 
СЛАУ – система линейных алгебраических уравнений 
ДН – диаграмма направленности 
РП – рабочая плоскость 
PBC – периодические граничные условия 
CableMode - программа анализа кабелей 
Touchstone – программа фирмы производителя EESoft, анализа линейных СВЧ 
структур 
Microwave Office (MWO)  программа универсального профиля линейного и 
нелинейного анализа СВЧ структур, включающих СВЧ транзисторы, диоды. 
Advanced Design System (ADS) – профессиональная программа анализа 
нелинейных СВЧ структур 
HFSS (High Frequency System Simulator) – программа электродинамического 
анализа трехмерных СВЧ структур, разработанная фирмой AnSoft. 
CST -  комплекс программ расчета СВЧ структур. 
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